
 

SKF @ptitude Analyst for  

SKF Microlog Analyzer 
Documents features applicable to  

SKF Microlog GX / AX Series and CMXA 51-IS 

 

 

 

Part No. 32296800-EN  

Revision C 

User Manual 

Read this manual before using this product.  Failure to follow the 

instructions and safety precautions in this manual can result in serious 

injury.  Keep this manual in a safe location for future reference. 

Copyright  2016 by SKF USA Inc.   

All rights reserved. 

Technical Support Email: tsg-americas@skf.com North and South America 

Technical Support Email: tsg-emea@skf.com 

mailto:tsg-americas@skf.com
mailto:tsg-emea@skf.com


 

SKF USA Inc. 

® SKF is a registered trademark of the SKF Group.  

All other trademarks are the property of their respective owners.   

© SKF 2016 

 

The contents of this publication are the copyright of the publisher and may not be reproduced (even 

extracts) unless prior written permission is granted. Every care has been taken to ensure the accuracy of 

the information contained in this publication but no liability can be accepted for any loss or damage whether 

direct, indirect or consequential arising out of the use of the information contained herein. SKF reserves the 

right to alter any part of this publication without prior notice. 

 

Patents:  US 4,768,380 • US 5,633,811 • US 5,679,900 • US 5,845,230 • US 5,852,351 • 

US 5,854,553 • US 5,854,994 • US 5,870,699 • US 5,907,491 • US 5,992,237 • US 6,006,164 • 

US 6,124,692 • US 6,138,078 • US 6,199,422 • US 6,202,491 • US 6,275,781 • US 6,301,514 • 

US 6,437,692 • US 6,489,884 • US 6,513,386 • US 6,633,822 • US 6,789,025 • US 6,792,360 • 

US 7,103,511 • US 7,697,492 • WO/2003/048714 

 

Product Support – Contact Information 

 

Product Support – To request a Return Authorization, Product Calibration or a Product Support Plan, use 

the web page links for direct contact and support.   

 

Product Sales - For information on purchasing condition monitoring products, services or customer 

support, contact your local SKF sales office. 

 

General Product Information 

 

For general product information (i.e., product data sheet, accessories catalog, etc.), visit the Condition 

Monitoring Products page on SKF.com and select the appropriate product link. 

 

Technical Support Group 

 

Discuss/review issues of specific interest with maintenance and reliability specialists from around the world 

at the SKF Knowledge Centre. 

 

For technical support on issues like troubleshooting product installation, troubleshooting product 

performance, etc., use our technical support web page to contact one of our Technical Support Groups. 

 

Product Registration 

 

Please take a moment to register your product at www.skf.com/cm/register to receive exclusive benefits 

offered only to our registered customers, including receiving technical support, tracking your proof of 

ownership, and staying informed about upgrades and special offers.  (Please visit our website for more 

details on these benefits.) 

 

Tell us how we’re doing! 

 

It’s important that you’re satisfied with the quality of our product user manuals.  We appreciate your 

feedback; if you have comments or suggestions for improvement, please tell us how we’re doing! 
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End-User License Agreement 

 

THIS END-USER LICENSE AGREEMENT (this 

“Agreement”) is entered into by and between 

SKF USA Inc. and/or SKF Condition Monitoring 

Center AB (hereinafter referred to collectively as 

the “Licensor”) and any person or business that 

executes this Agreement by clicking the “I agree” 

icon at the end of this Agreement or by 

accessing, using, or installing the Software 

(“Licensee” or “You”).  Licensor and Licensee 

shall be referred to collectively in this 

Agreement as the Parties. 

 

BY CLICKING THE ACCEPTANCE BUTTON OR 

ACCESSING, USING, OR INSTALLING THE 

SOFTWARE, OR ANY PART THEREOF, YOU 

EXPRESSLY AGREE TO BE BOUND BY ALL OF 

THE TERMS OF THIS AGREEMENT.  IF YOU 

DO NOT AGREE TO ALL OF THE TERMS OF 

THIS AGREEMENT, THE BUTTON INDICATING 

NON-ACCEPTANCE MUST BE SELECTED, 

AND YOU MAY NOT ACCESS, USE, OR 

INSTALL ANY PART OF THE SOFTWARE. 

 

1. DEFINITIONS 

 

(a) Derivative Works.  The Term 

“Derivative Works” shall have the 

same meaning as set forth in the U.S. 

Copyright Act, as amended from time 

to time, in title 17 of the United States 

Code. 

 

(b) Effective Date.  The term “Effective 

Date” shall mean the date on which 

Licensee assents to the terms of this 

Agreement by clicking the “I agree” 

button at the bottom of this 

Agreement. 

 

(c) Intellectual Property Rights.  The 

term Intellectual Property Rights shall 

mean all rights arising or protectable 

under the copyright, trademark, 

patent, or trade secrets laws of the 

United States or any other nation, 

including all rights associated with the 

protection of computer programs 

and/or source code. 

(d) Person.  The term “Person” shall 

mean an individual, a partnership, a 

company, a corporation, an 

association, a joint stock company, a 

trust, a joint venture, an 

unincorporated organization, or a 

governmental entity (or any 

department, agency, or political 

subdivision thereof). 

 

(e) Software.  The term “Software” shall 

mean the software application entitled 

Software for Wireless Monitoring 

System V/T, SKF @ptitude Analyst, 

SKF @ptitude Inspector, SKF @ptitude 

Observer, SKF @ptitude Decision 

Support or any other software within 

the SKF @ptitude family suite, which 

is an application developed, owned, 

marketed, and licensed by Licensor.  

The term Software shall include the 

object code of Software for Wireless 

Monitoring System V/T, SKF @ptitude 

Analyst, SKF @ptitude Inspector, SKF 

@ptitude Observer, SKF @ptitude 

Decision Support or any other object 

code within the SKF @ptitude family 

suite and any and all user manuals, or 

other technical documentation, 

authored by Licensor in connection 

with Software for Wireless Monitoring 

System V/T, SKF @ptitude Analyst, 

SKF @ptitude Inspector, SKF @ptitude 

Observer, SKF @ptitude Decision 

Support or any other software within 

the SKF @ptitude family.  The term 

“Software” includes any corrections, 

bug fixes, enhancements, releases, 

updates, upgrades, or other 

modifications, including custom 

modifications, to Software for 

Wireless Monitoring System V/T, SKF 



 

 

@ptitude Analyst, SKF @ptitude 

Inspector, SKF @ptitude Observer, 

SKF @ptitude Decision Support or any 

other software within the SKF 

@ptitude family suite and any and all 

user manuals.  The term Software 

also includes any supplemental, add-

on, or plug-in software code provided 

to Licensee in the course of receiving 

Product Support Plan services from 

Licensor.  The term Software shall not 

be construed to include the source 

code for Software for Wireless 

Monitoring System V/T, SKF @ptitude 

Analyst, SKF @ptitude Inspector, SKF 

@ptitude Observer, SKF @ptitude 

Decision Support or any other 

software within the SKF @ptitude 

family suite. 

 

2. LICENSE 

 

(a)  Grant of License.  Licensor grants 

Licensee, pursuant to the terms and 

conditions of this Agreement, a non-

exclusive, non-transferable, and 

revocable license to use the Software 

in strict accordance with the terms 

and conditions of this Agreement, 

including any concurrent use, network 

or other limitations set forth in 

subsection (b) below.  All rights not 

specifically granted by Licensor under 

this Agreement are retained by 

Licensor and withheld from Licensee. 

 

(b) Installation and Use Rights.  

Licensee shall use the Software only 

on its internal computer equipment, 

whether such equipment is owned, 

leased, or rented, at the Licensee’s 

principal business office.  The 

following paragraphs govern your 

installation and use rights with regard 

to the Software, depending on the 

type of license you have obtained from 

Licensor. 

(i) If you obtained a stand-alone 

license of the Software, you 

may install one (1) copy of the 

Software on one (1) computer 

residing in your principal 

business office. 

 

(ii) If you obtained a network 

license of the Software, you 

may install one (1) copy of the 

Software on as many 

networked clients 

(workstations) as authorized 

by your network license, as set 

forth more particularly in the 

applicable purchase order or 

other ordering documents 

memorializing your license 

acquisition; provided, however, 

that all network clients 

(workstations) are connected 

to a single licensed database 

residing in your principal 

business office. 

 

(iii) If you obtained a network 

license of the Software, you 

may connect to multiple 

licensed databases, you may 

install the database-dedicated 

clients up to the total number 

of networked clients acquired 

by you under the applicable 

purchase order or other 

ordering documents 

memorializing your license 

acquisition. 

 

(c) Other Conditions of Use.  Licensor 

understands and agrees that the 

Software works in conjunction and is 

compatible with database software 

licensed to you by Microsoft or 

Oracle.  Upon installation of the 

Software, the Software may detect 

an installed database software 

application from Oracle or Microsoft, 



  

 

and if so, the Software will be fully 

installed.  If no installed database 

software application from Oracle or 

Microsoft is detected, the Software 

will not install until such time as 

Licensee installs a valid and Software 

compatible copy of an Oracle 

database or a Microsoft SQL Server 

database and consents to the license 

terms of such database software 

application.  If Licensee does not 

agree to the terms of the Oracle 

database license or the Microsoft 

SQL Server license, or if the Licensee 

fails to install such database 

software, the Software will not work.  

Licensee is responsible for 

maintaining a valid database license 

in accordance with the Oracle or 

Microsoft license agreement (which 

ever is applicable) at all times. 

 

(d) Restrictions on Use.  Licensee may 

use the Software only for its internal 

business purposes and on the 

identified equipment on which the 

Software was first installed or for 

which it is otherwise licensed; 

provided, however, that Licensee 

may temporarily use the Software on 

a back-up system in the event that 

the primary licensed system is 

inoperative or test system not used 

for production but solely for the 

purposes of testing the Software.  

Licensee may not use the Software 

for any other purpose.  Licensee shall 

not: 

 

(i)  permit any parent, 

subsidiaries, affiliated entities 

or third parties to use the 

Software; 

 

(ii) use the Software in the 

operation of a service bureau; 

(iii) allow access to the Software 

through any workstations 

located outside of Licensee’s 

principal business offices; 

 

(iv) rent, resell, lease, timeshare 

or lend the Software to any 

Person; 

 

(v) sublicense, assign, or transfer 

the Software or this license for 

the Software to any Person; 

 

(vi) reproduce, distribute, or 

publicly display the Software; 

 

(vii) make the Software accessible 

to any Person by any means, 

including posting on a web site 

or through other distribution 

mechanisms over the Internet; 

 

(viii) reverse assemble, 

disassemble, reverse engineer, 

reverse compile, decompile, or 

otherwise translate the 

Software or prepare 

Derivative Works based on the 

Software; 

 

(ix) place, reproduce, or make 

available the Software on 

Licensee’s computer network 

if Licensee is only authorized 

by this Agreement to operate 

the Software on a single 

workstation; 

 

(x) exceed at any given point in 

time the total number of 

network clients authorized by 

the applicable purchase order 



 

 

or ordering document to use 

or access the Software; 

 

(xi) edit or modify the Software 

except as expressly authorized 

by Licensor, including altering, 

deleting, or obscuring any 

proprietary rights notices 

embedded in or affixed to the 

Software; 

 

(xii) use the Software in any 

manner that disparages 

Licensor, Microsoft, or Oracle, 

or use the Software in a way 

that infringes the Intellectual 

Property Rights of the 

foregoing parties; or 

 

(xiii) use the Software in a manner 

that violates any federal, state, 

or local law, rule or regulation, 

or use the Software to violate 

the rights of any third party, or 

use the Software to promote 

pornography, hatred, or 

racism. 

 

(e) Copies.  Licensee, solely to enable it 

to use the Software, may make one 

archival copy of the Software’s 

computer program, provided that the 

copy shall include Licensor’s copyright 

and any other proprietary notices.  

The Software delivered by Licensor to 

Licensee and the archival copy shall 

be stored at Licensee’s principal 

business office.  If you purchased a 

network license of the Software, you 

may install one additional copy of the 

Software on your network for the 

limited purpose of testing the 

Software’s operation.  Except for the 

limited reproduction rights set forth in 

this paragraph, Licensee shall have no 

other right to copy, in whole or in part, 

the Software.  Any copy of the 

Software made by Licensee is the 

exclusive property of Licensor. 

 

(f) Modifications.  Licensee agrees that 

only Licensor shall have the right to 

alter, maintain, enhance or otherwise 

modify the Software. 

 

(g) Protection of Software.  Licensee 

agrees that it will take action by 

instruction, written agreement, or 

otherwise as appropriate with any 

person permitted access to the 

Software to enable Licensee to comply 

with its obligations hereunder.  

Licensee shall maintain records of the 

number and location of all copies of 

Software.  Licensee shall not provide, 

permit access to or use of, or 

otherwise make available any 

Software in any form without 

Licensor’s prior written agreement, 

except to Licensee’s employees for 

purposes specifically authorized by 

this Agreement.  Licensee 

understands and agrees that the 

source code for the Software is a 

valuable copyright and contains 

valuable trade secrets of Licensor.  

Licensee agrees not to discover or 

attempt to discover, or assist or 

permit any Person to discover or 

attempt to discover, by any means 

whatsoever the source code of the 

Software. 

 

(h) Licensor’s Audit Rights.  Licensor 

shall possess the right to audit 

Licensee’s use of the Software to 

determine compliance with this 

Agreement (hereinafter referred to as 

“Licensor’s Audit Rights”).  Licensor’s 

Audit Rights shall be exercised in 

accordance with the following 

paragraphs: 



  

 

 

(i) Notice of Audit.  Licensor 

shall provide Licensee with at 

least five (5) calendar days 

advance written notice of its 

intent to exercise the 

Licensor’s Audit Rights. 

 

(ii) Conduct of Audit.  The audit 

conducted by Licensor shall 

consist of a physical review of 

the computer hardware, 

software, and middleware 

operated by Licensee at its 

principal business office and 

any other office for which 

Licensor, in its sole and 

arbitrary discretion, deems an 

audit appropriate.  Licensee 

shall provide Licensor with 

unrestricted access to its 

computer hardware, software, 

and middleware in connection 

with any audit conducted by 

Licensor. 

 

(iii) Costs of Audit.  If Licensor’s 

audit uncovers a violation of 

this Agreement by Licensee, 

Licensee shall pay all costs 

and expenses incurred by 

Licensor in exercising the 

Licensor Audit Rights, 

including, without limitation, 

all attorneys’ fees and agent 

fees incurred by Licensor.  If 

Licensor concludes that no 

violation of this License 

Agreement has occurred, 

Licensor shall bear all costs 

and expenses incurred in 

exercising the Licensor Audit 

Rights.  If Licensee obstructs, 

restricts, or otherwise 

prevents Licensor from 

conducting a full and 

unrestricted audit, Licensee 

shall bear all costs and 

expenses, including attorneys’ 

fees, incurred by Licensor in 

enforcing this Section 2(h) 

before any court or judicial 

tribunal. 

 

(iv) Frequency of Audits.  

Licensor’s Audit Rights shall be 

exercised no more than two 

(2) times in any one calendar 

year.  

 

(i) Validity of Intellectual Property 

Rights.  In any action, dispute, 

controversy, or lawsuit arising out of 

or related to this Agreement, Licensee 

shall not contest the validity of 

Licensor’s Intellectual Property Rights 

related to the Software.  Licensee 

hereby agrees that it has had an 

opportunity to investigate the validity 

of Licensor’s Intellectual Property 

Rights, and acknowledges that 

Licensor’s Intellectual Property Rights 

related to the Software are valid and 

enforceable. 

 

(j) Material Terms and Conditions.  

Licensee specifically agrees that each 

of the terms and conditions of this 

Section 2 are material and that failure 

of Licensee to comply with these 

terms and conditions shall constitute 

sufficient cause for Licensor to 

terminate this Agreement and the 

license granted hereunder 

immediately and without an 

opportunity to cure.  This subsection 

2(j) shall not be construed to preclude, 

or in any way effect, a finding of 

materiality with respect to any other 

provision of this Agreement. 

 



 

 

3.   LICENSE FEE 

The applicable licensee fees will be set forth 

in the quote issued to Licensee by Licensor 

or otherwise established in the applicable 

purchase order or other ordering 

documents memorializing your license 

acquisition. 

 

4.   OWNERSHIP 

 

(a) Title.  Licensee understands and 

agrees that Licensor owns all 

Intellectual Property Rights related to 

the Software, including custom 

modifications to the Software, 

whether made by Licensor or any 

third party.  Licensee agrees that this 

Agreement effects a license, not a 

sale, of the Software and that the first 

sale doctrine, as codified in 17 U.S.C. 

§ 109, does not apply to the 

transaction effected by this 

Agreement. 

 

(b) Transfers.  Under no circumstances 

shall Licensee sell, license, sublicense, 

publish, display, distribute, assign, or 

otherwise transfer (hereinafter 

referred to collectively as a “Transfer”) 

to a third party the Software or any 

copy thereof, in whole or in part, 

without Licensor’s prior written 

consent.  Any Transfer effected in 

violation of this Section 4(b) shall be 

void ab initio and of no force or effect. 

 

5. MAINTENANCE AND SUPPORT 

Licensor may provide you with support 

services related to the Software called 

Product Support Plan (“PSP”) services.  Use 

of PSP is governed by the policies and 

programs described in the PSP literature or 

other material from Licensor’s Product 

Support Department (hereinafter referred 

to as the “PSP Policies”) that may be 

updated by Licensor from time to time. If 

you select and pay for PSP, the PSP 

Policies shall be specifically incorporated 

into this Agreement by this reference.  

Licensee acknowledges that Licensor may 

use any technical information provided by 

Licensee in the course of receiving PSP 

services for Licensor’s business purposes, 

including for product support and 

development.  Licensor will not utilize such 

technical information in a manner that 

identifies Licensee. 

 

6. CONFIDENTIAL INFORMATION 

Licensee agrees that the Software contains 

proprietary information, including trade 

secrets, know-how and confidential 

information (hereinafter referred to 

collectively as the “Confidential 

Information”), that is the exclusive property 

of Licensor.  During the period this 

Agreement is in effect and at all times after 

its termination, Licensee and its employees 

and agents shall maintain the confidentiality 

of the Confidential Information and shall not 

sell, license, publish, display, distribute, 

disclose or otherwise make available the 

Confidential Information to any Person nor 

use the Confidential Information except as 

authorized by this Agreement.  Licensee 

shall not disclose the Confidential 

Information concerning the Software, 

including any flow charts, logic diagrams, 

user manuals and screens, to persons not 

an employee of Licensee without the prior 

written consent of Licensor. 

 

7.   LIMITED WARRANTIES 

 

(a) Licensor warrants that the Software 

will perform substantially in 

accordance with its documentation for 

a period of 180 days from the date of 

shipment of the Software; provided, 

however, that the foregoing warranty 

only applies if: (i) Licensee makes 



  

 

Licensor aware of any defect with the 

Software within seven (7) days after 

the occurrence of the defect; (ii) 

Licensee has paid all amounts due 

under this Agreement; and (iii) 

Licensee has not breached any 

provision of this Agreement.  The 

foregoing warranty does not apply in 

the event that: (i) the Software and 

documentation have been subject to 

misuse, neglect, alteration, 

modification, customization, improper 

installation, and/or unauthorized 

repair; (ii) the Software or any 

associated software or equipment 

have not been properly maintained in 

accordance with applicable 

specifications and industry standards 

or have been maintained in unsuitable 

environmental conditions; or (iii) 

Licensee has used the Software in 

conjunction with other equipment, 

hardware, software, or other 

technology that created an adverse 

impact on the operation, functioning, 

or performance of the Software. 

 

(b) EXCEPT AS SET FORTH IN THIS 

SECTION 7 AND TO THE EXTENT 

PERMITTED BY APPLICABLE LAW, 

ALL EXPRESS AND/OR IMPLIED 

WARRANTIES OR CONDITIONS, 

INCLUDING BUT NOT LIMITED TO 

IMPLIED WARRANTIES OR 

CONDITIONS OF MERCHANTABILITY, 

MERCHANTABILITY OF A COMPUTER 

PROGRAM, INFORMATIONAL 

CONTENT, SYSTEM INTEGRATION, 

FITNESS FOR A PARTICULAR 

PURPOSE, AND NON-

INFRINGEMENT, ARE HEREBY 

DISCLAIMED AND EXCLUDED BY 

LICENSOR. 

 

(c) The remedies set forth in this Section 

7 are the exclusive remedies available 

to Licensee for any problem in the 

performance of the Software. 

8.   LIMITATIONS ON LIABILITY 

 

(a) Limitations and Exclusions.  IN NO 

EVENT WILL LICENSOR BE LIABLE 

TO LICENSEE FOR ANY DIRECT, 

INDIRECT, INCIDENTAL, 

CONSEQUENTIAL, PUNITIVE OR 

OTHER SPECIAL DAMAGES, LOST 

PROFITS, OR LOSS OF INFORMATION 

SUFFERED BY LICENSEE ARISING 

OUT OF OR RELATED TO THIS 

AGREEMENT OR THE USE OF THE 

SOFTWARE, FOR ALL CAUSES OF 

ACTION OF ANY KIND (INCLUDING 

TORT, CONTRACT, NEGLIGENCE, 

STRICT LIABILITY, BREACH OF 

WARRANTY OR CONDITION, AND 

STATUTORY) EVEN IF LICENSOR HAS 

BEEN ADVISED OF THE POSSIBILITY 

OF SUCH DAMAGES.  THE 

PRECEDING EXCLUSION AND 

DISCLAIMER OF DAMAGES SHALL 

APPLY TO ALL CLAIMS MADE BY 

LICENSEE RELATED TO OR ARISING 

OUT OF LICENSEE’s USE OF THE 

SOFTWARE, INCLUDING, BUT NOT 

LIMITED TO, CLAIMS ALLEGING THAT 

THE SOFTWARE, OR ANY 

COMPONENT THEREOF, FAILED OF 

ITS ESSENTIAL PURPOSE OR FAILED 

IN SOME OTHER RESPECT. 

 

(b) Acknowledgment.  Licensee agrees 

that the limitations of liability and 

disclaimers of warranty set forth in 

this Agreement will apply regardless 

of whether Licensor has tendered 

delivery of the Software or Licensee 

has accepted the Software.  Licensee 

acknowledges that Licensor has set its 

prices and entered into this 

Agreement in reliance on the 

disclaimers of warranty and the 

limitations and exclusions of liability 

set forth in this Agreement and that 

the same form an essential basis of 

the bargain between the Parties. 



 

 

9.   TERM AND TERMINATION 

 

(a) Term.  This Agreement shall 

commence on the Effective Date and 

shall continue in existence until it is 

terminated in accordance with Section 

9(b) below. 

 

(b) Termination.  Licensor may 

terminate this Agreement and the 

license conveyed hereunder in the 

event that Licensee breaches any 

provision, term, condition, or 

limitation set forth in this Agreement, 

including but not limited to the license 

restrictions set forth in Section 2(d) of 

this Agreement. 

 

(c) Effect of Termination.  Within ten 

(10) days after termination of this 

Agreement and the license granted 

hereunder, Licensee shall return to 

Licensor, at Licensee’s expense, the 

Software and all copies thereof, and 

deliver to Licensor a certification, in 

writing signed by an officer of 

Licensee, that all copies of the 

Software have been returned to 

Licensor and that Licensee has 

discontinued its use of the Software. 

 

10. ASSIGNMENT 

 Licensee shall not assign or otherwise 

transfer the Software or this Agreement to 

anyone, including any parent, subsidiaries, 

affiliated entities or third Parties, or as 

part of the sale of any portion of its 

business, or pursuant to any merger, 

consolidation or reorganization, without 

Licensor’s prior written consent.  Any 

assignment or transfer effected in violation 

of this Section 10 shall be void ab initio 

and of no force or effect. 

 

11. FORCE MAJEURE 

 Neither party shall be in default or 

otherwise liable for any delay in or failure 

of its performance under this Agreement if 

such delay or failure arises by any reason 

beyond its reasonable control, including 

any act of God, any acts of the common 

enemy, the elements, earthquakes, floods, 

fires, epidemics, riots, failures or delay in 

transportation or  communications; 

provided, however, that lack of funds shall 

not be deemed to be a reason beyond a 

party’s reasonable control.  The Parties 

will promptly inform and consult with each 

other as to any of the above causes that in 

their judgment may or could be the cause 

of a delay in the performance of this 

Agreement. 

 

12. NOTICES 

 All notices under this Agreement are to be 

delivered by depositing the notice in the 

mail, using registered mail, return receipt 

requested, to the party’s last known 

principal business address or to any other 

address as the party may designate by 

providing notice.  The notice shall be 

deemed delivered four (4) days after the 

notice’s deposit in the mail, if such notice 

has been sent by registered mail. 

 

13. CHOICE OF LAW 

 This Agreement (including all Exhibits), 

including its formation, execution, 

interpretation, and performance, and the 

rights and obligations of the Parties 

hereunder, shall be governed by and 

construed in accordance with the laws of 

the Commonwealth of Pennsylvania, 

without regard to any conflicts of law (or 

choice of law) principles thereof. 

 

14. CONSENT TO JURISDICTION 

 In the event that either party initiates 

litigation relating to or arising out of this 



  

 

Agreement, Licensor and Licensee 

irrevocably submit to the exclusive 

jurisdiction of the state or federal court in 

or for Philadelphia, Pennsylvania for the 

purposes of any suit, action or other 

proceeding relating to arising out of this 

Agreement or any transaction 

contemplated hereby or thereby (“Legal 

Proceedings”).  Licensee further agree that 

service of any process, summons, notice, 

or document by U.S. registered mail to 

such Party’s respective address shall be 

effective service of process for any Legal 

Proceeding.  Licensor and Licensee 

irrevocably and unconditionally waive any 

objection to personal jurisdiction and/or 

the laying of venue of any Legal 

Proceeding in the state or federal court in 

or for Philadelphia, Pennsylvania, and 

hereby further irrevocably and 

unconditionally agree not to plead, argue, 

or claim in any such court that any Legal 

Proceeding brought in any such court has 

been brought in an inconvenient forum 

and otherwise waive any and all objections 

to the forum. 

 

15. EXPORT CONTROLS 

 Licensee shall not export or reexport, 

directly or indirectly, the Software without 

complying with the export controls 

imposed by the United States Export 

Administration Act of 1979, as amended 

(or any future U.S. export control 

legislation) and the regulations 

promulgated thereunder.  

 

16. GOVERNMENT END USERS 

 If Licensee is acquiring the Software for or 

on behalf of a subdivision of the U.S. 

federal government, this Section 16 shall 

apply.  The Software was developed 

completely at private expense, is existing 

computer software, is a trade secret for all 

purposes of the Freedom of Information 

Act, is “restricted computer software” and 

in all respects proprietary data belonging 

solely to Licensor, and all rights are 

reserved under the copyright laws of the 

United States.  Use, duplication, or 

disclosure by the Government is subject to 

restricted rights as set forth in 

subparagraphs (a) through (d) of the 

Commercial Computer Software Restricted 

Rights clause at FAR 52.227-19, or for 

DoD units, the restrictions as set forth in 

subparagraph (c)(1)(ii) of the Rights in 

Technical Data and Computer Software 

clause at DFARS 252.227-7013. 

 

17. TRADEMARKS 

 Licensee agrees that SKF @ptitude 

Analyst, SKF @ptitude Inspector, SKF 

@ptitude Observer, SKF @ptitude Decision 

Support or any other software within the 

SKF @ptitude family suite and the trade 

dress, logos and other designations of 

source used by Licensor to identify the 

Software are trademarks or registered 

trademarks of Licensor.  Licensee shall not 

use Licensor’s trademarks or service 

marks without the prior written consent of 

Licensor.  If the Software contains any 

active links to web sites, you agree to 

maintain such active links and not redirect 

or modify them. 

 

18. GENERAL PROVISIONS 

 

(a)  Complete Agreement.  The Parties 

agree that this Agreement is the 

complete and exclusive statement of 

the agreement between the Parties, 

which supersedes and merges all 

prior proposals, understandings and 

all other agreements, oral or written, 

between the Parties relating to the 

use of the Software. 

 

(b) Amendment.  This Agreement may 

not be modified, altered or amended 

except by written instrument duly 

executed by both Parties.  Any 



 

 

purchase orders or other ordering 

documents issued to Licensee by 

Licensor shall not have the effect of 

amending or modifying this 

Agreement, and shall only serve to 

memorialize the number of licenses 

or products ordered by Licensee.  In 

the event of a conflict between the 

PSP Policies and this Agreement, the 

terms of this Agreement shall 

control. 

 

(c) Waiver.  The waiver or failure of 

either party to exercise in any 

respect any right provided for in this 

Agreement shall not be deemed a 

waiver of any further right under this 

Agreement. 

 

(d) Severability.  If any provision of this 

Agreement is invalid, illegal or 

unenforceable under any applicable 

statute or rule of law, it is to that 

extent to be deemed omitted.  The 

remainder of the Agreement shall be 

valid and enforceable to the 

maximum extent possible. 

 

(e) Read and Understood.  Each party 

acknowledges that it has read and 

understands this Agreement and 

agrees to be bound by its terms. 

 

(f) Limitations Period.  No action 

arising under, or related to, this 

Agreement, may be brought by 

either party against the other more 

than two (2) years after the cause of 

action accrues, unless the cause of 

action involves death or personal 

injury. 

(g) Attorneys’ Fees.  In the event any 

litigation is brought by either party in 

connection with this Agreement, the 

prevailing party in such litigation will 

be entitled to recover from the other 

party all the costs, reasonable 

attorneys’ fees, and other expenses 

incurred by such prevailing party in 

the litigation. 

 

(h) Authorized Representative.  The 

person installing or using the 

Software on behalf of Licensee 

represents and warrants that he or 

she is legally authorized to bind 

Licensee and commit Licensee to the 

terms of this Agreement. 

 

(i) Injunctive Relief.  Licensee agrees 

that Licensor may suffer irreparable 

harm as a result of a violation of 

Sections 2, 4, 6, 10, 15, and 17 of 

this Agreement and that monetary 

damages in such event would be 

substantial and inadequate to 

compensate Licensor.  Consequently, 

Licensor shall be entitled to seek and 

obtain, in addition to such other 

monetary relief as may be 

recoverable at law or in equity, such 

injunctive other equitable relief as 

may be necessary to restrain any 

threatened, continuing, or further 

breach by Licensee without showing 

or proving actual damages sustained 

by Licensor and without posting a 

bond. 

 

CM-F0176 (Revision F, January 2011) 
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Introduction to SKF @ptitude Analyst for 

SKF Microlog Analyzer 

About This Manual 

As you'll soon realize, SKF @ptitude Analyst for SKF Microlog Analyzer is easy to install 

and use.  Chances are, after reading what you need to know in order to get going, you 

won't use this manual except as a quick reference aid. 

Note - This manual guides the SKF Microlog user through the @ptitude Analyst 

software.  For information on other aspects of @ptitude Analyst, such as SKF Microlog 

Inspector-specific applications, please reference the other provided user manual(s) for 

specific data acquisition devices. 

This manual helps you create your @ptitude Analyst machinery hierarchy of 

measurement POINTs, download and upload measurements between @ptitude Analyst 

and your data collection device, and generate graphic plots and reports for analyzing the 

measured machinery's condition.  This manual's chapters are organized according to the 

steps in this process (a chapter overview follows on page 2).   

 In writing this manual we assume you are familiar with common 

Windows operations.  Refer to your Windows guides for 

information in these areas. 

As you use this manual, you'll discover certain conventions used: 

Bold type is used to indicate text that appears in a SKF @ptitude Analyst menu, 

window, or dialog. 

Italics are used to emphasize important information. 

 - are used to indicate notes to the reader. 

Step-by-step procedures are sequenced using bullets, •. 

This manual contains information that applies to the GX and AX-Series Microlog units, as 

well as the CMXA51-IS, with any differences noted.   

When referencing the GX and AX, the term "Microlog" is used.   

If referencing a specific Microlog device, it will be noted accordingly.   

Technical Support 

If you have questions regarding the installation or operation of SKF @ptitude Analyst, 

please visit the self-help portal before contacting the help desk to see if the answer is 

already published:  . 

Technical Support Self-help Portal: www.skf.com/cm/tsg  

http://www.skf.com/cm/tsg


Introduction to SKF @ptitude Analyst for SKF Microlog Analyzer 

Chapter Overview 

1 - 2  SKF @ptitude Analyst for SKF Microlog Analyzer 

  User Manual 

If further assistance is needed, please submit a support request by clicking on the 

SUPPORT tab and one of our support engineers will contact you shortly.  

The technical support team can be reached during normal business hours (7:00 a.m. to 

4:00 p.m. local time) by phone, e-mail, or live chat:  

 Customers in Europe, Middle East and Africa:  

Phone: +46 31 337 6500  

E-Mail: TSG-EMEA@skf.com  

Chat: www.skf.com/cm/tsg  

 Customers in all other locations:  

Phone: 1-858-496-3627 or toll-free (USA) 1-800-523-7514  

E-Mail: TSG-Americas@skf.com   

Chat: www.skf.com/cm/tsg  

Note: Standard technical support will be provided at no cost on products or software 

covered under an SKF Product Support Plan (PSP), whenever applicable.  Many SKF 

Machine Health products include limited technical support for the first 180 days after 

purchase.  Support obtained after 180 days or without PSP coverage will be Support 

obtained after 180 days or without PSP coverage will be subject to a per-incident fee. 

Contact the technical support team for more information.  

Chapter Overview 

This SKF @ptitude Analyst for SKF Microlog Analyzer manual is divided into 5 chapters 

and 1 appendix: 

Chapter 1, Introduction - Introduces manual conventions and overviews the @ptitude 

Analyst / Microlog System. 

Chapter 2, Working With Your SKF @ptitude Analyst Hierarchy - Describes in detail 

how to organize your machinery measurement POINTs into @ptitude Analyst 

hierarchies, SETs, machines, and POINTs.  Also details how to establish @ptitude 

Analyst’s many alarm criteria.  Describes database editing procedures using @ptitude 

Analyst’s Templates, Modify by Attribute feature, and Filters. 

Chapter 3, Data Collection ROUTEs and Other Data Transfer Operations - 

Describes how to create @ptitude Analyst measurement collection ROUTEs, how to 

download ROUTEs to the data collection devices, how to upload measurements from 

the data collection devices, and how to manually enter data into the @ptitude Analyst 

database. 

Chapter 4, Displaying Graphic Plots - Describes methods for displaying collected 

machinery measurements in graphic plot format, and describes in detail @ptitude 

Analyst’s menu options for manipulating graphic plots to obtain useful analysis data. 

Chapter 5, Generating and Printing SKF @ptitude Analyst Reports - Describes in 

detail how to create report templates and how to generate and print @ptitude Analyst 

reports. 

Appendix A, SKF @ptitude Analyst Toolbars - Offers an overview of @ptitude 

Analyst’s toolbars and details the custom toolbar creation procedure. 

mailto:TSG-EMEA@skf.com
http://www.skf.com/cm/tsg
mailto:TSG-Americas@skf.com
http://www.skf.com/cm/tsg
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What is the SKF @ptitude Analyst for SKF Microlog Analyzer? 

An SKF @ptitude Analyst for SKF Microlog Analyzer system consists of two components: 

1. A Microlog Data Collector / Analyzer, and 

2. A host computer with @ptitude Analyst software. 

The Microlog Data Collector / Analyzer 

The Microlog series data collector / analyzer is a lightweight, hand-held, data acquisition 

device and portable maintenance instrument, designed to enable you to establish a 

comprehensive periodic condition monitoring program.  The Microlog collects machinery 

vibration and temperature measurements and performs detailed analyses in harsh 

industrial environments. 

 

Figure 1 - 1. 

The Microlog Portable Data Collector. 

The Microlog performs all the tasks required of a machinery predictive maintenance 

program.  It collects both dynamic (vibration) and static (temperature, flow, pressure) 

measurements. 

Vibration measurements are collected with a hand-held / magnetic-held probe or from 

an installed monitoring system.  Temperature measurements are collected with a 

non-contact infrared sensor or with a contact probe. 

Values read from machinery gauges and indicators are entered into the Microlog using 

the alphanumeric keys on the Microlog's keyboard.  Observations can be recorded in 

plain language or as coded notes.  

The Microlog automatically performs all filing, trending, and reporting of measurement 

data, with minimum effort and with minimum interaction. 

In addition to its data collection features, the Microlog is a powerful analyzer.  It is 

capable of displaying Fast Fourier Transform (FFT) frequency spectra and time domain 

waveforms on its liquid crystal display (LCD) screen.  

 At times this manual refers to the Microlog Data Collector / 

Analyzer.  Microlog operations are not discussed in this @ptitude 

Analyst User Manual.  For information on the Microlog Data 

Collector / Analyzer, reference your Microlog User Manual. 
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The Host Computer 

The host computer has Microsoft Windows 7, 8.1 or 10, an Intel 2.0 GHz, 32 or 64-bit, 

or better processor, 6 or more Gbytes of RAM, and a 30 Gbyte hard disk (minimum 10 

Gbyte); and enough free disk space to store your @ptitude Inspector measurement 

hierarchy (whose size depends on the number of monitored measurement POINTs).  

Together, the host computer and @ptitude Inspector software perform database 

management, trending, display, and reporting functions for the Microlog Inspector / 

MARLIN System. 

For further details, refer to the SKF @ptitude Analyst Installation Manual (P/N 

32312400). 

SKF @ptitude Analyst Software 

The easy-to-use @ptitude Analyst software works with DADs (Data Acquisition Devices) 

to assist machinery maintenance personnel in managing and analyzing their collected 

data.  @ptitude Analyst automatically uploads measurement data from DADs and 

performs the tedious clerical work required in sorting, storing, and pre-analyzing 

measurement data.  Use @ptitude Analyst to easily configure measurement POINTs (a 

machinery location at which measurement data is collected), for downloading 

measurement POINT setups to DADs, for database manipulation of collected data, and 

to graphically display and generate reports on collected measurement data. 

Exception Reports - @ptitude Analyst automatically compares current measurement 

values to past measurement values, and to pre-defined alarm values to detect changes 

from normal machinery conditions.  Using hierarchy list alarm status indicators and 

detailed printed reports, @ptitude Analyst alerts maintenance personnel to alarm 

conditions (exceptions from normal conditions). 

Analysis - @ptitude Analyst displays and prints various plots and reports for analyzing 

machinery condition. 
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Figure 1 - 2. 

Graphic Display of an @ptitude Analyst Measurement. 

Trend plots, FFT spectra (including waterfall and palogram plots), time waveforms, 

polar vector plots, and other plot types are easily displayed to help determine if 

machinery condition changes are occurring, and if so, to help with analyzing the cause 

of machinery condition changes. 

For the easiest and most effective use of the Microlog System, you should: 

Use @ptitude Analyst to: 

 Organize your hierarchy into SETs and machines. 

 Add measurement POINTs to these hierarchy machines, configuring each 

POINT's measurement and alarm settings as it is created. 

 Create a collection ROUTE of measurement POINTs. 

 Download the collection ROUTE to the Microlog 

Use the Microlog to: 

 Walk the ROUTE, collecting data for each pre-determined measurement POINT. 

Use @ptitude Analyst to: 

 Upload the collected data to @ptitude Analyst. 

 Use @ptitude Analyst’s alarm detection features to quickly scan for abnormal 

machine conditions. 

 Use @ptitude Analyst plots and reports to analyze, trend, report, and store 

measurement data. 
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Working With Your SKF @ptitude Analyst Hierarchy 

Selecting which of your machinery requires monitoring, what measurements to perform 

on the selected machinery, and how often to perform these measurements requires a 

careful study of the needs of the plant.   

Creating a Paper Copy Hierarchy 

It is advisable to create a paper copy hierarchy before creating your @ptitude Analyst 

hierarchy.  This paper copy hierarchy of your machinery measurement POINTs should be 

organized in hierarchical format by machines and POINTs for each machine. 

For each hierarchy, use an outline format to create your hierarchy’s organizational 

hierarchy, with measurement POINTs branching from machines, which branch from 

SETs.  

Take time to organize your paper copy hierarchy thoroughly.  A complete and organized 

paper copy hierarchy makes building your @ptitude Analyst hierarchy much easier.  

When naming POINTs, it is helpful to keep machine names and POINT identifiers in 

columns (as exampled above). 

 If you have several machines with the same title (for example, 

GAS TURBINE), use an alpha or numeric prefix or suffix to 

uniquely identify one machine only (for example, GAS TURBINE 

INLT). 

About POINT Names 

In the Microlog / @ptitude Analyst system, each measurement must be identified by a 

descriptive name.  This can be accomplished by adding a suffix to each equipment name 

to denote the specific location, measurement orientation, and type of measurement.  

Suffixes such as AHV, 1VD, and so on, can be used to identify specific MCD Probe 

vibration measurements, with letters denoting which end of the machine (A, B, 1, 2, 

etc.), direction (H - horizontal, V - vertical, or A - axial), and type of measurement (V - 

velocity, D - displacement, etc.). 

 POWER GENERATION 

  GAS TURBINE 

   GT INLT 1HV 

   GT INLT 1VV 

   GT INLT 1XV 

   GT INLT 2HV 

   GT INLT 2VV 

   GT INLT 2XV 

  MAIN PUMP 

 WATER TREATMENT 
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 In a hierarchy list, POINTs branching from the same machine 

must have unique names.  However, POINTs branching from 

different machines may share the same name.  Also, each 

machine must have a unique name.  If you try to create a 

machine with the same name as another in the hierarchy list, SKF 

@ptitude Analyst automatically adds a numeric suffix to the 

machine’s name.  The same holds true for POINTs branching 

from the same machine.  For example, if you have a machine 

named Pump and try to name another machine with the same 

name, @ptitude Analyst adds a suffix, and the new machine is 

named Pump.1. 

Overview 

In @ptitude Analyst, you create a database that organizes your monitored machinery 

measurements into a hierarchy structure consisting of Groups (which consist of 

organizational SETs, machines, or custom groups) and measurement POINTs. 

Each @ptitude Analyst hierarchy displays in the Hierarchy window in which its hierarchy 

items list.  Multiple databases display in the same Hierarchy window, and only one 

Hierarchy window may be open at a time. 

When building your hierarchy, you insert hierarchy Groups which you identify as either a 

Machine hierarchy item or an organizational SET hierarchy item, or a custom Group 

Type you create. 

IMPORTANT 

All hierarchy lists must contain Machine hierarchy items from which measurement 

POINTs branch.  Measurement POINTs cannot branch from a SET hierarchy item or the 

root node.  They must branch from a “Machine” hierarchy item. 

After creating your paper copy hierarchy, your next task is to use your paper copy 

hierarchy to input your organizational hierarchy into @ptitude Analyst to build your 

@ptitude Analyst hieararchy.  This chapter walks you through the usual @ptitude Analyst 

steps for creating a new hierarchy.  These steps are: 

 Create one or more new hierarchies. 

 Create each hierarchy’s organizational SETs (optional) and Machines. 

 Add measurement POINTs to their appropriate machine, configuring 

each POINT as it is created. 

The general steps required to create a new hierarchical structure are listed below.  

Refer to the indicated dialogs and topics for more information on specific steps. 

 Use the File menu’s New option to create a new hierarchy.  A hierarchy window 

displays with a Hierarchy root node. 

 With the Hierarchy window active, use the Insert menu to insert new Groups in the 

hierarchy window.  Specify the new Group's Type as either Machine group, a SET 

group, or one of your custom groups (if available). 

 Refer to Group Properties for more information. 
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 After inserting your Machine hierarchy items, click to highlight a specific Machine 

and insert New POINTs for the Machine.  Specify the new POINT's DAD and POINT 

Properties. 

 Refer to POINT Properties for more information. 

IMPORTANT: 

 

* Machines must have unique names. 

 

* POINTs must branch from a machine. 

 

* POINTs branching from the same machine must have unique names. 

Displaying Existing SKF @ptitude Analyst Hierarchies in the Hierarchy 

Window 

To display hierarchies in the Hierarchy window: 

 Use the File menu's Open/Close command to display the Open/Close dialog.  All 

available hierarchies display in the Open/Close dialog. 

 Only the hierarchies to which the user has access display.  For 

details on setting Hierarchy access, refer to the Customizing Your 

@ptitude Analyst Software section in Section 1, Chapter 2 – 

Getting Around in SKF @ptitude Analyst. 

 In the Open/Close dialog, enable the checkbox next to the hierarchy name(s) you 

wish to display in the Hierarchy window and click OK. 

The selected hierarchies’ display in the Hierarchy window. 

To remove a hierarchy from the Hierarchy window: 

 Use the File menu’s Open/Close command to display the Open/Close dialog.   

 In the Open/Close dialog, disable the checkbox next to the hierarchy name(s) you 

wish to no longer display in the hierarchy and click OK.  The disabled hierarchies no 

longer display in the Hierarchy window. 

Creating a New SKF @ptitude Analyst Hierarchy 

@ptitude Analyst’s installation program installs a “demo” hierarchy (unless you selected 

to install an empty database only).  You should create a new hierarchy to store your 

machinery vibration measurements. 

To create a new @ptitude Analyst hierarchy: 

 Select the File menu’s New command.  The New dialog opens. 

 Enter a unique name for the new hierarchy and click OK.   
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A blank hierarchy window displays.  The hierarchy name appears in the window’s title 

bar. 

 Access to the new hierarchy is assigned only to its creator.  To 

give other users access to the new hierarchy, refer to the 

Customizing Your @ptitude Analyst Software section in 

Section 1, Chapter 2 – Getting Around in SKF @ptitude 

Analyst. 

Setting Your Primary Hierarchy 

@ptitude Analyst’s Hierarchy window displays multiple hierarchies at one time in the 

same window.  One hierarchy must be designated as the primary hierarchy. 

The primary hierarchy is the default hierarchy and owns any newly created ROUTEs and 

Workspaces.  When working in areas of the application that require hierarchy selection 

(e.g., Reports, Filters, Workspaces, etc.), this hierarchy will be offered by default.  When 

in areas of the application where hierarchy selection is not offered (for example, 

Transfer), the primary hierarchy will automatically be used. 

To set the primary hierarchy: 

 In the File menu’s Open/Close dialog, you may click the Set Primary button to set 

the highlighted hierarchy as the primary hierarchy.  The primary hierarchy name 

appears in bold with the [primary] displayed next to the hierarchy name. 

OR 

 In the Hierarchy window, right click the hierarchy’s root node, and select the Set 

Primary option.  The primary hierarchy name displays in bold. 

Inserting @ptitude Analyst Groups 

When building your database, you insert hierarchy Groups which you identify as either a 

Machine hierarchy item, an organizational SET hierarchy item, or a custom Group Type 

previously created. 

To insert a new Group: 

 Select the Insert menu’s New Groups option.  The Group Properties screen 

displays.   

 The keyboard’s Insert key may also be used to insert a new group 

when in a Hierarchy, ROUTE, or Workspace window. 
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Group Properties Screen 

General Tab 

Group Properties / General fields are organized into three areas; Settings, Segment 

and asset tracking, and Miscellaneous. 

Settings fields include: 

Name – Enter a unique name to identify the new group. 

Description – (optional) Enter a description to further identify the new group. 

Type – Select Machine or SET from the drop down list. 

 Custom group types may also be available for selection.  Creation 

of custom group types is discussed later in this chapter. 

 Once a Group’s Type is specified, it cannot be changed. 

Enable data collection checkbox – Click the checkbox to enable POINT transfer to a 

DAD. 

 By default, data collection is enabled.  To temporarily disable data 

collection, clear the checkbox. 

Segment and asset tracking fields include: 

Segment name – Enter text that defines the Group’s physical location.  For example, 

enter “Level 2” or “Press Section.” 

Asset name – Enter text that defines the physical machinery currently occupying the 

Segment entered above.  For example, enter a machine’s serial or part number. 

 Segments remain fixed while Assets may be moved from one 

location (segment) to another. 

 Segment name and Asset name fields are unavailable when 

working with a template item's group properties. 

Miscellaneous fields include: 

Priority – Priority assignments may be used in filtering and reporting.  A machine is 

typically given a Priority rating when a problem is found and you wish to prioritize the 

problems to be addressed.  Specify a machine's priority from the drop down list.   

 The Priority field is only available if you are working with a 

Machine-type Group. 

 Assign a color for each machine priority to allow easy 

identification of all machines with priority assignments.  Enable to 

display a machine priority color in the hierarchy for all machines 

with assigned priority levels on the Customize / Preferences / 

General tab.  Default is disabled. 
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Available priority assignments are: 

<No Priority> 

1 – Critical 

2 – High 

3 – Medium 

4 – Low 

5 – Lowest 

 

Figure 2 - 1. 

Example of Machine Priority Color Displayed in Hierarchy. 

Filter Keys Tab 

@ptitude Analyst allows you to create Filter Keys which can be associated with POINTs 

and Machines for automated filtering purposes.  For example, if you activated a “Pump” 

filter key for a Group and later filter a hierarchy list using the Filter Key / Pump, then 

all Groups with active Pump filter keys display in the filtered Workspace. 

 Filter key creation is discussed later in this chapter. 

Filter key searches list all POINTs or Machines sharing a specified filter key (or multiple 

filter keys).  The Filter Key tab lists all created filter keys and indicates whether or not 

they are currently assigned.   

 Click a specific filter key’s checkbox to associate it to the current POINT. 

 The checkbox appears gray if the filter key is enabled for a parent 

hierarchy item. 

 Click the Filter Key dialog’s OK button to save your filter key assignments. 
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Messages Tab 

The Messages tab allows you to apply previously defined “shared” messages, and to 

create new, private messages to assign to the selected group. 

 

Figure 2 - 2. 

The Group Properties Screen’s Messages Tab. 

@ptitude Analyst's Group Properties / Messages feature allows you to create and 

assign one message for general machine instruction purposes.  The Messages context 

area displays the type of message available for assignment and any existing messages 

already applied.  You can assign a previously created public message to the current 

group, or create and apply a new private message. 

The Name drop down list displays all previously created messages and a <Private> 

option.  Use this drop down list to specify whether you wish to set up a unique  

<Private> message for the current group only, or specify a previously defined “shared” 

message (selected by name).  If you specify a shared message, its format, summary, 
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and content automatically display in subsequent fields.  If you specify a Private message, 

proceed to configure the message settings as described below. 

 For more information on creating and managing public messages, 

refer to the Customize / Hierarchy Operations section later in 

this chapter. 

Format – This drop down list allows you to specify your message's format. 

Free form – Allows you to manually type in the summary and content for your 

message. 

Summary – Type in text summarizing your message for easy recognition.  For example, 

if you have a message that details specifics about a group of machinery, your summary 

may read, "FD Fan Data Collection Information." 

Content – Enter your complete message in the content text area.  Using the above 

example, your alarm message content would include detailed data collection 

information, specific to the current group.  For example, your message may read 

"Ensure sensor is properly mounted before collecting data, etc." 

To assign a shared message to the current group: 

 Select the shared message from the drop down list and click the OK button.  

Shared messages may be applied to an unlimited number of groups. 

Shared Message 

Alarm messages initially created as private messages may be converted into shared 

(public) messages.  To share a newly created Private message, select the new Private 

message and click the tab’s Share As button. 

The Enter Name  dialog specifies the message as a shared (public) message.  When the 

Enter Name dialog displays, you will be prompted to give the shared message a unique 

name for easy identification.   

 Enter a name for the shared message and click the OK button. 

 The new shared message now appears as an available selection in the tab's drop 

down list.  Shared messages are easily assigned to other groups to simplify setup 

and maintenance. 

Notes Tab 

The Group Properties / Notes tab allows you to attach a text note to the Group along 

with a date / time stamp.  This feature conveniently stores and records relevant Group 

information such as maintenance history. 

 Coded notes uploaded from the Microlog for the current Machine 

display in the Notes tab. 

 Click the Notes tab’s Add button to add a new note and date / time stamp. 

 Click the Save button to save edits made to a note. 

 Click the Undo button to cancel edits made to a note. 

 Click the Remove button to remove the selected note from the display. 
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Group Properties / Notes fields include: 

Date – Select the current date from the drop down list. 

Time – Select the current time. 

The selected date and time appear in the tab’s left Notes field. 

Text – Type in desired note text in the text field. 

 Click the tab’s OK button to save all entries. 

Images Tab 

Scanned photographs or digital images can be added to a particular Group, stored in the 

hierarchy, and viewed from the Images tab.  Images help identify SETs / machines, 

organize similar equipment, and document known defects. 

Group Properties / Images fields include: 

Image – All attached images display in the drop down list. 

Description – Enter text to identify the image.  Click the Save button to save your 

description entry.  If saved, the new description replaces the filename in the Images list. 

 Click OK to save your new description entry. 

To add a new image: 

 Click the Add button to add a new image.  The Windows’ Open dialog displays.  

Select desired image and click Open to add or Cancel to undo. 

 Added images use the filename as the default description. 

To replace / update the current image: 

 Click the Browse button. 

 Select a replacement image.  The new image displays on the tab. 

 Click Save to confirm the image replacement. 

 Click Cancel to undo the image replacement. 

 The image name and description of the old image are retained for 

the replacement image. 

To export an image to a specific location: 

 Select the image to export. 

 Click the Export button. 

 When prompted, enter the desired export location and click OK. 

The image is copied and saved to the specified location, but still remains attached to the 

assigned Group.  
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Details Tab 

 

Figure 2 - 3. 

The Group Properties Screen’s Details Tab. 

 The Details tab is available only for custom Group Types. 

Additional Group information can be entered in the Details tab and stored in the 

hierarchy.  The five fields that appear in the Details tab are defined in the Customize / 

Hierarchy / Group Types screen when you define a custom Group Type.   

Enter appropriate information in the text box following the customized fields.  Helpful 

Details information may include serial number, RPM, address, etc.  These fields may be 

customized to support any type of information applicable to your specific application. 

The Details tab is unavailable if detail options have not been previously defined in the 

Hierarchy / Group Type screen. 
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Inserting New POINTs 

Use the Insert menu to insert new measurement POINTs to your hierarchy machines. 

To insert new POINTs: 

 In the Hierarchy window, select the machine from you wish the new POINT to 

branch. 

 Select the Insert menu’s New POINT option.  The DAD / POINT Type Selection 

screen displays. 

 The keyboard’s Insert key may also be used to insert a new 

POINT. 

 

Figure 2 - 4. 

The DAD / POINT Type Selection Screen. 

From the DAD / POINT Type Selection screen, your DAD Type, Application, Sensor, 

and Units selections determine the POINT type.  For example, Vibration / 

Accelerometer / mm / sec settings denote an acceleration to velocity type 

measurement, whereas Vibration / Accelerometer / gE settings denote an enveloped 

acceleration measurement.  

Fields in this screen include: 

DAD Type – Select the appropriate data acquisition device type from the drop down list 

of available DADs. 

 Application – Only applications consistent with your DAD type 

selection display in the Application drop down list.  Select the 

appropriate application.   

Sensor – Only sensors consistent with your selected application display in the Sensor 

drop down list.  Select the appropriate sensor. 

Units – Only units consistent with your selected sensor type display in the Units drop 

down list.  Select the appropriate units. 

 Click OK to save your settings. 

 Click Cancel to terminate POINT insertion. 

 Once the POINT is saved with DAD / POINT Type information, 

this information cannot be modified. 
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After DAD / POINT Type Selection settings are saved, the POINT Properties screen 

automatically displays. 

POINT Properties 

The POINT Properties screen allows you to enter all POINT information and settings.  

On each tab: 

 Click OK to save settings 

 Click Cancel to undo settings. 

General Tab 

The POINT Properties screen’s General tab allows you to enter the POINT name and 

description and displays the DAD / POINT Type information you previously entered. 

 

Figure 2 - 5. 

The POINT Properties Screen’s General Tab. 
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POINT Properties / General fields include: 

Name – Enter a unique name to identify the POINT. 

Description – Enter a description to further identify the POINT. 

Enable data collection – When POINTs are downloaded to the collection instrument, 

the Enable data collection setting determines whether the POINT is downloaded or 

ignored.  Click the checkbox to enable. 

DAD Type – Displays the DAD type previously assigned when the POINT was created. 

Application – Displays the application type assigned when the POINT was created. 

Sensor – Displays the sensor type assigned when the POINT was created. 

Units – Displays the appropriate measurement unit assigned when the POINT was 

created. 

 The DAD Type, Application, Sensor, and Units fields of the 

General tab cannot be edited once they have been assigned. 

 When a POINT is disabled from downloading, its existing alarm 

conditions do NOT affect the system. 

Location – Enter the data collection POINT on the machine.  Options include: 

Normal – Alphabetic identifiers A-J. 

Displacement – Numeric identifiers 1-10. 

Other – Six specific identifiers: 

Drive End 

Non-Drive End 

Outboard 

Inboard 

Coupled End 

Non-Coupled End 

Orientation – Select from drop down list options (Axial, Horizontal, None, Radial, 

Triax, Vertical, X, Y). 

Exclude from reports if last measurement is a Non-collection event. – Select 

(check) to have any reports that would include this POINT exclude it if its last 

measurement was a non-collection event (for example, the machine was marked as 

non-operating or certain measurement conditions were not met). 

Clear Alarms for Non-collection last measurements. – Select (check) to have the 

system clear any previous measurement alarms for this POINT if its last measurement 

was a non-collection event (for example, the machine was marked as non-operating or 

certain measurement conditions were not met). 
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Setup Tab (Microlog POINTs)  

Enter Microlog POINT setup information in this tab. 

 The POINT Properties / Setup tab displays differently, depending 

on the POINT type.  The following Setup fields apply to POINTs 

defined with the Microlog DAD. 

 Depending on the sensor type and units, different fields may 

display.  All possible Setup fields are defined below. 

 

Figure 2 - 6. 

The POINT Properties Screen’s Microlog Setup Tab. 
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ROUTE Mode vs. Analysis Mode 

Vibration data is taken in two modes, either in ROUTE data collection mode for early 

fault detection purposes – or, after a problem is detected, in analysis / trouble shooting 

mode to determine the type of problem, how severe the problem is, and the root cause 

of the problem.  Measurement POINT setups are different for each mode.  In ROUTE 

mode, you typically collect vibration data for trending and alarming purposes, allowing 

you to get early detection of machinery problems.  If a measurement’s vibration level 

changes and a trend alarm occurs, then for that machine location you switch to analysis 

/ troubleshooting mode, this is when spectral analysis of specific machinery frequencies 

comes into play. 

Since you may be taking hundreds of ROUTE measurements daily, ROUTE 

measurements are set up to allow you to collect data quickly and yet still capture 

reliable, accurate trend data.  After a problem is detected, analysis / troubleshooting 

measurements should not consider the speed of data collection.  Since you typically 

have early detection of the problem, you typically don’t have to hurry through your 

analysis.  When you’re wearing your Analyst hat, you typically take more measurements 

on and around the suspect machinery, and the measurements you take are higher 

resolution measurements to best determine the type, severity, and root cause of the 

problem.  When making these types of analysis decisions, accuracy is much more 

important than data collection speed. 

For example, when collecting ROUTE data, the lines of resolution setting is typically set 

at 400 lines.  This provides enough resolution to detect vibration changes for common 

machinery faults.  However, in analysis / troubleshooting mode, you typically increase to 

800 or 1600 lines of resolution, causing measurements to take twice or four times as 

long to collect.  These higher resolution settings allow you to better analyze discreet 

frequencies to help you make the correct diagnosis. 

 ROUTE POINT Setup Tip - Throughout this section, POINT setup 

tips are provided for ROUTE mode, velocity and enveloped 

acceleration measurements on standard rotating machinery 

operating between 1500 and 3600 RPM. 

POINT Properties / Setup tab fields include: 

Full Scale – Enter a number to define the spectrum’s maximum amplitude value. 

 ROUTE POINT Setup Tip – For both the velocity and enveloped 

acceleration measurements, set Full Scale to 20% higher than the 

anticipated maximum amplitude value.  If you do not know the 

measurement’s anticipated maximum amplitudes, you should 

perform baseline off-ROUTE Microlog measurements using the 

Microlog’s Autorange function to determine them. 

 

 For SEE measurements, initially set the Full Scale value at 100 

SEEs.  You may change this value as you gain experience with 

measuring SEEs. 

The Units selected on the DAD/POINT Type Selection screen display next to the Full 

Scale field.  If General was selected in the DAD/POINT Type Selection screen’s 

Application field, the units may be edited.  Adjust the units if necessary.   
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Input mV / EU– If applicable, enter a value for the sensitivity of the pickup to be used in 

making the measurement. 

 100 mV / EU is used for most acceleration sensors, 200 mV / EU 

for most non-contact displacement sensors, and 1,000 mV / EU if 

the input is volts and the scale is to be read directly. 

Detection – Click on the list box to view the choices (Peak, Peak to Peak, and RMS).  

Select the method of dynamic signal detection from the list. 

 ROUTE POINT Setup Tip – @ptitude Analyst software defaults to 

the appropriate Detection type based upon the POINT’s DAD / 

POINT Type Selection settings.  Enveloped acceleration 

measurements should always use Peak to Peak Detection.  For 

trending purposes, it is important to be consistent with Detection 

settings as, for example, Peak to Peak readings will be double the 

Peak readings. 

Enable ICP – Click to enable the Microlog to provide power to the accelerometer or 

velocity sensor.   

Input filter range - Specify the amplitude range scaling for envelope acceleration 

POINTs. 

300 to 6K CPM  3K to 60K CPM 

30K to 600K CPM 300K to 2.4M CPM 

 ROUTE POINT Setup Tip – For “standard” machinery, ROUTE 

enveloped acceleration measurements are typically collected 

using the third filter, 30K to 600K CPM.  If you do not observe a 

signal using the third filter, try collecting data using the second 

filter, and then the first filter.  Using your best judgment, collect 

data using the filter that displays the most energy, (i.e., 1X 

bearing fault frequencies and harmonics).   

Freq. Type – Click the list box to view the choices (Fixed Span or Order Track). 

Fixed Span – Specifies frequency as the unit of measurement for the 

horizontal axis of the FFT spectrum. 

Order Track – Specifies orders of running speed as the unit of 

measure for the horizontal axis of the FFT spectrum, requires a phase 

reference input to collect the measurement. 

 ROUTE POINT Setup Tip - Except for special needs, ROUTE data 

of all types is collected in Fixed Span, as most machinery does 

not have a permanent method to input shaft speed data. Order 

Track requires a tachometer signal. 

Save Data – Determines whether the DAD collects FFT data, Time Record data, or 

both.  An additional FFT and Phase option is available for Order Tracking POINTs. 

 ROUTE POINT Setup Tip – Enable FFT data storage.  When you 

are back in the office analyzing the collected ROUTE data, you will 

be able to view FFT spectra for POINTs in alarm without having to 

return to the machine to collect the FFT.  When collecting data on 

gear driven units, also save the Time waveform data. 
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Start / End Freq. –  

Start Freq. triggers the Microlog’s Automatic Zoom feature.  To do so, 

Start Freq. must equal or exceed 50% of the End Freq. value.  For 

example, if; Start Freq. = 500 Hz, End Freq. = 1 kHz, and Lines of 

resolution = 400; in order to provide the required 400-line resolution 

between Start Freq. and End Freq., the Microlog automatically selects 

800 lines as the fzero to fmax resolution. 

If Start Freq. = 750 Hz, End Freq. = 1000, and Lines = 400; the 

Microlog automatically selects 1600 Lines.  Under these 

circumstances, the display cannot be changed to view spectral 

components outside the fstart to fmax display range. 

Fixed Span / Frequency – If Freq. Type is Fixed Span, enter the 

lower and upper, full scale frequency range of the FFT between 0.00 

kCPM and 4800 kCPM, or the equivalent in Hz.  Unless you are 

making a very unusual measurement, the upper full scale frequency 

should always be greater than running speed. 

Order Track / Orders – If Freq. Type is Order Track, enter the lower 

and upper, full scale order range of the FFT between 0 and 100.0 

orders.  For optimum results, use values from approximately 2 to 10 

orders. 

 ROUTE POINT Setup Tip 

Start Frequency 

Velocity and Env. Acc. – 0, the Start Freq setting facilitates the 

Microlog’s automatic zoom feature, which is typically not applied 

for ROUTE data collection.   

End Frequency 

Velocity – Ten times shaft speed is a good place to start.  This will 

capture shaft 1X and its harmonics, along with most bearing 

fundamental fault frequencies. 

Env. Acc - Four times the bearing’s BPFO, rounded up to the next 

even number to capture the BPFO and its harmonics.  If you don't 

know the bearing’s BPFO, then start with 20 times shaft speed 

(this assumes the BPFO is around 5X shaft speed). 

 The highest upper scale frequency range available for the 

Microlog GX Series (CMXA 70/75) allows up to 2400 kCPM.  The 

Microlog AX allows up to 4800 kCPM. 

Low Freq. Cutoff – Enter a low frequency cutoff filter value to exclude any unwanted 

lower frequency components (i.e., noise).  Although values are allowed from 0.0 CPM to 

1200 kCPM, the range for normal measurements is from approximately 200 CPM to 

600 CPM, or the equivalent in Hz. 

 ROUTE POINT Setup Tip – For velocity measurements, set the 

Low Frequency Cutoff to 600 CPM to cut out the ski slope that 

appears due to integration of the signal.  For enveloped 

acceleration measurements, set to 0, as there is no integration of 

the signal. 



Working With Your SKF @ptitude Analyst Hierarchy 

POINT Properties 

2 - 18  SKF @ptitude Analyst for SKF Microlog Analyzer 

  User Manual 

Pulses / Rev - Used to determine machine running speed.  If a tachometer is 

connected, enter the number of tach. pulses that occur for each shaft revolution. 

Lines – The spectrum’s FFT resolution.  Click the list box to view choices. 

100 200 400 800 1600 

3200 6400  12800 25600 

 ROUTE POINT Setup Tip - The higher the resolution, the slower 

the data collection.  For both velocity and enveloped acceleration 

measurements, 400 lines of resolution is adequate. 

Window – Select the type of window used in the FFT processing.  Click the list box to 

view the choices (Uniform, Hanning, or Flat Top).  A window function must be applied 

to any periodic time record prior to performing an FFT.  The Hanning and Flat Top 

window functions attenuate to zero both the leading and trailing edges of the sample in 

order to prevent leakage error caused by discontinuities in the time record. 

Uniform – A dynamic signal analyzer window function with uniform 

weighting across time.  Useful for measuring transients or mechanical 

response measurements. 

Hanning – A dynamic signal analyzer window function that provides 

better frequency resolution than Flat Top, but with reduced amplitude 

accuracy.  Useful for machine vibration measurements, general 

purpose measurement, and measurements containing random noise. 

Flat Top – A dynamic signal analyzer window function which provides 

the best amplitude accuracy for measuring discrete frequency 

components.  Useful for calibration of machine vibration 

measurements using displacement probes in fluid-film bearings. 

 ROUTE POINT Setup Tip – For both velocity and enveloped 

acceleration measurements, select Hanning. 

Autocapture – Click the list box to view the choices (Off, On Overall Alarm, Always).  

Determines when the DAD transfers a recorded FFT spectrum to @ptitude Analyst. 

Off – The FFT Spectrum is never transferred. 

On Overall Alarm – The FFT spectrum is only transferred when either 

overall alarm value is exceeded (alert or danger). 

Always – The FFT spectrum is always transferred. 

 ROUTE POINT Setup Tip - Always enable Autocapture.  

Computer memory size is typically not an issue, and it’s 

advantageous to have the spectrum available if you need it. 

 You must also have the Microlog device configured to capture the 

FFT spectrum.  Refer to your Microlog user manual for 

instructions. 

Speed – Enter the nominal shaft speed in CPM or Hz. 

Averages – Enter the number of FFT averages to be collected (from 1 to 99).  The 

higher the number of averages, the slower the data collection. 
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 ROUTE POINT Setup Tip – For enveloped acceleration, set to one 

average.  For velocity measurements, four averages are typically 

adequate, however, if the machine has large variations in 

vibration amplitudes, six or eight averages may be needed. 

Averaging – (Average, Off, Peak Hold, or Synchronous Time) If averaging has been 

selected for the POINT, determines the type of averaging performed, (either normal 

averaging, no averaging, peak hold averaging, or synchronous time averaging).  

Synchronous Time requires a tachometer assignment. 

 ROUTE POINT Setup Tip – Select Average (normal averaging) for 

both velocity and enveloped acceleration measurements. 

Linear Factor – Type in the numeric linear factor. 

Linear Speed Units – Type in the linear speed unit. 

Speed tag reference – To assign a POINT for speed tag reference, click the Select 

POINT button to browse POINTs.  Once selected, the parent / POINT name appears in 

the POINT field.  Enter a numerical value for the desired multiple in the Ratio field. 

Setup Tab (2-Channel Microlog POINTs)  

Enter Microlog POINT setup information in this tab. 

 The POINT Properties / Setup tab displays differently, depending 

on the POINT type.  The following Setup fields apply to POINTs 

defined with the Microlog DAD for Vibration (2-Channel) 

application types. 

 The Microlog allows you to set up measurements on-the-fly that 

may be transferred to @ptitude Analyst as non-ROUTE POINTs.  

If you collect a four channel, non-ROUTE POINT on the Microlog 

AX, two 2-channel POINTs are created in @ptitude Analyst.  

These are identified by the last three characters of the POINT 

name: [POINT NAME].1_2 and [POINT NAME].3_4.  Data from the 

four channel POINT is distributed as follows: 

Channel 1 = POINT.1_2 Channel 1 

Channel 2 = POINT.1_2 Channel 2 

Channel 3 = POINT.3_4 Channel 1 

Channel 4 = POINT.3_4 Channel 2 
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Figure 2 - 7. 

The POINT Properties Screen’s Microlog Setup Tab. 

Setup fields include: 

Full Scale – Enter a number to define the spectrum’s maximum amplitude value. 

 For SEE measurements, initially set the Full Scale value at 100 

SEEs.  You may change this value as you gain experience with 

measuring SEEs. 

Detection – Click on the list box to view the choices (Peak, Peak to Peak, and RMS).  

Select the method of dynamic signal detection from the list. 

Enable ICP – Click to enable the Microlog to provide power to the accelerometer or 

velocity sensor.   
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Input filter range - Specify the amplitude range scaling for envelope acceleration 

POINTs. 

300 to 6K CPM  3K to 60K CPM 

30K to 600K CPM 300K to 2.4M CPM 

Freq. Type – Click the list box to view the choices (Fixed Span or Order Track). 

Fixed Span – Specifies frequency as the unit of measurement for the 

horizontal axis of the FFT spectrum. 

Order Track – Specifies orders of running speed as the unit of 

measure for the horizontal axis of the FFT spectrum, requires a phase 

reference input to collect the measurement. 

Save Data – Determines whether the DAD collects FFT data, Time Record data, or 

both.  An additional FFT and cross-phase option is available for Order Tracking 

POINTs.  Cross-phase is the difference in phase between the two channels. 

Start / End Freq. –  

Order Track / Orders – If Freq. Type is Order Track, enter the lower 

and upper, full scale order range of the FFT between 0 and 100.0 

orders.  For optimum results, use values from approximately 2 to 10 

orders. 

Fixed Span / Frequency – If Freq. Type is Fixed Span, enter the 

lower and upper, full scale frequency range of the FFT between 0.00 

kCPM and 4800 kCPM, or the equivalent in Hz.  Unless you are 

making a very unusual measurement, the upper full scale frequency 

should always be greater than running speed. 

 The highest upper scale frequency range available for the 

Microlog GX Series (CMXA70) allows up to 2400 kCPM.  The 

Microlog AX allows up to 4800 kCPM. 

Low Freq. Cutoff – Enter a low frequency cutoff filter value for dynamic (AC) 

measurements.  Although values are allowed from 0.0 CPM to 1200 kCPM, the range 

for normal measurements is from approximately 200 CPM to 600 CPM, or the 

equivalent in Hz. 

Pulses / Rev - Used to determine machine running speed.  If a tachometer is 

connected, enter the number of tach. pulses that occur for each shaft revolution. 

Lines – The spectrum’s FFT resolution.  Click the list box to view choices. 

 The higher the resolution, the slower the data collection. 

100 200 400 800 

1600 3200 6400  12800 

Window – Select the type of window used in the FFT processing.  Click the list box to 

view the choices (Uniform, Hanning, or Flat Top).  A window function must be applied 

to any periodic time record prior to performing an FFT.  The Hanning and Flat Top 

window functions attenuate to zero both the leading and trailing edges of the sample in 

order to prevent leakage error caused by discontinuities in the time record. 
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Uniform – A dynamic signal analyzer window function with uniform 

weighting across time.  Useful for measuring transients or mechanical 

response measurements. 

Hanning – A dynamic signal analyzer window function that provides 

better frequency resolution than Flat Top, but with reduced amplitude 

accuracy.  Useful for machine vibration measurements, general 

purpose measurement, and measurements containing random noise. 

Flat Top – A dynamic signal analyzer window function which provides 

the best amplitude accuracy for measuring discrete frequency 

components.  Useful for calibration of machine vibration 

measurements using displacement probes in fluid-film bearings. 

Autocapture – Click the list box to view the choices (Off, On Overall Alarm, Always).  

Determines when the DAD transfers a recorded FFT spectrum to @ptitude Analyst. 

Off – The FFT Spectrum is never transferred. 

On Overall Alarm – The FFT spectrum is only transferred when either 

overall alarm value is exceeded (alert or danger). 

Always – The FFT spectrum is always transferred. 

 You must also have the Microlog device configured to capture the 

FFT spectrum.  Refer to your Microlog user manual for 

instructions. 

Speed – Enter the nominal shaft speed in CPM or Hz. 

Averages – Enter the number of FFT averages to be collected (from 1 to 99).  Four to 

six averages are adequate and are normally used for machine monitoring.  The higher 

the number of averages, the slower the data collection. 

Averaging – (Average, Off, Peak Hold, or Synchronous Time) If averaging has been 

selected for the POINT, determines the type of averaging performed, (either normal 

averaging, no averaging, peak hold averaging, or synchronous time averaging).  

Synchronous Time requires a tachometer assignment. 

Linear Factor – Type in the numeric linear factor. 

Linear Speed Units – Type in the linear speed unit. 

Speed tag reference – To assign a POINT for speed tag reference, click the Select 

POINT button to browse POINTs.  Once selected, the parent / POINT name appears in 

the POINT field.  Enter a numerical value for the desired multiple in the Ratio field. 
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2-Channel Tab 

  The POINT Properties / 2-Channel tab displays when the 

Vibration(2-Channel) application type is selected.  Use this tab to 

define 2-channel settings for each channel. 

 

Figure 2 - 8. 

The POINT Properties Screen’s Microlog 2-Channel Tab. 

POINT Properties / 2-Channel fields may include: 

Channel X and Y settings 

Input mv/EU – Enter a number to define the sensitivity of the pickup to be used in 

taking measurements for each channel. 

Orientation – Choose the sensor orientation for each channel (Axial, Horizontal, 

Radial, Tangential, or Vertical) 
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Setup Tab (3-Channel Microlog POINTs)  

Enter Microlog POINT setup information in this tab. 

 The POINT Properties / Setup tab displays differently, depending 

on the POINT type.  The following Setup fields apply to POINTs 

defined with the Microlog DAD for Vibration (3-Channel) 

application types. 

 

Figure 2 - 9. 

The POINT Properties Screen’s Microlog Setup Tab. 

Setup fields include: 

Full Scale – Enter a number to define the spectrum’s maximum amplitude value. 
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 For SEE measurements, initially set the Full Scale value at 100 

SEEs.  You may change this value as you gain experience with 

measuring SEEs. 

Detection – Click on the list box to view the choices (Peak, Peak to Peak, and RMS).  

Select the method of dynamic signal detection from the list. 

Enable ICP – Click to enable the Microlog to provide power to the accelerometer or 

velocity sensor.   

Input filter range - Specify the amplitude range scaling for envelope acceleration 

POINTs. 

300 to 6K CPM  3K to 60K CPM 

30K to 600K CPM 300K to 2.4M CPM 

Freq. Type – Click the list box to view the choices (Fixed Span or Order Track). 

Fixed Span – Specifies frequency as the unit of measurement for the 

horizontal axis of the FFT spectrum. 

Order Track – Specifies orders of running speed as the unit of 

measure for the horizontal axis of the FFT spectrum, requires a phase 

reference input to collect the measurement. 

Save Data – Determines whether the DAD collects FFT data, Time Record data, or 

both.  An additional FFT and Phase option is available for Order Tracking POINTs. 

Start / End Freq. –  

Order Track / Orders – If Freq. Type is Order Track, enter the lower 

and upper, full scale order range of the FFT between 0 and 100.0 

orders.  For optimum results, use values from approximately 2 to 10 

orders. 

Fixed Span / Frequency – If Freq. Type is Fixed Span, enter the 

lower and upper, full scale frequency range of the FFT between 

0.000.06 kCPM and 4800 kCPM, or the equivalent in Hz.  Unless you 

are making a very unusual measurement, the upper full scale 

frequency should always be greater than running speed. 

 The highest upper scale frequency range available for the 

Microlog GX Series (CMXA70) allows up to 2400 kCPM.  The 

Microlog AX allows up to 4800 kCPM. 

Low Freq. Cutoff – Enter a low frequency cutoff filter value for dynamic (AC) 

measurements.  Although values are allowed from 0.0 CPM to 1200 kCPM, the range 

for normal measurements is from approximately 200 CPM to 600 CPM, or the 

equivalent in Hz. 

Pulses / Rev - Used to determine machine running speed.  If a tachometer is 

connected, enter the number of tach. pulses that occur for each shaft revolution. 

Lines – The spectrum’s FFT resolution.  Click the list box to view choices. 

 The higher the resolution, the slower the data collection. 

100 200 400 800 

1600 3200 6400   
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Window – Select the type of window used in the FFT processing.  Click the list box to 

view the choices (Uniform, Hanning, or Flat Top).  A window function must be applied 

to any periodic time record prior to performing an FFT.  The Hanning and Flat Top 

window functions attenuate to zero both the leading and trailing edges of the sample in 

order to prevent leakage error caused by discontinuities in the time record. 

Uniform – A dynamic signal analyzer window function with uniform 

weighting across time.  Useful for measuring transients or mechanical 

response measurements. 

Hanning – A dynamic signal analyzer window function that provides 

better frequency resolution than Flat Top, but with reduced amplitude 

accuracy.  Useful for machine vibration measurements, general 

purpose measurement, and measurements containing random noise. 

Flat Top – A dynamic signal analyzer window function which provides 

the best amplitude accuracy for measuring discrete frequency 

components.  Useful for calibration of machine vibration 

measurements using displacement probes in fluid-film bearings. 

Autocapture – Click the list box to view the choices (Off, On Overall Alarm, Always).  

Determines when the DAD transfers a recorded FFT spectrum to @ptitude Analyst. 

Off – The FFT Spectrum is never transferred. 

On Overall Alarm – The FFT spectrum is only transferred when either 

overall alarm value is exceeded (alert or danger). 

Always – The FFT spectrum is always transferred. 

 You must also have the Microlog device configured to capture the 

FFT spectrum.  Refer to your Microlog user manual for 

instructions. 

Speed – Enter the nominal shaft speed in CPM or Hz. 

Averages – Enter the number of FFT averages to be collected (from 1 to 99).  Four to 

six averages are adequate and are normally used for machine monitoring.  The higher 

the number of averages, the slower the data collection. 

Averaging – (Average, Off, Peak Hold, or Synchronous Time) If averaging has been 

selected for the POINT, determines the type of averaging performed, (either normal 

averaging, no averaging, peak hold averaging, or synchronous time averaging).  

Synchronous Time requires a tachometer assignment. 

Linear Factor – Type in the numeric linear factor. 

Linear Speed Units – Type in the linear speed unit. 

Speed tag reference – To assign a POINT for speed tag reference, click the Select 

POINT button to browse POINTs.  Once selected, the parent / POINT name appears in 

the POINT field.  Enter a numerical value for the desired multiple in the Ratio field. 
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Triax Tab 

 The POINT Properties / Triax tab displays when the Vibration(3-Channel) application 

type is selected.  Use this tab to define Triax sensor settings for each channel. 

The Triax Accelerometer Sensor automatically sequences through three measurements 

for the sensor location (one for each axis monitored by the triax sensor) 

 

Figure 2 - 10. 

Triax Accelerometer Sensors. 

 The triax sensor's axes are labeled Axis 1, Axis 2, and Axis 3.  On 

the POINT Properties / Triax tab, match the labeled axis to a 

measurement orientation (i.e., horizontal, vertical, axial).  

To collect valid measurements, the triax accelerometer sensor must always be oriented 

in the same direction for all measurements at the same location.   

For example, if the machine is mounted horizontally, mount the triax sensor in the 

vertical direction to the shaft to orient Axis 2 in the axial direction, Axis 1 in the 

horizontal direction, and Axis 3 in the vertical direction.  If a vertical mounting is not 

possible, mount the triax accelerometer sensor in the horizontal direction to the shaft.  

Please note that in this case the horizontal and vertical axes are reversed for this 

measurement POINT. 
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Triax Tab Options 

 

Figure 2 - 11. 

The POINT Properties Screen’s Triax Tab. 

POINT Properties / Triax fields may include: 

Channel X, Y, and Z settings 

Input mv/EU – Enter a number to define the sensitivity of the pickup to be used in 

taking measurements for each channel. 

Orientation – Choose the triax sensor’s orientation for each channel (Horizontal, 

Vertical, or Axial) 

Sensor axis – Match the axis label to the sensor orientation for each channel (1, 2, or 3) 
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Setup Tab (Orbit/SCL POINTs)  

Orbit and shaft centerline data supports the collection of two-channel data which can be 

displayed on an orbit plot.   

Prior to setting Orbit/SCL  tab options, use the DAD / POINT Type Selection screen’s 

setup fields to specify a Orbit/SCL POINT type. 

To specify a Orbit/SCL POINT type: 

 Select the Insert menu’s New POINT option.  The DAD / POINT Type Selection 

screen displays. 

 Select the DAD type field’s Microlog option. 

 Select the Application field’s Orbit/SCL option.   

 Select the appropriate Sensor type and Units. 

Enter Microlog POINT setup information in this tab. 

 The POINT Properties / Setup tab displays differently, depending 

on the POINT type.  The following Setup fields apply to POINTs 

defined with the Microlog DAD for Orbit/SCL application types. 
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Figure 2 - 12. 

The POINT Properties Screen’s Microlog Setup Tab. 

Setup fields include: 

Full Scale – Enter a number to define the spectrum’s maximum amplitude value. 

 For SEE measurements, initially set the Full Scale value at 100 

SEEs.  You may change this value as you gain experience with 

measuring SEEs. 

Detection – Click on the list box to view the choices (Peak, Peak to Peak, and RMS).  

Select the method of dynamic signal detection from the list. 

Enable ICP – Click to enable the Microlog to provide power to the accelerometer or 

velocity sensor.   
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Freq. Type – Set to Order Track for Orbit POINTs. 

Order Track – Specifies orders of running speed as the unit of 

measure for the horizontal axis of the FFT spectrum, requires a phase 

reference input to collect the measurement. 

Save Data – Set to Time for Orbit POINTs.   

 Freq. Type and Save Data fields currently not available.  The 

Microlog currently does not support FFT data for an orbit POINT 

at this time. 

Start / End Orders – Enter the lower and upper, full scale order range of the FFT 

between 0 and 100.0 orders.  For optimum results, use values from approximately 2 to 

10 orders. 

Low Freq. Cutoff – Enter a low frequency cutoff filter value for dynamic (AC) 

measurements.  Although values are allowed from 0.0 CPM to 1200 kCPM, the range 

for normal measurements is from approximately 200 CPM to 600 CPM, or the 

equivalent in Hz. 

Pulses / Rev - Used to determine machine running speed.  If a tachometer is 

connected, enter the number of tach. pulses that occur for each shaft revolution.  

Set to 1 for Orbit/SCL application type. 

Samples – The spectrum’s FFT resolution.  Click the list box to view choices. 

 The higher the resolution, the slower the data collection. 

256 512 1024 2048 

2560 4096 8192  

Window – Select the type of window used in the FFT processing.  Click the list box to 

view the choices (Uniform, Hanning, or Flat Top).  A window function must be applied 

to any periodic time record prior to performing an FFT.  The Hanning and Flat Top 

window functions attenuate to zero both the leading and trailing edges of the sample in 

order to prevent leakage error caused by discontinuities in the time record. 

Uniform – A dynamic signal analyzer window function with uniform 

weighting across time.  Useful for measuring transients or mechanical 

response measurements. 

Hanning – A dynamic signal analyzer window function that provides 

better frequency resolution than Flat Top, but with reduced amplitude 

accuracy.  Useful for machine vibration measurements, general 

purpose measurement, and measurements containing random noise. 

Flat Top – A dynamic signal analyzer window function which provides 

the best amplitude accuracy for measuring discrete frequency 

components.  Useful for calibration of machine vibration 

measurements using displacement probes in fluid-film bearings. 

Speed – Enter the nominal shaft speed in CPM or Hz. 

Linear Factor – Type in the numeric linear factor. 

Linear Speed Units – Type in the linear speed unit. 
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Orbit/SCL Tab 

Enter orbit and shaft centerline information on this tab.   

 

Figure 2 - 13. 

The POINT Properties Screen’s Orbit/SCL Tab. 

POINT Properties / Orbit/SCL fields may include: 

Channel X and Y Settings  

X-Input mv/EU – Enter a number to define the sensitivity of the pickup to be used in 

taking measurements for channel X. 

X-Sensor angle - Specify the angle that defines the X sensors’ physical location. 

Y-Input mv/EU - Enter a number to define the sensitivity of the pickup to be used in 

taking measurements for channel Y. 
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Y-Sensor angle - Specify the angle that defines the Y sensors’ physical location. 

 The orbit axis may use Scientific or Standard mode for the 0 

degree reference point, depending on your Angular axis view 

preference setting.  This setting should be taken into account 

when entering your sensor angles. 

 

Figure 2 - 14. 

Diagram Showing Scientific vs. Standard. 

Orbit Settings 

Top dead center – Specify the label to display at the top of the Orbit/SCL plot. 

Display tacho angle – Enable to allow the tacho angle to display on the Orbit/SCL 

plot. 

Shaft rotation – Specify the shaft rotation direction as either Bidirectional, 

Clockwise, or Counter clockwise for reference on the Orbit/SCL plot. 

Tacho angle – Specify the angle that defines the tachometer’s physical location (0 to 

359 degrees). 

Shaft Centerline Settings 

 This section is only available if the POINT uses a displacement 

probe. 

X-Cold gap – Specify the X probe’s cold gap value.  Together the X and Y probe cold 

gap values define the distance between the displacement probe and the shaft’s 

position in the bearing when the machine is at rest. 

Y-Cold gap – Specify the Y probe’s cold gap value. 

Cold gap position – Define the cold gap position in the bearing clearance circle when 

viewing the shaft centerline plot.  Choices are Bottom, Center, Left, Right, and Top. 

Bearing clearance – Specify the bearing’s clearance value (typically supplied by the 

manufacturer).  The clearance value assumes the shaft is centered in the bearing 

and defines the physical distance between the shaft and the bearing, multiplied by 2.   
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Setup Tab (Manual POINTs) 

 The POINT Properties / Setup tab displays differently, depending 

on the POINT type.  The following Setup fields apply to POINTs 

defined with a manual sensor. 

Enter Manual POINT Setup information in this tab.   

 

Figure 2 - 15. 

The POINT Properties Screen’s Manual Setup Tab. 

POINT Properties / Setup fields may include: 

 The POINT Setup Validation Dialog launches when you enter 

incompatible or erroneous information on the Setup tab.  

Reference the POINT Setup Validation section later in this 

manual for more information. 

Full Scale – Enter a number to define the spectrum’s maximum amplitude value. 
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The Units selected on the DAD/POINT Type Selection screen display next to the Full 

Scale field.  If Any Units was selected, the units may be edited.  Adjust the units if 

necessary.   

Setup Tab (DC POINTs) 

If the sensor type is DC, enter POINT setup information on this tab. 

 

Figure 2 - 16. 

The POINT Properties Screen’s DC Setup Tab. 

Full Scale – Enter a number to define the measurement’s maximum value. 

The Units selected on the DAD/POINT Type Selection screen display next to the Full 

Scale field.  Adjust the units if necessary.   

Zero offset – Enter a value (-1000000000.000 to 1000000000.000) in milivolts to 

offset the zero point of the measurement. 

Input mV/EU - Enter a number to define the sensitivity of the pickup to be used in 

taking measurements. 
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Setup Tab (Derived POINTs) 

 A derived POINT provides data from an operator created formula that uses previously 

collected measurement POINT data in its calculation. 

Prior to setting Setup tab options, use the DAD / POINT Type Selection screen’s setup 

fields to specify a derived POINT type. 

To specify a derived POINT type: 

 Select the Insert menu’s New POINT option.  The DAD / POINT Type Selection 

screen displays. 

 Select the DAD type field’s Derived POINT option. 

 Select the Sensor field’s Calculated option.  Note that for Microlog DADs, derived 

POINT data appears only in @ptitude Analyst (derived POINTs are not downloaded 

to the Microlog unit).  The Calculated setting indicates that Microlog POINT data 

used in a derived POINT calculation is first uploaded to @ptitude Analyst and then 

automatically “calculated” for the derived POINT during upload data processing. 

 For Derived POINTs, the DAD / POINT Type Selection screen’s 

Application field defaults to General, and the Units field defaults 

to Any Units. 

Setup Tab Options 

Enter Derived POINT Setup information in this tab.  A Derived POINT consists of an 

operator created formula (expression) using measurement POINTdata (variables), fixed 

numbers (constants; i.e., Pi) and mathematical functions (i.e., sin). 
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Figure 2 - 17. 

The POINT Properties Screen’s Setup Tab for Derived POINTs.  

POINT Properties / Setup fields may include: 

Full Scale – Enter a number to define the spectrum’s maximum amplitude value. 

Evaluation time – Ensures relevant variable data.  Defines the maximum time 

range during which all variables (POINTs) must collect measurement data for the 

derived POINT to calculate.  All variables in the expression formula must have data 

collected within this specified time range, or the derived POINT does not calculate.  

For example, if the Evaluation time is set to 15 minutes, all variables (POINTs) must 

be collected within 15 minutes of each other. 
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Expressions Tab (Derived POINTs) 

 The POINT Properties / Expressions tab displays when the 

Derived POINT type is selected.  Use this tab to create or edit the 

derived POINT’s Expression formula (the derived POINT’s 

calculation). 

 

Figure 2 - 18. 

The POINT Properties Screen’s Expressions Tab for Derived POINTs. 

The Expressions drop down list displays all previously created “shared” expression 

formulas (calculations) and a <Private Expression> option.  Use this drop down list to 

specify whether you wish to set up a unique <Private Expression> for the current 

derived POINT only, or specify a previously defined “shared” expression formula 

(selected by name).  If you specify a shared expression, its settings display in subsequent 

fields. 

 Specify either a shared or Private Expression and proceed to configure the tab’s 

expression settings as described below.  
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Assigning Variables 

POINTs used in the derived POINT’s calculation are identified as “variables.”  Assigned 

variables list in the Available Variables area.   

To assign variables for a derived POINT: 

 Click the Variables button.  The Variables screen displays. 

 

Figure 2 - 19. 

The Variables Screen. 

 In the Variables screen, click the Add button.  The Variables area displays the New 

Variable with an “unassigned POINT.”  The Properties area also displays the New 

Variable. 

 Click the Select POINT assignment option button to activate the hierarchy, 

allowing you to select the POINT to assign to the new variable. 
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 Click the Clear POINT assignment option to clear the point 

assigned to the selected variable.  Once cleared, <Unassigned> 

displays in the Assigned POINT column in the Variables list.   

 In the hierarchy, select the POINT to assign to the variable. 

 In the Properties area, type in a name for the new variable.  Tip - you may use the 

same name as the POINT ID. 

 Specify the Value type as FFT data, Overall-Trend, or Time wave form data.  

 Click the Save button to save the new variable.  Its information displays in the 

Variables area.  Repeat the process to Add all necessary variables. 

 You may click the Remove button to remove a variable from the 

Variables list for the current derived POINT. 

 When finished adding variables, click the Close button to return to the POINT 

Properties / Expressions tab.  The new variables display in the Available 

Variables area. 

Once variables have been created for the derived POINT, you can create the POINT’s 

expression formula (calculation).  Enter the calculation in the Expression formula entry 

box.  An expression formula must contain at least one variable, and may also contain 

constants and functions.  Insert mathematical operators (e.g., +, -, /, *) as necessary. 

To insert a variable to the expression formula: 

 In the Expression Formula area, position the cursor where you wish to insert the 

variable. 

 Select a variable from the Variables list and click the Insert button.  The selected 

variable appears at the cursor position. 

To add a constant to the expression formula: 

 In the Expression formula field, position the cursor where you would like to insert 

the constant. 

 Click the Constants button to display the Constant dialog. 

 Select a constant, or create a new constant by clicking the Add button. 

 

Figure 2 - 20. 

The Add Constant Dialog. 

 Click OK.  The selected constant appears at the cursor position.   
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To add a function to the expression formula: 

 Place the cursor in the Expression formula section where you wish to insert the 

function and click the Functions button. The Functions dialog displays. 

 

Figure 2 - 21. 

The Functions Dialog. 

 Select a function from the dialog and click OK.  The selected function is entered at 

the cursor position in the Expression formula section along with the type of input 

data that is used for the function, shown in parentheses; for example: 

AVERAGE(<Variable>, <Length>). 

 Highlight the input data placeholder (e.g., <Variable>) and enter the applicable 

data, or select a constant to enter by using the Constants button.  You can also 

enter a variable by selecting it from the Variables section and clicking Insert. 

 To calculate more complex formulas, you can enter multiple 

functions within a single expression formula. 

Depending on the function, the type of input data can either be scalar data or dynamic 

data. 

Scalar data can be derived from: 

 Overall trend data from a Microlog Analyzer, Microlog Inspector/MARLIN, 

WMx/WVT, DMx, IMx, LMU/CMU/TMU 

 Inspection results (the calculated formula for inspection results will produce a result 

of either 0 (not valid) or 1 (valid) based on the inspection result that is entered) 

 Manual entry 

 Data from XML import (from sources such as the SKF Wireless Machine Condition 

Sensor, third party developments, etc.) 

 OPC from other systems (Digital Control Systems (DCS), Canary Labs and other 

data historians, etc.) 

 Oil Analysis / Trend Oil 
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 MCD (Enveloped Acceleration, Velocity, or Temperature) 

 WMCD 

 Derived POINTS themselves 

Dynamic data includes: 

 Time waveform data 

 FFT data 

The table below contains a list of the different functions that you can use for an 

expression formula, along with a description of the function and whether the function is 

based on scalar or dynamic data. 

 

Function Description Type of data 

ABS(<Variable>) Calculates the absolute value of the <Variable> entered. Scalar 

ALARMSTATUS 

(<Variable>) 

Determines and stores the current alarm status for the <Variable> 

(POINT) entered. Notice that this function does not re-evaluate past 

alarm conditions and therefore must be operated immediately when 

new alarm conditions are set for the <Variable>. 

 

Returned values are: 

-1   No alarm level (when the <Variable> has no values, no set alarm) 

0   Safe 

1   Alert 

2   Danger 

Scalar 

Dynamic 

ARCCOS(<Radians>) Calculates the arc cosine of the <Radians> value entered. The value 

returned is in degrees. 

Scalar 

ARCSIN(<Radians>) Calculates the arc sine of the <Radians> value entered. The value 

returned is in degrees. 

Scalar 

ARCTAN(<Radians>) Calculates the arc tangent of the <Radians> value entered. The value 

returned is in degrees. 

Scalar 

AVERAGE(<Variable>, 

<Length>) 

Calculates the average of the <Variable> entered using a sliding window 

of <Length> values entered. 

Scalar 

AVERAGE(<Dynamic 

Variable>,<Channel 

Number>) 

Calculates the average of the <Dynamic Variable> entered for the 

specified <Channel Number>. For non-multi-channel measurements, 

<Channel Number> should be set to 1. 

Dynamic 

CEIL(<Param>) Calculates the smallest (closest to negative infinity) integer that is not 

smaller than the <Param> value. 

Scalar 

CONTRIBUTION2 

(<Dynamic Variable>, 

<Speed Multiple>) 

Calculates the contribution (in percentage) of the energy periodical to 

the <Speed Multiple> entered. The <Dynamic Variable> entered is the 

time waveform. The <Speed Multiple> is specified in multiples of 

running speed including fractional values. 

Dynamic (best 

for time 

waveform data) 

CONTRIBUTION3 

(<Dynamic Variable>, 

<Speed Multiple>, 

<Ref Speed>) 

Calculates the contribution (in percentage) of the energy periodical to 

the <Speed Multiple> entered. The <Dynamic Variable> entered is the 

time waveform. The <Speed Multiple> is specified in multiples of 

running speed including fractional values. The <Ref Speed> entered is 

the machine speed value to use. The <Ref Speed> may be a fixed value, 

an overall value from a trend, or a speed value extracted with Speed() 

from a time waveform or spectrum. 

Dynamic (best 

for time 

waveform data) 

COS(<Radians>) Calculates the cosine of the <Radians> value entered. Scalar 
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Function Description Type of data 

COUNT_SPIKES 

(<Dynamic Variable>, 

<Channel Number>, 

<Threshold>, <DC>) 

Counts the number of spikes in the waveform indicated by the 

<Dynamic Variable> entered for the specified <Channel Number> 

entered. A spike is defined as a signal level equal or higher than the 

<Threshold> value entered. The <DC> bias value entered is subtracted 

from the signal prior to evaluation against the threshold value.  

 

Use the Average function to de-trend signals with strong DC bias i.e.: 

COUNT_SPIKES(<Dynamic Variable>, <Channel Number>, <Threshold>, 

AVERAGE(<Dynamic Variable>, <Channel Number>) ) 

 

For non-multi-channel measurements, <Channel Number> should be 

set to 1. 

Dynamic (best 

for time 

waveform data) 

CRESTFACTOR 

(<Dynamic Variable>) 

Calculates the crest factor. The crest factor is defined as the time 

waveform’s Peak value divided by its RMS value. The <Dynamic 

Variable> entered is the time waveform. The resulting value is 

dimensionless. 

Dynamic (best 

for time 

waveform data) 

CTA_PK_PK(<Waveform 

Data>, <Speed Multiple>) 

Calculates the Cyclic Time Average of a time waveform using the 

<Speed Multiple> averaging period. The <Waveform Data> entered is 

the time waveform. The <Speed Multiple> entered must be in seconds. 

The returned value is in the same engineering units as the <Waveform 

Data> and Peak to Peak detection type. 

Dynamic (best 

for time 

waveform data) 

CTA_RMS(<Waveform 

Data>, <Speed Multiple>) 

Calculates the Cyclic Time Average of a time waveform using the 

<Speed Multiple> averaging period. The <Waveform Data> entered is 

the time waveform. The <Speed Multiple> entered must be in seconds. 

The returned value is in the same engineering units as the <Waveform 

Data> and RMS detection type.  

Dynamic (best 

for time 

waveform data) 

CUSUM(<Variable>, 

<Variable>) 

Calculates the cumulative difference of the first <Variable> entered 

against the second <Variable> entered. 

Scalar 

DEGTORAD(<Degrees>) Converts the angle <Degrees> value entered to radians. Scalar 

DELTATIME(<Variable>) Calculates the difference in seconds between two adjacent 

measurements. 

Scalar 

Dynamic 

DELTAVALUE(<Variable>) Calculates the difference in value between two adjacent measurements. Scalar 

ENERGY_VALUE 

(<Dynamic Variable>, 

<Band Number>) 

Calculates the overall energy found in the specified <Band Number> 

frequency band. <Band Number> starts at 1. Returns zero when no 

frequency band exists for the specified <Band Number>. Returns a 

band overall energy value with the same units and detection type as the 

<Dynamic Variable> entered. 

Dynamic (best 

for FFT data) 

FLOOR(<Param>) Calculates the largest (closest to positive infinity) integer that is not 

greater than the <Param> value. 

Scalar 

FORECAST_EXP 

(<Variable>, <Length>, 

<Length>) 

Calculates a forecasted alarm, in days, of the <Variable> entered using 

a sliding window of specified <Length> values. Uses an exponential 

fitting function. 

Scalar 

FORECAST_LIN 

(<Variable>, <Length>, 

<Length>) 

Calculates a forecasted alarm, in days, of the <Variable> entered using 

a sliding window of specified <Length> values. Uses a linear fitting 

function. 

Scalar 

HAL(<Dynamic Variable>, 

<Speed Multiple>) 

Calculates the Harmonic Activity Index for the frequency specified by the 

<Speed Multiple> entered in the <Dynamic Variable> entered. The 

<Speed Multiple> must be in orders. The returned value is a 

dimensionless indicator of the likelihood that a harmonic pattern at the 

<Speed Multiple> exists. 

Dynamic (best 

for FFT data) 
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Function Description Type of data 

KURTOSIS(<Variable>, 

<Length>) 

For overall measurements, calculates the Kurtosis of excess for the 

<Variable> entered using a sliding window of specified <Length> 

values. There should be at least three measurements in the POINT 

referenced by the <Variable>. 

Scalar 

KURTOSIS(<Dynamic 

Variable>, <Channel 

Number>) 

Calculates the standard deviation of a dynamic signal (FFT or waveform) 

for the specified <Channel Number> entered. For non-multi-channel 

measurements, <Channel Number> should be set to 1. 

Dynamic 

LN(<Param>) Calculates the natural logarithm of the <Param> value entered. Scalar 

LOG(<Param>) Calculates the logarithm of the <Param> value entered. Scalar 

MAX(<Variable>, 

<Variable>) 

Calculates the maximum value between each <Variable> entered. 

Returns the appropriate <Variable>. 

Scalar 

MIN(<Variable>, 

<Variable>) 

Calculates the minimum value between each <Variable> entered. 

Returns the appropriate <Variable>. 

Scalar 

MOD(<Param>, 

<Param>) 

Calculates the remainder after the division of the first <Param> value 

entered by the second <Param> value entered; for example:  

MOD(7, 3) = 1. 

Scalar 

Operating Time This function is available only by selecting “Operating Time” for 

Application Type when creating the POINT. It computes the amount of 

time an asset has been operative in the time unit specified in the create 

POINT dialog. 

Scalar 

PEAK_VALUE(<Dynamic 

Variable>, <Band 

Number>) 

Calculates the peak value found in the specified <Band Number> 

frequency band. <Band Number> starts at 1. Returns zero when no 

frequency band exists for the specified <Band Number>. Returns a 

peak value with the same units and detection type as the <Dynamic 

Variable> entered. 

Dynamic (best 

for FFT data) 

PERCENTCHANGE 

(<Variable>) 

Calculates the percentage change between two adjacent measurements. 

What is computed is: (Value – PreviousValue ) / PreviousValue. 

Scalar 

POWER(<Base>, 

<Exponent>) 

Raises the <Base> entered to the power of the <Exponent> entered. Scalar 

ROC(<Variable>, <Days 

Multiple>) 

Calculates the rate of change (in days) between two adjacent 

measurements. 

Scalar 

ROUND(<Param>) Calculates the integer closest to the <Param> value. Scalar 

SIN(<Radians>) Calculates the sine of the <Radians> value entered. Scalar 

SKEW(<Variable>, 

<Length>) 

Calculates the skew for the <Variable> entered using a sliding window 

of specified <Length> values. There should be at least four 

measurements in the POINT referenced by the <Variable>. 

Scalar 

SKEW(<Dynamic 

Variable>, <Channel 

Number>) 

Calculates the skew of a dynamic signal (FFT or waveform) for the 

specified <Channel Number>. For non-multi-channel measurements, 

<Channel Number> should be set to 1. 

Dynamic 

SMAX(<Dynamic 

Variable>) 

Calculates the maximum vector magnitude of an Orbit. The <Dynamic 

Variable>value entered must refer to a 2 channel time waveform value. 

Dynamic (best 

for time 

waveform data) 

SPEED(<Dynamic 

Variable>) 

Extracts the machine speed from the <Dynamic Variable> entered. The 

<Dynamic Variable> must be either a time waveform or spectrum. The 

returned value is in Hertz. 

Dynamic 

SQRT(<Param>) Calculates the square root of the <Param> value entered. Scalar 

STDEV(<Variable>, 

<Length>) 

Calculates the standard deviation of the <Variable> entered using a 

sliding window of specified <Length> values. There should be at least 

two measurements in the POINT referenced by the <Variable>. 

Scalar 
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Function Description Type of data 

STDEV(<Dynamic 

Variable>, <Channel 

Number>) 

Calculates the standard deviation of a dynamic signal (FFT or waveform) 

for the specified <Channel Number>. For non-multi-channel 

measurements, <Channel Number> should be set to 1. 

Dynamic 

SUMDURATION 

(<Variable>, <Duration>) 

Enter any number of days (for example: 1, 7, 31, etc.) or partial days 

(for example: 0.5, 3.5, 11.75, etc.) for <Duration>. This function sums 

the <Variable>’s (POINT’s) last measurement with all of its previous 

measurements found within the specified number of days (or partial 

days) prior to the last measurement date/time. 

 

Sample cases: 

Enter a <Duration> of 7 to sum the <Variable>’s (POINT’s) last 

measurement with all of its previous measurements starting 

exactly 7 days prior to the last measurement. 

 

Enter a <Duration> of 3.5 to sum the <Variable>’s (POINT’s) last 

measurement with all of its previous measurements starting 

exactly 3 and one half days prior to the last measurement. 

Scalar 

SUMPERIOD(<Variable>, 

<Period>) 

Enter a specific <Period> (defined in sample cases, below). This function 

sums the <Variable>’s (POINT’s) last measurement with all of its 

previous measurements found within the specified <Period> and 

stamps the result with the period start date/time. 

 

SUMPERIOD differs from the other functions in that it always creates a 

measurement at the start of a period as soon as it begins, even when 

the source <Variable> (POINT) has not yet collected a measurement. 

The initial value is 0, and will be updated as the source <Variable> 

(POINT) collects measurements for that period. 

 

Sample cases: 

Enter a <Period> of Period_Hour to sum the Variable’s (POINT’s) 

last measurement with all of its previous measurements within the 

same hour, starting at the top of the hour (for example 08:00 AM). 

Alternatively, you can enter the constant 1 as the <Period> value 

to represent Period_Hour. 

 

Enter a <Period> of Period_Day to sum the Variable’s (POINT’s) 

last measurement with all of its previous measurements found 

within the same day, starting at 12:00 AM. Alternatively, you can 

enter the constant 2 as the <Period> value to represent 

Period_Day. 

 

Enter a <Period> of Period_Week_Sunday to sum the Variable’s 

(POINT’s) last measurement with all of its previous measurements 

found within the same week, starting Sunday at 12:00 AM. 

Alternatively, you can enter the constant 3 as the <Period> value 

to represent Period_Week_Sunday. 

 

Enter a <Period> of Period_Week_Monday to sum the Variable’s 

(POINT’s) last measurement with all of its previous measurements 

found within the same week, starting Monday at 12:00 AM. 

Alternatively, you can enter the constant 4 as the <Period> value 

to represent Period_Week_Monday. 

 

Scalar 



Working With Your SKF @ptitude Analyst Hierarchy 

POINT Properties 

2 - 46  SKF @ptitude Analyst for SKF Microlog Analyzer 

  User Manual 

Function Description Type of data 

Enter a <Period> of Period_Month to sum the Variable’s (POINT’s) 

last measurement with all of its previous measurements found 

within the same month, starting the first day of the month at 

12:00 AM. Alternatively, you can enter the constant 5 as the 

<Period> value to represent Period_Month. 

 

Enter a <Period> of Period_Quarter to sum the Variable’s 

(POINT’s) last measurement with all of its previous measurements 

found within the same quarter, starting Jan 1, Apr 1, Jul 1, or Oct 

1 at 12:00 AM. Alternatively, you can enter the constant 6 as the 

<Period> value to represent Period_Quarter. 

 

Enter a <Period> of Period_Year to sum the Variable’s (POINT’s) 

last measurement with all of its previous measurements found 

within the same year, starting Jan 1 at 12:00 AM. Alternatively, 

you can enter the constant 7 as the <Period> value to represent 

Period_Year. 

SUMSINCE(<Variable>, 

<Start Date>) 

Enter any <Start Date> code (using the format yyyymmdd or, 

optionally, yyyymmddhhmmss). This function sums all of the 

<Variable>’s (POINT’s) measurements found on or after the specified 

date/time. 

 

Sample cases: 

Enter a <Start Date> of 20140101 to sum all of the Variable’s 

(POINT’s) measurements found on or after Jan 1, 2014 at 12:00 

AM. 

 

Enter a <Start Date> of 20140101090000 to sum all of the 

Variable’s (POINT’s) measurements found on or after Jan 1, 2014 

at 09:00 AM. 

Scalar 

TAN(<Radians>) Calculates the tangent of the <Radians> value entered. Scalar 

Total Operating Time This function is available only by selecting “Operating Time” for 

Application Type when creating the POINT. It computes the total 

amount of time an asset has been operative in the time unit specified in 

the create POINT dialog. 

Scalar 

Dynamic 

TRUNC(<Param>) Removes any fractional part from the <Param> value entered. Scalar 

XMAG(<Dynamic 

Variable>, <Channel 

Number>, <Channel 

Number>, <Speed 

Multiple>) 

Computes the cross magnitude value (as opposed to cross phase) 

between two time waveform signals. The waveform signals are 

referenced by the <Dynamic Variable> entered and either of the 

specified <Channel Number> values. The specific frequency the cross 

magnitude value is computed for is determined by the speed value 

associated with the measurement and the <Speed Multiple> value 

entered: f = 1 / (s * Speed Multiple). 

 

This function operates on multi-channel measurements only. 

Dynamic (best 

for time 

waveform data) 
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Function Description Type of data 

XPHASE(<Dynamic 

Variable>, <Channel 

Number>, <Channel 

Number>, <Speed 

Multiple>) 

Computes the cross phase value (as opposed to cross magnitude) 

between two time waveform signals. The waveform signals are 

referenced by the <Dynamic Variable> entered and either of the 

specified <Channel Number> values. The specific frequency the cross 

phase value is computed for is determined by the speed value 

associated with the measurement and the <Speed Multiple> value 

entered: 

f = 1 / (s * Speed Multiple). 

 

This function operates on multi-channel measurements only. 

Dynamic (best 

for time 

waveform data) 

 The value entered for the SIN, COS, and TAN functions must be in 

radians, not degrees.  If the value entered is in degrees, the 

@ptitude Analyst will assume it is in radians, and the calculation 

will be wrong.   

To convert degrees to radians, use the DEGTORAD function in the 

formula.  For example, if you have a value of 45 degrees, the 

entered formula may look like this:  

SIN(DEGTORAD(45))   

When the formula is calculated, 45 degrees is automatically 

converted into radians.   

 Use the DeltaTime function to calculate the difference in seconds 

between the two most recent measurements for that POINT. 

 Use the DeltaValue function to calculate the difference in value 

between the two most recent measurements for that POINT.  

 Use the PercentChange function to calculate the percent change 

between the two most recent measurements for that POINT.  The 

formula will look like this: 

(LastValue – PreviousValue) / PreviousValue 

Important – After initial setup of a derived POINT that references variables 

(POINTs) with existing data records, you must manually calculate the derived 

POINT to immediately acquire derived POINT data based upon the variable POINTs’ 

historical data records.  Reference the Calculating Derived POINTs section later in 

this chapter for details. 

Share As 

 Click Share As to make the expression a shared expression.  The Enter Name 

dialog displays. 

 Enter a name for the shared expression and click OK. 

The new shared expression now appears as an available selection in the tab's drop 

down list.  Shared expressions are easily assigned to other POINTs to simplify setup and 

maintenance. 
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Compliance Tab 

Use the Compliance tab to enter data collection and archiving scheduling information. 

The Data collection area allows you to specify an Interval-based or Calendar-based 

data collection schedule for the POINT. 

Interval Based 

An interval-based collection schedule allows you to schedule data collection at a set 

time interval.  For example, if data is scheduled to be collected for a POINT every seven 

days, the POINT must be collected within seven days of the last time data was collected 

for the POINT.  If data is not collected within the set time interval, the POINT is 

considered Overdue and displays as missed when included in generated reports.  

Calendar-Based  

A calendar-based collection schedule allows you to schedule data collection starting 

from a specified calendar date and time, at a specified calendar interval (hours, days, 

weeks, etc.).  If, for such a POINT, data is not collected at all within the time period, the 

POINT is considered Out of Compliance and displays as missed when included in 

generated reports.  

 To learn how to set up a calendar-based data collection schedule, 

reference the Customize / Database Operations / Compliance 

section later in this chapter. 

@ptitude Analyst allows you to archive collected data using its Scheduler feature, its 

Monitor application, or Manually.  To archive with Analyst’s Scheduler wizard or with 

the Monitor application, you must set archive parameters in the POINT Properties / 

Compliance tab and in the Scheduler wizard or Monitor application respectively.  
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Figure 2 - 22. 

The POINT Properties Screen’s Compliance Tab – Interval-Based. 

 IMPORTANT - Keep current data for, Short term archive, and 

Long term archive settings operate ONLY with the Scheduler’s  

archive process or when using the Monitor application’s archive 

feature.  They do not apply to Manual archives. 

Interval-based fields include: 

Take data every – Enter a numerical value to indicate how often data should 

be collected and select the appropriate units from list box options (None, 

Second(s), Minute(s), Hour(s), Day(s)).  The POINT is tagged as overdue for 

data collection if the time range between the current date (today) and the last 

data collection date is longer than the specified Take data every setting. 



Working With Your SKF @ptitude Analyst Hierarchy 

POINT Properties 

2 - 50  SKF @ptitude Analyst for SKF Microlog Analyzer 

  User Manual 

 The Take data every field is used to determine if a POINT is 

overdue for data collection.   

Keep current data for – Enter a value to indicate how long to keep (store) the 

measurement record in the hierarchy’s “current data” bin and select the 

appropriate units (Week(s), Month(s), Year(s), Forever, Measurement(s)).  

When the specified time from data collection elapses, and a Scheduled or 

Monitor archive process is performed, the measurement is typically moved 

from the “current data” bin into the “short term archive” bin (or discarded) as 

specified in the Short term archive / Archive data every field. 

 The Keep current data for field determines the length of time a 

measurement is kept before it is archived. 

Example - Using a Microlog DAD, you may select to Take data every <30 

days> and Keep current data for <1 Yr>.  If you use Analyst’s Scheduler 

feature to schedule an archiving process every month, no archiving will 

take place for the first year.  After the first year, on a monthly basis,  all 

measurement records in the “current data” bin whose date / timestamp 

is older than 1 year from the current date will either be placed in the 

“short term archive” bin (if short term criteria are met) or discarded. 

 

Figure 2 - 23. 

The POINT Properties Screen’s Compliance Tab – Calendar-Based. 

Calendar-based fields include: 

Compliance name – Select a pre-configured compliance schedule from the drop down 

list.   

 Create and edit compliance schedules on the Customize / 

Database / Compliance tab.  Reference Chapter 3’s Customize / 

Database Operations section for details. 

Starting from – Displays the initial start date / time of when the data collection interval 

is scheduled. 

Data due every – Displays the frequency of when the scheduled data collection is due 

to be collected. 
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Keep current data for – Enter a value to indicate how long to keep (store) the 

measurement record in the hierarchy’s “current data” bin and select the appropriate 

units (Week(s), Month(s), Year(s), Forever, Measurement(s)).  When the specified 

time from data collection elapses, and a Scheduled or Monitor archive process is 

performed, the measurement is typically moved from the “current data” bin into the 

“short term archive” bin (or discarded) as specified in the Short term archive / Archive 

data every field. 

 The Keep current data for field determines the length of time a 

measurement is kept before it is archived. 

Short term archive (optional, but typically enabled) 

Fields in the short term archive section include: 

Archive data every – Determines whether data leaving the “current data” bin 

is archived in the “short term archive” bin.  Enter numerical value to indicate 

how often data leaving the “current data” bin is stored in the “short term 

archive” bin and select appropriate units (None, Day(s), Week(s), Month(s), 

Year(s)).  As scheduled archives occur, measurements leaving the “current 

data” bin are accepted into the “short term archive” bin only if this Archive 

data every setting has expired since the last measurement was stored in the 

“short term archive” bin.  Otherwise, they are discarded. 

Example - To continue with our example of a scheduled monthly archive.  If 

we set this Archive data every setting to three months, on the 13th 

month of data collection, the measurement(s) leaving the “current data” 

bin are placed in the “short term archive” bin as there is no data yet 

stored in the “short term archive” bin.  On months 14 and 15, 

measurement(s) that exceed the Keep for setting and leaving the 

“current data” bin are discarded, as three months have not expired since 

the last “short term archive” data was stored.  On month 16, 

measurement(s) leaving the “current data” bin are three months newer 

than the last measurement stored in the “short term archive” bin, and 

are therefore stored in the “short term archive” bin.  Thus, by configuring 

this setting to three months, you are able to “thin” the data stored in the 

“short term archive” bin (store short term archive data every three 

months instead of every month). 

Keep archive for – Enter a value to indicate how long to keep (store) the 

measurement record in the “short term archive” bin and select appropriate 

units (Week(s), Month(s), Year(s), Forever, Measurement(s)).  When the 

specified time of storage elapses, and a scheduled archive process performed, 

the measurement is typically moved from the “short term archive” bin into the 

“long term archive” bin (or discarded) as specified in the Long term archive 

fields. 

Fields in the long term archive section include: 

Archive data every – Determines whether data leaving the “short term 

archive” bin is archived in the “long term archive” bin.  Enter numerical value to 

indicate how often data leaving the “short term archive” bin is stored in the 

“long term archive” bin and select appropriate units (None, Day(s), Week(s), 

Month(s), Year(s)).  As scheduled archives occur, measurements leaving the 
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“short term archive” bin are accepted into the “long term archive” bin if this 

Archive data every setting has expired since the last measurement was stored 

in the “long term archive” bin. 

Keep archive for – Enter value to indicate how long to keep (store) the 

measurement record in the “long term archive” bin and select appropriate 

units (Week(s), Month(s), Year(s), Forever, Measurement(s)).  When the 

specified time of storage elapses, and a scheduled archive process is 

performed, the measurement is discarded. 

Unscheduled data 

The last section of the tab schedules alarm data.  In on-line DAD systems, alarm data is 

automatically placed in the “Unscheduled data” bin.  This setting determines how long 

alarm data is stored in the alarm data bin before it is discarded.   Fields include: 

Keep for – Specify value to indicate the desired length of time to store alarm 

data and select appropriate units (Week(s), Month(s), Year(s), Forever, 

Measurement(s)).  After the specified storage time elapses, the alarm data is 

discarded. 
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Filter Keys Tab 

 

Figure 2 - 24. 

The POINT Properties Screen’s Filter Keys Tab. 

@ptitude Analyst allows you to create Filter Keys which can be associated with POINTs 

and Machines for automated filtering purposes.  For example, if you activate a “Pump” 

filter key for a Group and later filter a hierarchy list using the Filter Key / Pump, then 

all Groups with active Pump filter keys display in the filtered Workspace. 

 Filter key creation is discussed later in this chapter. 

Filter key searches list all POINTs or Machines sharing a specified filter key (or multiple 

filter keys).  The Filter Key tab lists all created filter keys and indicates whether or not 

they are currently assigned.   

 Click a specific filter key’s checkbox to associate it to the current POINT. 
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 The checkbox appears gray if the filter key is enabled for a parent 

hierarchy item. 

 Click the Filter Key dialog’s OK button to save your filter key assignments. 

Overall Tab 

The Overall tab allows you to re-apply previously defined “shared” overall alarms, 

eliminating the need to define alarms individually, saving time and hierarchy space. 

Use the Overall tab to set a POINT’s overall alarm settings.  The alarm can be 

configured in a variety of ways using the Overall tab’s fields. 

The current alarm appears in the Overall alarm field.  The current alarm’s values 

display below in the tab’s Properties and Settings areas. 

 

Figure 2 - 25. 

The POINT Properties Screen’s Overall Tab. 
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The Channel drop down list displays all available channels.  Specify the channel to 

which to apply the overall alarm, or click Set All, to apply the alarm to all available 

channels.   

The Overall alarms drop down list displays all previously created overall alarms and a 

<Private Alarm> option.  Use this drop down list to specify whether you wish to set up 

a unique  <Private Alarm> for the current POINT only, or specify a previously defined 

“shared” alarm (selected by name).  If you specify a shared alarm, it’s alarm settings 

automatically display in subsequent fields.  If you specify a Private Alarm, proceed to 

configure the tab’s alarm settings as described below. 

The Properties area options relate to Alert and Danger alarm detection values specified 

in the Settings area.  Select from: 

None – No overall alarm is set for the POINT. 

Level – Measurements exceeding the specified Settings will result in an alarm 

condition. 

In Window – Measurements falling within the specified Settings will result in 

an alarm condition. 

Out of Window – Measurements falling outside the specified Settings will 

result in an alarm condition. 

To assign a shared alarm to the current POINT: 

 Select the shared alarm from the drop down list and click the OK button.  Shared 

alarms may be applied to an unlimited number of POINTs. 

Shared Alarm 

Alarms initially created as private alarms may be converted into shared alarms.  To 

share a newly created Private alarm, select the new Private alarm and click the tab’s 

Share As button. 

The Share As dialog specifies the alarm as a shared alarm.  When the Share As dialog 

displays, you will be prompted to give the shared alarm a unique name for easy 

identification.   

 Enter a name for the shared alarm and click the OK button. 

The new shared alarm now appears as an available selection in the drop down list.  

Shared alarms are easily assigned to other POINTs to simplify POINT setup and 

maintenance. 
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Variable Speed Alarms 

As a machine’s speed increases, the overall vibration increases.  In order to accurately 

determine if measurements are in alarm, alarm levels should be adjusted based on the 

machine’s speed levels.  @ptitude Analyst’s variable speed alarms allow you to 

customize overall and band alarm levels based on machine speed. 

The POINT Properties / Speed Alarm tab allows you to specify the POINT’s alarm 

adjustments for each speed region.   

 

Figure 2 - 26. 

The POINT Properties’ Speed Alarm Tab. 

Speed alarm fields include: 

Speed Alarm – Specify a private or shared alarm from the drop down list. 

Range – Select the speed regions for which the Properties settings will apply.  You may 

select the region from the Range drop down list, or by clicking on the specific region on 

the speed alarm display.  The values in the Properties fields update to reflect the 

specified speed region. 
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 Click Insert to add a new region to the speed alarm. 

 Click Clear to remove the selected speed region. 

Start / End Range– Enter each region’s start and end RPMs (i.e., 0 to 1000, 1000 to 

2000, 2000 to 3000, etc.).  

Ratio – Enter the adjustment to overall and band alarm levels.  The normal running 

speed region's ratio will be 100.  If the next higher speed range is expected to produce 

vibration levels 10% higher than the nominal running speed, then the next speed range 

ratio would be set to 110. 

Linear – This option allows for either a flat, rectangular definition of the adjustment (if 

disabled, the entire region will have the same ratio), or a more linear definition of the 

ratio (if enabled, the ratio will start from the level defined in the previous speed region 

and rise throughout the region until it reaches the next speed region's level).  

Deadband – When enabled, no alarm processing will occur for this region.  This is 

mainly to be used when the machine reaches its resonant speed, at which vibration will 

be indeterminately high.  When enabled, Ratio and Linear fields are disabled.  

The variable speed alarm settings produce a table of speed ratios for the POINT.  When 

data is collected, the overall alarm value is multiplied by the speed ratio before it is 

compared to the overall value returned from the sensor to determine whether the 

POINT is in alarm.  When viewing a trend display, the variable speed alarm overlay 

adjusts based on the speed of the measurement. 

 

Figure 2 - 27. 

Trend Display with Variable Speed Alarm Overlay. 
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Figure 2 - 28.  

Band Trend Display with Variable Speed Alarm Overlay. 

Shared Alarm 

Variable speed alarm adjustments initially created as private definitions may be 

converted into shared definitions.  To share a newly created Private definition, select the 

new Private definition and click the tab’s Share As button. 

The Share As dialog specifies the definition as a shared definition.  When the Share As 

dialog displays, you will be prompted to give the shared definition a unique name for 

easy identification.  Enter a name for the shared definition and click the OK button. 

The new shared definition now appears as an available selection in the drop down list.  

Shared definitions are easily assigned to other POINTs to simplify POINT setup and 

maintenance. 
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Messages 

The Messages tab allows you to apply previously defined “shared” alarm messages, and 

to create new alarm messages for various overall alarm levels. 

 

Figure 2 - 29. 

The POINT Properties Screen’s Messages Tab. 

@ptitude Analyst's POINT Properties / Messages feature allows you to create and 

assign four alarm messages corresponding to the four overall alarm levels; Overall 

Alert High, Overall Alert Low, Overall Danger High, and Overall Danger Low.  The 

Messages context area displays the message context available for message assignment 

and any existing alarm messages already applied.  You can assign a created public 

alarm message to one or more alarm levels, or create a new private alarm message 

and apply it to the selected POINT. 
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The Name drop down list displays all previously created alarm messages and a 

<Private> option.  Use this drop down list to specify whether you wish to set up a 

unique  <Private> message for the current POINT only, or specify a previously defined 

“shared” message (selected by name).  If you specify a shared message, its format, 

summary, and content automatically display in subsequent fields.  If you specify a 

Private message, proceed to configure the message settings as described below. 

 For more information on creating and managing public alarm 

messages, refer to the Customize / Hierarchy Operations 

section later in this chapter. 

Format – This drop down list allows you to specify your alarm message's format. 

Free form – Allows you to manually type in the summary and content for your 

alarm message. 

Summary – Type in text summarizing your alarm message for easy recognition.  For 

example, if you have an alarm message that details shut down instructions in the case 

of an overall danger high alarm level, your summary may read, "Emergency Shut Down 

Instructions." 

Content – Enter your complete alarm message in the content text area.  Using the 

above example, your alarm message content would include detailed shut down 

instructions, and any other pertinent information required in the case of the triggered 

alarm type. 

To assign a shared message to the current POINT: 

 Select the shared message from the drop down list and click the OK button.  

Shared messages may be applied to an unlimited number of POINTs. 

Shared Message 

Alarm messages initially created as private messages may be converted into shared 

(public) messages.  To share a newly created Private message, select the new Private 

message and click the tab’s Share As button. 

The Enter Name  dialog specifies the message as a shared (public) message.  When the 

Enter Name dialog displays, you will be prompted to give the shared message a unique 

name for easy identification.   

 Enter a name for the shared message and click the OK button. 

 The new shared message now appears as an available selection in the tab's drop 

down list.  Shared messages are easily assigned to other POINTs to simplify POINT 

setup and maintenance. 
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Frequencies Tab 

The POINT Properties screen’s Frequencies tab allows you to re-apply previously 

defined Frequency Sets, or configure a new fault Frequency Set to attach to the 

current POINT. 

 

Figure 2 - 30. 

The POINT Properties Screen’s Frequencies Tab. 

You can select a frequency shared with other POINTs or create a private frequency set 

for use with the current POINT only. 

To assign a shared frequency set to the current POINT: 

 Select the shared frequency set from the Frequency Set drop down list.  The 

corresponding included frequencies appear in the tab’s Included frequencies area.   

 Click OK to assign the selected set to the current POINT. 
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Use the Frequency tab to create a private set for use with the current POINT only.   

 Check the Private frequency set checkbox.  <Private frequencies> displays in the 

tab’s Frequency Set field. 

 Click the Edit Set button.  The Frequency Sets Editor dialog opens automatically.   

 Complete edits and click OK. 

The Frequencies tab also allows you to create a private set based on an existing shared 

set.  This is convenient when your new frequency set is only slightly different from an 

existing frequency set. 

 When a shared frequency set is made private, changes made to 

the shared set will not be reflected in private sets. 

To edit a shared set for private use: 

 Select the shared frequency set you wish to modify from the Frequency Set drop 

down list.   

 Click the Private Frequency set box.  The Frequency Sets Editor dialog opens. 

 Complete edits and click OK. 

 Refer to the Frequency Sets section in this chapter for more 

information on Frequency Sets. 

Notes Tab 

The POINT Properties / Notes tab allows you to attach a text note to the POINT along 

with a date / time stamp.  This feature conveniently stores and records relevant POINT 

information such as maintenance history. 

 Coded notes uploaded from the Microlog for the current Machine 

display in the Notes tab. 

 Click the Notes tab’s Add button to add a new note and date / time stamp. 

 Click the Save button to save edits made to a note. 

 Click the Undo button to cancel edits made to a note. 

 Click the Remove button to remove the selected note from the display. 

POINT Properties / Notes fields include: 

Date – Select the current date from the drop down list. 

Time – Select the current time. 

The selected date and time appear in the tab’s left Notes field. 

Text – Type in desired note text in the text field. 

 Click the tab’s OK button to save all entries. 
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HAL Alarms Tab 

HAL (harmonic activity locator) alarms provide alert and danger alarms on Harmonic 

Activity Index (HAI) indicators for designated frequencies. Use the HAL Alarms tab to 

configure HAL alarms for a dynamic measurement POINT.  

 

Figure 2 - 31. 

HAL Alarms Tab. 

If you are working with a multi-channel POINT, first select a Channel. Any existing HAL 

alarm settings that display and any existing or new HAL alarm settings you configure 

are for the selected Channel only. 

 At any time, you can click Copy to All Channels to apply the 

selected Channel’s settings to all channels. 

To exclude all frequencies from HAL alarm analysis on the selected channel: 

 Select (mark) the None radio button.  

 If no frequencies are defined for the POINT, None is the only 

available option. To associate a frequency set with the POINT, go 

to the Frequencies tab.  
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To set the same HAL alarms for all frequencies on the selected channel: 

 Select (mark) the HAL Alarms for all frequencies radio button. 

 At least one frequency must be defined for the POINT before you 

can select this radio button. 

 Select (check) the Danger High checkbox and enter a value to represent the HAI 

value danger alarm threshold. Any calculated HAI values for any of the frequencies 

on this channel that are greater than or equal to the value entered will trigger a 

danger alarm. 

 The default value is “8.” 

 Select (check) the Alert High checkbox and enter a value to represent the HAI value 

alert alarm threshold. Any calculated HAI values for any of the frequencies on this 

channel that are greater than or equal to the value entered but less than the 

Danger High threshold value will trigger an alert alarm. 

 The default value is “5.” 

 

To set HAL alarms individually per frequency on the selected channel: 

 Select (mark) the HAL Alarms for individual frequencies radio button. 

 At least one frequency must be defined for the POINT before you 

can select this radio button. 

Each row in the grid represents an individual frequency on the selected channel and 

contains the Name assigned to the frequency, the Frequency value itself, the 

Danger alarm threshold, and the Alert alarm threshold. 

 Select (check) a row’s Danger checkbox and enter a value to represent the HAI 

value danger alarm threshold for the frequency. Any calculated HAI value for this 

frequency on this channel that is greater than or equal to the value entered will 

trigger a danger alarm. 

 Select (check) a row’s Alert checkbox and enter a value to represent the HAI value 

alert alarm threshold for the frequency. Any calculated HAI value for this frequency 

on this channel that is greater than or equal to the value entered but less than the 

frequency’s Danger threshold value will trigger an alert alarm. 
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To copy one frequency’s HAL alarm settings to other individual frequencies on a 

channel: 

 Select the entire source frequency row and click Copy. 

 Select the entire destination frequency row and click Paste. 

 To copy the source frequency’s thresholds to all frequencies on 

this channel, click Copy to All Frequencies instead of Paste. 

 If you wish to disable an alarm for any frequency, deselect (uncheck) the 

appropriate checkbox. 

If you are working with a multi-channel POINT, select each Channel and proceed with 

any of the appropriate steps described above. When you click OK to save all changes on 

the POINT Properties screen, the system saves all settings you have configured or 

updated for each applicable channel on this tab. 

Contribution Tab 

To configure the combination contribution bar chart and profile plot display, the POINT 

Properties provides the Contribution tab. The list of frequencies presented on the 

Contribution tab is always based on the frequencies currently associated with the 

POINT on the Frequency tab. Any frequency types that are not supported on the 

Contribution plot are excluded from the Contribution tab.  The Contribution tab 

displays two types of frequencies:  

 Frequencies from bearings  

 Non-bearing RPM multiple frequencies 

 Unsupported frequencies are: Non-bearing Constant, Non-

bearing Offset and Non-bearing Sideband 

Use the Contribution tab to choose which frequencies to include in the contribution bar 

graph and roundness profile plot display, as well as to select an external source to use 

as the Speed Reference.  

Important! Upon opening, the Contribution tab list of frequencies will update to 

match changes made to the Frequency tab list. If frequencies from bearings or 

non-bearing RPM-multiple frequencies were edited on the Frequencies tab, the list 

on the Contribution tab will update to match those changes. 

Any frequencies of the relevant types (from bearings or Non-bearing RPM multiple 

frequencies) that were deleted are removed from the Contribution tab list. Any 

frequencies of the relevant types that were added are also added to the 

Contribution tab list. They are set to their default settings: unchecked, with the 

speed reference set to the current point. 
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Figure 2 - 32. 

POINT Properties, Contribution Tab.  

The columns and features on the Contribution tab are described below: 

Name – If the checkbox in the Name column is selected, that frequency will be 

displayed in the POINT’s contribution bar graph and roundness profile plot display. Click 

Check All to select and include all the frequencies. Click Uncheck All to deselect all the 

frequencies. 

Frequency – This column displays the frequency as <F> x RPM>.  The value of F depends 

on the frequency type, the Speed reference and Frequency: <value> x RPM (external 

reference) values. If the frequency is for a bearing, the numeric value substituted for F will 

be the Fundamental frequency for the row (for example, BPFO, BPFI etc.).  

 Bearing frequencies do not support external Speed References 

or Frequency: <value> x RPM (external reference) values. 

Speed Reference – Each frequency has its own speed reference. The default speed 

reference is the current POINT itself, shown in the column as <Self reference>. If the 

frequency is for a non-bearing RPM multiple and no external speed reference is set, F is 

the value of the Frequency formula of the row.   
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Figure 2 - 33. 

Frequency Sets Editor > Other Tab, Frequency Formula Field. 

The speed reference value for a non-bearing RPM multiple frequency can be changed 

to an external speed reference (for example, a tachometer signal), as detailed in the 

procedure below. 

To change the speed reference POINT for the selected frequency: 

 Highlight the frequency you want to modify. The Speed Reference field 

displays the speed reference point that will be used to derive the speed for 

calculations made in contribution graphs for this point.  

 Click the “Select...” button. The POINT Selection dialog opens.  
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Figure 2 - 34. 

POINT Selection Dialog for Selecting a New Speed Reference Point. 

If the speed reference for the current frequency is set to the default, the Set to current 

point option button will be selected and the machine for the current POINT will be 

displayed in the item hierarchy presented.  

 Select the option button Select new speed reference point.  

 Browse to the POINT in the hierarchy that you want to use as the speed 

reference. (See the section About Speed References, below.) 

 When the correct POINT is highlighted, click OK.  

 To return the speed reference to its default, select the option 

button Set to current point, and then press OK. 

You are returned to the Contribution tab. The new reference for the selected row displays 

in the Speed Reference field as “<Machine>/<Point>”. 
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Figure 2 - 35. 

Contribution Tab Showing One External Speed Reference. 

Frequency: <value> x RPM (external reference) is enabled when the selected row is 

using an external speed reference. The Frequency: <value> x RPM (external 

reference) value is used in conjunction with the frequency to calculate the speed for the 

frequency on the Contribution plot. The default value is 1.0. Enter the Frequency: 

<value> x RPM (external reference) value. 

 If the Frequency: <value> x RPM (external reference) value is 

not 1.0, F is the value of the Frequency: <value> x RPM (external 

reference) field. 

 If the Frequency: <value> x RPM (external reference) is 1.0, F is 

the value of the Frequency formula of the row (the same as no 

external reference). 

 If the speed reference is set back by using the Set to current 

point option button, then the Frequency: <value> x RPM 

(external reference) returns to its default value of 1.0. 
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OK – Click OK to save changes. Settings changed on the Contribution tab are saved 

only when one of the following conditions is met:  

 At least one frequency is checked, or  

 At least one Speed Reference or Frequency: <value> x RPM (external reference) 

value is set to something other than the default. 

More about Speed References 

Valid speed references can be any POINT (static or dynamic). For static measurements, 

the overall value is to be taken as the speed reference. For dynamic measurements 

which are speed stamped, the speed stamp will be used as the external reference. OPC 

provided speeds, as well as MODBUS provided speeds, are also supported.  

The date/time stamp (DTS) of the incoming measurement and DTS of the 

tachometer/speed reference must be within a user-defined window of time (in seconds) 

or else a warning message will be displayed on the Contribution plot. The message 

states: Speed reference out of range. 

The initial size of this window is set in a pair of Plot preferences: Speed Reference Time 

Window (Unit) and Speed Reference Time Window (Value). Go to Customize > 

Preferences > Plot tab to set these preferences. 

  

Figure 2 - 36. 

Contribution Plot Preferences for Speed Reference Time Window. 
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You can change the Speed Reference Time Window values from within the Contribution 

plot by right-clicking to open the context menu. Select Settings to open the 

Contribution Plot Settings dialog. The default is 24 hours; the maximum is 48 hours. 

 

Figure 2 - 37. 

Contribution Plot Settings Dialog. 

Images Tab 

Scanned photographs or digital images can be added to a particular POINT, stored in 

the hierarchy, and viewed from the Images tab.  Images help identify SETs / machines, 

organize similar equipment, and document known defects. 

POINT Properties / Images fields include: 

Image – All attached images display in the drop down list. 

Description – Enter text to identify the image.  Click the Save button to save your 

description entry.  If saved, the new description replaces the filename in the Images list. 

To add a new image: 

 Click the Add button to add a new image.  The Windows’ Open dialog displays.  

Select desired image and click Open to add or Cancel to undo. 

 Added images use the filename as the default description. 

To replace the current image file with a newer image: 

 Click the Browse button. 

 Select a replacement image file.  The new image displays on the tab. 

 The image name and description of the old image are retained for 

the replacement image. 

 Click Save to confirm the image replacement. 

 Click Cancel to undo the image replacement. 

To export an image to a specific location: 

 Select the image to export. 

 Click the Export button. 

 When prompted, enter the desired export location and filename and click OK. 

The image is copied and saved to the specified location, but still remains attached to the 

assigned POINT.  
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Baseline Tab 

A Baseline is a measurement taken when the machine is in “known good” operating 

condition.  Baseline spectra are used for analysis comparison with future spectral 

measurement results. 

 The POINT Properties / Baseline tab is available only when the 

current POINT has stored spectral data.  If there is no collected 

FFT data, or the POINT type does not support FFT data, the 

Baseline tab does not appear. 

 

Figure 2 - 38. 

The POINT Properties Tab’s Baseline Tab. 
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To specify a POINT’s baseline spectrum: 

 Select the POINT in the hierarchy list. 

 Right-click to display the POINT’s context menu and select the Properties option.  

The POINT Properties tab displays. 

 Select the Baseline tab. 

Current Baseline  

The Current baseline field lists measurement record timestamps for the POINT’s 

stored measurements.  Click to specify the measurement to use as the baseline 

spectrum.  The specified measurement’s spectrum displays graphically in the tab’s lower 

area.   

 A No baseline option appears in the drop down list as the default, 

and to clear the current baseline selection. 

 In the drop down list, the assigned baseline is tagged for easy 

recognition. 

All measurements with FFT data for the current POINT appear with a time / date stamp 

in the Current Baseline drop down list.  The last assigned baseline is tagged for easy 

recognition.  The current baseline value is indicated by “ ___ date / ___ time” in the 

Current baseline field. 
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Phase Tab 

 This tab is available only if the POINT has stored phase data. 

 

Figure 2 - 39. 

The POINT Properties Screen’s Phase Tab. 

Polar vector plots show vibration amplitude and phase.  The phase angle is the angle 

the shaft travels from the start of a triggering event to when the point at which the 

sensor experiences maximum positive force.  This relationship provides valuable 

information on shaft orbit and shaft position and is used for analysis, balancing, and 

shaft orbital analysis. 

The POINT Properties / Phase tab set up area specifies polar vector alarm settings, 

and provides a graphical display of the defined alert and danger acceptance regions. 
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Orders are multiples of running speed.  Use the Order drop down list box to assign new 

acceptance regions to a specific order of the phase measurement (1X, 2X, 3X, 4X). 

Alert / Danger alarm fields 

 Click the Alert or Danger checkbox to enable set-up of an alert or danger 

acceptance region. 

 Use text box operations to enter Min Mag., Max Mag., Min Phase, and Max Phase 

polar vector settings. 

A summary of Enabled alarms displays vertically in the tab’s lower left column.  Alarm 

settings may also be defined graphically with drag and drop operations. 

To define graphically: 

 Move the mouse cursor over the line to be modified. 

 Depress and hold the left mouse button and drag the line to its new location before 

releasing the mouse button. 

 Click the SET button to apply alarm settings. 

Band Tab 

Band Alarms provide alert and danger alarms on both peak and spectral values within a 

defined frequency band.  Use the Band tab to Add new band alarms for the POINT, or 

Load existing “shared” band alarms for the POINT.   

 Loaded band alarms may not be edited from this tab.  Use the 

Customize menu’s  Alarm Hierarchy option to edit “shared” 

alarm parameters. 
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Figure 2 - 40. 

The POINT Properties Screen’s Band Tab. 

The Channel drop down list displays all available channels.  Specify the channel to 

which to apply the band alarm, or click Set All, to apply the alarm to all available 

channels.   

The current band alarm name appears in the Band alarms field.  All available band 

alarms are listed in the drop down list.   

To Load “shared” alarms to the selected POINT: 

 Click the Band tab’s Load button, the Load Band Alarms dialog displays all 

available shared band alarms by name.  Enable all band alarms to assign to the 

POINT and click OK.  The names of the enabled band alarms appear in the Band 

tab’s Band Alarms drop down list. 
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To Add a new band alarm for the POINT: 

 You may mix added band alarms with loaded band alarms.  

However, only added band alarms may be edited from this tab. 

 Click the Band tab’s Add button, the tab’s Band Information fields become 

available. 

Edit and view alarm values in the tab's Band information area.  The band name 

appears in the Label field. 

The following fields are available for viewing set values or editing: 

Label – Enter band name. 

Low freq – View or edit the low frequency value or multiple of running speed. 

High freq – View or edit the high frequency value or multiple of running speed. 

 In Low and High Frequency fields, you may specify a multiple of 

running speed by adding x to the end of the number.  For 

example, enter “1.5x” for 1.5 times running speed. 

Peak danger – View or edit the peak danger value or % Full Scale value. 

Peak alert – View or edit the peak alert danger value or % Full Scale value. 

 In Peak and Overall alarm fields, you may specify the alarm 

setpoint as a percentage of full scale by adding “%” to the end of 

the entered number.  For example, enter “10%” to set the alarm 

at 10 percent of the full scale value.   

Overall danger – View or edit the overall danger value or % Full Scale value. 

Overall alert – View or edit the overall alert value or % Full Scale value. 

 The tab's spectrum graphic display automatically updates as edits 

are made. 

Edits may be made on the tab's spectrum graphic display.   

To edit the band graphically: 

Spectrum source - If two or more POINTs are currently active, specify the POINT 

whose spectrum you wish to graphically display. 

Spectrum - using its time record, specify the spectrum measurement to display.  

Once the proper spectrum is displayed, specify the band alarm to edit from the Band 

Alarms drop down list.  Notice the mouse pointer changes when positioned over a band 

alarm parameter (line) on the graphic.   

 Click on the line of the band to edit and drag the line to its new position.  The value 

in the affected field automatically updates to reflect your setting. 

 Use the Save or Undo buttons to save or undo changes for the current band alarm 

edit.  After editing all necessary band alarms, use the tab’s OK or Cancel buttons to 

save all edited band alarms with the POINT, or cancel all edited and new band 

alarm efforts. 
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The total number of band alarms appears in the upper right corner of the tab’s Band 

information area.  Use the up and down arrow buttons to navigate between band 

alarms. 

 Click the Show all bands checkbox to display all available band alarms on the 

spectrum display.  The checkbox is not available when editing a band. 

 Click Share As to make the current band alarm a shared alarm.  The Enter Name 

dialog displays  Enter a name and click OK. 

 Click Add to create a new band alarm. 

 Click Remove to remove the current band alarm.  A confirmation dialog displays. 

 Confirm action.  The band alarm is deleted. 

 A band alarm may not be removed if it is currently assigned. 

Load Band Alarms 

Use the Load Band Alarms dialog to select shared band alarm(s) for the active POINT.  

All available shared band alarms display.   

 Click the checkbox to select alarm(s) to be included / assigned to the active POINT. 

 Click OK to select, Cancel to close dialog without saving selections. 

 You may sort the available shared alarms by band alarm name, 

inclusion status (included or excluded), or frequency range. 

Envelope Tab 

Use the POINT Properties' Envelope tab to specify a "total spectrum" envelope alarm 

for the POINT.  You can select from a list of previously created envelope alarms or edit a 

private (unique) alarm for the current POINT. 
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Figure 2 - 41. 

The POINT Properties Screen’s Envelope Tab. 

The Channel drop down list displays all available channels.  Specify the channel to 

which to apply the envelope alarm, or click Set All, to apply the alarm to all available 

channels.   

All available envelope alarms display in the Envelope alarm drop down list, or you may 

Generate a new envelope alarm.   

Shared envelope alarms may not be edited from this tab (use the Customize menu’s 

Alarm Hierarchy option to edit "shared" alarm parameters). 

 First, select the FFT spectrum to which the envelope alarm will conform, using: 

Spectrum source – specifies from which POINT to  graphically display the spectrum if 

two or more POINTs are currently active. 
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Spectrum – displays all available time record measurements for the active POINT 

(typically the baseline measurement) in a drop down list.  The current spectrum displays 

graphically below. 

To assign a "shared" envelope alarm to the POINT: 

 On the Envelope tab, select the desired shared envelope alarm’s name from the 

Envelope Alarms drop down list, the tab fields display the specified alarm’s settings 

and the specified envelope appears on the displayed spectrum. 

To Generate a new envelope alarm for the POINT: 

 Select the Envelope Alarms drop down list’s  <Custom envelope> option. 

 Click the Generate button.  The Generate Envelope Alarm dialog displays. 

Use the Generate Envelope Alarm Dialog to create an envelope alarm based on your 

entered values. 

% Overdrive – Enter the percent of the POINT’s full scale value to determine the height 

of the envelope alarm above the spectral peak.  The smaller the number specified, the 

tighter the comparison envelope conforms to the designated spectrum. 

Spreading %– Enter percent of full scale (or center frequency) to increase the width of 

the envelope alarm around spectral peaks.  The smaller the number specified, the 

tighter the envelope conforms to the sides of the peaks in the specified spectrum. 

Spreading Type – (either Center Frequency or Full Scale).  If Center Freq. is selected, 

the bandwidth about each center frequency increases with higher frequencies.  If Full 

Scale is selected, the bandwidth about each center frequency is constant, based on a 

percent of the full scale frequency. 

Threshold – Enter % of the POINT’s full scale value, or an absolute value.  The threshold 

value provides an opportunity to eliminate false alarms due to vibration "noise."  It also 

establishes the envelope alarm’s low amplitude "threshold" on the displayed spectrum.  

The envelope alarm conforms around all peaks whose amplitudes are higher than the 

established threshold as per the Overdrive %, Spreading %, and Spreading Type 

settings.  All peaks below the established threshold are ignored by the envelope alarm.  

The Threshold % default value is set using the Customize menu’s Preferences / Plot 

tab. 

 Click OK to generate an envelope alarm based on your entries.  Click Cancel to 

close the dialog without creating an envelope alarm. 

Editing the Envelope Alarm 

After you have generated an envelope alarm, you can edit it graphically using your 

mouse, or enter numeric envelope parameters using the Set Frequency Range dialog. 

To graphically edit the envelope alarm: 

 Click anywhere inside the Envelope dialog’s spectrum window.  The cursor appears 

as an up arrow.   

 Click the mouse on the portion of the envelope alarm line to be edited.  A square 

icon identifies where the line will be drawn. 
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 Drag the mouse to draw the line to create the new envelope alarm.   

 Click the dialog’s OK button to save your changes. 

Tip -  You can use your keyboard’s Insert key to begin drawing the envelope alarm line.  

Then, use the arrow keys to move the line, and the Insert key again to stop drawing the 

line.  Refer to Section 1 - Appendix B - SKF @ptitude Analyst Keyboard Support for 

more information on using your keyboard to edit your envelope alarm. 

To edit the envelope alarm using numeric frequency ranges: 

 Click the Set Range button.  The Set Frequency Range dialog displays. 

 Use the Set Frequency Range dialog to enter low frequency, high frequency, and 

level values to edit an existing envelope alarm. 

To numerically edit an envelope alarm: 

 Enter the desired low frequency, high frequency, and level value. 

 Click OK.  The displayed envelope alarm automatically conforms to your entries. 

Share As 

 Click Share As to make the envelope alarm a shared alarm.  The Enter Name 

dialog displays. 

 After completing the POINT’s envelope alarm setup, click the OK button to save the 

envelope alarm with the POINT. 

Waveform Tab 

When analyzing orbit data, it is desirable to filter out impurities in the shaft.  This can be 

accomplished by capturing a waveform measurement when the shaft is rotating very 

slowly (1 – 400 RPM).  This “slow roll” waveform highlights the normal variances in the 

rotation of the shaft, which can then be factored out when viewing orbit plots.  

The Waveform tab in POINT Properties lets you select the desired waveform 

measurement. 

 The POINT Properties / Waveform tab is available only when the 

current POINT has stored data.  If there is no collected data, or the 

POINT type is not Orbit / SCL, the Waveform tab does not appear. 
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Figure 2 - 42. 

The POINT Properties Screen’s Waveform Tab. 

To specify a POINT’s waveform measurement: 

 Select the POINT in the hierarchy list. 

 Right-click to display the POINT’s context menu and select the Properties option.  

The POINT Properties screen displays. 

 Select the Waveform tab. 

Current Waveform 

The Current Waveform field lists measurement record timestamps for the POINT’s 

stored measurements.  Click to specify the measurement to use as the slow roll 

waveform.  The specified measurement’s time waveforms display graphically in the tab’s 

lower area.   
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 A <No waveform> option appears in the drop down list as the 

default, and to clear the current waveform selection. 

Vector Tab 

When analyzing orbit data, orbit plots utilize a vector containing the magnitude and 

phase angle.  Vector compensation allows you to specify known magnitude and phase 

angle values that represent inherent impurities in the shaft.  These values are used in 

orbit plots to subtract out these known impurities. 

 Vector compensation is applied based on the  Orbit 

Compensation setting in Plot Preferences. 

 The vector settings are also used with Bode and Nyquist plots.   

The Vector tab in POINT Properties lets you enter the magnitude and angle that 

should be used to compensate orbit plots for Channel X and Channel Y at 1X, 2X, and 

3X machine running speed. 

 If the POINT type is not Orbit / SCL, the Vector tab does not 

appear. 
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Figure 2 - 43. 

The POINT Properties Screen’s Vector Tab. 

To specify a POINT’s vector compensation settings: 

 Select the POINT in the hierarchy list. 

 Right-click to display the POINT’s context menu and select the Properties option.  

The POINT Properties screen displays. 

 Select the Vector tab. 

Enable vector compensation – Mark this check box to enable the fields on this tab. If 

this is unmarked, no vector compensation is performed for the POINT. 

 Vector compensation is applied to the measurement as it is stored 

to the database.  Marking this check box only affects new 
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measurements.  Vector compensation will not be available for any 

measurements that were taken with this check box unmarked. 

 The General Preferences Angular Axis View setting specifies 

whether to use Scientific or Standard mode when determining the 

0 reference point to define probe placement.  This setting should 

be taken into account when entering your compensation angles. 

Channel X and Y compensation – The vector compensation settings that should be 

used in orbit plots for Channel X and Channel Y data, respectively.   

magnitude (1X, 2X, and 3X Speed) – The magnitude of the vector that should be 

factored out of orbit plots at 1X, 2X, and 3X the machine running speed. 

angle (1X, 2x, and 3X Speed) – The phase angle, in degrees, of the vector that should 

be factored out of orbit plots at 1X, 2X, and 3X the machine running speed. 

 The magnitude and angle settings together define the vector. 

POINT Setup Validation Dialog 

The POINT Setup Validation dialog launches when you enter incompatible or 

erroneous information on the Setup or Expressions tabs.   

The POINT Setup Validation dialog displays both errors and recommendations.  For 

recommendations, a message box displays prior to the POINT Setup Validation dialog, 

which allows you to ignore or view the POINT Setup Validation dialog. 

 

Figure 2 - 44. 

The POINT Setup Validation Recommendation Message Box. 

 If you do not wish to see the POINT Setup Validation Message Box for 

recommendations or warnings, uncheck and disable the Show this message box 

again checkbox.   

 You may also modify this preference from the Customize menu's 

Preferences screen. 

 Press Yes to view the POINT Setup Validation dialog.  

 Press No if you wish to close the message box without viewing the 

recommendation details. 
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Figure 2 - 45. 

The POINT Setup Validation Dialog for the Setup tab. 

 

Figure 2 - 46. 

The POINT Setup Validation Dialog for the Expressions tab. 

 The POINT Setup Validation dialog displays automatically for 

settings in error, and after the message box for settings that are 

recommendations or warnings. 

You may edit POINT setup information while the POINT Setup Validation dialog is 

displayed.  Simply move the dialog out of the way, and make any changes to your 

POINT Properties / Setup or Expressions tab while referencing the errors or 

recommendations. 
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 Press the Refresh button if you have made corrective changes to your 

POINT Properties / Setup or Expressions tab in the background.  If you 

have eliminated the error or recommendation, they will no longer display 

in the POINT Setup Validation dialog. 

 Press the Close button to close the POINT Setup Validation dialog and return to 

the POINT Properties Setup or Expressions tab. 

Multiple POINT Properties 

The Multiple POINT Properties screen is available when more than one POINT is 

selected.  This screen provides a set of tabs to view and modify set-up parameters 

common among the set of selected POINTs.  The type of POINTs selected determine 

which tabs display in the Multiple POINT Properties screen.   

 Configured parameters overwrite each selected POINT’s previous 

settings. 

Schedule Tab 

The Schedule tab allows you to set a common schedule for all the currently selected 

POINTs. 

Fields in the data collection portion of the Schedule tab include: 

Take data every – Enter a numerical value to indicate how often data should 

be collected and select the appropriate units from list box options (Second(s), 

Minute(s), Hour(s), Day(s)).  The POINT is tagged as overdue for data 

collection if the time range between the current date (today) and the last data 

collection date is longer than the specified Take data every setting. 

 The Take data every field is used to determine if a POINT is 

overdue for data collection.   

Keep current data for – Enter a value to indicate how long to keep (store) the 

measurement record in the hierarchy’s “current data” bin and select the 

appropriate units (Wk(s), Mo(s), Yr(s)).  When the specified time from data 

collection elapses, and a Scheduled or Monitor archive process is performed, 

the measurement is typically moved from the “current data” bin into the “short 

term archive” bin (or discarded) as specified in the Short term archive / 

Archive data every field. 

 The Keep current data for field determines the length of time a 

measurement is kept before it is archived. 

Short term archive (optional, but typically enabled) 

Fields in the short term archive section include: 

Archive data every – Determines whether data leaving the “current data” bin 

is archived in the “short term archive” bin.  Enter numerical value to indicate 

how often data leaving the “current data” bin is stored in the “short term 

archive” bin and select appropriate units (Wk(s), Mo(s), Yr(s)).  As scheduled 

archives occur, measurements leaving the “current data” bin are accepted into 
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the “short term archive” bin only if this Archive data every setting has expired 

since the last measurement was stored in the “short term archive” bin.  

Otherwise, they are discarded. 

Keep archive for – Enter a value to indicate how long to keep (store) the 

measurement record in the “short term archive” bin and select appropriate 

units (Wk(s), Mo(s), Yr(s)).  When the specified time of storage elapses, and a 

scheduled archive process performed, the measurement is typically moved 

from the “short term archive” bin into the “long term archive” bin (or discarded) 

as specified in the Long term archive fields. 

Fields in the long term archive section include: 

Archive data every – Determines whether data leaving the “short term 

archive” bin is archived in the “long term archive” bin.  Enter numerical value to 

indicate how often data leaving the “short term archive” bin is stored in the 

“long term archive” bin and select appropriate units (Wk(s), Mo(s), Yr(s)).  As 

scheduled archives occur, measurements leaving the “short term archive” bin 

are accepted into the “long term archive” bin if this Archive data every setting 

has expired since the last measurement was stored in the “long term archive” 

bin. 

Keep archive for – Enter value to indicate how long to keep (store) the 

measurement record in the “long term archive” bin and select appropriate 

units (Wk(s), Mo(s), Yr(s)).  When the specified time of storage elapses, and a 

scheduled archive process is performed, the measurement is discarded. 

Unscheduled data 

The last section of the tab schedules alarm data.  In on-line DAD systems, alarm data is 

automatically placed in the “Unscheduled data” bin.  This setting determines how long 

alarm data is stored in the alarm data bin before it is discarded.   Fields include: 

Keep for – Specify value to indicate the desired length of time to store alarm 

data and select appropriate units (Wk(s), Mo(s), Yr(s)).  After the specified 

storage time elapses, the alarm data is discarded. 

Filter Keys Tab 

@ptitude Analyst allows you to create Filter Keys which can be associated with POINTs 

and Machines for automated filtering purposes.  For example, if you activated a “Pump” 

filter key for a Group and later filtered by Filter Key / Pump, the group would display. 

 Filter key creation is discussed later in this chapter. 

Filter key searches list all POINTs or Machines sharing a specified filter key (or multiple 

filter keys).  The Filter Key tab displays all created filter keys and indicates whether or 

not they are currently assigned.   

 Click a specific Filter Key’s checkbox to associate it with the current Group. 

 Click the Filter Key dialog’s OK button to save your filter key assignments. 

 The checkbox appears gray if the filter key is assigned to the 

current group only because it was assigned to the group’s parent. 
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 Click the Filter Key dialog’s OK button to save your filter key 

assignments. 

Overall Tab 

The Overall tab allows you to re-apply previously defined “shared” overall alarms, 

eliminating the need to define alarms individually, saving time and hierarchy space. 

 

Figure 2 - 47. 

The Multiple POINT Properties Screen's Overall Tab. 

Use the Overall tab to set POINTs’ overall alarms.  The alarm can be configured in a 

variety of ways using the Overall tab’s fields. 

The current alarm appears in the Overall alarm field.  The current alarm’s values 

display below in the screen’s Properties and Settings areas. 

The Overall alarms drop down list displays all previously created overall alarms and a 

<Private Alarm> option.  Use this drop down list to specify whether you wish to set up 
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a unique  <Private Alarm> for the current POINTs only, or specify a previously defined 

“shared” alarm (selected by name).  If you specify a shared alarm, its alarm settings 

automatically display in subsequent fields.  If you specify a <Private Alarm>, proceed to 

configure the tab’s alarm settings as described below. 

The Properties area displays alarm detection options.  Select from: 

None – No overall alarm is set for the POINTs. 

Level – Measurements exceeding the set levels will result in an alarm 

condition. 

In Window – Measurements falling within the set levels will result in an alarm 

condition. 

Out of Window – Measurements falling outside the set levels will result in an 

alarm condition. 

To assign a shared alarm to the current POINTs: 

 Select the shared alarm from the drop down list and click the OK button.  Shared 

alarms may be applied to an unlimited number of POINTs. 

Shared Alarm 

Alarms initially created as private alarms may be converted into shared alarms.  To 

share a newly created Private alarm, select the new Private alarm and click the tab’s 

Share As button. 

The Share As dialog specifies the alarm as a shared alarm.  When the Share As dialog 

displays, you will be prompted to give the shared alarm a unique name for easy 

identification.   

 Enter a name for the shared alarm and click the OK button. 

The new shared alarm now appears as an available selection in the drop down list.  

Shared alarms are easily assigned to other POINTs to simplify POINT setup and 

maintenance. 

Frequencies Tab 

The Multiple POINT Properties screen’s Frequencies tab allows you to reapply 

previously defined Frequency Sets, or configure a new fault Frequency Set to attach to 

the current POINT. 

The <Private Alarm> is used to set the same alarm values for all currently selected 

POINTs, yet making the alarm definition private for each POINT.  This option may be 

used when you know all the selected POINTs will have unique alarm values, but the 

initial settings will be the same. 

To assign a shared frequency set to the current POINTs: 

 Select the shared frequency set from the drop down list.  The corresponding 

included frequencies appear in the Included frequencies portion of the tab.   

 Two additional options are available, <No selection made> and 

<No frequencies>.  Use the <No selection made> option when 

no changes to the current frequency setting for the POINTs are 
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needed.  Use the <No frequencies> option to clear all frequency 

settings for all selected POINTs. 

 Click OK to assign the selected set to the current POINT. 

Band Tab 

Band Alarms provide alert and danger alarms on both peak and spectral values within a 

defined frequency band.  Use the Band tab to Add new band alarms for the active 

POINTs, or Load existing “shared” band alarms for the POINTs.   

 Loaded band alarms may not be edited from this tab.  Use the 

Customize menu’s  Alarm Hierarchy option to edit “shared” 

alarm parameters. 

The current band alarm name appears in the Band alarms field.  All available band 

alarms are listed in the drop down list.   

To Load “shared” alarms to the selected POINTs: 

 Click the Band tab’s Load button, the Load Band Alarms dialog displays all 

available shared band alarms by name.  Enable all band alarms to assign to the 

POINT and click OK.  The names of the enabled band alarms appear in the Band 

tab’s Band Alarms drop down list. 

To Add a new band alarm for the POINTs. 

 You may mix added band alarms with loaded band alarms.  

However, only added band alarms may be edited from this tab. 

 Click the Band tab’s Add button, the tab’s Band Information fields become available. 

Edit and view alarm values in the tab's Band information area.  The band name 

appears in the Label field. 

The following fields are available for viewing set values or editing: 

Label – Enter band name. 

Low freq – View or edit the low frequency value or multiple of running speed. 

High freq – View or edit the high frequency value or multiple of running speed. 

 In Low and High Frequency fields, you may specify a multiple of 

running speed by adding x to the end of the number.  For 

example, enter “1.5x” for 1.5 times running speed. 

Peak danger – View or edit the peak danger value or % Full Scale value. 

Peak alert – View or edit the peak alert danger value or % Full Scale value. 

Overall danger – View or edit the overall danger value or % Full Scale value. 

Overall alert – View or edit the overall alert value or % Full Scale value. 

 In Peak and Overall alarm fields, you may specify the alarm 

setpoint as a percentage of full scale by adding “%” to the end of 

the entered number.  For example, enter “10%” to set the alarm 

at 10 percent of the full scale value.   
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 The tab's spectrum graphic display automatically updates as edits 

are made. 

Edits may also be made on the tab's spectrum graphic display.   

To edit the band graphically: 

Spectrum source - If two or more POINTs are currently active, specify the POINT 

whose spectrum you wish to graphically display. 

Spectrum - using its time record, specify the spectrum measurement to display.  

Once the proper spectrum is displayed, specify the band alarm to edit from the Band 

Alarms drop down list.  Notice the mouse pointer changes when positioned over a band 

alarm parameter (line) on the graphic.   

 Click on the line of the band to edit and drag the line to its new position.  The value 

in the affected field automatically updates to reflect your setting. 

 Use the Save or Undo buttons to save or undo changes for the current band alarm 

edit.  After editing all necessary band alarms, use the tab’s OK or Cancel buttons to 

save all edited band alarms with the POINT, or cancel all edited and new band 

alarm efforts. 

The total number of band alarms appears in the upper right corner of the tab’s Band 

information area.  Use the up and down arrow buttons to navigate between band 

alarms. 

 Click the Show all bands checkbox to display all available band alarms on the 

spectrum display.  The checkbox is not available when editing a band. 

 Click Share As to make the current band alarm a shared alarm.  You will be 

prompted to assign the band alarm a unique name.  Enter a name and click OK. 

 Click Add to create a new band alarm. 

 Click Remove to remove the current band alarm.  A confirmation dialog displays. 

 Confirm action.  The band alarm is deleted. 

 A band alarm may not be removed if it is currently assigned. 

Load Band Alarms 

Use the Load Band Alarms dialog to select shared band alarm(s) for the active POINTs.  

All available shared band alarms display.   

 Click the checkbox to select alarm(s) to be included / assigned to the active POINTs. 

 Click OK to select, or Cancel to close dialog without saving selections. 

 You may sort the available shared alarms by band alarm name, 

inclusion status (included or excluded), or frequency range. 
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Envelope Tab 

Use the POINT Properties' Envelope tab to specify a "total spectrum" envelope alarm for 

the POINT.  You can select from a list of previously created envelope alarms or edit a 

private (unique) alarm for the current POINT. 

All available envelope alarms display in the Envelope alarm drop down list, or you may 

Generate a new envelope alarm.   

Shared envelope alarms may not be edited from this tab (use the Customize menu’s 

Alarm Hierarchy option to edit "shared" alarm parameters). 

 First, select the FFT spectrum to which the envelope alarm will conform, using: 

Spectrum source – specifies from which POINT to  graphically display the spectrum if 

two or more POINTs are currently active. 

Spectrum – displays all available time record measurements for the active POINT 

(typically the baseline measurement) in a drop down list.  The current spectrum displays 

graphically below. 

To assign a "shared" envelope alarm to the POINT: 

 On the Envelope tab, select the desired shared envelope alarm’s name from the 

Envelope Alarms drop down list, the tab fields display the specified alarm’s settings 

and the specified envelope appears on the displayed spectrum. 

To Generate a new envelope alarm for the POINT: 

 Select the Envelope Alarms drop down list’s  <Custom envelope> option. 

 Click the Generate button.  The Generate Envelope Alarm dialog displays. 

Use the Generate Envelope Alarm dialog to create an envelope alarm based on your 

entered values. 

% Overdrive – Enter the percent of the POINT’s full scale value to determine the height 

of the envelope alarm above the spectral peak.  The smaller the number specified, the 

tighter the comparison envelope conforms to the designated spectrum. 

Spreading %– Enter percent of full scale (or center frequency) to increase the width of 

the envelope alarm around spectral peaks.  The smaller the number specified, the 

tighter the envelope conforms to the sides of the peaks in the specified spectrum. 

Spreading Type – (either Center Frequency or Full Scale).  If Center Freq. is selected, 

the bandwidth about each center frequency increases with higher frequencies.  If Full 

Scale is selected, the bandwidth about each center frequency is constant, based on a 

percent of the full scale frequency. 

Threshold – Enter % of the POINT’s full scale value, or an absolute value.  The threshold 

value provides an opportunity to eliminate false alarms due to vibration "noise."  It also 

establishes the envelope alarm’s low amplitude "threshold" on the displayed spectrum.  

The envelope alarm conforms around all peaks whose amplitudes are higher than the 

established threshold as per the Overdrive %, Spreading %, and Spreading Type 

settings.  All peaks below the established threshold are ignored by the envelope alarm.  

The Threshold % default value is set using the Customize menu’s Preferences / Plot 

tab. 
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 Click OK to generate an envelope alarm based on your entries.  Click Cancel to 

close the dialog without creating an envelope alarm. 

Editing the Envelope Alarm 

After you have generated an envelope alarm, you can edit it graphically using your 

mouse, or enter numeric envelope parameters using the Set Frequency Range dialog. 

To graphically edit the envelope alarm: 

 Click anywhere inside the Envelope tab’s spectrum window.  The cursor appears as 

an up arrow.   

 Click the mouse on the portion of the envelope alarm line to be edited.  A square 

icon identifies where the line will be drawn. 

 Drag the mouse to draw the line to create the new envelope alarm.   

 Click the tab’s OK button to save your changes. 

Tip -  You can use your keyboard’s Insert key to begin drawing the envelope alarm line.  

Then, use the arrow keys to move the line, and the Insert key again to stop drawing the 

line.  Refer to Section 1 - Appendix B - SKF @ptitude Analyst Keyboard Support for 

more information on using your keyboard to edit your envelope alarm. 

To edit the envelope alarm using numeric frequency ranges: 

 Click the Set Range button.  The Set Frequency Range dialog displays. 

 Use the Set Frequency Range dialog to enter low frequency, high frequency, and 

level values to edit an existing envelope alarm. 

To numerically edit an envelope alarm: 

 Enter the desired low frequency, high frequency, and level value. 

Click OK.  The displayed envelope alarm automatically conforms to your entries. 

Setup Log 

The POINT Properties’ Setup Log tab records changes made to the POINT’s 

configuration.   

POINT Properties / Setup Log fields include:  

Date/Time – Displays the date/time stamp when the change occurred. 

User – Displays the user’s name that made the change. 

Category – Displays the POINT properties tab to which changes were made. 

Previous Value – Displays the previous value before the current change occurred. 

Reason – Displays the user entered reason for making a change to the POINT’s 

configuration.  If no reason is required or entered, this column is empty.   

 When you make a change to a POINT’s properties, you are 

requested to enter a reason for the change.  Reference Chapter 2 

- Setting Your @ptitude Analyst Preferences in the SKF 
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@ptitude Analyst Introduction and Global Features user 

manual for details. 

Save As – Click to save a copy of the log file to your computer’s hard drive.   

Print – Click to print a copy of the log file. 

Modify by Attribute 

@ptitude Analyst’s Modify by Attribute feature allows you to make similar changes for 

one or more machines or POINTs by allowing you to change specific attributes (for 

example, alarm values, collection schedules, etc.) all at once. 

 POINT setup changes made in Modify by Attribute are not 

incorporated into POINT Properties. 

 

 

Figure 2 - 48. 

The Modify by Attribute screen. 
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To Modify Settings: 

 Select the hierarchy group (SET / Machine) that contains POINTs whose attributes 

you wish to modify. 

 All Groups and POINTs branching from the specified Group display 

in the Modify by Attribute screen.   

 Select the Edit menu’s Attributes option.  The Modify by Attribute screen 

displays. 

The Modify by Attribute screen is split into two panels: 

Right panel - displays the selected hierarchy items and their value for the 

currently selected attribute in the left panel. 

 Click to highlight the POINT for which you wish to modify the selected 

attribute.  Its current setting / value displays in an area beneath the 

panels. 

Left panel - displays the attributes available for modification organized into 

eight categories: Alarm Settings, Derived Settings, FFT Settings, General 

Settings, Messages Settings, Misc. Settings, Multi-Channel Settings, and 

Orbit/SCL Settings. 

 If you have in the full version of @ptitude Analyst (CMSW 7400), 

you will also have an On-line Settings option. 

 Open the appropriate category’s folder to view its attributes, then click to specify 

the attribute you wish to modify.  The right panel updates to show the selected 

attribute’s current setting for each item. 

 Edit the setting. 

 Click the Set button to update the attribute setting for the selected POINT only, or 

click the Set All button to update the attribute setting for all POINTs in the right 

panel.  

 Use the Set All feature to quickly modify an attribute value for 

multiple items simultaneously.  For example, if you want to set all 

Averages to an identical value, select Averages from the 

Attributes list.  Attribute values display for all items in the tab's 

Attribute values area.  Select an individual item, enter the 

desired value, and click the Set All button.  All items will now have 

the specified number of averages. 

 After completing attribute modifications for all POINTs, click the OK button to save 

the settings in the hierarchy. 
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Measurement Properties 

General Tab 

The Measurement Properties screen displays properties for individual measurement 

data records.   

To view / edit a measurement’s properties: 

 Select the measurement record.  

 Select the Edit menu’s Properties option, or use the Properties toolbar button.  

The Measurement Properties screen displays.  

The current measurement’s time and date appears in the Date and Time fields of the 

Measurement Properties / General tab.   

Measurement Properties fields include: 

Date - View or edit the measurement record’s data collection date.  Select a new date 

from the drop down list.   

Time - View or edit the measurement record’s data collection time.   Use the arrows to 

adjust the time. 

 This feature should only be used to edit an incorrect date or time. 

Overall / Channel # - View or edit the measurement record’s overall value.  Values are 

displayed for Channel 1, Channel 2, and/or Channel 3 as applicable.  

 

Figure 2 - 49. 

The Measurement Properties Screen’s General Tab's Overall Area. 

 This feature should only be used to edit an incorrect overall value.  

 If necessary, the measurement’s alarm status will automatically 

update for the new measurement value.   

Exclude measurement - Enables / disables the measurement record for inclusion in 

statistical calculations. 

Readings - Displays which readings correspond to the current measurement on the 

indicated date / time.  

Alarm status will be automatically updated for the new current measurement, if 

necessary.   

The overall value for the current Process measurement's indicated date / time appears 

in the tab’s Overall area.  Values are displayed for Channel 1 and/or Channel 2 as 
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applicable.  These values may be edited in the General tab.  Enter a new value in the 

appropriate channel’s text box. 

 This feature should only be used to edit an incorrect overall value.  

The tab’s Readings area displays which readings correspond to the current 

measurement on the indicated date / time. 

 Click the Exclude measurement checkbox to exclude the current measurement 

from being included in statistical calculations. 

 After editing all necessary properties, click the OK button to save changes. 

 Click Cancel to close the screen without saving changes. 

Set Baseline 

Use the Edit menu's Set Baseline dialog to specify the selected POINT's (or multiple 

POINTs') baseline.  This feature allows you to quickly reset baselines within a hierarchy 

after a change is made to the machinery. 

 In the hierarchy list, select one or more POINTs (or a hierarchy branch) whose 

baseline you wish to set as the oldest measurement record or the newest 

measurement record, or to clear the baseline altogether. 

 Select the Edit menu’s Set Baseline option. 

 Using the dialog's option buttons, specify whether to use the Oldest measurement 

or Newest measurement record as the baseline for the selected POINT(s), or 

select Clear baseline to remove the current baseline for the selected POINT(s). 

 A baseline spectrum is a vibration spectrum taken when a 

machine is in good operating condition.  It is used as a reference 

for monitoring and analysis.   

 Click OK to save setting. 

 Click Cancel to undo. 

Set Speed (Multiple) 

Use the Set Speed (Multiple) feature to set the same measurement speed for multiple 

FFT measurements: 

 Starting from a hierarchy, ROUTE, or workspace, expand the appropriate machine. 

Beneath the machine in the hierarchy, right-click on the measurement POINT you 

wish to use as a reference and select Set Speed (Multiple) from the resulting 

context menu. 

OR 

 Starting from a hierarchy, ROUTE, or workspace, expand the appropriate machine. 

Beneath the machine in the hierarchy, click on the appropriate measurement 

POINT to display its measurements in the right panel. Then, right-click on the 



Working With Your SKF @ptitude Analyst Hierarchy 

Set Speed (Multiple) 

SKF @ptitude Analyst for SKF Microlog Analyzer  2 - 99 

User Manual 

single measurement you wish to use as a reference and select Set Speed 

(Multiple) from the resulting context menu. 

OR 

 Starting from an FFT measurement plot, right-click on the single cursor and select 

Set Speed (Multiple) from the resulting context menu. 

 

           

Figure 2 - 50. 

Selecting Set Speed (Multiple) from a POINT Versus from a Measurement within a Hierarchy. 

 

 

Figure 2 - 51. 

Selecting Set Speed (Multiple) from an FFT Measurement Plot. 
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The Set Speed (Multiple) window appears. 

 

Figure 2 - 52. 

Set Speed (Multiple) Window. 

 Expand the machine in the Set Speed (Multiple) window’s hierarchy view and 

deselect (remove checks from) any POINTs for which you do NOT intend to set a 

measurement speed value. By default, all POINTs are selected (checked) for 

adjustment. 

 Specify the range of measurements for which you intend to set a measurement 

speed value: 

Last measurement – Select to work only with the last measurement collected 

for each selected POINT. 

Measurements + / - … minutes – Select, then specify x number of minutes to 

work only with measurements collected within the range starting x minutes 

prior to and ending x minutes following the basis date and time. 

 If you selected a POINT as the reference (launched this window 

from a POINT), the basis date and time are equal to the date/time 

stamp of the POINT’s last measurement. If you selected a single 

measurement as the reference (launched this window from a 

single measurement or from an FFT plot), the basis date and time 

are equal to the date/time stamp of that measurement. 

 The system will remember the specified number of minutes when 

you launch this dialog again. 

Measurements… From… To… - Select, then specify starting and ending dates 

and times to work only with measurements collected within that range. 

 By default, this range starts x minutes prior to and ends x 

minutes following the basis date and time, based on the current 

Measurements + / - … minutes setting. 
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 Select, then enter an MPA Tag value to work only with measurements that contain 

that value in their Description (Point Properties > General tab). 

 Click Next>>. The Set Speed (Multiple) Measurement List window appears, 

displaying a list of all measurements for the applicable POINTs that meet the 

criteria established. 

 

The Set Speed (Multiple) Measurement List window displays a list of all 

measurements for the applicable POINTs that meet the criteria established in the Set 

Speed (Multiple) window. 

 

Figure 2 - 53. 

Set Speed (Multiple) Measurement List Window. 

 From the measurement list, select (check) each measurement to which you intend 

to apply the reference POINT’s measurement speed. 

 Select (check) the checkbox in the list header to select all 

measurements. 

 To change the criteria established in the previous window that 

determine the measurements in this list, click <<Back. 

 Click on any column header to sort the list according to that 

column. 

 Verify and/or enter Set Speed values. 

Current Frequency – The speed value from the reference POINT 

measurement. 

 If you initially selected a POINT as the reference, this speed value 

comes from the POINT’s last measurement. If you initially 

selected a single measurement as the reference, this speed value 

comes from that measurement. If you launched this function from 
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an FFT plot, this speed value is the frequency value of the single 

cursor on that FFT plot. 

Equivalent to order – If the speed value entered is at a known harmonic, then 

you can use this value to factor the Calculated running speed to its 1x 

component. 

Calculated running speed – Enter the speed value you wish to apply to all 

selected (checked) measurements. 

 Click Finish. The system applies the Calculated running speed and Equivalent to 

order values to all measurements selected (checked) in this list. 

Calculate Derived POINTs 

You must manually calculate derived POINTs upon the initial creation of a derived 

POINT, or after editing a derived POINT’s expression settings.  Once the initial 

calculation has been performed manually, @ptitude Analyst automatically calculates the 

derived POINT during data upload processing.   

 Upon the initial creation of a derived POINT, if the assigned 

variables do not have existing measurement data, it is not 

necessary to manually calculate the derived POINT.  It is 

necessary to manually calculate a derived POINT only when the 

assigned variables already have measurement data. 

To manually calculate a derived POINT: 

 Select the newly created or recently edited derived POINT from the Hierarchy. 

 Select the Edit menu's Calculate Derived POINTs option to quickly calculate 

measurement values for the derived POINT. 

 The Calculate Derived POINTs message dialog displays.  Select Yes to calculate 

the selected derived POINT. 

 If calculating a newly created derived POINT, new measurement 

data displays in the Hierarchy’s right panel.  Existing 

measurement data for the assigned variables is used in the 

calculation to create measurement data records for the derived 

POINT.   

 If calculating a recently edited derived POINT, all existing derived 

POINT measurement values previously calculated for the selected 

derived POINT(s) are deleted and replaced with new derived 

POINT measurements. 

 

Figure 2 - 54. 

The Edit menu’s Calculate Derived POINTs Message Dialog. 
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After manual calculation of a derived POINT, @ptitude Analyst automatically calculates 

any newly uploaded data for the derived POINT during data upload processing.  The 

newly calculated data displays along with the existing derived POINT data measurement 

records in the right panel. 

 For a multi-user environment, Machine Monitor calculates the 

new data for derived POINTs.  If Machine Monitor is not running, 

then the derived POINTs will not be calculated.  

Manual Archive 

@ptitude Analyst’s Manual Archive feature adds flexibility as it allows you to specify 

POINTs to archive, and allows you to archive the newest data in addition to the oldest 

data. 

The Manual Archive process differs from a Scheduled or Monitor archive process in 

several ways.   

Manual Archive: 

 Takes place immediately.   

 Archives only POINTs branching from the selected hierarchy item (or specified 

measurement records). 

 Only archives measurements from the “current data” bin (unless a specific 

measurement record from another bin is specified). 

 Allows you to specify whether to archive each selected POINT’s Oldest or Newest 

measurement record from the current data bin. 

 Allows you to specify the archive bin in which to place the archived measurements. 

Use Manual Archive to change the archive status for any or all hierarchy items.  

Manual Archive is useful to manually set a measurement’s archive status, bypassing 

automatic archive schedule (if applicable). 

To use manual archive: 

 In the hierarchy list, select a hierarchy item(s) whose measurements you wish to 

manually archive.  All POINTs branching from the selected item are archived. 

 Select the File menu’s Manual Archive option.  The Manual Archive dialog 

displays. 

The dialog’s top area displays a warning if the selected data is tagged as baseline.  

Baseline data cannot be modified. 

Change archive status in the dialog’s Store measurements as area.  Select from: 

Current data bin (available only when archiving a measurement record from 

other bins) 

Unscheduled data bin 

Short term archive data bin 

Long term archive data bin 
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The dialog’s bottom area displays Archive measurements.  If working from a POINT or 

above on the hierarchy branch, select from: 

Oldest Measurement – Each selected POINT’s oldest measurement in the current data 

bin. 

Newest Measurement – Each selected POINT’s newest measurement in the current 

data bin. 

 Manual Archive does not utilize “scheduled” archive settings 

@ptitude Analyst Scheduler 

Current Scheduled Events 

The Scheduler feature allows you to configure the software to perform scheduled 

functions based on specific conditions.  A scheduled event consists of a system event 

and an action to be executed whenever that event occurs. For example, you can use 

Scheduler to configure the software to display a message when a specific operation 

completes (action) when a DAD has completed processing (system event). 

 Select the Customize menu’s Scheduler option.  The Scheduler dialog displays. 

The Scheduler dialog displays all current scheduled events and the action assigned to 

each event.  Use the Scheduler dialog to add new events and maintain existing events. 

To add an event:  

 Click the Add button to define an event.  The Event Scheduler Wizard launches 

automatically. 

You can also add an event by copying an existing event, then modifying the copy as 

necessary. 

To copy an event:  

 Highlight the event you would like to copy and click Copy.  The Event Scheduler 

Wizard launches.  As you navigate the wizard, options default to the settings from 

the copied event.  You may modify the settings as necessary. 

To edit an event:  

 Highlight the event you would like to modify and click Edit.  The Event Scheduler 

Wizard launches with the settings from the event you are editing.   

 Navigate the wizard to the settings you wish to modify and edit the event as 

necessary. 

To remove an event:  

 Click the Remove button to delete a scheduler entry. 

 Scheduled entries remain in effect until they are removed. 
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Event Scheduler Wizard 

A scheduled event consists of a system event and an action to be executed whenever 

that event occurs.   

The Event Scheduler Wizard guides you through the process of scheduling events. 

 Click the Next button to continue. 

 Select the event you want the system to monitor and that will cause the scheduled 

action to be performed.  All available events appear in the Select an event window.   

 

Figure 2 - 55. 

The Event Scheduler Wizard. 

Some events require specific settings that further define the event.  When settings are 

required, the Settings button is enabled.  You must specify the required Settings 

before the Next button is enabled. 

 Complete all Settings entries, if required. 

 Click the Next button. 

 Individual events are detailed later in this section. 

All available actions display in the Select an action area. 

 Select the action you wish the system to perform when the indicated event occurs 

Some actions require specific settings that further define the action.  When settings are 

required, the Settings button is enabled.  You must specify the required Settings 

before the Next button is enabled. 

 Complete all Settings entries, if required. 
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 Click the Next button. 

 Individual actions are detailed later in this section. 

By default, scheduled events only execute if the user who created the event performs 

the triggering action.  (For example, a report set to run on @ptitude Analyst startup only 

runs when the user who created the event logs in.)   

If the user creating the scheduled event is an administrator, an additional dialog displays 

providing the option of assigning the event to another user, or delegating it to the 

Transaction Server.  

The Select Users list shows all @ptitude Analyst users.   

 Select the user who should trigger this event. 

 Events scheduled to trigger at a specified time only occur if the 

user with whom the event is associated is logged into @ptitude 

Analyst.  This applies to both users who are assigned an event by 

an administrator and non-administrator users who create an 

event for themselves.  For example, if the event is scheduled for 

three a.m., the specified action will not be performed if the 

designated user is shut down at three a.m., and it will not be 

automatically performed when the program is restarted.  

Alternatively, if you have selected to generate a report with this scheduled event, 

Delegate to Transaction Server enables.  The transaction server is a process that 

stays running in the background at all times.  If your triggering event is on Microlog 

upload, this option allows you to have the transaction server generate the report 

whenever any user uploads Microlog data.  If your triggering event is a specified time, 

the report runs at that time, regardless of whether the associated user is logged in.  

 The report is generated to a file in the path specified in the 

Report Location field on the Report Generator’s Assign tab.  If 

the Delegate to Transaction Server option is selected and the 

report location path references a local hard drive, the report is 

written to the Transaction Server host computer.  It is 

recommended that you set the report location to a network drive 

and make sure the Transaction Server has read / write access to 

that location. 

 Enable Delegate to Transaction Server to have the transaction server generate 

the report, rather than a specified user. 

 Click the Next button. 

The Event Scheduler Wizard displays a summary of the new scheduled event settings. 

 Click the Finish button to save the scheduled event. 

 Click the Back button to modify the scheduled event. 

 Click the Cancel button to cancel the wizard dialog. 
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Scheduler Events 

Analyst startup 

This event is the application’s start up.  Performs an action as soon as the application 

completes its startup process. 

Alarm condition 

This event is used to schedule an action to be performed when specific alarms occur. 

 Click the Settings button to specify the data source, alarm condition, and alarm 

type for which this event should occur.  The Alarm Condition Settings dialog 

displays. 

Data source –Select the Hierarchies, SETs, Machines, POINTs, ROUTEs, and / or 

Workspaces to monitor for alarm conditions. 

Alarm Conditions –Select the alarm condition (In alert, In danger, or Both) to monitor. 

Alarm Type – Select one or more alarm types to monitor. 

 Click OK to save settings. 

 Click Cancel to discard settings. 

At specified time 

Schedules a task to be performed at a specific time.   

 Click the Settings button to specify the time that this event should occur.  The 

Time Event Settings dialog appears. 

Start Date - Select the date on which the scheduled event should run for the first time. 

Start Time – Select the time at which the scheduled event should run for the first time. 

Specify the interval for the event.  Options are: 

Hourly – Select to run the event Every X hour(s).  Enter the hourly time 

increment in the field (e.g., every 8 hours). 

Daily - Select to run the event Every X day(s).  Enter the number of days in 

the field (e.g., every 3 days). 

Weekly – Select to run the event Every X week(s).  Enter the number of weeks 

in the field, and enable the check box(es) for the day(s) of the week on which 

the event should run. (e.g., Every 2 weeks on Monday and Wednesday) 

Monthly – Select to run the event on a monthly basis.  Select the day of the 

month (1-31) and the frequency of the event in month(s) (e.g., Day 15 of every 

2 month(s)); or select a day of the week and the 1st, 2nd, 3rd, 4th, or last week 

of the month, and the frequency of the event in month(s). (e.g., The 2nd Friday 

of every 1 month(s)) 

Yearly – Select to run the event on a yearly basis.  Select the month / day and 

the frequency of the event in year(s). (e.g., January 1st  of every 1 year(s)); or 

select a day of the week, the 1st, 2nd, 3rd, 4th, or last week of the month, the 

month, and the frequency of the event in year(s). (e.g., The 2nd Friday of 

January every 2 year(s)) 
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 Click OK to save settings. 

 Click Cancel to discard settings. 

Microlog Upload Complete 

Performs an action when a Microlog upload completes (as soon as the data has been 

processed into the hierarchy). 

 The Scheduler feature is user specific and may only be applied to 

data uploaded by the current user. 

 Click the Settings button to filter the event based on the ROUTE being uploaded.  

The Upload Schedule Settings dialog appears. 

This dialog allows you to specify that the action should only occur if the data being 

uploaded from the Microlog belongs to a specific ROUTE.   

All Uploads – Leave this option enabled if you do not wish to filter on data source. 

ROUTE – Select this option if you only want the action to run when incoming data is 

from specified ROUTEs.  Enable the check boxes next to the ROUTEs that should trigger 

the action.  If data is uploaded from a ROUTE that is not selected, the event will not run. 

Scheduler Actions 

Display a message 

Select the “display message” action to display your specified message text when the 

associated event occurs.   

 Click the Settings button to enter your message text. 

The Display Message Action Settings dialog appears. 

 Type in the desired text. 

 Click the OK button to save. 

 Click the Cancel button to discard changes. 

Generate Report 

Select the Generate Report action to generate a specified report type when the 

associated event occurs. 

To select report type: 

 Select Generate Report from the dialog’s Select an action area. 

 Click the Settings button.  The Generate Report dialog appears. 

Generate Report Settings 

Description – Enter descriptive text to identify this report in the Scheduler. 

Report – Select the desired report type from the drop down list. 

Data Source – Select the data source for the report.  This section varies, 

depending on whether the Report can specify data sources from multiple 

hierarchies option was enabled on the Report Editor’s General tab for the 

selected report. 
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If Report can specify data sources from multiple hierarchies was enabled, 

all of your @ptitude Analyst hierarchies display.  Select multiple hierarchies, 

groups, and POINTs to include in your report. 

If Report can specify data sources from multiple hierarchies was not 

enabled, available options include: 

Primary Hierarchy – Use the POINTs from the currently selected primary 

hierarchy as the report’s source. 

Last Upload – Use the POINTs last uploaded from the data collector as the 

report’s source. 

ROUTEs (all available) – Enable the check box next to each ROUTE you 

would like to include. 

Workspaces (all available) – Enable the check box next to each Workspace 

you would like to include. 

 If the Data Source is a Filtered Workspace, the Workspace will not be 

filtered again before report generation.  The report is based on the 

Workspace in its current state. 

Destination – Select the desired report destination from the drop down list.  

Available options include: 

Email – Automatically sends an email of the report in HTML and PDF 

format to selected email recipients.  Click the Select button to display the 

Recipient Selection dialog and select one or more contacts or groups of 

contacts.  

HTML – Save to the subdirectory as an HTML file. 

Open Window – Window opens automatically, displaying the report. 

Printer / Landscape – Automatically prints in landscape mode. 

Printer / Portrait – Automatically prints in portrait mode. 

 The Destination selection is not used if the report is delegated to 

the Transaction Server.  In this case, the report is always 

generated to HTML. 

 Click OK to save report settings. 

 Refer to the SKF @ptitude Analyst Introduction and Global 

Features User Manual, Chapter 2, Getting Around in @ptitude 

Analyst / Contact Information section for details on how to set 

up contacts and groups. 

Measurement Management / Archive 

Select the Measurement Management / Archive action to schedule the 

Monitor application to perform measurement management and archiving.  

This action checks the measurements in the current hierarchy, and either 

archives old data to the short term or long term status, or deletes old data 

from the hierarchy.  This action is performed on measurements in the current 

hierarchy only.  Refer to your SKF @ptitude Analyst Introduction and Global 

Features User Manual, Chapter 3 - SKF Machine Monitor Application for 

more information on the Monitor’s functions, including archiving data. 
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Send Message 

Select the Send message action to send an email or text message to selected recipients 

when the associated event occurs. 

 Click the Settings button to configure your message settings. 

The Send Message Settings dialog appears. 

 In the Subject text box, type the subject of the event’s email message. 

 In the Message text area, type the event’s message to be sent as email and/or text 

messages. 

 Text messages are often limited to a maximum number of 

characters.  Check with the recipient’s service provider to 

understand text message limitations. 

 Click the Select button to display the Recipient Selection dialog and select one or 

more recipients from the list of available contacts and groups. 

 Refer to the SKF @ptitude Analyst Introduction and Global 

Features User Manual, Chapter 2, Getting Around in @ptitude 

Analyst / Contact Information section for details on how to set 

up contacts and groups. 

 If you wish to include an HTML file with your email message, use the Browse 

button next to the HTML content text box and select an HTML file to include. 

 HTML content is not supported by text messaging. 

 If you wish to include any other type of attachment with your email message, select 

the Browse button next to the Attachments text box to select the file you wish to 

include. 

 Attachments are not supported by text messaging. 

 Enable the Allow content from triggering event check box to allow the default 

alarm message to override the Message text message when a triggering event 

occurs. 

 Enable the Send email check box to send the message to the selected recipients as 

an email. 

 Enable the Send text to phone check box to send the message to the selected 

recipients as a text message. 

 Texting limitations depend on the recipient’s service provider. 

 Click the OK button to save the message settings. 

 Click the Cancel button to discard changes. 
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Customize / Database Operations 

The Database screen allows you to create custom group types and to define filter keys, 

coded notes, and operator names.  

Creating Custom Group Types 

Use the powerful Customize  / Database screen’s Group Types tab to create custom 

Group Types to conveniently organize your machines, SETs, and POINTs to fit your 

application. 

To create a custom Group Type: 

 Select the Customize menu’s Database option.  The Database screen displays. 

 Select the Group Types tab. 

 

Figure 2 - 56. 

The Database Screen’s Group Types Tab. 
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 Click the Group Types tab’s Add button.  The tab enters edit mode. 

 Specify appropriate information into the following fields: 

Group Type – This field is unavailable if you are adding a new Group Type.  In the 

Group type properties area, the following fields are available: 

Name – Specify a name to define your custom group type.  For example, you may want 

to create a custom Group type named “pumps,” for easy organization of all pump 

machinery. 

Base on – Select a type to base the new group type on (SET or Machine). 

 Once a Group Type has been “based on” a SET or Machine, the 

setting cannot be edited. 

Once defined, the new Group Type will be available as a selection in the Group 

Properties screen’s Type list. 

Optional data - Provides up to five fields to enter titles for additional data.  Text 

entered in these fields appears as prompts for data entry when new Groups are 

created.  This feature allows you to store detailed information with your Groups. 

 Specify prompt titles that will appear in the Group Properties / Details tab. 

 Examples are “serial number,” “manufacturer,” “operator name,” 

etc. 

 Click the Save button to save the new Group Type and add it to the available types. 

 Click the Undo button to undo changes. 

 Click Remove to remove the current Group Type. 

 Group types currently in use cannot be removed. 

Creating Filter Keys 

Custom filter keys can be assigned to POINTs and/or Machines or SETs.  

To add a new filter key: 

 Select the Customize menu’s Database option.  The Database screen displays. 

 Select the Filter Keys tab. 



Working With Your SKF @ptitude Analyst Hierarchy 

Customize / Database Operations 

SKF @ptitude Analyst for SKF Microlog Analyzer  2 - 113 

User Manual 

 

Figure 2 - 57. 

The Database Screen’s Filter Key Tab. 

 Click the tab’s Add button.  The dialog enters edit mode. 

Fields include: 

Filter keys – Displays all previously defined filter keys. 

Name – Specify filter key text. 

 Click the Save button.  The new filter key is now available for assignment. 
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Coded Notes 

Coded notes are notes created and stored in @ptitude Analyst and automatically 

transferred from the software to the DAD.  Create coded notes in the Customize / 

Database screen’s Coded Notes tab. 

All previously defined coded notes appear in the tab’s Coded notes area.   

To add a new coded note: 

 Click the Add button. 

Fields include: 

Coded notes – Displays all previously defined coded notes. 

Note - Enter coded note text. 

 Enter your descriptive text in the Note field and click the Save button. 

 To cancel settings, click the Undo button. 

To remove an existing coded note: 

 Select the coded note from the Notes area. 

 Click the Remove button. 

 The coded note, “Machine Not Operating,” may not be removed. 

 If the listing order of the coded notes has changed, you must 

download the coded notes to all DADs to ensure synchronization. 

Compliance 

Compliance schedules enable you to schedule data collection into a manageable 

workflow, by allowing you to define a calendar-based data collection time period to 

specify when a POINT must be collected.  The compliance schedule allows data 

collection any time within the set time period.  

For example, if we schedule data collection for 100 POINTs starting at 01-Dec-2011 at 

6 AM, with a weekly interval.  If all 100 POINTs are collected within the time interval, 

then the POINTs are “in compliance.”  POINTs that are not collected within the specified 

time period are marked as “out of compliance.” 

Use the Customize / Database screen’s Compliance tab to define, edit, and delete 

compliance schedules. 

All previously defined compliance schedules appear in the Compliance drop down list.  

To edit an existing compliance schedule, select a schedule from the Compliance drop 

down list and make necessary changes to the fields below. 

To add a compliance schedule:  

 Click Add to create a new compliance schedule. 

 In the Properties area, edit the Name, Start from, and Data due every fields to 

customize the compliance schedule. 

Name – Enter a descriptive name for the compliance schedule. 
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Start from – Enter the date and time of day the data collection interval is to 

begin. 

Data due every – Enter a numerical value to indicate how often data should 

be collected and select the appropriate units from list box options (Hours(s), 

Day(s), Week(s), Month(s), or Years(s)).   

Operators 

Some DADs support operator names to tag measurement data with the corresponding 

operator’s name.  You can also create operator sets that group several operators 

together, making it easier to identify several operators in an associated group.  Operator 

names are downloaded to the DAD.   

Operator names are automatically downloaded to the DAD. 

 When collecting data, the data collection person logs in using their 

operator name. 

Manage operator names and sets in the Customize / Database screen’s Operator tab.  

Add or remove Operator names in the Customize / Database screen’s Operator tab. 
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Figure 2 - 58. 

The Database Screen’s Operators Tab in View by Operator Mode. 

The Operators tab has two modes: 

View by operator – Select this mode to manage operators organized by 

operator name. 

View by set – Select this mode to manage operators organized by operator 

set. 

View by Operator Mode 

In View by operator mode, all available operator names display in the Operators drop 

down list.  In this mode, you can add or remove operators, and organize your operators 

into sets.  For example, you can add operators to an "early shift" operator set. 

To add a new operator: 

All previously defined operator names appear in the tab’s Operator Names area.   
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To add a new operator name: 

 Click the Add button. 

Fields include: 

Operators - Displays all previously defined operator names. 

Name - Enter the new operator name. 

 Enter the new operator name in the Name field and click the Save button. 

To add an operator to a set: 

All previously created sets display in the Available sets area.  The Included sets area 

displays sets to which the selected operator name is already assigned. 

 Select the operator name from the drop down list. 

 Select the desired set from the Available sets area. 

 Click the Include button to include the selected operator name with the selected 

set.  Click the Include All button to include the selected operator in all available 

sets.   

 Click the Save button. 

 To cancel settings, click the Undo button. 

To remove an existing operator name: 

 Select the operator name from the Operator Names window. 

 Click the Remove button. 

View by Set Mode 

In View by set mode, all previously created operator sets display in the Operator sets 

drop down list.  In this mode, you can add or remove sets, and organize your operators 

into sets.  For example, you can create an operator set for the early shift, and include 

appropriate operators into the set. 

To create a new operator set: 

 Select New Set from the drop down list. 

 Enter the new set's name in the Set name field and click the Save button. 

All available operators display in the Available operators area.  All operators already 

included in the set display in the Included Operators area. 

 Use the Include, Include All, Exclude, and Exclude All buttons to organize 

operators into the appropriate sets. 

 Click the Save button to save you changes. 
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Messages 

Use the Customize / Database screen’s Messages tab to create shared (public) 

instruction messages to assign to machines and POINTs to automatically display 

important instructions and information.   

All previously defined instruction messages appear in the Instruction messages drop 

down list. 

To create a public Message: 

 Select the Customize menu’s Database option.  The Database screen displays. 

 Select the Messages tab. 

 Click the Messages tab’s Add button.  The tab enters edit mode. 

 Specify appropriate information into the following fields: 

Name – Specify a name to define your custom message.   

Format – Select the message format from the drop down list.  Available options 

include: 

Free form – Allows you to manually type in the summary and content for your 

message. 

Summary – Type in text summarizing your instruction message for easy recognition.  

For example, if you have a message that details specifics about a group of machinery, 

your summary may read, "FD Fan Data Collection Information."  

Content – Enter your complete instruction message in the content text area.  Using the 

above example, your instruction message content would include detailed data collection 

information, specific to the current group.  For example, your message may read 

"Ensure sensor is properly mounted before collecting data, etc." 

 Click the Save button to save the new message and add it to the available public 

messages. 

 Click the Undo button to undo changes. 

 Click Remove to remove the current message. 

 Messages currently in use cannot be removed. 
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Frequency Sets 

Frequency Sets allow you to quickly assign fault frequency markers to a POINT.  When 

the POINT’s FFT measurements display in a spectral plot, you may overlay its assigned 

fault frequency markers to easily determine if spectral peaks appear at anticipated fault 

frequencies. 

Select the Customize  menu’s POINT Attributes / Frequency Sets option to display the 

Frequency Sets dialog.   

All shared frequency sets appear in the Frequency sets area.   

Available options include: 

Add – Click to add a new frequency set.  The Frequency Sets Editor screen launches 

automatically. 

Copy – Click to make a copy of an existing shared frequency set.  This option is useful 

when you are creating a new frequency set that is a slight modification of an existing 

frequency set.  The Frequency Sets Editor screen launches automatically. 

Edit – Click to edit an existing frequency set.  The Frequency Sets Editor screen 

launches automatically. 

Remove – Remove the selected frequency set. 

Frequency Sets Editor 

The Frequency Sets Editor screen contains three tabs; General, Bearings, and Other.  

Each tab is detailed below. 
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Figure 2 - 59. 

The Frequency Sets Editor Screen’s General Tab. 

General Tab 

Displays the current frequency set’s name and description.  Included frequencies appear 

with their Name, Type, Multiples, Bandwidth%, and Details. 

Name - Displays current frequency set name. 

Description - Displays current frequency set description. 

Included frequencies - Displays all frequencies included in the current frequency set, 

with their: 

Name – Displays the frequency name. 

Type – Displays the type of frequency. 

Multiples – Displays the multiple of frequency markers to display on the plot. 

Bandwidth % - Displays the frequency range boundaries used by the 

frequency marker to locate a peak. 

Details – Displays fault frequency settings for the bearing’s components. 

 Click on a frequency to select it.   
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Display Adjustments – Allows you to edit the Multiples and Bandwidth% settings for 

the selected frequency.   

 Click OK to save changes. 

 Click Cancel to close dialog without saving changes. 

Bearings Tab 

 

Figure 2 - 60. 

The Frequency Sets Editor Screen’s Bearings Tab. 

The Frequency Sets Editor / Bearings tab allows selection and/or de-selection of 

bearings included in the current set.   

Select manufacturer - Use the drop down list to select the desired bearing 

manufacturer. 

Find bearing - Specify the bearing name and click the Find button.  @ptitude Analyst 

locates bearings matching your entry, and displays them in the Available bearings 

(Model #) window. 

Bearings included in set - Displays bearings currently included in the frequency set. 

Available bearings (Model #) - Displays bearings from the selected manufacturer that 

match the entered criteria. 
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 Use the << Include button to include the selected bearing(s) in the frequency set 

(move selected bearing(s) from the Available bearings (Model)# column to the 

Bearings included in set column). 

 Use the Exclude >> button to exclude the selected bearing(s) from the frequency 

set (move selected bearing(s) from the Bearings included in set column to the 

Available bearings (Model #) column). 

Fundamentals of – Displays the fault frequency settings for the selected bearing’s 

components. 

 Click Add to add bearings to the hierarchy, or Edit to modify an existing bearing.  

The Bearing Editor screen displays in both cases.   

 Click Remove to remove a bearing from the bearing hierarchy. 

Bearing Editor 

 The Bearing Editor screen displays in either “edit” or “add” mode, 

depending on your previous selection in the Frequency Sets 

Editor. 

 

Figure 2 - 61. 

The Bearing Editor Screen. 

The Bearing model # and Manufacturer fields in the screen’s Identity area cannot be 

modified when in “edit” mode. 

Bearing Editor fields include: 
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Identity area - Enter the identification characteristics in the following fields: 

Bearing model #: - Displays the model number.  Cannot be modified in “edit” 

mode. 

Manufacturer: - Displays the bearing’s manufacturer.  Cannot be modified in 

“edit” mode. 

Description - Specify up to 32 characters that identify the new bearing. 

Dimensions - Specify the appropriate values in the following fields: 

Number of balls 

Ball diameter 

Pitch diameter 

Contact angle 

 Click the Calculate button.  @ptitude Analyst automatically calculates and enters 

the Fundamentals values. 

Fundamentals – Manually specify appropriate values in the available fields: 

BPFO: (Ball Pass Freq. Outer race) 

BPFI: (Ball Pass Freq. Inner race) 

BSF: (Ball Spin Freq.) 

FTF: (Fundamental Train Freq. / Cage Freq.) 

 Click OK to save changes. 

 Click Cancel to close screen without saving changes. 
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Other Tab 

 

Figure 2 - 62. 

The Frequency Sets Editor Screen’s Other Tab. 

Use the Frequency Sets Editor / Other tab to select a generic frequency to include in 

the current Frequency Set, or to add, edit, or remove a generic frequency. 

The Other tab displays all included generic frequencies.   

To include a frequency in the current frequency set: 

 Click the frequency's checkbox in the Included generic frequencies area.  The 

checkbox toggles the Included status between Yes and No. 

To add a new frequency: 

 Click the Add button.  A new frequency displays with default settings that may be 

edited. 

To remove a frequency: 

 Select the desired frequency from the Included generic frequencies windows so 

that the frequency information is visible in the Properties area 

 Click the Remove button. 
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 You cannot remove a frequency that is currently used within any 

frequency set.  You must remove all associations with frequency 

sets before you can remove a frequency. 

Properties- Displays the selected frequencies attributes.  You may edit these attributes: 

Name: - The selected frequency's name. 

Frequency type: - The selected frequency’s frequency type.  

Frequency formula: - Specific fields based on the frequency type. 

To edit frequency properties: 

 Enter a descriptive name (up to 32 characters). 

 Select the desired frequency type option from the drop down list. 

Frequency type options include: 

Constant - Constant frequency value.  (Example: 10 Hz) 

Offset - Multiple of running speed and offset (+) by constant frequency 

value.  (Example: 4.00 x RPM + 10 Hz) 

RPM - Multiple of running speed.  (Example: 4.00 x RPM) 

Sideband - Multiple of running speed and offset (+ and -) by constant 

frequency value.  (Example: 4.00 x RPM + / - 10 Hz) 

 Edit the applicable Frequency formula fields. 

 Specific Frequency formula edit options are available according 

to the current frequency type selection.  If enabled, the first field 

is a running speed, or RPM value.  The second field is a fixed 

frequency in Hz or CPM.   

For example, with an RPM multiple frequency type, entering a 4 in the 

first field indicates that the frequency would show up at 4 times the 

running speed. 

 Click the tab's Save button to save changes. 

 Click Undo to undo changes. 

 Click the OK button to close the tab.  You will be prompted to save any unsaved 

changes. 
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Alarm Settings 

Use the Alarm Settings to create alarms that can be assigned to one or more POINTs.  

Created alarms can be re-assigned and edited. 

To access the Alarm Settings screen: 

 Select the Customize menu’s Alarm Attributes / Alarm Settings option.  The 

Alarm Settings screen displays. 

 

Figure 2 - 63. 

The Alarm Settings Screen’s Overall Tab. 
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Alarm Settings - Overall 

Existing alarms may be edited or removed from the hierarchy.  The Overall tab allows 

you to create, edit, or remove shared Overall alarms. 

To create a new alarm: 

 Click the tab's Add button.  The Overall alarms field displays “New Overall Alarm” 

to indicate that you have created a new alarm.   

 In the Name field, assign the new alarm a unique name. 

 Once the editing process begins, the Overall alarms field is no 

longer accessible.  You must complete and Save your edits or 

cancel them by clicking the Undo button. 

 Click Save.  The Overall alarms field now displays the new alarm name you 

specified.   

You can also adjust the alarm’s Properties and Settings in this tab.  The current 

settings graphically display in the tab’s Settings area. 

To edit or create Overall Alarm Properties and Settings: 

Properties – Select the type of Overall Alarm by clicking the desired option button.  

Choose from: 

Level - Measurements exceeding the specified alert and danger Settings will 

result in an alarm condition. 

In Window - Measurements falling within the specified alert low, danger, and 

alert high Settings will result in an alarm condition. 

Out Of Window -  Measurements falling outside the specified danger low, 

alert low, alert high, and danger high Settings will result in an alarm condition. 

Settings – Select the levels you wish to include by clicking each checkbox. 

 The availability of the levels, their checkboxes, and their text fields 

is based on the type of Overall Alarm selected in the Properties 

area.  

 Enter the desired values for each available alarm level. 

 Click the Save button to save your alarm settings. 

To remove an existing alarm from the database: 

 Select the desired alarm from the drop down list.   

 Click the Remove button.  A confirmation dialog displays.   

 Confirm removal.  The selected alarm is permanently removed from the hierarchy. 

 An alarm cannot be removed if it is currently assigned to one or 

more POINT.  A warning dialog displays if you attempt to remove 

a currently assigned alarm. 
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Alarm Settings – Band 

Band Alarms provide alert and danger alarms on both peak and spectral values within a 

defined frequency band.  Use the Band tab to edit and/or specify POINTs’ bands and to 

manage shared band alarms. 

 

Figure 2 - 64. 

The Alarm Settings Screen’s Band Tab. 

Band alarms – Displays the current band alarm.  All available band alarms list in the 

drop down list. 

Band information – Edit and view alarm values. 

The following fields are available for viewing set values or editing: 

Label – Displays the band name. 

Low freq – View or edit the low frequency value or multiple of running speed. 
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High freq – View or edit the high frequency value or multiple of running speed. 

 To make the value a multiple of running speed, add an "x" to the 

end of the entered number.  For example, enter "1.5x" for 1.5 

times running speed. 

Peak danger – View or edit the peak danger value or % Full Scale value. 

Peak alert – View or edit the peak alert danger value or % Full Scale value. 

Overall danger – View or edit the overall danger value or % Full Scale value. 

Overall alert – View or edit the overall alert value or % Full Scale value. 

 To make the value a percentage of the full scale, add a "%" to the 

end of the entered number.  For example, enter "10%" for 10 

percent of the full scale value at the time the band is used. 

 The tab's spectrum graphic display automatically updates as edits 

are made. 

The Spectrum source field displays the source of the spectrum if two or more POINTs 

are currently active. 

The Spectrum field displays all available spectra for the active POINT in a drop down 

list.  The current spectrum displays graphically below. 

 The tab's spectrum graphic display automatically updates as edits 

are made 

Browse – Click to select a POINT to use as the source of the spectrum readings viewed 

while editing the band alarm.  The POINT Selection dialog displays.  Select a POINT to 

use to define a shared alarm.  The hierarchy displays.  Select the desired POINT and 

click OK. 

 Bands defined in the Alarm Settings are not assigned to the 

POINTs used to create them. 

Edits may be made on the tab's spectrum graphic display.   

To edit the band graphically: 

 Click on the portions of the graphic band to edit.  Notice the mouse cursor changes 

when over a portion of the band.   

 Drag the band piece to a new position.  The value in the edit field updates. 

 When editing, you may Save or Undo changes for the current 

alarm. 

 Click Add to create a new band alarm. 

 Click Remove to remove the current band alarm.  A confirmation dialog displays. 

 Confirm action.  The band alarm is deleted. 

 A band alarm may not be removed if it is currently assigned. 
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Alarm Settings – Speed Alarm 

Speed alarms allow you to customize overall and band alarm levels based on machine 

speed.  Use the Speed Alarm tab to edit and/or specify the POINTs’ alarm adjustments 

for each speed region. 

 

Figure 2 - 65. 

The Alarm Settings / Speed Alarm tab. 

Speed alarm – Displays the current speed alarm.  All available speed alarms list in the 

drop down list. 

Name – Displays the speed alarm name. Range – Select the speed regions for which 

the Properties settings will apply.  You may select the region from the Range drop 

down list, or by clicking on the specific region on the speed alarm display.  The values in 

the Properties fields update to reflect the specified speed region. 

 Click Insert to add a new region to the speed alarm. 

 Click Clear to remove the selected speed region. 

Properties - Edit and view alarm values. 

The following fields are available for viewing set values or editing: 

Start / End Range - Enter each region’s starting and stopping RPMs (i.e., 0 to 1000, 

1000 to 2000, 2000 to 3000, etc.).  
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Ratio - Enter the adjustment to overall and band alarm levels.  The normal running 

speed region's ratio will be 100.  If the next higher speed range is expected to produce 

vibration levels 10% higher than the nominal running speed, then the next speed range 

ratio would be set to 110. 

Linear - This option allows for either a flat, rectangular definition of the adjustment (if 

disabled, the entire region will have the same ratio), or a more linear definition of the 

ratio (if enabled, the ratio will start from the level defined in the previous speed region 

and rise throughout the region until it reaches the next speed region's level).  Deadband 

– When enabled, no alarm processing will occur for this region.  This is mainly to be 

used when the machine reaches its resonant speed, at which vibration will be 

indeterminately high.  When enabled, Ratio and Linear fields are disabled. 

 The tab's spectrum graphic display automatically updates as edits 

are made. 

 Click Add to create a new speed alarm. 

 Click Remove to remove the current speed alarm.  A confirmation dialog displays. 

 Confirm action.  The speed alarm is deleted. 

 A speed alarm may not be removed if it is currently assigned. 

Alarm Settings – Envelope 

Use the Envelope tab to manage and edit shared envelope alarms.  All available 

envelope alarms display in the Envelope alarms drop down list.   
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Figure 2 - 66. 

The Alarm Settings Screen’s Envelope Tab. 

All available envelope alarms display in the Envelope alarm drop down list, or you may 

Generate a new envelope alarm.   

Shared envelope alarms may not be edited from this tab (use the Customize menu’s 

Alarm Database option to edit "shared" alarm parameters). 

 First, select the FFT spectrum to which the envelope alarm will conform, using: 

Spectrum source – specifies from which POINT to  graphically display the spectrum if 

two or more POINTs are currently active. 

Spectrum – displays all available time record measurements for the active POINT 

(typically the baseline measurement) in a drop down list.  The current spectrum displays 

graphically below. 
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To assign a "shared" envelope alarm to the POINT: 

 On the Envelope tab, select the desired shared envelope alarm’s name from the 

Envelope Alarms drop down list, the tab fields display the specified alarm’s settings 

and the specified envelope appears on the displayed spectrum. 

To Generate a new envelope alarm for the POINT: 

 Select the Envelope Alarms drop down list’s  <Custom envelope> option. 

 Click the Generate button.  The Generate Envelope Alarm dialog displays. 

Use the Generate Envelope Alarm Dialog to create an envelope alarm based on your 

entered values. 

% Overdrive – Enter the percent of the POINT’s full scale value to determine the height 

of the envelope alarm above the spectral peak.  The smaller the number specified, the 

tighter the comparison envelope conforms to the designated spectrum. 

Spreading %– Enter percent of full scale (or center frequency) to increase the width of 

the envelope alarm around spectral peaks.  The smaller the number specified, the 

tighter the envelope conforms to the sides of the peaks in the specified spectrum. 

Spreading Type – (either Center Frequency or Full Scale).  If Center Freq. is selected, 

the bandwidth about each center frequency increases with higher frequencies.  If Full 

Scale is selected, the bandwidth about each center frequency is constant, based on a 

percent of the full scale frequency. 

Threshold – Enter % of the POINT’s full scale value, or an absolute value.  The threshold 

value provides an opportunity to eliminate false alarms due to vibration "noise."  It also 

establishes the envelope alarm’s low amplitude "threshold" on the displayed spectrum.  

The envelope alarm conforms around all peaks whose amplitudes are higher than the 

established threshold as per the Overdrive %, Spreading %, and Spreading Type 

settings.  All peaks below the established threshold are ignored by the envelope alarm.  

The Threshold % default value is set using the Customize menu’s Preferences / Plot 

tab. 

 Click OK to generate an envelope alarm based on your entries.  Click Cancel to 

close the dialog without creating an envelope alarm. 

Editing the Envelope Alarm 

After you have generated an envelope alarm, you can edit it graphically using your 

mouse, or enter numeric envelope parameters using the Set Frequency Range dialog. 

To graphically edit the envelope alarm: 

 Click anywhere inside the Envelope tab’s spectrum window.  The cursor appears as 

an up arrow.   

 Click the mouse on the portion of the envelope alarm line to be edited.  A square 

icon identifies where the line will be drawn. 

 Drag the mouse to draw the line to create the new envelope alarm.   

 Click the tab’s OK button to save your changes. 

Tip -  You can use your keyboard’s Insert key to begin drawing the envelope alarm line.  

Then, use the arrow keys to move the line, and the Insert key again to stop drawing the 
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line.  Refer to Section 1, Appendix B SKF @ptitude Analyst Keyboard Support for 

more information on using your keyboard to edit your envelope alarm. 

To edit the envelope alarm using numeric frequency ranges: 

 Click the Set Range button.  The Set Frequency Range dialog displays. 

 Use the Set Frequency Range dialog to enter low frequency, high frequency, and 

level values to edit an existing envelope alarm. 

To numerically edit an envelope alarm: 

 Enter the desired low frequency, high frequency, and level value. 

 Click OK.  The displayed envelope alarm automatically conforms to your entries. 

Messages 

Use the Customize  / Alarm Settings screen’s Messages tab to create shared (public) 

alarm messages to assign to machines and POINTs to automatically display important 

alarm information.   

All previously defined alarm messages appear in the Alarm messages drop down list. 

To create a public Message: 

 Select the Customize menu’s Alarm Attributes / Alarm Settings option.  The 

Alarm Settings screen displays. 

 Select the Messages tab. 

 Click the Messages tab’s Add button.  The tab enters edit mode. 

 Specify appropriate information into the following fields: 

Name – Specify a name to define your custom message.   

Format – Select the message format from the drop down list.  Available options 

include: 

Free form – Allows you to manually type in the summary and content for your 

message. 

Summary – Type in text summarizing your alarm message for easy recognition.  For 

example, if you have an alarm message that details shut down instructions in the case 

of an overall danger high alarm level, your summary may read, "Emergency Shut Down 

Instructions." 

Content – Enter your complete alarm message in the content text area.  Using the 

above example, your alarm message content would include detailed shut down 

instructions, and any other pertinent information required in the case of the triggered 

alarm type. 

 Click the Save button to save the new message and add it to the available public 

messages. 

 Click the Undo button to undo changes. 

 Click Remove to remove the current message. 

 Messages currently in use cannot be removed. 



Working With Your SKF @ptitude Analyst Hierarchy 

Speed Tag 

SKF @ptitude Analyst for SKF Microlog Analyzer  2 - 135 

User Manual 

Speed Tag 

Speed Tag Overview 

Speed tagging allows you to link multiple POINTs (Microlog dynamic data POINTs) to a 

specific Microlog DAD dynamic or manual input speed reference POINT.  Data collected 

for these linked POINTs reflect the rotating speed of their associated speed reference 

POINT. 

Speed Tag Dialog 

The Speed Tag dialog allows you to select or clear speed tags specified for POINTs 

selected in the hierarchy list. 

To set speed tag: 

 Highlight a POINT and select the Edit menu’s Properties option.  The POINT 

Properties screen displays. 

 You may also access the POINT Properties screen by right 

clicking while the POINT is selected, or by using the toolbar 

button. 

 Select the Setup tab. 

 Click the Select POINT button in the tab’s Speed tag reference area.  The Speed 

Tag dialog displays. 

 

Figure 2 - 67. 

The Speed Tag Dialog. 

 Click the Select speed reference POINT option button.  

 Select the desired speed reference POINT from the hierarchical display. 
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To clear speed tag: 

 Click the Clear button in the Speed Tag dialog.  The speed tag is cleared for the 

selected POINT. 

 Click OK to save changes. 

 Click Cancel to undo settings. 

Statistical Alarms Wizard 

Statistical Overall Alarms Wizard  

Overview 

For POINTs in a Workspace window, the Statistical Overall Alarms Wizard guides you 

through a process that automatically generates accurate overall alarm settings based 

upon historical measurement data. 

 The Statistical Overall Alarms Wizard only operates on an active 

Workspace window. 

To initiate the wizard: 

 Open the desired Workspace window. 

 Select the Customize menu’s Alarm Attributes / Statistical Overall… option.  The 

wizard’s Introduction screen displays. 

Introduction 

The Introduction screen is the first screen in the Statistical Overall Alarms Wizard.  

The measurement data used to generate the alarm values is generated from the 

POINTs included in the selected Workspace (identified in the Workspace field). 

 From the Workspace drop down list, select the Workspace from which you would 

like to use to generate the alarm values. 

 From the Full scale units drop down list, select a measurement unit.  The Full 

scale units drop down list displays a list of the full scale units for POINTs in the 

selected workspace.  Only POINTs with the selected measurement unit are used to 

generate alarm values. 

 Click the Save processing details to “Statistical Overall Alarms.log” check box to 

create and save a log file. 

 Click Next to continue. 

Alarm Assignment 

Select the calculation method to use to determine alarm values. 

Individual POINTs – Select to use each POINT's readings to generate a unique set of 

alarm values for the POINT.  The resulting values are assigned to each POINT as a 

private alarm. 

 This operation generates and assigns a private alarm for each 

POINT. 
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Across all POINTs – Select to use the readings for all the POINTs to generate one set 

of alarm values that is assigned to each POINT included in the calculation.  The resulting 

values are saved as a shared alarm. 

 If Across all POINTs is selected, a Review screen displays before 

alarms are applied, allowing verification and confirmation. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 

Measurement Selection 

Determine the method for selecting the measurement data to generate overall alarm 

values. 

All measurements – Select to use all measurement data to generate the overall alarm 

values. 

Measurements in this date range – Select and enter a date range to use all 

measurements in the indicated date range to generate the overall alarm values. 

Last fixed number of measurements – Select and enter number of measurements to 

use the specified number of measurements to generate overall alarm values. 

Limits – Allow you to filter abnormal measurements from the calculation: 

Max. Amplitude- Enter the maximum amplitude of the overall value to include 

in calculation. 

Min. Amplitude – Enter the minimum amplitude of the overall value to include 

in calculation. 

Min Measurements – Enter the minimum number of the POINT's 

measurements to be included in calculation. 

 Only POINTs that have the number of indicated minimum 

measurements (or more) are included in the calculation. 

 Min. Measurements field is not available if measurement selection 

is  "Last fixed number of measurements." 

Channel – Enter the channel number of multi-channel POINTs to included in 

the calculation.  

Enable outlier removal – An “outlier” refers to data that is not typical, or is 

outside a specified data measurement range.  When the Enable outlier 

removal check box is enabled, measurement values that fall outside the outlier 

range are excluded from the calculation. 

 Outlier detection only occurs if the number of measurements is 

greater than or equal to the Min Measurements specification. 
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Outlier threshold factor – Enter a threshold factor (1.0 to 5.0) to calculate the 

lower and upper limits of the outlier range (outlier threshold).  The threshold 

factor is multiplied by the standard deviation to calculate the outlier threshold.  

The default threshold factor is 3.0. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 

Alarm Type 

Select the type of overall alarm to generate: 

Level – Provides two alarm levels (Alert High and Danger High).  An appropriate alarm 

registers if the measured value is greater than either of the alarm levels.   

Out of Window – Provides four alarm levels (Danger High, Alert High, Alert Low, 

Danger Low).  An appropriate alarm registers if the measured value progresses out of 

the alarm window (does not fall between the alert high and alert low alarm settings). 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 

Generation Parameters 

 

Figure 2 - 68. 

The Statistical Overall Alarms Wizard’s Generation Parameters Screen. 
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Note that you need not perform the standard deviation math.  The wizard’s default 

values have been selected to produce overall alarms that work well for most situations.  

However, if you wish to conform the overall alarms closer, enter smaller numbers.  To 

conform the overall alarms further away, enter higher numbers.  After completing the 

wizard, view your trend plots and make adjustments as necessary. 

 If necessary, edit the standard deviation information to be used in the overall alarm 

calculations.   

Standard deviation factors 

Danger High – Value to be multiplied by the standard deviation to establish 

the danger high level. 

Alert High - Value to be multiplied by the standard deviation to establish the 

alert high level. 

Alert Low – Value to be multiplied by the standard deviation to establish the 

alert low level. 

Danger Low – Value to be multiplied by the standard deviation to establish the 

danger low level. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 

Minimum Alarm Values 

Set the minimum alarm values to be used in the calculation.  If the standard deviation is 

small, the minimum alarm values allow you to set a wider range, minimizing the chance 

for bad alarms to occur. 

Enter the minimum values for Danger High, Alert High, Alert Low, and Danger Low. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 

Process 

Click the Next button to begin the overall alarm calculations.  Process progress displays 

along with the number of POINTs processed. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 
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Review 

 This screen only displays if Across all POINTs was selected on 

the wizard's Alarm Assignment screen. 

 

Figure 2 - 69. 

The Statistical Overall Alarms Wizard’s Review Screen. 

The statistically derived overall alarm results display on this screen.  These numbers 

may be edited, if necessary. 

Fields include: 

Alarm set name – Specify a unique name for the alarm. 

Calculated alarm values – Edit values as needed. 

 Calculated alarm values fields are available based on overall 

alarm type selection. 

POINTs processed for input criteria – Number of POINTs selected as candidates for 

processing. 

POINTs included – Number of included POINTs. 

POINTs excluded – Number of excluded POINTs. 

 Alarms are still applied to the POINTs excluded from calculation 

functions. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 
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Finish 

 Click the Finish button to assign the statistically derived overall alarm to all POINTs 

in the specified workspace. 

Process progress displays on the screen. 

 Click Back to return to the previous screen. 

 Click Cancel to stop the operation without changing the POINTs. 

Templates 

Templates save time, contribute to consistent organization, and allow you to make bulk 

entries.  For example, you can quickly set the machine speed for all POINTs beneath a 

machine with a template.  Templates allow you to define custom organizational 

structures for repeated use when building or defining your hierarchy.   

 The same template may be used across many different 

hierarchies.   

Managing Templates 

To add a new template: 

 Select the Customize menu’s Template option.  The Template screen displays. 

 

Figure 2 - 70. 

The Template Screen. 
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 Click the screen’s Add button.  The Template Properties dialog displays. 

 Enter the new template’s Name and Description. 

 Select the template’s Type from the drop down list.  Select a previously created 

template or <Custom>.   

 If you need a new template that is only slightly different from a 

previously created template, you can select a previous template 

as your Type and then edit only the necessary items. 

 Click the dialog’s OK button.  The new template window displays. 

In the template window, insert new Groups and POINTs to build the new template’s 

hierarchy structure. 

 Using the Insert menu, insert desired structure elements (groups and POINTs) in 

the desired configuration into the template window. 

 You may also use Copy, Paste, and Paste Multiple to build your 

template’s structure. 

 

Figure 2 - 71. 

Template Window With Custom Structure. 

When building your template structure, you may also set up custom names using 

“special” characters in the name fields. 

When applying a template, the template wizard assists with naming hierarchy items 

whose template name includes “special” characters 

Custom Names 

Templates hierarchy items may be inserted in your hierarchy : 

 With the name specified in the template, or 

 With the Template wizard prompting you to enter a name for items inserted in your 

hierarchy, or 
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 With custom names created by the Template wizard that are based upon your 

existing hierarchy. 

The last two options are accomplished by special characters within your template 

hierarchy names. 

 When a new item is inserted into the Template, its Properties dialog displays. 

 You may also access the Properties dialog by right-clicking to 

access the context menu, or using the Properties toolbar button. 

You can configure the custom naming feature to prompt you to input a unique name for 

the specified item as the template is applied.  You can also set up your template to 

automatically name structure items based on your entered parameters. 

To set up name prompt: 

 In the Properties dialog’s Name field, enter a “^” as the first character.  During the 

application of the template, the template wizard will prompt you to either accept 

the item’s name as it appears after the “^”, or enter a new name for the hierarchy 

item as the template is being processed. 

Use of special characters enables automatic naming during template application.  Based 

on your entries, the new items take their name from the portions of the parent item’s 

name. 

To set up automatic naming: 

   In the Properties dialog’s Name field, use a “$” to cause the inserted template 

item (child) to use a portion of the target hierarchy parent’s name.  Each “$” in the 

template item’s name is replaced by a sequential word from the target hierarchy 

parent’s name.  Use as many “$”s as necessary.  For example, if the parent item’s 

name is “Dryer Section,” you might apply a template item named  “$ $ Felts.”  This 

will insert the template item (child) and name the it “Dryer Section Felts.” 

 Also, square brackets (“[ ]”) may be used to strip items from the final name.  This 

allows you to use  

“[ ]”s and “$”s together to use some portions of the parent’s name while skipping 

others.  For example, if the parent’s name is “FD Fan”, and you wish to remove the 

“FD” prefix, place “[ ]”s around the dollar sign representing the “FD” ( [$]$ ).  The 

inserted item will be named “Fan.”  You can also use “[ ]”s to include comments that 

are visible when viewing the template and as the template is applied.  The 

comment text does not appear in the final name.  To do so, enter your auto-

naming characters followed by your comment text enclosed in brackets.  For 

example, using the earlier “FD Fan” example, the entry “[$]$[left env] would result 

in the item being named “Fan.”  The comment text, “left env” is visible to you when 

you view the template, and as the template is applied, but is deleted from the item’s 

name in the hierarchy list.. 

To open an existing template: 

 In the Template screen, select the template to open. 

 Click the screen’s Open button.  The selected template window displays. 

To remove an existing template: 

 In the Template screen, select the template to remove. 
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 Click the screen’s Remove button.  When prompted, confirm action. 

The selected template is removed. 

To add a Template Type: 

 In the Template screen, click Add, or select an existing template and click Edit.  

The Template Properties dialog displays. 

 In the General tab’s Type field, place your cursor in the drop down list and enter 

the new type name. 

 Click OK to save the new template type and apply it to the current template. 

Applying Templates 

To apply a template: 

 In your target Hierarchy, select the item under which you wish the template items 

to branch. 

 Select the Insert menu’s Apply Template option.  The Apply Template dialog 

displays. 

The Apply Template dialog lists all available templates. 

 Select desired template and click Apply to launch the Apply Template Wizard. 

Introduction Screen 

 

Figure 2 - 72. 

The Apply Template Wizard Screen. 
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The Apply Template Wizard guides you through the required steps to create new 

entries under the selected hierarchy item, using the selected template. 

The introduction screen displays the following information about the selected template: 

Name – Displays the name of the template being applied. 

Description – Displays the description provided for the template. 

Destination – Displays the location in the hierarchy to which the template will 

be applied.   

Before continuing, ensure the template name is correct, and ensure the destination is 

accurate. 

 Click Next to continue. 

Configuration Screen 

The template application process begins on the Configuration screen.  This screen 

walks through the template, gathering information as needed:   

Name - If necessary, you will be prompted to specify the name of the item being 

processed. 

Running speed - Specify the machine speeds for the highlighted machine.  This speed 

will be used to set the speed of each POINT beneath the machine.   

 The processing stops to allow you to enter necessary information. 

Custom Naming 

 You will be prompted to enter a name if you set your template up 

using the special  name-prompt character “^.”  Your structure 

elements will be automatically named if you set up your template 

using auto-name characters. 

 Click Next to continue. 

When the template processing is complete, click Next to continue to the build screen. 

 View the template’s progress in the screen’s progress bar. 

 Click Back to return to the wizard’s last stopping point. 
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Build Screen 

 

Figure 2 - 73. 

The Apply Template Wizard Screen. 

This screen uses the template to build the template hierarchy items within the specified 

target hierarchy item.   

 The wizard is capable of generating multiple copies of the 

template. 

 Specify the number of copies required. 

 Click Next to build the hierarchy. 

 Click Finish to close the wizard. 
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Working with Filters 

Filters allow you to setup and apply filter criteria that determine which POINTs display 

in a new filtered Workspace window.  Filtered workspaces group together POINTs and 

Groups (based on your filter input) in one window for easy comparison and analysis. 

Managing Filters 

Use the Customize menu’s Filters option to manage (add, copy, edit, and remove) 

filters.  This allows you to define reusable filters. 

To add a new filter: 

 Select the Customize menu’s Filters option.  The Filters dialog displays. 

 Click the Add button.  The Filter Editor screen displays. 

 

Figure 2 - 74. 

The Filter Editor Screen. 

Name - Specify the new filter’s name. 

 It is helpful to give the filter a name based on its criteria for easy 

recognition.  For example, if you need to sort Groups based on 

their priority setting, you may want to create and name a filter 

specifically for Priority. 

Keep hierarchy – Click the checkbox to determine whether the hierarchy Groups appear 

with their filtered POINTs in the filtered workspace, or whether only the filtered POINTs 

appear in the filtered workspace.  If disabled, filtered POINTs appear beneath the 
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filtered machine without the original hierarchical format.  The filtered workspace lists all 

filtered POINTs under a “Filtered Machine” hierarchy item. 

Filter on attributes – Define which attributes to filter on.  Attributes are categorized by 

machine, measurement, POINT, data type, and/or attribute type.  Select an attribute 

group to modify its individual settings. 

Settings – Displays current individual attribute settings for the specified attribute 

category.  Use the edit fields to view and/or edit attributes as necessary. 

 When one or more attribute within an attribute category is 

included in the current filter, a checkmark displays next to the 

attribute category folder. 

 Use the All and Clear buttons to quickly include all or none of the displayed 

attributes (rather than selecting / de-selecting one by one) for the selected attribute 

category in your current filter. 

Include – Specify whether to filter for POINTs that match every attribute setting, or 

filter for POINTs that match at least one attribute setting. 

Any Selected – Select to filter for POINTs matching any individual attribute of 

the total included in the filter.  Only these POINTs display in the Filtered 

Workspace 

All Selected - Select to filter for POINTs matching all attributes included in the 

filter.  Only these POINTs display in the Filtered Workspace. 

 The number of attributes selected and the total number of 

available attributes displays in the screen’s lower left corner. 

 Click the OK button to create a new workspace based on the defined criteria of the 

current filter.  A progress bar displays, indicating filter process status. 

 Click Cancel to close screen without performing filter and without saving filter 

entries. 

To create a new filter based on a copy of an existing filter: 

If you need a new filter that is only slightly different from a previously created filter, you 

can select the previous filter and then edit only the necessary items. 

 In the Filters dialog, select the existing filter you wish to copy and use as a 

template. 

 Click the dialog’s Copy button.  The Filters Editor screen displays. 

 Enter the new filter’s name. 

 By default, the new filter is given the same name as the copied 

filter on which it is based, with a numerical suffix. 

Filter on attributes - Select additional individual attributes, or edit the existing 

attributes.  When an existing filter is selected, its existing selected attributes display. 

 Click OK to apply the new filter. 
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To edit an existing filter: 

 In the Filters dialog, select the existing filter you wish to edit. 

 Click the dialog’s Edit button.  The Filters Editor screen displays. 

Filter on attributes – Displays the selected existing filter’s selected attributes. 

 Perform your edits and click the screen’s OK button to save the edited filter. 

To remove an existing filter. 

 In the Filters dialog, select the existing filter you wish to remove. 

 Click the dialog’s Remove button.  Confirm removal when prompted.  The filter is 

removed. 

Applying Filters 

You can create and apply private and shared filters using the Insert menu’s Apply 

Filters screen.  When a filter is applied, the resulting items display in a new Workspace 

window. 

To apply a filter: 

 Select the Insert menu’s Apply Filter option.  The Apply Filter screen displays. 

 

Figure 2 - 75. 

The Apply Filter Screen. 

Filter – Select an existing filter or <Private Filter>.  This determines what to base your 

filter on (either a copy of an existing shared filter or to create a new private filter). 
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Filter on attributes – Displays the selected existing filter’s selected attributes. 

Keep hierarchy - Click the checkbox to determine whether the hierarchy Groups appear 

with their filtered POINTs in the filtered workspace, or whether only the filtered POINTs 

appear in the filtered workspace.  If disabled, filtered POINTs appear beneath the 

filtered machine without the original hierarchical format.  The filtered workspace lists all 

filtered POINTs under a “Filtered Machine” hierarchy item. 

 In the screen’s Filter from area, select Root node – My Hierarchies to search all 

open hierarchies for matching POINTs.  Select Selected node to search from your 

selected node and below only. 

 In the screen’s Filter on attributes area, define which attributes to filter on.  

Attributes specific to machine, measurement, POINT, data type, and/or attribute 

type are grouped together.  Select an attribute type to include in the filter. 

 Attribute settings for the selected attribute group display in the screen’s Settings 

area.  View and/or edit attributes as necessary in the displayed input fields. 

 Individual attributes are described in detail in the next section. 

 When one or more attribute within an attribute group is included 

in the current filter, a checkmark displays next to the attribute 

group folder. 

Include – Specify whether to filter for POINTs that match every attribute setting, or 

filter for POINTs that match at least one attribute setting. 

Any Selected – Select to filter for POINTs matching any individual attribute of 

the total included in the filter.  Only these POINTs display in the Filtered 

Workspace. 

All Selected - Select to filter for POINTs matching all attributes included in the 

filter.  Only these POINTs display in the Filtered Workspace. 

 The number of attributes selected and the total number of 

available attributes displays in the screen’s lower left corner. 

 Click the screen’s OK button to apply the filter as a private filter 

 When a filter is applied, the resulting items display in a new 

Workspace window. 

To make the filter a shared filter: 

 Click Share As to assign the current filter a unique name and make it available as a 

shared filter.  The Enter Filter Name dialog displays. 

 Enter a unique filter name and click OK. 

 Click the Apply Filter screen’s OK button to create a workspace based on the 

defined criteria of the current filter.  A progress bar displays, indicating filter 

process status. 

 Click Cancel to close screen without performing filter and without saving filter 

entries. 
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Individual Filter Attributes 

All individual filter attributes are described below. 

Asset 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated asset (the 

physical machinery occupying the segment). 

Edit – Enter the asset in the text field. 

 Standard wildcard operations are supported. 

Machine Description 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated 

description. 

Edit – Enter the machine description in text field. 

 Standard wildcard operations are supported. 

Machine Name 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated name. 

Edit – Enter the machine name in the text field. 

 Standard wildcard operations are supported. 

Priority 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated priority 

assignment. 

 Edit – Select one or more priority assignment(s). 

Segment 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated segment 

(physical location of a Group). 

Edit – Enter the segment in the text field. 

 Standard wildcard operations are supported. 
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Alarms 

This attribute is located under Measurement. 

Filters for all POINTs with a last measurement in the indicated alarm. 

Edit – Select one or more alarms from the settings list.  Use the All button to 

select all alarms in the settings list.  Use the Clear button to clear all selections 

from the alarms in the settings list.  Select Include All Selected to include 

POINTs matching all alarm selections.  Select Include Any Selected to include 

POINTs matching at least one alarm selection. 

Last Measurement Date 

This attribute is located under Measurement. 

Filters for all POINTs with a last measurement taken between (and including) 

the specified dates. 

Edit – Enter the dates using standard date selection operation. 

Last Measurement Value 

This attribute is located under Measurement. 

Filters for all POINTs with an overall value (Channel 1) between and including 

specified values. 

Edit – Enter values in the edit fields. 

Overdue 

This attribute is located under Measurement. 

Filters for all POINTs’ schedule condition (Overdue or Not Overdue). 

Edit – Select Overdue or Not Overdue. 

Number of Days – Enter the number of days (from now).  Filters for POINTs 

matching the selected status (Overdue or Not Overdue) within the entered 

date range. 

Band Alarm 

This attribute is located under POINT / Alarm. 

Filters for all POINTs with the selected shared band alarm. 

Edit – Select one or more shared band alarm from the settings list.  Use the All 

button to select all shared band alarms in the settings list.  Use the Clear 

button to clear all selections from the shared band alarms in the settings list. 

Envelope Alarm 

This attribute is located under POINT / Alarm. 

Filters for all POINTs with the selected shared envelope alarm. 

Edit – Select one or more shared envelope alarm from the settings list.  Use 

the All button to select all shared envelope alarms in the settings list.  Use the 

Clear button to clear all selections from the shared envelope alarms in the 

settings list. 
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HAL Alarm 

This attribute is located under POINT/Alarm. 

If HAL Alarm Set is set to “Yes” for the HAL Alarm filter attribute, then when 

the filter is applied, the workspace will display only POINTs for which HAL 

alarms are configured. 

If HAL Alarm Set is set to “No” for the HAL Alarm filter attribute, then when 

the filter is applied, the workspace will display only POINTs for which HAL 

alarms are not configured. 

Overall Alarm 

This attribute is located under POINT / Alarm. 

Filters for all POINTs with the selected shared overall alarm. 

Edit – Select one or more shared overall alarm from the settings list.  Use the 

All button to select all shared overall alarms in the settings list.  Use the Clear 

button to clear all selections from the shared overall alarms in the settings list. 

Application Type 

This attribute is located under POINT / General. 

Filters for all POINTs configured to collect the indicated application data. 

Edit – Select one or more application type from the settings list.  Use the All 

button to select all application types in the settings list.  Use the Clear button to 

clear all selections from the application types in the settings list. 

DAD Type 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated DAD type. 

Edit - Select one or more DAD type from the settings list.  Use the All button 

to select all DAD types in the settings list.  Use the Clear button to clear all 

selections from the DAD types in the settings list. 

Enable / Disable 

This attribute is located under POINT / General. 

Filters for all POINTs enabled or disabled for download. 

Edit – Select Enable or Disable. 

Filter Keys 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated filter key(s). 

Edit - Select one or more filter key from the settings list.  Use the All button to 

select all filter keys in the settings list.  Use the Clear button to clear all 

selections from the filter keys in the settings list.  Select Include All Selected 

to include POINTs matching all filter key selections.  Select Include Any 

Selected to include POINTs matching at least one filter key selection. 
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Frequency Sets 

This attribute is located under POINT / General. 

Filters for all POINTs with the selected shared frequency set. 

Edit – Select one or more shared frequency set from the settings list.  Use the 

All button to select all shared frequency sets in the settings list.  Use the Clear 

button to clear all selections from the shared frequency sets in the settings list. 

POINT Description 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated description. 

Edit – Enter POINT description in POINT Description field. 

POINT Name 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated name. 

Edit – Enter POINT name in POINT Name field. 

 Wildcard characters are available for use. 

Sensor Type 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated sensor type. 

Edit - Select one or more sensor type from the settings list. 

Evaluation Time 

This attribute is located under POINT / Derived. 

Filters for all derived POINTs with the indicated evaluation time. 

Edit – Enter the evaluation Units, and Minimum and Maximum values in the 

appropriate fields. 

Expression 

This attribute is located under POINTs / Derived. 

Filters for all POINTs with the selected shared expression. 

Edit – Select one or more expressions from the settings list.  Use the All 

button to select all expressions in the settings list.  Use the Clear button to 

clear all selections from the settings list. 
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Compliance 

This attribute is located under POINT / Schedule. 

Filters for all POINTs with the indicated compliance schedule setting (as 

configured in POINT Properties / Compliance). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units.   

 Units are automatically evaluated for compatibility.  For example, 

an entry of 24 hours will include a POINT with a DAD schedule set 

to 1 day. 

Keep Current Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching the indicated Keep Current Data units (as 

configured in POINT Properties / Schedule). 

Edit - Select units from the drop down list.  Enter minimum and maximum 

number of selected units.   

Keep Unscheduled Data 

This attribute is located under POINT  / Schedule. 

Filters for all POINTs matching indicated Keep Unscheduled Data units (as 

configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 

Long Term Archive Keep Data 

This attribute is located under POINT  / Schedule. 

Filters for all POINTs matching the indicated Long Term Archive Keep Data 

units (as configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 

Long Term Archive Take Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching the indicated Long Term Archive Take Data 

units (as configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 
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Short Term Archive Keep Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching the indicated Short Term Archive Keep Data 

units (as configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 

Short Term Archive Take Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching the indicated Short Term Archive Take Data 

units (as configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 

Unscheduled 

This attribute is located under POINT / Schedule. 

Filters for all POINTs without a configured compliance schedule. 

Autocapture 

This attribute is located under POINT / Setup. 

Filters for POINTs matching the indicated autocapture setting. 

Edit – Select the autocapture setting from the settings list.  Use the All button 

to select all autocapture settings in the settings list.  Use the Clear button to 

clear all selections from the autocapture setting in the settings list. 

Averages 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the specified number of averages (as configured in 

POINT Properties). 

Edit – Enter minimum and maximum number of averages in edit fields. 

Averaging 

This attribute is located under POINT / Setup. 

Filters for all POINTs matching the indicated Averaging Type (Average, Off, 

Peak Hold, or Synchronous Time)  

Edit – Select one or more average types from the settings list.  Use the All 

button to select all average types in the settings list.  Use the Clear button to 

clear all selections from the average types list. 
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Detection 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the specified detection setting. 

Edit - Select detection setting from the settings list.  Use the All button to 

select all detection settings in the settings list.  Use the Clear button to clear all 

selections from the detection setting in the settings list. 

FFT Frequency 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated frequency settings. 

Edit – Specify Fixed span or Order track.  Enter the minimum / maximum 

start (freq or orders) and the minimum / maximum end (freq or orders). 

 Enter Minimum and maximum values in frequency or orders, as 

indicated in Freq. Type selection. 

Full Scale 

This attribute is located under POINT / Setup. 

Filters for all POINTs whose Full Scale setting falls within the indicated full 

scale value range.  

Edit – Select unit types from the settings list.  Use the All button to select all 

unit types in the settings list.  Use the Clear button to clear all selections from 

the settings list.  

Full Scale Units 

This attribute is located under POINT / Setup. 

Filters for all POINTs matching the indicated Full Scale Units type.  

Edit – Select full scale unit types from the settings list.  Use the All button to 

select all full scale unit types in the settings list.  Use the Clear button to clear 

all selections from the full scale units settings list. 

Input Filter Range 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated input filer range settings. 

Edit – Select input filter range(s) from the settings list.  Use the All button to 

select all input filter ranges in the settings list.  Use the Clear button to clear all 

selections from the settings list. 

Input mV / EU 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated mV / EU settings. 

Edit – Enter minimum and maximum mV / EU values in edit fields. 
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Lines 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated lines setting. 

Edit – Select line(s) from the settings list.  Use the All button to select all lines 

in the settings list.  Use the Clear button to clear all selections from the 

settings list. 

Linear Factor 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated linear factor value (as indicated in 

POINT Properties / Setup). 

Edit – Enter the minimum and maximum linear factor values. 

Linear Speed Units 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated linear speed units (as configured in 

POINT Properties / Setup). 

Edit – Select one or more linear speed units type from the settings list.  Use 

the All button to select all liner speed units in the settings list.  Use the Clear 

button to clear all selections from the linear speed units settings list. 

Location 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated location setting. 

Edit – Select location(s) from the settings list.  Use the All button to select all 

locations in the settings list.  Use the Clear button to clear all selections from 

the settings list. 

Low Frequency Cutoff 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated low frequency cutoff. 

Edit – Enter minimum and maximum frequency values in edit fields. 

 Units display in either CPM or Hz, based on frequency units 

preference setting (Preferences / General). 

Orientation 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated orientation. 

Edit – Select orientation(s) from the settings list.  Use the All button to select 

all orientations in the settings list.  Use the Clear button to clear all selections 

from the settings list. 
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Pulses / Rev 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated minimum and maximum pulses / rev 

setting (as configured in POINT Properties / Setup). 

Edit – Enter Minimum and Maximum pulses / rev values. 

Save Data 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated save data setting. 

Edit - Select save data setting from the settings list.  Use the All button to 

select all save data settings in the settings list.  Use the Clear button to clear all 

selections from the settings list. 

Speed 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated speed settings. 

Edit – Enter minimum and maximum speed values in edit fields. 

Speed Ratio 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated speed ratio. 

Edit – Enter minimum and maximum speed ratio values in edit fields. 

Speed Tag Reference 

This attribute is located under POINT / Setup. 

Filters for all POINTs with common indicated speed tag reference POINT. 

Edit - Select the speed tag reference POINT(s) from the settings list.  Use the 

All button to select all speed tag reference POINTs in the settings list.  Use the 

Clear button to clear all selections from the settings list. 

Window 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated window setting. 

Edit - Select window setting(s) from the settings list.  Use the All button to 

select all window settings in the settings list.  Use the Clear button to clear all 

selections from the settings list. 

Zero Offset 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated zero offset. 

Edit – Enter the minimum and maximum zero offset values in edit fields. 
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Clear Alarm Non Collection  

This attribute is located under POINT / General.  

Filters for all POINTs with Clear Alarms for Non-collection last 

measurements enabled or disabled. 

Edit – Select Enable or Disable. 

Exclude Non-Collection From Report 

This attribute is located under POINT / General.  

Filters for all POINTs with Exclude from reports if last measurement is a 

Non-collection event enabled or disabled. 

Edit – Select Enable or Disable. 

Command Line Parameters    

You can use command line parameters to further customize @ptitude Analyst.  

Command line parameters are entries you type in when creating your @ptitude Analyst 

shortcut to automate certain preferences.  Enter the following characters after the path 

(in the Run dialog or in the shortcut Properties’ Target field) to enable the desired 

feature. 

 For more information on creating shortcuts, refer to your 

Microsoft Windows User's Guide. 

-u:“username” Analyst starts up displaying the specified user name 

in the Log In screen. 

-u:“username,password” Analyst starts up  

displaying the specified user name and password in 

the Log In screen. 

-fastexit Disables the exit confirmation prompt (“Are you 

sure you want to exit the application?”). 

-d“database” Analyst opens the specified database on start up. 

-connect:“sid” Analyst opens the specified “sid” (database service 

identity) on start up. 
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Customize / Derived POINTs 

The Derived POINTs screen allows you to customize shared expressions, create new 

expressions, and to edit variables, constants, and the expression formula. 

 

Figure 2 - 76. 

The Customize menu’s Derived POINTs Expressions tab. 

To customize a shared expression: 

 Select the expression you wish to edit from the Expressions drop down list. 

Important - Any changes made to a shared expression affect all other POINTs 

sharing that expression, and overwrites the currently selected expression 

 You may rename the shared expression in the Name entry box.  

 Click the Variables button to edit, add, or remove variables.   

 You cannot assign POINTs to the variables from the Customize / 

Derived POINTs screen.  Refer to the POINT Properties / 
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Expressions tab section earlier in this chapter for details on 

assigning POINTs to variables. 

 

Figure 2 - 77. 

The Variables Screen. 

 Edit the expression formula by inserting variables, constants, or formulas.   

 To add a new expression, click the Add button, and enter settings 

as previously described in this chapter’s POINT Properties / 

Expression Tab section. 

To edit constants: 

There are two ways to edit shared constants.  You can edit constants using the 

Expressions tab's Constants button, or by using the Constants tab.  Both methods 

are described below. 

 From the Expressions tab, click the Constants button to add a new constant to the 

Constants list.  In the Constants dialog, click the Add button. 

Or 

 Click the Constants tab to add or remove a constant, or to edit pre-existing 

constants. 

 Click the Add button to create a new constant, or select a constant from the 

Constants list and edit the Name and Value in the Constant properties area.   

 Click the Remove button to remove the selected constant from the Constants list. 
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Figure 2 - 78. 

The Customize menu’s Derived POINTs Constants tab. 

Important – After editing a derived POINT, you must manually calculate the derived 

POINT to update the POINT’s existing data records.  Reference the Calculating 

Derived POINTs section later in this chapter for details. 
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3 

Data Collection ROUTEs and Other Data Transfer 

Operations 

Overview 

After establishing your hierarchy's POINTs, you are ready to create your collection 

ROUTEs. 

 It is not imperative that you create @ptitude Analyst ROUTEs to 

download POINTs to the data acquisition device.  Downloading 

directly from a plant hierarchy list is discussed later in this 

chapter. 

A ROUTE is a measurement POINT collection sequence.  ROUTEs are downloaded to a 

DAD to provide orderly collection of measurement data on a timely basis. 

ROUTEs are first created on paper.  You simply walk through your facility and list (in a 

logical, efficient collection sequence) the equipment and pre-defined POINTs you plan to 

collect at a given time.  For example, list the measurements you plan to perform weekly 

(e.g., every Tuesday) as “Tuesday's ROUTE”, and/or list the measurements you plan to 

perform monthly as the “monthly ROUTE.” 

Take time to organize your collection ROUTE paper copy thoroughly.  A complete and 

organized paper copy collection ROUTE makes building @ptitude Analyst ROUTEs much 

easier. 

After establishing your paper copy ROUTE(s), your next task is to use your paper copy 

ROUTE to create a @ptitude Analyst ROUTE. 

How To Build ROUTEs 

@ptitude Analyst's method for creating ROUTEs is simple. 

Using your paper copy ROUTE, open the Hierarchy, ROUTE, or Workspace window for 

those measurement POINTs you wish to have in the ROUTE, and copy selected items 

(machines with their POINTs, SETs with their machines and POINTs, Custom Groups 

with their machines and POINTs, or the entire hierarchy) from the open Hierarchy 

window to the new ROUTE window, creating the new ROUTE's hierarchy list. 

You may also insert (Insert menu) Groups directly into a ROUTE window, then select 

POINTs from a Hierarchy, ROUTE, or Workspace window, and copy them to your new 

ROUTE, organized beneath your newly inserted Groups. 

If necessary, move hierarchy items in the ROUTE window to match the most efficient 

collection sequence (detailed on your paper copy ROUTE). 
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With MARLIN data collectors, you can also configure your ROUTE to keep ROUTE 

statistics by designating it as a Structured ROUTE.  Currently, only the MARLIN DAD 

supports structured ROUTEs. 

If a ROUTE has been designated as a structured ROUTE, then ROUTE statistics, such as 

collection time duration, start and stop times, and operator ID are recorded with the 

ROUTE.  A structured ROUTE also requires that data be collected in the order in which 

the POINTs are listed in the ROUTE. 

  Statistical ROUTE information can provide valuable information 

to assist in managing your ROUTEs.  IMPORTANT - When 

moving hierarchy items to create the most efficient collection 

sequence, note that in a ROUTE list, parental hierarchy items 

always remain attached to their measurement POINTs.   

 IMPORTANT - In a ROUTE window, changes to a POINT’s 

placement in the list, and POINT deletions do not affect the 

Hierarchy window .  However, changes to individual POINT setup 

settings (POINT Properties) do apply to the hierarchy and reflect 

in Hierarchy window. 

 

Changes to Group item Properties do not affect the  Hierarchy 

window. 

To open an existing ROUTE: 

 Select the View menu’s ROUTE command.  The ROUTE dialog displays. 

 Select an existing ROUTE and click the Open button.  The selected ROUTE window 

opens. 

To add a new ROUTE: 

 Click the ROUTE dialog’s Add button.  The ROUTE Properties screen displays. 
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ROUTE Properties / General 

 

Figure 3 - 1. 

The ROUTE Properties Screen’s General Tab. 

ROUTE Properties / General fields include: 

Name – Enter a new ROUTE name. 

Description – Enter a new description. 

The ROUTE Statistics area allows you to make your ROUTE a structured ROUTE, and 

determine the type of historical information to keep.  If historical record settings are 

entered, then ROUTE statistics, such as collection time duration, start and stop times, 

and operator ID, are recorded with the ROUTE.  If the ROUTE is designated as a 

structured ROUTE, then data must be collected in the order in which the POINTs are 

listed in the ROUTE.To create a structured ROUTE: 

 Click the Structured ROUTE checkbox to designate the selected ROUTE as a 

structured ROUTE. 
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To enter ROUTE statistic settings: 

 Click an option button to specify the amount of historical records to keep.  Included 

in each historical record are the ROUTE’s collection time duration, start and stop 

times, and Operator ID.  Options include: 

Keep all historical records – Saves all historical ROUTE collection statistics for 

the selected ROUTE. 

Keep fixed number of historical records – Enter the number of historical 

records to save for the selected ROUTE. 

Keep records for – Enter a time duration value for storing historical records.  

For example, enter 6 in the text box and select weeks from the drop down list 

to save historical records for 6 weeks.   

The number of POINTs included in the selected ROUTE display at the bottom of the tab. 

ROUTE Properties / Schedule 

The ROUTE Properties / Schedule tab allows you to specify a time period for when the 

ROUTE is to be collected.  If the ROUTE is not collected during the specified time period, 

the ROUTE will appear as overdue in the ROUTE Statistics report, in the ROUTE dialog, 

and in the Transfer dialog’s Download to DAD / Route View. 

  

Figure 3 - 2. 

The ROUTE Properties Screen’s Schedule Tab – Interval-based. 
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On the ROUTE Properties / Schedule tab, click the Enable collection schedule 

checkbox to configure the ROUTE’s collection schedule. 

ROUTE Properties / Schedule has schedule types; Interval-based – select interval-

based if you wish to schedule data collection at a set time interval and Calendar- based 

- select calendar-based if you wish to schedule data collection based on a calendar date 

and time. 

Interval-Based 

An interval-based collection schedule allows you to schedule data collection at a set 

time interval.  For example, if data is scheduled to be collected for a ROUTE every seven 

days, the ROUTE must be collected within seven days of the last time data was collected 

for the ROUTE.  If data is not collected within the set time interval, the ROUTE is 

considered Overdue in the ROUTE Statistics report, he ROUTE dialog, and in the 

Transfer dialog’s Download to DAD / Route View. 

Interval-based fields include: 

Schedule – Enter the ROUTE’s collection interval (in days or hours, starting from the 

Next ROUTE Due entry). 

Next ROUTE due – Enter the beginning collection date for the ROUTE. Together, the 

Next ROUTE Due and Schedule fields establish the ROUTE’s collection schedule. 

First shift starts at – Enter the time the first shift begins. This field is only available if 

the Schedule entry is in hours. 
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Figure 3 - 3. 

The ROUTE Properties Screen’s Schedule Tab – Calendar-based. 

Calendar-Based 

A calendar-based collection schedule allows you to schedule data collection starting 

from a specified calendar date and time, at a specified calendar interval (hours, days, 

weeks, etc.).  If, for such a ROUTE, data is not collected within the time period, the 

ROUTE is tagged as Overdue when included in generated reports and ROUTE dialogs. 

Calendar-based fields include: 

 Use the Collection time area to set the data collection 

boundaries, and the Collection Schedule area to specify the data 

collection frequency. 

Collection Time Area 

Start date – Select the initial start date of when the data collection time period is to 

begin.  Note that, depending on settings in the Collection schedule area, data collection 

may not actually occur on the specified Start date.  This date only specifies that data 

collection must take place from this date forward. 

Start time – Together, the Start time and End time settings specify the time period in 

which data collection must be completed.  Select the time at which data collection 

should begin, according to the specified collection schedule. 

End time – Select the time at which data collection should end, according to the 

specified collection schedule. 
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 Does not apply when collection schedule is set to Hourly. 

Collection Schedule Area  

The left side of the Collection Schedule area displays calendar based options for data 

collection frequency (e.g., hours, days, weeks, etc.).  The right side of the Collection 

Schedule area updates to apply to the option selected in the left side. 

Hourly – Enter the duration of shift in hours.  After the specified Start date, data 

collection must be complete within the specified shift duration. 

Daily – Enter the frequency of the collection schedule in days.  For example, if the 

collection schedule is set to Every 2 day(s), then (after the specified Start date) data 

collection must be completed every other day within the specified start and end times. 

Weekly – Enter the frequency of the collection schedule in weeks, and select the day of 

the week that data collection must occur.  For example, if the collection schedule is set 

to Every 1 week(s) on Monday, then the ROUTE’s data must be collected the first 

Monday after the specified Start date and every Monday thereafter, within the specified 

start and end times. 

Monthly – Provides two methods to select monthly data collection time periods.  You 

may select the day of the month (1-31) and the frequency of the collection schedule in 

months; or you may select a day of the week and the 1st, 2nd, 3rd, 4th, or last week of 

the month, and the frequency of the collection schedule in months.  For example, with 

the first method, if you specify Day 25 of every 1 month(s), then data collection must 

occur (after the specified Start date) every month on the 25th.  With the second method, 

if the collection schedule is set to The 1st Monday of every 1 month(s), then data 

collection must occur (after the specified Start date) on the first Monday of each month. 

Yearly – Provides two methods to select yearly data collection time periods.  You may 

select the month / day and the frequency of data collection in years; or you may select a 

day of the week, the 1st, 2nd, 3rd, 4th, or last week of the month, the month, and the 

frequency of the collection schedule in years.  For example, with the first method, if you 

specify January 25 of every 1 year(s), then data collection must occur (after the 

specified Start date) once a year on January 25th.  With the second method, if the 

collection schedule is set to The 1st Monday of January, every 2 years, then data 

collection must occur (after the specified Start date) every other year on the first 

Monday in January. 
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ROUTE Properties / Notes 

ROUTE Properties / Notes fields include: 

ROUTE instruction notes – Allows you to create, edit, and store instructions / 

notes relating to the ROUTE.  ROUTE instructions are downloaded to the data 

acquisition device along with the ROUTE, and may be viewed on the DAD’s LCD 

panel. 

 Enter appropriate ROUTE properties and click OK.  The new ROUTE’s window 

displays. 

 Use drag and drop or copy and paste operations to copy selected Groups and 

POINTs, from the Hierarchy or Workspace windows into the new ROUTE's window 

to create the new ROUTE's hierarchy list. 

 

Figure 3 - 4. 

The ROUTE Window With Copied Items. 

To remove an unnecessary ROUTE: 

 In the ROUTE dialog, select the ROUTE name. 

 Click the Remove button.  Confirm action when prompted.  The selected ROUTE is 

removed. 

To set the same measurement speed for multiple FFT measurements: 

 Starting from a ROUTE, expand the appropriate machine. Beneath the machine in 

the hierarchy, right-click on the measurement POINT you wish to use as a 

reference and select Set Speed (Multiple) from the resulting context menu. 

OR 
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 Starting from a ROUTE, expand the appropriate machine. Beneath the machine in 

the hierarchy, click on the appropriate measurement POINT to display its 

measurements in the right panel. Then, right-click on the single measurement you 

wish to use as a reference and select Set Speed (Multiple) from the resulting 

context menu. 

The Set Speed (Multiple) window appears. 

Downloading ROUTEs To the Microlog  

Microlog Transfer Overview 

The Microlog transfer function allows you to download measurement POINT setups to 

the Microlog, upload collected data from the Microlog, check the Microlog status, and 

configure, clear, or reset the Microlog . 

The Microlog features three ways to communicate with @ptitude Analyst: 

Serial 

Modem 

USB 

It is important to note that some options only transfer when communicating via USB. If 

you use a serial or modem connection, the following information is not transferred: 

 Orbit SCL, Triax (3-channel), and 2-channel type POINTs are only 

transferred to or from the DAD when using the USB connection. 

 Multiple-measurement data (i.e., data from a single POINT that produces 

multiple measurements) is only uploaded to @ptitude Analyst from the DAD 

using the USB connection. 

 You may only transfer data to or from a Microlog AX using the USB 

connection. 

 POINTs with greater than 6400 lines of resolution or an end 

frequency greater than 2400 kCPM are only supported on the 

Microlog AX using the USB connection.  If these POINTs are 

transferred to a non-AX Microlog, the lines and end frequency will 

be set back to the maximum supported by the unit. 

If you have configured any of these POINT types or settings, you must use a USB 

connection when transferring data to or from the Microlog to include these options. 

To Set Up the Microlog for Data Transfer: 

 Connect the Microlog to the host computer through the Microlog Support Module.  

Reference your Microlog User Manual for specifics. 

 Turn on the Microlog. 

 In @ptitude Analyst, select Microlog Analyzer from the Transfer menu.  The 

Microlog Analyzer screen displays.   
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 The software automatically checks for a connection between the host computer and 

the Microlog .  An alert dialog displays if there is a connection error.  

Important – If the Microlog’s internal clock does not match your system clock, @ptitude 

Analyst will reset your Microlog’s clock as soon as communications are established. See 

the SKF @ptitude Analyst Installation Manual for more details on this configuration. 

 This screen appears if the communication settings have not yet been configured, or 

if prior settings are not currently working. Click OK at the message to continue. 

Refer to the Communication heading, later in this section, for instructions on setting 

up the connection. 

 If you are using a serial connection, the software's auto detection 

capabilities will alert you of connection status. 

 If you are using a modem connection, you must select the proper 

modem type. 

 For first time use, you must install the modem in the 

Communications tab of the Microlog screen.  You need only to 

install the modem once.  The screen opens after initial modem 

installation and will either automatically dial out (in Originate 

mode), or will wait for the Microlog to dial in (in Auto Answer 

Mode). 

 Appropriate error messages display if the modem connection is 

not successful. 

 Check the screen’s Status tab to compare the Microlog's current hierarchy to the 

current @ptitude Analyst hierarchy.  If there is a hierarchy discrepancy, an error 

dialog appears when the download process is initiated. 
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Download to DAD 

 

Figure 3 - 5. 

The Microlog Screen’s Download to DAD Tab Displaying Tree View. 

Items available for download appear in the tab's Select items to download window.  

You can download items from the Hierarchy, ROUTEs, and Workspaces directly using 

Tree View or select one or more ROUTEs using ROUTE View by clicking the item’s 

check box. 

Tree View 

Select items to download in Tree View: 

 A checkmark in the checkbox indicates all items in the Hierarchy, ROUTE, or 

Workspace are selected. 

 A grey checkmark indicates some items are selected. 

 No checkmark indicates no items are selected. 

 By default, only Hierarchies, ROUTEs, or Workspaces associated 

with the primary hierarchy display for download in Tree View.  To 
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display all Hierarchies, ROUTEs, or Workspaces associated with all 

open hierarchies, you must enable the Allow multiple hierarchy 

support on DADs option on the Customize / Preferences / 

General tab. 

ROUTE View 

 

Figure 3 - 6. 

The Microlog Screen’s Download to DAD Tab Displaying ROUTE View. 

ROUTEs are organized into six categories; ROUTE Name, Due Date, Schedule Date, 

Last Download Date, Overdue Status, and Hierarchy.   

 Only complete ROUTEs may be downloaded.  To download 

individual POINTs, select them from Tree View. 

 By default, only ROUTEs associated with the primary hierarchy 

display for download in ROUTE View.  To display all ROUTEs 

associated with all open hierarchies, you must enable the Allow 

multiple hierarchy support on DADs option on the Customize / 

Preferences / General tab. 
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Download Options 

There are three Download Options: 

Force spectrum collection 

Forces spectrum collection on every overall measurement.  Use for baseline 

data collection and/or data collection before or after a machine overhaul (when 

collected spectra are necessary for every POINT). 

Download spectral bands 

Available only when downloading to a CMVA Series Microlog with firmware 

version 3.30 or newer, or a Microlog GX or AX.  Use this feature to download 

spectral band alarms for the downloaded POINTs. 

Download FAM information 

Available when downloading to a CMVA Series Microlog with firmware version 

3.80 or newer.  Use this feature to download bearing fault frequency 

information associated with the downloaded POINTs. 

 Not applicable to Microlog GX or AX. 

Hierarchy Name 

If you select items directly from the Hierarchy list, they will appear as a specially named 

ROUTE in the Microlog. 

 Assign a unique name in the Hierarchy Name text field for identification purposes. 

Download button 

 Click to begin the download.  The download progress displays in the progress bar. 

Upload from DAD 

After you have completed collecting data, re-connect the Microlog and establish 

communications using the same procedure described earlier for downloading. 

Important – If the Microlog’s internal clock does not match your system clock, @ptitude 

Analyst will reset your Microlog’s clock as soon as communications are established.  

The transaction service can also be configured to adjust the dates and times of any 

measurements being processed, provided those measurements’ dates and times fall 

outside the configured tolerance period. The software can be configured to create a new 

Event Log record and/or POINT Notes entry reflecting each adjustment. 

See the SKF @ptitude Analyst Installation Manual for more details on the configurations 

mentioned above. 
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Figure 3 - 7. 

The Microlog Screen’s Upload from DAD Tab. 

Select items to upload or remove – Displays all ROUTEs currently stored in the 

connected Microlog .   

 Select the ROUTE(s) you wish to upload or remove (multiple selections are allowed). 

 By default, only ROUTEs associated with the primary hierarchy 

display for upload.  To display all ROUTEs associated with all open 

hierarchies, you must enable the Allow multiple hierarchy 

support on DADs option on the Customize / Preferences / 

General tab. 

Brute Force 

 After selecting which ROUTEs to upload, use the Brute Force check box to select 

whether to use brute force to create new hierarchy POINTs for the uploaded data. 

 Orbit / SCL, Triax (3-Channel), and 2-Channel POINTs will only be 

created if you are communicating using a USB connection. 

A Brute Force upload creates new POINTs (beneath a Non-ROUTE set in the hierarchy) 

for all uploaded collector POINTs (even if the uploaded POINTs already exist in the 

hierarchy) and uploads all data into these new POINTs. 
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If multiple hierarchy support is disabled, a Brute Force upload overrides this setting and 

all ROUTEs currently stored on the DAD are uploaded to @ptitude Analyst, even if they 

are from different hierarchies. 

Upload Measurement History - When data is collected on the Microlog for a POINT 

that already has a stored measurement, there is an option to append the new 

measurement.  If a new measurement is appended, the original measurement is added 

to an historical data file.  Enable this check box to include historical measurements in 

the upload.  Disable it to only upload the most recent measurement for each POINT. 

To Upload Data: 

 Click the Upload button to initiate the upload process.  POINTs are automatically 

processed into the hierarchy after the upload.  Process status displays on the status 

bar. 

To Remove ROUTEs from Microlog: 

 Select ROUTEs you wish to remove and click the Remove button. 

 You may remove ROUTEs from the Microlog if you are using a 

CMVA series Microlog with firmware version 3.52 or newer, or a 

Microlog GX or AX.   

Reset 

 To clear collected data for selected ROUTEs in the Microlog , select the ROUTEs 

you wish to clear and click the Reset button. 
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Status 

The Status tab displays the connected Microlog’s status, and compares the Microlog’s 

current hierarchy with the current @ptitude Analyst hierarchy.  Status information 

appears in the Device status information window. 

 

Figure 3 - 8. 

The Microlog Screen’s Status Tab. 

The tab’s Configuration Parameters area provides options to determine the system 

and frequency units to send to the Microlog when the Config or Clear buttons are used. 

This area also allows you to select operator sets and download them to the DAD using 

the Clear and Reset buttons. 

System Units – Select English or Metric. 

Frequency Units – Select CPM or HZ. 

Operator sets – Select an operator set from the drop down list.   

 Click the View Sets button to view all operators assigned to the selected 

operator set. 
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 Select a set from the drop down list.  All operators included in the selected set 

display in the Operators area.   

Device status information includes: 

Internal Clock – Date and time from the Microlog ‘s clock. 

Data Source – The name of the source hierarchy for POINTs currently stored in the 

Microlog . 

POINTs Downloaded – Number of POINTs currently stored in the Microlog . 

Version – The Microlog firmware version number. 

Free RAM – The percent of the Microlog‘s memory that is free for storage. 

Internal Temperature – The Microlog‘s internal temperature (CMVA series only). 

Battery – The Microlog ‘s battery voltage level. 

Serial Number – Available only with a Microlog GX or AX. 

Three command buttons appear in this tab.  They are: 

Config – Use this option to change hierarchies, or when the Microlog ‘s internal clock is 

incorrect.  It updates the Microlog ‘s status information to match those of the host 

computer. 

Clear – Use this option to clear the entire Microlog .  It erases all data, SETs, Machines, 

POINTs, ROUTEs, ROUTE Instructions, non-ROUTE POINTs, coded notes, and operator 

names stored in the Microlog.  All existing operator names are removed and replaced 

with the operators in the selected operator set.  It does not change the Microlog ‘s menu 

settings. 

Reset – Use this option to clear collected data but leave the downloaded SETs, 

Machines, and POINTs.  It deletes all spectral data, deletes all non-ROUTE POINTs and 

measurement data, and resets the current measurement data to zero for all POINTs 

(current values are retained as LAST values).  ROUTEs, SETs, Machines, and POINT 

sequence and measurement instructions are not affected.  This allows you to take data 

for a ROUTE, upload it, reset the data out of the Microlog without losing the ROUTEs, 

SETs, Machines, or POINTs, and then take data on the same ROUTEs, SETs, Machines, 

or POINTs again.  The reset option also downloads all operator names within the 

selected operator set to the Microlog. 
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Communication 

Communication options control communication between the software and the Microlog.  

Configure communication settings in the Communication tab. 

Connection settings include: 

Communication type – Used to specify how the Microlog communicates with the 

software.  Options include: 

Serial – for direct, hard-wired connection between the Microlog and the host 

computer via serial ports. 

Modem Originate – Used for modem connections over communication lines 

between the Microlog and the host computer in attended mode.  To make the 

connection, the host computer operator dials the Microlog via the Reconnect 

button. 

Modem Auto Answer – Used for modem connection over communication lines 

between the Microlog and the host computer in attended mode.  To make the 

connection, the Microlog dials in to the host computer while the host 

computer's modem is in waiting mode. 

Active Sync – Used to communicate using Microsoft’s ActiveSync (via USB, 

serial, or TCP/IP). 

 Selecting ActiveSync communication type disables the Port and 

Serial Baud Rate drop-down lists.  Use ActiveSync’s Connection 

Settings to configure communication parameters. 

 Refer to Microsoft.com for more information about ActiveSync 

communication. 

Port (COM1, COM2, COM3, COM4) – Used with Serial and Modem communications to 

specify the host computer's COM port you are using. 

Serial Baud Rate – Used with Serial and Modem communications to set the baud rate 

for direct, hard-wired communications.  This setting must match the Microlog’s Baud 

Rate setting. 

Phone number – Used in Modem Originate mode to dial a Microlog in a remote 

location.  Enter the phone number of the modem on the Microlog-end of the modem 

link. 

 If you are communicating via modem, click the Modems button to launch your 

computer’s modem dialog.  The dialog allows you to install a new modem or set up 

the existing modem on your computer.  Refer to your modem manual for 

instructions on installing the modem. 

 The Modem dialog may also be launched from the control panel. 

 Click the Reconnect button to renew the connection between the Microlog and the 

host computer using the current settings on the Communication tab.  If the 

connection is successful, the title bar in the Microlog dialog in @ptitude Analyst 

changes to Microlog Ready, and the Microlog displays a generic communications 

indicator on its screen. 
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 If the title bar of the Microlog dialog displays Microlog not 

responding after clicking Reconnect, verify that the DAD is 

properly connected using the selected Communication Type and 

that all communication settings are correct. 

 Reconnecting is only necessary if you change communications 

settings.  Once the communication options are set, the connection 

is established as soon as you open the Microlog dialog from the 

Transfer menu. 

 The Reconnect button is only available when this tab is accessed 

from the Microlog dialog.   

 Click OK to save changes, or Cancel to discard changes.  

Coded Notes 

Coded notes are a list of common machinery notes automatically transferred from 

@ptitude Analyst to the DAD to enable quick and easy notation during data collection.  

Create your coded notes in the Customize / Database screen’s Coded Notes tab. 

Previously defined coded notes appear in the tab’s Coded notes area.  

IMPORTANT 

Never edit the hierarchy’s Coded Notes list unless you intend to immediately re-

download to all affected DADs.  If coded notes stored in DADs do not sync up with 

the hierarchys Coded Notes list, the wrong notes will be uploaded. 

To add a new coded note: 

 Click the Add button. 

 Enter descriptive text in the Note field and click the Save button. 

To remove an existing coded note: 

 Select the coded note. 

 Click the Remove button. 

 The coded note, “Machine Not Operating” may not be removed. 

Manual Data Entry 

Use the Insert menu's Manual Entry option to manually enter overall measurement 

values into your @ptitude Analyst hierarchy.  This feature allows you to store, trend, 

and analyze measurements made with the SKF Pens (VibPen Plus, SEE Pen, and 

ThermoPen).  Also, other machinery operating conditions such as flow, speed, and 

pressure can be manually entered and trended.  The Manual Entry screen allows you 

to manually type in one overall value per POINT. 
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Figure 3 - 9. 

The Manual Entry Screen. 

To manually enter data: 

 Select a POINT from the Items area.  

 Type in the value in the Measurement data field(s). 

 The Measurement data section varies depending on the type of 

POINT that is selected. 

 Click the Set button. 

 By default, the current date / time is applied to the entered POINT 

value.  Select desired date and time from the drop down menus 

to edit these fields as needed. 

 To quickly enter multiple values that all use the default Date / 

Time, simply click the Value field, type the value and press Enter.  

The value is stored and the pointer moves to the next item’s 

Value field. 

To clear entered data: 

 Select a measurement with a set value and click the Clear button. 

 Click OK to store the specified values and automatically re-process alarms, or 

Cancel to undo settings. 
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Displaying Graphic Plots 

Overview 

After uploading your measurement data to @ptitude Analyst, you can easily display the 

collected measurements in various plot formats for machinery analysis purposes. 

Graphic Microlog plot formats include: 

 Trend 

 Spectrum 

 Trend/Spectrum 

 Time 

 Trend / Time 

 Trend/Spectrum/Time 

 Spectrum Waterfall 

 Polar Vector 

 Mag/Phase Trend 

 Mag/Speed Spectrum 

 Mag/Speed/Time 

 Orbit 

 Shaft Centerline 

 Band Trend 

 Extracted Trend 

 Extracted Band 

 Contribution/Profile 

 HAL Trend 

 Although Nyquist, Bode, Cascade, and Topology plots are also 

available for Microlog POINTs, they primarily apply to transient 

data.  They are documented in Chapter 8, Transient Data 

Analysis, in the SKF @ptitude Analyst for SKF Multilog On-Line 

Systems manual [PN 32296700]. 



Displaying Graphic Plots 

How To Display Graphic Plots 

4 - 2  SKF @ptitude Analyst for SKF Microlog Analyzer 

  User Manual 

How To Display Graphic Plots 

@ptitude Analyst offers multiple methods for displaying measurement data in plot format.  

Each method has its advantages.  However, regardless of the selected method, the first 

step in displaying plots is to open any view that contains POINTs (Hierarchy, ROUTE, 

Workspace, Plot, and Alarms view).  The second step is to select the measurement 

POINT(s) whose data you wish to display in plot form.   

Then use one of the following methods for displaying measurement data in graphic plot 

format. 

 The File menu's Print option may be used at any time to print the 

contents of the “active” window (including graphic display 

windows). 

Displaying Plots Using Toolbar Buttons 

@ptitude Analyst has toolbar buttons for commonly used plots. 

 

Figure 4 - 1. 

Plot Toolbar Buttons (Shown Here as Two Columns). 

 To select multiple POINTs for display in a single plot, you must 

first select the machine in which the POINTs list in the hierarchy’s 

left panel, then select the desired multiple POINTs in the 

hierarchy’s right panel. 
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 To select POINTs from multiple machines, you must first copy the 

desired POINTs to a Workspace window. 

To display graphic plots using the toolbar: 

 Select (highlight) the POINT(s) you wish to display in the Hierarchy, ROUTE, 

Workspace, or Alarms windows. 

 Click one of the toolbar's graphic display buttons to display the selected POINTs or 

measurement(s) in a specific type of plot. 

   
Click the All Plots toolbar button to display the All Plots dialog.  From this dialog, 

you may select the plot type to display from all available plots, rather than only the 

commonly used plot types represented with toolbar buttons. 

 Different plot display toolbar buttons may be manually added or 

removed using the Customize menu’s Toolbars option.  Custom 

toolbars are detailed in Appendix A, SKF @ptitude Analyst 

Toolbars. 
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Displaying Plots Using the View Menu 

View menu graphic display operations are similar to toolbar button graphic display 

operations. The View menu allows you to display every graphic plot type that applies to 

the selected POINT(s).   

 

Figure 4 - 2. 

The View Menu’s Plot Option. 

To display graphic plots using the View menu: 

 Highlight the POINT(s) you wish to display in the Hierarchy, ROUTE, Workspace, or 

Alarms windows. 

 Select the View menu’s Plot option.  Select one of the visible plot types, or select 

All Plots for more selections.  All plot types display in the dialog.   
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Displaying Plots Using the POINT’s Context Menu 

You can also display a plot directly from selected single or multiple POINTs using the 

context menu.   

To display a plot using the context menu: 

 Select POINT(s) from a Hierarchy, ROUTE, Workspace, or Alarm window. 

 Using your mouse, right click to activate the context menu. 

 

Figure 4 - 3. 

The Hierarchy Context Menu’s Plot Option. 

 Select the desired Plot type.  The selected plot type displays in a plot window for 

the selected POINT(s). 

 You can also use the right-click context menu to display a plot 

directly from a selected single measurement data record or 

multiple measurement data records. 
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Plot Window 

The Plot window displays collected measurements in various graphic plot formats for 

machinery analysis purposes.  

 

 

 

 

Figure 4 - 4. 

Plot Window. 

 cursor feedback  various overlay tabs 

 mouse feedback  active overlay   

 inactive plot line  inactive overlays 

 active plot line  right-click context menu 

 running speed anchor   

Plot Window Overview 

The Plot window’s title bar displays the plot type displayed for the current POINT.  The 

Machine name (from the hierarchy) corresponding to the POINT displays in front of the 

POINT name (for a single POINT).  The Machine and POINT name display in the plot 

window’s top center area for all plots.  The date / time stamp and overall value display 

for spectrum and time plots.  Multiple POINTs are not individually identified. 

There are two areas in the Plot window.  The top area is the plot area.  The lower part 

is the information area. 

 You may re-size the entire Plot window, and/or either of the 

window's areas, for customized viewing.  You may also hide the 

information area automatically (using Preferences) or manually 

(using the toolbar or context menu). 

 The status of the information area affects plot print-out.  If a plot 

is printed when the Info tab is displayed, the Info tab’s 

information prints along with the plot.  If a plot is printed when 
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the Info tab is hidden, the Info tab’s information does not print 

with the plot. 

Plot Window Information Area  

 

Figure 4 - 5. 

The Plot Window Information Area. 

The information area’s tabs display various plot information for the active plot.   

Info tab – Displays general information for the active plot.  

Summary tab – Displays measurement summary information for all POINTs displayed 

on the plot.   

Plot type tab (Trend, Spectrum, etc.) – Displays information for each single cursor on 

the active plot.   

Other tabs appear in the information area depending on the type(s) of overlay(s) used 

on the current plot, and display information specific to each overlay type. 

Plot Feedback Areas  

 

Figure 4 - 6. 

Plot Feedback Areas. 

 feedback areas 

The first line displays information corresponding to the active cursor overlay’s current 

position. 

The second line displays information corresponding to the mouse pointer’s current 

position (when positioned over a plot item). 
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Plot Window Operations 

Mouse Operations 

There are several ways to work within the Plot window.  The mouse can be used to 

display specific plot information.  The mouse’s pointer changes to an up arrow () when 

placed over a plot item.  Typical plot items include overlay, plot line (trace), anchor, any 

object with feedback information, and context menus. 

Overlays 

Plot “overlays” superimpose cursors, alarms, text annotations, and frequency markers 

on displayed plots.  Each overlay displays an “anchor” which you use to manipulate the 

overlay. 

Anchors 

Anchors indicate overlays and plot lines on the active plot.  Anchors also identify the 

active status of an overlay and plot line (trace). 

The Active plot line anchor is indicated using a triangle icon.  Plot line anchors 

display on the plot’s left. 

The Active overlay anchor is indicated using a square icon.   Active overlay 

anchors indicate which plot’s data is displayed using the plot’s color in the 

overlay’s square icon.   

Inactive plot line and overlay anchors are indicated using circle icons. 

 Double-click an overlay’s anchor to switch it to another plot.   

Some overlay anchors appear at the top of the plot, others appear to the plot’s right.  

Band cursor, harmonic cursor, sideband cursor, and single cursor anchors display 

across the top of the plot, directly above their respective overlays.  Band alarm, 

envelope alarm, frequencies, curve fit, overall alarm, and peak cursor anchors display 

on the plot’s right.  The running speed anchor displays beneath the plot. 

Many anchors indicate overlay position in respect to the plot’s X and/or Y axis.  Anchors 

provide easy access to the plot item’s right-click context menu.  For example, to access 

the settings dialog for your frequencies overlay, right-click on the frequency overlay 

anchor to launch the frequencies Settings dialog. 

If two or more traces are displaying on a plot and an overlay is added to the plot, it 

automatically attaches itself to the active plot line (trace). 

Text annotations (temporary textual notations ) may be placed anywhere on the plot. 

Text annotations do not have anchors. 
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Figure 4 - 7. 

Text Annotation Example. 

Plot Line (Trace) Right-Click Context Menu 

Position the cursor over the plot line and using your mouse, right-click to access the 

plot line context menu.  Menu options include: 

Lock Trace – Enable this option to “lock” the selected plot line data so it will 

remain visible when auto linking is used.  This allows you to compare the 

“locked” plot line data to the new data that is added or removed when 

autolinking is used. 

Remove – Removes trace from plot. 

Properties – Displays POINT Properties screen for the plot’s active POINT. 

Go to Hierarchy – Displays the Hierarchy window with the selected hierarchy 

item highlighted for easy identification. 

Priority – Assign a priority level to the Machine the POINT is under. 

Plot Right-Click Context Menu 

Position the cursor over the plot background and using your mouse, right-click to 

access the plot context menu.  Menu options include: 

Plot Specific Options – Plot options display in the menu’s top area (if 

available), allowing you to configure the plot’s content.  Which options appear 

(if any) depends upon the current plot type.   

For example, you can convert the units in an acceleration, velocity, or 

displacement spectrum plot.  Unit types display in the menu’s top area and are 

available for selection. 
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Settings – Launches the Settings screen for the current plot type.  This screen 

allows you to change the way the plot displays.  For example, use the Settings 

screen to change axis ranges. 

Reset Settings – Resets to default plot settings.  Use Reset Settings to clear 

all settings you made and reset the plot window based on its current content. 

Copy – Copies the plot image to the clipboard. 

Info Area – Show / Hide the current plot’s information area. 

 Square icons on a trend plot line indicate the measurement is 

included in calculations for mean and standard deviation (as in the 

Info tab) and statistical alarm generation.  Use the single cursor's 

context menu or Measurement Properties to change the 

“include” status. 

Overlay Anchor Right-Click Context Menu 

The Overlay anchor right-click context menu provides quick access to the overlay’s 

options (e.g. Remove the overlay, or if more than one trace is displayed, move the 

overlay to the Next Trace, etc.) 

Drag and Drop Operation 

Drag and drop operation allows you to easily display plots for different measurements.  

These measurements can belong to the same POINT, or to different POINTs.  By 

default, when the POINT is selected, the plot is displayed for the POINT’s last 

measurement.  The drag and drop feature allows you to override this default setting 

and display specific measurements on the plot. 

You can also drag and drop to view multiple POINTs on the same plot.  Simply drag the 

desired POINT(s) and/or measurement(s) into the open plot window.  

 Some plots combine multiple plot types in one window for side-

by-side comparison.  In most cases, you may only drag and drop 

into the primary plot (i.e., the top plot area). 
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Multiple Measurements and Channels in Plots 

You may have multiple measurements from one or more POINTs represented in a plot, 

either by selecting them when opening the plot, or by dragging and dropping additional 

measurements onto an open plot.   

It is also possible to have multiple channels represented on a plot for multi-channel 

POINTs.  When you access a plot from a multi-channel POINT, the Plot Preferences 

Channel Number setting specifies whether all channels open automatically, only 

channel X opens, or the Select Channel Number dialog displays where you may select 

a single channel or All Channels.  

 If Auto Link is turned on, this setting is overridden and all 

channels display.  

 

Figure 4 - 8. 

The Select Channel Number Dialog. 

If all channels open, each channel is treated as a separate measurement on the plot. 

Depending on your plot type, multiple measurements may overlay each other (e.g., 

spectrum and time plots) or may be represented as individual data points on the plot 

(e.g., waterfall and trend plots).  

A plot anchor is located on the left of the plot for each measurement.  Depending on the 

plot type, the anchors are color-coded to match the data.   

Inactive plot line and overlay anchors are indicated using circle icons. 

The Active plot line anchor is indicated using a triangle icon.   

In the case of plots that are designed to display multiple measurements (e.g., waterfall 

and trend plots), all measurements under the same POINT are included in one plot 

anchor.  Separate plot anchors only appear if you have multiple POINTs or channels 

represented in the plot.   

For combination plots (e.g., Trend / Spectrum), the channel anchors only toggle the 

channel on the top plot.  To toggle the channels on additional plots, click the single 

cursor overlay anchor. 

The active measurement determines the cursor feedback and information window's 

content and overlay settings.  You may toggle between the measurements by clicking on 

the appropriate anchor.   
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Zoom Operation 

The zoom operation allows you to easily zoom in and out on the plots for a closer look.  

You may zoom in and out one of two ways: 

 Using the zoom buttons on the toolbar 

 Using the mouse scroll wheel 

To zoom in / out on a plot using the zoom buttons: 

 

Figure 4 - 9. 

Zoom Buttons. 

 activates zoom 

 zooms out 

 Activate the zoom by clicking the left magnifying glass.   

 Click and drag across the area of the plot to which you would like to zoom.   

 Click the right magnifying glass to zoom out. 

To zoom in / out using the mouse scroll wheel: 

 Position your cursor over the area of the plot to which you would like to zoom. 

 While holding the Ctrl key, roll the mouse scroll wheel up or down.  Rolling up 

causes the plot to zoom in, while rolling down causes the plot to zoom out. 

Plot Navigation 

While viewing a plot, use the arrow keys on your keyboard to navigate to the next / 

previous measurement on the plot or to the next / previous POINT’s plot.   

To navigate to the next / previous measurement on the plot: 

 While holding the Ctrl key, press the left arrow to display the previous 

measurement, or press the right arrow to display the next measurement. 

To navigate to the next / previous POINT’s plot: 

 While holding the Ctrl key, press the up arrow to display the plot for the previous 

POINT, or press the down arrow to display the plot for the next POINT. 

Set Speed (Multiple) 

Use the Set Speed (Multiple) feature to set the same measurement speed for multiple 

FFT measurements. 

 Starting from an FFT measurement plot, right-click on the single cursor and select 

Set Speed (Multiple) from the resulting context menu.  

The Set Speed (Multiple) window appears. 
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Plot Types 

Machinery measurements can be displayed in a variety of graphic display formats that 

aid machinery analysis.  Each graphic display type is detailed below. 

For each type of graphic display, @ptitude Analyst provides settings to manipulate the 

plot display and to gain valuable analysis information.  These settings dialogs are 

available from the @ptitude Analyst View menu and from the toolbar (which changes 

according to the active plot display type).  Each plot’s settings dialogs are also detailed 

below. 

 This section does not document Nyquist, Bode, Cascade, or 

Topology plots.  Although these plots are available for Microlog 

POINTs, they primarily apply to transient data.  They are 

documented in Chapter 8, Transient Data Analysis, in the SKF 

@ptitude Analyst for SKF Multilog On-Line Systems manual. 

Trend Plot 

 

Figure 4 - 10. 

Example of a Trend Plot. 

Trend plots allow you to easily compare a POINT’s most recent reading against its 

previous readings and its alarm set up, allowing you to see how the POINT is “trending” 

over time.  Trend plots are an easy and accurate method of detecting gradual changes 

in process conditions and changes that might otherwise be overlooked. 

In addition to displaying trend plots for individual POINTs, you can display multiple 

POINTs' trends (from the same machine or from different machines) in one graphic 

display window.  This allows easy comparison between various POINTs' trends. 

In a trend plot, the X axis (horizontal axis) represents time and the Y axis (vertical axis) 

represents magnitude. 
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 Square icons on a trend plot indicate the measurement is 

included in calculations.  Use the single cursor’s context menu or 

the Measurement Properties screen to change the “include” 

status. 

Trend Settings 

To access the Trend Settings Screen: 

 With a trend plot displayed, select the View menu’s Plot/Settings option, use the 

settings toolbar button, or right-click to display the plot’s context menu and select 

the Settings option. 

Magnitude scale fields include: 

Autoscale - Enabling Autoscale automatically scales the initial amplitude axis so it is 

approximately 120% of the largest amplitude.  Disabling Autoscale displays the 

spectrum on the same full scale vertical axis used when it was recorded.  

% Full Scale - When enabled, the amplitude axis displays as a % value of the POINT’s 

full scale value.  Use % Full Scale to compare measurements that do not have the same 

units or the same Full Scale value. 

 If you do not select Autoscale or % Full Scale, you must enter 

values to determine the plot’s magnitude scale (Y-axis scaling). 

Magnitude Scale - Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

Date / Time scale fields include: 

Date / Time Scale - Enter minimum and maximum date and time. 

 With a plot displayed, to reset all settings back to their defaults, 

click the right-click context menu’s “Reset Settings” option. 

Adjust date/time range to include latest notes – When enabled, all notes created 

after the date / time of the last collected measurement display on the plot.  Default is 

enabled.   
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Spectrum Plot 

 

Figure 4 - 11. 

Example of a Spectrum Plot. 

As different types of machinery problems often occur at different frequencies, it is very 

useful to analyze measured vibration signals with respect to frequency. 

FFT spectrum plots (pl. spectra) display vibration amplitudes at various component 

frequencies. 

 FFT is the abbreviation for Fast Fourier Transform (the 

mathematical formula that transforms the vibration signal into its 

component frequencies). 

In an FFT spectrum, the X axis (horizontal axis) represents vibration frequency in Hz or 

CPM (or orders of running speed).  The Y axis (vertical axis) represents vibration 

amplitude. 

FFT spectrum plots are extremely useful machinery analysis tools.  FFT spectra provide 

information that helps determine the location of a problem, the cause of the problem, 

and with trending, how long until the problem becomes critical. 

In addition to single display, you can display multiple POINTs’ or measurements’ FFT 

spectra (POINTs may be from the same machine or from different machines).  This 

allows easy comparison between various POINTs' FFT spectra. 
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Spectrum Settings 

To access the Spectrum Settings screen:  

 With a spectrum plot displayed, select the View menu’s Plot / Settings option, or 

use the settings toolbar button. 

 The Settings screen is also available from the spectrum plot’s 

context menu. 

View Type fields include: 

Combined / Stacked - Determine the plot orientation for multi-channel data.  Stacked 

displays each channel as a separate plot.  Combined shows a single plot overlaid with all 

channels.  

Link - If View Type is set to Stacked, determine whether cursors and overlays are 

linked across all plots, or operate independently.  If Link is enabled, cursors and 

overlays appear in the same position across all plots.  If Link is disabled, you may add 

and move cursors and overlays in each plot independently. 

Magnitude scale fields include: 

Autoscale - Enable to automatically scale the initial amplitude axis so it is approximately 

120% of the largest amplitude.  Disable to display the spectrum on the same full scale 

vertical axis used when it was recorded.  

% Full Scale - Enable to display the amplitude axis as a % value of the full scale.  Use % 

Full Scale to compare measurements that do not have the same units or the same Full 

Scale value. 

 If you do not select Autoscale or % Full Scale, you must enter 

values to determine the plot’s magnitude scale (Y-axis scaling).  

Magnitude Scale - Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

You must enter values to determine the plot’s frequency scale (X-axis scaling) 

Frequency scale fields include: 

Frequency Scale - Enter the minimum and maximum frequency scale values in the 

designated text boxes. 

Frequency Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

 With a plot displayed, to reset all settings back to their defaults, 

click the right-click context menu’s Reset Settings option. 
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Spectrum Plot – Multi Channel 

For two channel and Triax POINTs, you have the option to display spectrum plots in 

either a Stacked or Combined view, based on preferences.  

 To view multi-channel spectrums in Stacked view, set the Layout Orientation / 

Spectrum Plot Preference to Stacked. 

 

Figure 4 - 12. 

Example of a Stacked Spectrum Plot with Unlinked Cursors / Overlays. 

In Stacked mode, each channel displays in a separate panel.  Depending on your Stack 

Mode plot preference, cursors and overlays on the plot may either be linked or unlinked.   

If Link is selected, cursors and overlays appear in the same position across all plots.  

Where applicable, overlay tabs in the information area provide a separate column for 

each channel (for example, Amp X, Amp Y, and Amp Z). 

If Unlink is selected, you may add and move cursors and overlays in each plot 

independently.  Where applicable, overlay tabs in the information area list overlay 

details for each channel on a separate line. 

 To view multi-channel spectrums in Combined view, set the Layout Orientation / 

Spectrum Plot Preference to Combined. 
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Figure 4 - 13. 

Example of a Combined Spectrum Plot. 

 Inactive channels 

 Active channel 

Combined spectrum plots overlap the data from each channel.  The channel indicators 

on the side of the plot are color-coded to match the spectrum data.  The active 

spectrum is shown as a triangle.  Toggle between the channels by clicking on the 

appropriate indicator.  The active channel determines the cursor feedback and 

information window's content and overlay settings.  
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Trend / Spectrum Plot 

 

Figure 4 - 14. 

Example of a Trend / Spectrum Plot. 

Trend/Spectrum Plots display both a trend plot and a spectrum plot for a trend record 

indicated by the single cursor position.  

Each single cursor on the trend plot has a corresponding spectrum data line, if FFT data 

is available.  Removing the cursor from the trend also removes the associated spectrum 

data line. 

The active plot (trend or spectrum) determines the information window’s content and 

overlay settings.   

All other trend and spectrum operations behave as described previously in the trend 

and spectrum plot descriptions. 

 Right-click on either plot to access the appropriate context menu. 

 See Trend Settings and Spectrum Settings for display parameters 

that can be modified to change the plot display. 
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Time Plot 

 

Figure 4 - 15. 

Example of a Time Plot. 

Time Plots display a short time sample of a raw vibration signal with vibration 

amplitude plotted over the time scale.  Current time plots are compared to past time 

plots to analyze changes in vibration amplitude or frequency.  

Each plot line represents a time waveform measurement for a single POINT.  You may 

configure the X-axis to display time in seconds or milliseconds.   

Time Plot Settings 

To access the Time Plot Settings screen: 

 
 With a time plot displayed, select the View menu’s Plot / Settings option, or 

use the settings toolbar button.  

 The Settings screen is also available from the time plot’s right-

click context menu. 

Magnitude Scale fields include: 

Autoscale - Enabling autoscale automatically scales the initial amplitude axis so it is 

approximately 120% of the largest amplitude.  Disabling autoscale displays the 

spectrum on the same full scale vertical axis used when it was recorded.  

% Full Scale - When enabled, the amplitude axis displays as a % value of the full scale.  

Use % Full Scale to compare measurements that do not have the same units or the 

same Full Scale value. 
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 If you do not select Autoscale or % Full Scale, you must enter 

values to determine the plot’s magnitude scale (Y-axis scaling). 

Magnitude Scale - Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

You must enter values to determine the plot’s time scale (X-axis scaling) 

Time Scale - Enter the minimum and maximum time scale values in the designated 

text boxes.  Select Seconds or Milliseconds.   

Sound Byte 

@ptitude Analyst's Sound Byte utility allows you to listen to sound data waveform 

through your computer's speakers or connected earphones. 

To utilize Sound Byte: 

 Select a POINT with saved time data and display its time plot. 

 
 Click the Sound Byte toolbar button, or select the Plot menu's Play Sound 

Byte option.  The Sound Byte utility launches, providing various playback 

options. 

Sound Byte Controls 

Play Time – Controls the play back period length.  To change the setting, highlight the 

displayed play back length value and type in a new value, or use the arrows to increase 

or decrease play back length.  The maximum play time is 10 seconds. 

RPM Multiplier – Controls the play back speed.  The range is 0.5 – 2, which is 

equivalent to playing the data back at half the running speed, or double the running 

speed. 

Cursor Update Speed – Controls the cursor update rate so the sound and cursor 

position are synchronized.  Use a lower cursor update speed setting if the cursor is 

slower than the sound.  To change the setting, click the drop down list and select the 

new cursor update speed. 

Volume – Controls the play back sound volume.  Click the slider bar and move up or 

down to increase or decrease the volume. 

 Click the Play button to generate sound from the vibration data, and listen to the 

waveform. 

 Click the Save button to save the sound data into a Windows ".wav" file. 

 Click the Exit button to exit the Sound Byte utility. 
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Trend / Time Plot 

 

Figure 4 - 16. 

Example of a Trend / Time Plot. 

Trend / Time Plots display both a trend plot and a time waveform plot for a trend 

record indicated by the single cursor (if available). 

The active plot (trend or time) determines the information window’s content and overlay 

settings.  Use a single cursor to view dynamic data for the measurement’s date and 

time.  Use multiple cursors to overlay dynamic data to visually display different data 

values. 

All other trend and time plot operations behave as described previously in the single 

trend and time plot descriptions. 

 Right-click on either plot to access the appropriate context menu. 

 See Trend Settings and Time Plot Settings for display 

parameters that can be modified to change plot display. 
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Trend / Spectrum / Time Plot 

 

Figure 4 - 17. 

Example of a Trend / Spectrum / Time Plot. 

Trend / Spectrum / Time plots display a point’s trend plot, spectrum plot, and time 

waveform plot.  The three plots display in three different panels.  The trend panel is the 

primary panel of the display.   

Use a single cursor to view dynamic data for the measurement’s date and time.  Use 

multiple cursors to overlay dynamic data to visually display different data values. 

All trend, spectrum, and time plot operations behave as described previously in plot 

descriptions.   

 Right-click on each plot to access its context menu 

 See Trend Settings, Spectrum Settings, and Time Plot 

Settings for display parameters that can be modified to change 

plot display. 
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Waterfall Plot 

 

Figure 4 - 18. 

Example of a Waterfall Plot. 

Three-dimensional Waterfall Plots display POINT’s historical spectra collected over time.  

Historical spectra may be displayed as either a waterfall plot or a palogram plot as 

configured in Plot Settings or Plot Preferences. 

In a waterfall plot: 

X axis = frequency (Hz / CPM, or orders of running speed) 

Z axis = date 

In a palogram plot: 

X axis = date 

Z axis = frequency (Hz / CPM, or orders of running speed) 

 The slant angle for palogram and waterfall mode may be modified 

in Plot Preferences, allowing further customization of the 

waterfall plot, including even spacing between spectra regardless 

of time interval between readings. 
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Waterfall Settings 

To access the Waterfall Plot Settings screen: 

 
 With a waterfall plot displayed, select the View menu’s Plot / Settings 

option, or use the settings toolbar button.  

 The Settings screen is also available from the waterfall plot’s 

right-click context menu. 

Waterfall Plot Settings fields include: 

View type - Select display configuration, Waterfall or Palogram. 

Waterfall - Three dimensional plot displaying a single POINT’s historical spectral data 

collected over time (frequency axis along bottom). 

Palogram - Shows a rotated historical spectrum displaying in a three dimensional 

format, allowing easy observation of trends at each frequency (date / time axis along 

bottom). 

Even Spacing - Enable to retain the date order, but space evenly for simple viewing. 

Date / Time Scale - Enter the minimum and maximum date / time scale values in the 

designated text boxes. 

Magnitude Scale - Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

Frequency Scale - Enter the minimum and maximum frequency scale values in the 

designated text boxes. 

Frequency Lin / Log - Select Linear scaling to space out data equally. Select 

Logarithmic scaling to emphasize lower values. 
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Polar Vector Plot 

 

Figure 4 - 19. 

Example of a Polar Vector Plot. 

Polar Vector plots show vibration amplitude and phase.  Phase is the angular difference 

between a known mark on a rotating shaft and the shaft’s vibration signal.  This 

relationship provides valuable information on shaft orbit and shaft position and is used 

for analysis, balancing, and shaft orbital analysis. 

The newest measurement for the current data line is indicated by an asterisk ( * ). 

 Access the right-click context menu anywhere on the polar vector plot to change 

order view, copy, reset settings, and turn amplitude labels on or off. 

Polar Vector Settings 

To access the Polar Vector Settings screen: 

 
 With a polar vector plot displayed, select the View menu’s Plot / Settings 

option, or use the settings toolbar button.  

 The Settings screen is also available from the polar vector plot’s 

context menu 

Polar Vector Settings fields include: 

Full Scale - Enter full scale amplitude 

Order - Select order from drop down menu (1-4). 
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Mag / Phase Trend 

 

Figure 4 - 20. 

Example of a Mag/Phase Trend Plot. 

Mag/Phase trends plot the amplitude (top) and phase/angle (bottom) aligned by the 

measurement date.  Mag/Phase trends may be used to determine if a machine’s 

mechanics are changing by analyzing the shifting in phase. 

Mag / Phase Settings 

To access the Mag / Phase Plot Settings screen: 

 
 With a mag/phase plot displayed, select the View menu’s Plot/Settings 

option, or use the settings toolbar button.  

 The Settings screen is also available from the mag/phase plot’s 

right-click context menu. 

Mag / Phase Plot Settings fields include: 

Date / Time Scale- Enter the minimum and maximum date / time scale values in the 

designated text boxes. 

Magnitude Scale - Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

Phase Scale - Enter the minimum and maximum phase angles in the designated text 

boxes. 

Order - Determines which frequency order of running speed to display (1X, 2X, 3X, 4X). 
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Mag / Speed Trend 

 

Figure 4 - 21. 

Example of a Mag / Speed Trend Plot. 

Mag / Speed trends plot the speed (top) and amplitude (bottom) aligned by the 

measurement date.  Mag / Speed trends may be used to determine if a machine’s 

mechanics are changing by analyzing the relationship between vibration amplitude and 

speed. 

 The speed value comes from the dynamic measurement.  If only 

the overall value is stored for a particular date / time, then there 

will not be a corresponding Mag / Speed trend value. 

Mag / Speed Settings 

To access the Mag / Speed Plot Settings screen: 

 
 With a mag / speed plot displayed, select the View menu’s Plot/Settings 

option, or use the settings toolbar button.  

 The Settings screen is also available from the mag / speed plot’s 

right-click context menu. 

Mag / Speed Plot Settings fields include: 

Date / Time Scale- Enter the minimum and maximum date / time scale values in the 

designated text boxes. 
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Speed Scale - Enter the minimum and maximum speed scale values in the designated 

text boxes. 

Magnitude Scale – Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

Mag / Speed / Spectrum Trend 

 

Figure 4 - 22. 

Example of a Mag / Speed / Spectrum Trend Plot. 

Mag / Speed / Spectrum trends display a POINT’s mag / speed plot and spectrum plot.  

The two plots display in two different panels.  The mag / speed panel is the primary 

panel of the display.   

All mag / speed and spectrum plot operations behave as described previously in plot 

descriptions.   

 Right-click on each plot to access its context menu 

See Mag / Speed Settings and Spectrum Settings for display parameters that can be 

modified to change plot display. 
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Mag / Speed / Spectrum / Time Trend 

 

Figure 4 - 23. 

Example of a Mag / Speed / Spectrum / Time Trend Plot. 

Mag / Speed / Spectrum / Time trends display a POINT’s mag / speed plot, spectrum 

plot, and time plot.  The three plots display in three different panels.  The mag / speed 

panel is the primary panel of the display.   

All mag / speed, spectrum, and time plot operations behave as described previously in 

plot descriptions.   

 Right-click on each plot to access its context menu 

See Mag / Speed Settings, Spectrum Settings, and Time Settings for display 

parameters that can be modified to change plot display. 
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Mag / Speed / Time Trend 

 

Figure 4 - 24. 

Example of a Mag/Speed/Time Trend Plot. 

Mag / Speed / Time trends display a POINT’s mag / speed plot and time plot.  The two 

plots display in two different panels.  The mag / speed panel is the primary panel of the 

display.   

All mag / speed and time plot operations behave as described previously in plot 

descriptions.   

 Right-click on each plot to access its context menu 

See Mag / Speed Settings and Time Settings for display parameters that can be 

modified to change plot display. 
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Orbit Plot 

 

 

  

Figure 4 - 25. 

Example of an Orbit Plot. 

 directional arrows 

 flash blank 

 X channel sensor location 

 Y channel sensor location 

 tachometer’s physical location 

 X Channel Time Plot 

 Y Channel Time Plot 

The Orbit plot displays the shaft’s most recent orbit data for the two input channels (X 

and Y).  Orbit plots can be used to show the movement of the shaft within the bearing. 

Orbit plot labels include: 

 - Indicates the direction the shaft is rotating.   indicates the shaft is rotating 

counterclockwise,  indicates the shaft is rotating clockwise, and  indicates the 

shaft is rotating bi-directional. 

T – Indicates the physical location of the tachometer sensor. 

X – Indicates the physical location of the channel X sensor. 

Y – Indicates the physical location of the channel Y sensor. 

Flash blank – Indicates the starting point of the rotation of the shaft.  A blank on the 

orbit plot precedes the dot for easier identification of the starting point. 
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Orbit Plot Settings 

To access the Orbit Plot Settings screen: 

 
 With an orbit plot displayed, select the View menu’s Plot/Settings option, or 

use the settings toolbar button.  

 The Settings screen is also available from the orbit plot’s right-

click context menu. 

Orbit Plot Settings fields include: 

Autoscale - Enabling autoscale automatically scales the initial orbit axis so it is 

approximately 120% of the largest orbit.  Disabling autoscale displays the orbit on the 

same full scale axis used when it was recorded. 

Mag. Min. / Mag. Max. - Enter the minimum and maximum magnitude scale values in 

the designated text boxes. 

Orbit settings 

Slow roll compensation – When the machine is shut down for maintenance, the shaft 

will rotate very slowly (1 – 400 RPM).  Enable the Slow roll compensation checkbox to 

allow the plot to compensate based on either the vector compensation or waveform 

compensation settings in PONT Properties (depending on the Filtering settings, below). 

 Press F2 on your keyboard when viewing the plot to toggle vector 

compensation on or off. 

Filtering – Allows you to display the orbit data for a specific frequency.  Choices are 

Raw, 1x, 2x, 3x.  If 1x, 2x, or 3x is selected with Slow roll compensation, the 

corresponding 1X, 2X, or 3X vector compensation settings on the Vector tab in POINT 

Properties are applied.  If Raw is selected along with Slow roll compensation, it uses 

the waveform measurement selected in POINT Properties.   

 Press F3 on your keybord when viewing the plot to scroll through 

the filtering options.   

Revolutions – Specify the number of revolutions to display on the orbit plot.  Choices 

are 1 revolutions, 2 revolutions, 3 revolutions, 4 revolutions, 5 revolutions, or All 

revolutions. 

 Press F4 on your keyboard when viewing the plot to scroll 

through the revolution options. 
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Shaft Centerline Plot 

 

Figure 4 - 26. 

Example of a Shaft Centerline Plot. 

The Shaft Centerline plot displays a trend of the shaft’s average centerline for Orbit 

POINTs.  Shaft centerline plots can be used to show the movement of the shaft within 

the bearing. 

Shaft Centerline Plot Settings 

To access the SCL Plot Settings screen: 

 
 With a Shaft Centerline plot displayed, select the View menu’s 

Plot/Settings option, or use the settings toolbar button.  

 The Settings screen is also available from the shaft centerline 

plot’s right-click context menu. 

SCL Plot Settings fields include: 

Autoscale - Enabling autoscale automatically scales the initial amplitude axis so it is 

approximately 120% of the largest amplitude.  Disabling autoscale displays the 

spectrum on the same full scale vertical axis used when it was recorded. 

Mag. Min. / Mag. Max. - Enter the minimum and maximum magnitude scale values in 

the designated text boxes. 
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Date / Time Scale- Enter the minimum and maximum date / time scale values in the 

designated text boxes. 

Tag – Allows you to display RPM tags on the plot.  Select either No Tag or RPM. 

Band Trend 

 

Figure 4 - 27. 

Example of a Band Trend. 

Band trends combine the spectrum and available band trends for the selected POINT.  

Band Trends are used to analyze the energy within the band to closely monitor that 

particular frequency range. 

To view a spectral band trend plot: 

 Select the POINT whose band trends you wish to display. 

 Select the View menu’s Plot / All Plots option.  The All Plots dialog displays. 

 Select the Band Trend option. 

Initially, all bands for the specified POINT display in the Band Trend display’s plots. 

To view specific bands / band trends: 

 On the display’s spectrum plot, right-click on the overlay “anchor” in the plot’s 

upper right corner and select the Settings option.  The Band Alarm Settings dialog 

displays. 
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Figure 4 - 28. 

Band Alarm Settings Dialog. 

POINT – Displays the selected POINT name. 

Available band alarms 

 Use checkboxes to enable and disable bands for display. 

In the plot window’s lower band trend plot, specified bands display along with band 

alarm overlays for one of the band trends.  Right-click on the trend’s overlay anchor to 

display the Next Trace’s band alarms. 

 On the band trend plot, position the cursor and mouse pointer and use feedback 

areas to analyze the plot. 

 Right-click on either plot to access the appropriate context menu. 

See Trend Settings and Spectrum Settings for display parameters that can be 

modified to change plot display. 
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Extracted Trend 

 

Figure 4 - 29. 

Example of an Extracted Trend Plot. 

Extracted trend plots display a trend plot of spectrum amplitudes at a frequency.  A 

waterfall plot shows which spectra are to be used.  The single cursor in the waterfall 

controls which frequency to plot in the trend.  In addition, the single cursor in the 

waterfall plots selects which spectrum is displayed in the spectrum plot.  The waterfall 

plot is the primary plot. 

 Right-click on each plot to access its context menu. 

See Trend Settings, Spectrum Settings and Waterfall Settings for display 

parameters that can be modified to change plot display. 
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Extracted Band 

 

Figure 4 - 30. 

Example of an Extracted Band Plot. 

Extracted band plots display a waterfall and extracted band plot.  The energy of the 

frequency within the band across the spectrum displays.  You may create and move the 

band while viewing, allowing you to analyze a particular component’s energy. 

 Right-click on either plot to access the appropriate context menu. 

See Trend Settings and Waterfall Settings for display parameters that can be 

modified to change plot display. 

HAL Trend 

The HAL trend plot can be viewed for any POINT that has: a) a defined Frequency set in 

the POINT Properties dialog and b) FFT data measurements. The POINT does not need 

to be in HAL alarm to view the trend.  

The HAL trend plot has the following characteristics: 

 Trend plot shows the HAI values calculated from the FFT data.  

 Each plot/data line in the HAL trend represents a frequency. 

 The selection of one or more frequencies can be displayed. 

 The HAL trend plot view supports individual POINT and multiple POINT trends. 

 You can right-click the active plot line (triangle) anchor and select View 

Frequencies from the context menu to exclude or include specific frequency 

plot/data lines. 
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 The cursor in a HAL trend plot is used to update the frequency display for that 

particular date and time. 

 You can drag and drop POINTs from the hierarchy into the HAL trend view to 

display all applicable HAL trends that are assigned to the same bearing type and 

same frequencies (BPFO, BPFI, etc.). 

 Standard trend plot functionality applies. 

 Live HAL trend plots are NOT supported due to processing time 

constraints and the need to recalculate the HAL values before the 

next live measurement. 

 If the HAI value for a frequency cannot be calculated, that frequency does not 

display on the plot. See About HAL Trend Plot Calculation Limitations below for 

details. 

About HAL Trend Plot Calculation Limitations  

Under specific limiting conditions, the HAI value for a frequency cannot be calculated or 

the calculation result is zero. When this occurs, a HAL trend plot for that frequency is 

not generated. The main benefit of these limiting conditions is to eliminate the display of 

trace lines that do not present coherent, useful information. 

 Derived point HAL calculations that return a non-calculation 

result will produce a non-collection measurement. 

The following terms are used in the table below: 

Fundamental Frequency = Multiplier x Running Speed 

Resolution = Fmax / (Number of Lines – 1 ) 

Harmonics = Fmax / Fundamental Frequency 

Base Energy = Sum (FFT values ) 

Average Base Energy = Base Energy / Number of Lines 

 

Reason a HAL Trend Plot Is Not 

Produced  

One or More Limiting Conditions Applied to the Calculation 

HAL Calculation Cannot Be 

Completed 

No FFT values in the measurement 

Number of Lines = 0 

Harmonics is greater than or equal to Number of Lines / 4 

HAL Calculation Results = 0 Harmonics is less than 1.0. 

All individual harmonic energy levels are less than Average Base 

Energy. 

Two additional limitations are enforced by Analyst to make the HAL calculation results 

meaningful for condition monitoring purposes.  

 One is a global preference setting, Maximum harmonics to use in HAL 

calculations. The default range is 4 to 50, but the maximum can be increased up 

to 500. 

 The other limitation is that the Fundamental Frequency cannot be in low frequency 

cut-off region. (Low freq. cutoff parameter displays on POINT Properties, Setup 

tab.) 

Information Area Displays 
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In the HAL Trend tab (which shows the values for the measurement where the single 

cursor is active), the column is blank for any frequency that could not be calculated (the 

FTF column in the example below). 

 

Figure 4 - 31. 

Blank FTF Column. 

In the Summary tab, frequencies for which HAI values could not be calculated display in 

the Not Calculated column, as shown below.  

 

Figura 4 - 32. 

Not Calculated Summary Column. 

To view historical HAL data in a trend plot: 

 From the hierarchy, select a POINT that meets the two requirements of having 

assigned frequencies and FFT data. 

 Right–click the POINT and select Plot > HAL Trend, OR click the HAL trend icon 

. 
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Figure 4 - 33. 

Path to Open a HAL Trend Plot. 

 

Figure 4 - 34. 

Example of HAL Trend Plot. 
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All HAL trends display in one trend plot.  Each frequency associated with the POINT 

displays a separate HAL trend line.  When a frequency has a sideband cursor, two 

trends are displayed for the sidebands: one for the right side and one for the left. 

 Click the Previous Frequency/Next Frequency buttons ( /

) or use the -/+ keys on your keyboard’s ten-key area to cycle 

through which frequencies are shown in the plot (all, each 

individually, etc.). 

Preference settings determine how many historical spectra are computed in the HAL 

trend. The preferences for all measurements are set in the Measurement tab (go to 

Customize > Preference > Measurement tab).  

 HAL Trend plot itself and the Summary tab show Units = HAI 

(harmonic activity index). 

 A plot line anchor represents a POINT and one of its channels 

(indicated as X, Y, or Z). A 3-channel POINT will display three plot 

line anchors, as shown below. 

 

Figure 4 - 35. 

Example of a 3-channel POINT Showing Three Plot Line Anchors. 

You can right-click the anchor at the upper left to open the context menu. Select View 

Frequencies to specify which frequencies to display in the HAL trend view. 
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Figure 4 - 36. 

Example of the Context Menu Accessible Via the Anchors. 

The View Frequency dialog opens, showing only available frequencies. 

 

Figure 4 - 37. 

View Frequency Dialog. 

In the View Frequency dialog, all frequencies associated with the POINT are listed with 

the Visibility set to Yes by default. You can deselect a checkbox to change Visibility in 

the HAL trend plot to No. Click OK to accept your changes. 

 The Show All and Hide All buttons enable setting all the 

frequencies as visible or not visible. 
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Figure 4 - 38. 

Example of HAL Trend Plot with Some Frequencies Changed to Not Visible. 

If you drag a single channel POINT into the HAL trend, it will add another plot line 

anchor. Similarly, dragging in a 2-channel POINT will add two more plot line anchors 

and a 3-channel POINT will add three plot line anchors. 

 The drag and drop feature does NOT check if the additional 

POINTs are assigned to the same bearings or frequencies. The 

View Frequencies dialog can be used to remove any frequencies 

that do not match the frequencies associated with the original 

POINT. 

Spectrum/HAL Trend Plot 

When a POINT with associated frequencies is selected in the hierarchy, you can view the 

Spectrum and HAL Trend plots together. The two plots interact so that the 

measurement and frequency selections made on one plot alter the data displayed on 

the other. This behavior is described below. 

When the Spectrum/HAL Trend plot opens, the spectrum is highlighted by default and 

the HAL trend below is disabled by default. 
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Figure 4 - 39. 

Example of a Spectrum/HAL Trend Combo Plot. 

The frequencies displayed in the spectrum plot control which frequencies are shown in 

the HAL trend plot. This includes the frequencies indicated with spectrum single cursor 

markers and the frequency markers shown by the frequency overlay. 

The Spectrum/HAL trend combo plot does not support the frequency selection menus 

that are available on the standalone HAL trend plot. Instead, the frequencies displayed 

in the HAL trend plot are controlled by the frequencies being called out in the spectrum 

plot. You can show or hide frequencies by using the methods described below. 

 To show all frequencies, click on the Frequencies  icon in the SKF @ptitude 

Analyst toolbar. The spectrum plot will show all the frequencies available. The info 

area is also updated and the FAM tab appears containing the details of the 

frequencies. 

 

Figure 4 - 40. 

Example of Spectrum Plot Showing all Available Frequencies with the Cursor on 7414B (SKF) BPFO. 

 You can change from one frequency to another by clicking the Next Frequency  

or Previous Frequency  icons in the toolbar. The frequency now displayed in 

the spectrum plot is reflected in the HAL trend also. 
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 To select a specific frequency (hiding the others), you can right-click on any 

frequency in the spectrum to open the Frequency Settings dialog. Enable the 

desired frequency (in this example, 7416B (SKF) BPFI) to show, and then click OK. 

 

Figure 4 - 41. 

The Frequency Settings Dialog. 

 The selected frequency is now the only one shown in the in the HAL trend plot. 

 

Figure 4 - 42. 

Example of Frequency Changed to 7416B (SKF) BPFI in the Spectrum/HAL Trend Plot. 

You can drag and drop an additional POINT on to the existing combo plot window in the 

same manner as other plot types. The additional POINT will display all HAL trends 

related to it. 
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Contribution/Profile 

A Note about Cyclic Time Averaging (CTA) 

CTA is a post process operation that operates on time waveform signals, creating an 

averaged waveform similar to a Synchronous Time Averaging (STA) measurement. 

Unlike STA, CTA does not require a trigger and can be computed on already acquired 

time domain signals.   

One of the best cases for using Cyclic Time Averaging is when an external trigger is not 

possible, or practical, such as when monitoring the inner shafts of a gearbox. The goal is 

to find out if there are damaged gear teeth on the gear without having to stop the 

machine and open it up for inspection. 

CTA uses only a single measurement to perform averaging. CTA can be performed on 

any time domain measurement as long as this measurement covers more than two 

revolutions of the defect source under study. Consider a measurement length of 10 

seconds (not uncommon in the paper industry) and a defect frequency of 5 Hz (200 

ms). One single measurement captures 10/0.2 = 50 cycles of the defect. CTA realigns 

the samples in the measurement so that they can be averaged to produce an improved 

signal waveform with reduced noise.  

In the Roundness Profile plot, the time domain is wrapped around each component 

frequency’s periodic cycle time. It can be seen that a damaged gear tooth generates a 

significant amount of high frequency vibration during initial contact with the mating 

tooth.  

The Contribution/Profile Plot 

The Contribution/Profile combo plot shows the contribution bar graph. The Trend plot in 

the bottom panel is a standard Trend plot that displays traces for selected points and 

channels. The Contribution (upper left panel) and Roundness Profile (upper right panel) 

plots display data for the point and channel indicated by the active Single Cursor on the 

trend plot.  
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Figure 4 -43. 

Example of Contribution/Profile Plot with Contribution Tab Below. 

The Trend Plot and Data Selection 

The Trend plot is the standard Trend plot so it supports the usual behaviors and 

overlays. It opens with a Single Cursor but additional Single Cursors can be added. 

The data selection process through the plots is as follows: 

 The Trend plot is the initial content driver. The active Single Cursor determines the 

data that displays in the Contribution plot.  When there are multiple Single Cursors 

on the Trend plot, only the active Single Cursor drives the Contribution plot. 

 Use the arrow keys to navigate among measurements. The Contribution plot 

updates to display data for the selected measurement. 

 The Contribution plot drives the content of the Roundness Profile plot based on the 

selected bar (either the CTA Overall or a Frequency). The CTA Overall bar is initially 

selected. CTA stands for Cyclical Time Averaging; CTA Overall applies specifically to 

the Contribution plot. 

 If the Single Cursor that currently drives the Contribution plot is 

removed, the Contribution and Roundness Profile plots will go 

blank and show the message: “There is no data available to 

display on the plot”. 

 The Contribution/Profile combo plot supports “live data” mode. 

Details are provided later in this document. 

 Only the Trend plot supports the zoom function. 
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The Contribution Plot 

As stated, the contribution plot displays data for the frequencies associated with the 

particular trace that is indicated by the active single cursor on the Trend plot.  The plot 

title presents the following elements: plot type as Contribution, Machine/Point name, 

Measurement date/time, and Channel. 

 

Figure 4 - 44. 

Example of a Contribution Plot Only. 

The data displays in bar chart format, showing the measurement value and vibration 

contribution by percent of the total (the x-axis) for each frequency (the y-axis). The top 

bar, labeled CTA Overall, represents the total of the selected frequencies associated 

with the POINT and therefore represents 100%. The overall value of the measurement 

is given at the right of the CTA Overall bar.  

The other bars show the names (up to 15 characters) of the frequencies selected for 

inclusion by the checkboxes on the POINT Properties > Frequencies tab. Each bar 

represents the relative contribution of a frequency; the label at the right provides both 

the measurement value and percent of the contribution to the overall. If more than 15 

frequencies are enabled on the Frequencies tab, only the first 15 (depending on the 

sort type) will display in the bar chart.  

Right-click in the Contribution plot to open the context menu. 

 

Figure 4 - 45. 

Contribution Plot Context Menu 

Settings… - open the Contribution Settings dialog. 

Reset Settings - reset changes made in the Contribution Settings dialog to the default 

settings. 
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Copy - copy the Contribution plot to the Windows clipboard. (This menu item appears in 

all plots.) 

Info Area – hide or show the Info Area. (This menu item appears in all plots.) 

Sort Frequency Bar by Name - sort the Frequency bars by the frequency name in 

ascending order.  

 The CTA Overall bar is not sortable and remains at the top.  

Sort Frequency Bar by % Contribution - sort the Frequency bars by the % contribution 

in descending order.  

To change the Speed Reference Time Window: 

 Select Settings… to open the Contribution Plot Settings dialog.  

 

Figure 4 - 46. 

Contribution Plot Settings Dialog. 

 You can change the Speed reference time window value and units. The maximum 

allowable value is 48 hours; this is equivalent to 2880 minutes or 172800 seconds. 

 Click OK to save the settings.  Any change you make applies only to the plot 

currently open; the global plot preference setting is not changed.  Bear in mind that 

the settings implemented in this dialog continue to be applied to this plot when the 

data changes (until the settings are changed manually again). 

The Roundness Profile Plot 

The Roundness Profile plot shows only one time waveform at a time.  The Roundness 

Profile plot is determined by the frequency bar selected in the Contribution section.  

Selecting a frequency bar (the color changes upon selection) updates the profile to show 

CTA(Fd) in a roundness plot.  The calculated statistics for the Contribution-derived time 

waveform are also displayed. 

 The Roundness Profile plot supports only the Linear Speed 

overlay 

The Roundness Profile plot is drawn as follows:  

 The circle angle represents the Time.  

– 0 degree is 0 second. 

– 360 degrees is the time for one revolution, using the specified speed reference. 

 Each circle represents the waveform amplitude.  

– The innermost circle is the minimum amplitude.  
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– The outermost outer circle is the maximum amplitude. 

– There are five circles for the max value, min value, mid level, a circle between 

the mid and max circles and another between the mid and min circles. 

 Traces for values outside the minimum and maximum values will be clipped. 

When first opened, the CTA Overall bar is selected in the Contribution plot and the 

Roundness Profile plot draws the whole raw time waveform, with each cycle 

representing one revolution. The plot line color matches the color of the CTA Overall bar 

in the Contribution plot. (Refer to the first example, Figure 2-1.) The plot title presents 

the following elements: plot type as Roundness Profile, Machine/Point name, 

Measurement date/time, Channel, and Overall value. The Machine/Point name, 

Measurement date/time, Channel, and Overall value reflect the data from the trace 

selected by active single cursor in the Trend plot. 

When a Frequency bar is selected in the Contribution plot, the roundness plot draws 

one revolution of the frequency time waveform. The plot line color matches the color of 

the selected Frequency bar in the Contribution plot. The plot title presents the following 

additional elements: the selected frequency name, RMS and speed.  

 

Figure 4 - 47. 

The Roundness Profile Plot with a Frequency Bar Selected. 

Right-click in the Roundness Profile plot to open the context menu. 

 The access levels "Operator" and "View Data HMI Operator" will 

not see Settings… and Reset Settings. All users will see the 

Copy and Info Area options.  

 

Figure 4 - 48. 

Roundness Profile Plot Context Menu (Complete). 

Settings… - open the Roundness Profile Plot Settings dialog. 

Reset Settings - reset changes made in the Roundness Profile Plot Settings dialog to 

the default settings. 

Copy - copy the Contribution plot to the Windows clipboard. (This menu item appears in 

all plots.) 
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Info Area – hide or show the Info Area. (This menu item appears in all plots.) 

To change the Magnitude Range: 

 Select Settings… to open the Roundness Profile Plot Settings dialog.  

 

Figure 4 - 49. 

Roundness Profile Plot Settings Dialog.  

 When Autoscale is disabled, you can change the values for Mag. min. and Mag. 

max. Negative values and values with decimal points are allowed.  

 Click OK to save the settings. 

Linear Speed Overlay 

From the Roundness Profile plot, click the Linear Speed tool  in the overlay toolbar. 

Or go to View > Plot Overlays > All Overlays and select Linear Speed. 

 Only one instance of the Linear Speed overlay is supported in the 

Roundness Profile plot. 

The overlay behavior is the same as Linear Speed in the Time plot.  An anchor displays 

at the top left of the plot and feedback for Linear Speed displays. 

 

Figure 4 - 50. 

Roundness Profile Plot with Linear Speed Overlay. 

Speed References 

As stated previously, the Contribution/Profile combo plot supports “live” display. For 

setups that require an external speed reference, the live display includes the external 

speed reference as part of the live display so that a valid value is obtained. 
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If the nearest speed measurement is outside the allowable speed reference window 

time, the frequency bar will change different color.  The Contribution plot will display the 

massage: "Speed reference out of range". The same color change and message also 

appear in the Roundness Profile plot. 

If the speed measurement is not available (that is, the speed reference was removed 

from system, or no measurement data is available), then the Frequency bar is not 

shown.  Instead, there is the message: “No speed data”. 

If any of the calculations fail (for frequencies or CTA Overall), then the bar is not shown.  

Instead, there is the message: "Insufficient data". 

Live Data Mode 

Click the Live Data tool to switch the Trend plot (main content driver) into live mode.  

As the Trend plot is updated with live data, the Contribution plot is also updated 

depending on the Single Cursor position in the live Trend plot. 

If the frequency uses an external speed point, the speed point is also put into live mode 

so that the frequency will have the live speed data. 

 The external speed point live data will not be shown in the Trend 

plot. 

 If one or more external speed points fail to go live, a message will 

inform you of it, but other live POINTs will continue. 

 As with other plots, saving live data is supported.  If an external 

speed point is used, the speed point’s live data is saved as well.  
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Working with Overlays 

Plot “overlays” superimpose cursors, alarms, and frequency markers on displayed plots.  

Each overlay displays an “anchor” which you use to manipulate the overlay. 

Displaying Overlays Using Toolbar Buttons 

@ptitude Analyst has toolbar buttons for commonly used overlays. 

 

Figure 4 - 51. 

Overlay Toolbar Buttons (Shown Here as Two Columns). 

Toolbar buttons are available for each overlay.  The buttons on the toolbar can be 

configured using the Customize menu’s Toolbar option.  For more information on 

customizing toolbars, refer to Appendix A, SKF @ptitude Analyst Toolbars.  

Each button is enabled / disabled based on whether the overlay can appear on the 

active plot.  Individual toolbar buttons are identified later in this section. 

Displaying Overlays Using the View Menu 

The View menu’s Plot Overlays option contains a list of commonly used overlays.  

Individual items on this list are enabled or disabled based on whether the overlay is 

available for the plot window displayed when the item is selected. 
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Figure 4 - 52. 

The View Menu’s Plot Overlays Option. 

Using the View menu’s Overlay option: 

Select the View menu’s Plot Overlay option.  A group of commonly used overlay types 

displays on the menu. 

 Select one of the visible overlay types, or select All Overlays for more selections. 

 
You may also use the All Overlays toolbar button to display the All Overlays dialog. 

All Overlays 

 Select the View menu’s All Overlays option.  The All Overlays dialog displays.   

All overlays applicable to the open plot display in the dialog. 

 Select an overlay to display and click OK.  The selected overlay displays in the plot 

window. 

 You may add as many instances of overlays as needed (excluding 

the peak cursor). 

 Click Cancel to undo your selection. 

Overlay Settings 
 

To access the Settings screen for the selected overlay, either click the toolbar’s 

overlay settings button, or use the View menu’s Plot Overlays / Settings option. 
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Overlay Types 

Individual Overlay types and settings are listed below: 

Text Annotation 
 

Use text annotation overlays to create temporary textual notations and display on 

a plot. 

 Text annotations are for temporary use.  They are not attached to 

the measurement or stored in the hierarchy.  They remain on a 

plot until the plot is closed. 

To create a text annotation: 

 With a plot displayed, click the toolbar’s text annotation button, or select the View 

menu’s Plot Overlays / Text Annotation option.  The “Text Annotation” displays on 

the plot. 

To edit the text annotation: 

 Double-click the text annotation.  The Text Annotation Settings screen displays. 

 

Figure 4 - 53. 

The Text Annotation Settings Screen. 

Annotation text - Enter text to display on the plot.  The entered text displays in the 

screen’s Preview area, allowing you to view the entered text before displaying it on the 

plot. 

Text attributes options include: 

Left justified, Centered, or Right justified - Determine how the text displays in its text 

box. 

Transparent - Enable to make the annotation’s background area transparent, allowing 

you to see the plot beneath the text. 

Background Color - Click to select the annotation’s background area color. 
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Font - Click to select the font for the annotation text. 

 Click the OK button.  The entered text annotation displays on the active plot. 

Context Menu - Right-click on the displayed text annotation to reveal its context menu.  

Available operations are: 

Remove – Removes the annotation from the plot. 

Settings – Launches Text Annotation Settings screen. 

Keyboard Support – Press Delete to remove the annotation from the plot.  Use up / 

down / left / right arrow keys to re-position.  Use Shift and the left or right arrow key to 

enlarge in the direction of the selected arrow.  Use Ctrl and the up / down / left / right 

arrow keys to shrink the box from the direction of the selected arrow. 

Feedback Area – Displays the annotation text. 

Information Area – None. 

Available Preferences 

None. 

 Text annotation may also be moved with the mouse (drag and 

drop).  Click on an anchor area and drag to re-size. 

Trend / Notes 

Use the notes overlay to create and display notes at a specific date / time on the trend 

plot. 

To create a note: 

 With a trend plot displayed, position your cursor over the plot area and right click to 

display the right-click context menu.   

 Select Add Notes.  The Add Notes screen displays.  A new note displays in the 

Notes list with the date and time of the location you right-clicked on the plot.   
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Figure 4 - 54. 

The Add Notes Screen.  

 If you need to change the date / time of the note, use the Date and Time fields to 

adjust the date / time as necessary.  The Add / Remove buttons will change to 

Save / Undo buttons.  Click Save and the note’s date / time adjusts accordingly in 

the Notes list. 

 Type your note in the Text area and click Save. 

 Click OK.  The created note displays on the plot at its specified date / time location.  

To create additional notes: 

 Click the Add button.  A new note is added to the Notes list with the current date / 

time stamp. 

 Adjust the date / time using the Date and Time fields as necessary.   

 Type your note in the Text area and click Save. 

 Click OK.  The created note displays on the plot at its specified date / time location.    

To remove a note: 

 Select the note you wish to remove in the Notes list. 

 Click the Remove button. You will be asked to confirm that you wish to remove the 

note. 

 Click Yes, or if you do not wish to remove the note, click No. 
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How Notes Overlays Display on the Plot 

Feedback Area - Displays note and date / time information. 

Information Area – Specific information displays on the Notes tab.  Tab information 

includes the POINT on which the cursor is currently positioned, note, and date / time. 

Context Menu - Right-click on the displayed note to reveal its context menu.  Available 

operations are: 

Remove – Removes overlay from the plot.   

 This does not delete existing notes.  To display the notes overlay 

again, select View / Plot Overlays / Notes. 

Next Trace – Toggles between traces when the plot is displaying more than 

one trace. 

Display Note – Displays the note on the plot. 

Remove All Display Notes – Hides all notes displayed on the plot. 

Filter Notes – Allows you to select one or more note categories to display on 

the plot.   

 

Figure 4 - 55. 

The Filter Notes Dialog. 

 From the list of note categories, enable the check box next to one or more note 

categories.   

 In the Include from group area, select the check boxes to include notes from SETs, 

Machines, and / or POINTs. 

 Click OK.  Only notes from the selected note categories display on the plot. 

Available Preferences 

The following preferences are found on the Preferences screen’s Plot tab. 

Notes – Configure the default display status (on or off). 

Notes Indicator Location – Configure the display notes indicator (at top or 

bottom of plot).  
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Notes Indicator Tooltip – Configure whether to display the tooltip (on or off) 

when hovering over the notes indicator. 

Notes Line Style – Configure how the notes cursor line displays (dashed, solid, 

etc.). 

Trend / Single Cursor 
 

Use a single cursor to view individual measurement data on the trend plot by 

moving the cursor to various measurement records.   

To display a single cursor: 

 With a trend plot displayed, select the View menu’s Plot / Plot Overlays / Single 

Cursor option, or use the single cursor overlay toolbar button. 

 Drag the cursor to position it on the plot. 

 If multiple traces appear in a plot, double-click the cursor overlay’s anchor to 

position it on another trace.  The anchor’s color indicates the current trace. 

Feedback Area - Displays amplitude and date / time information. 

Information Area – Specific information displays on the Trend tab.  Tab information 

includes the POINT on which the cursor is currently positioned, cursor color, amplitude, 

and date / time.   

Right-Click Context Menu -  Right-click on the single cursor overlay anchor to reveal 

its context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Exclude Reading – Toggles selected measurement's Exclude status on and off.  

When Exclude is selected, the measurement is excluded from all calculations.  

This setting is stored with the measurement and is in effect until the setting is 

changed. 

Keyboard Support – Move the cursor with the left and right arrow keys.  Press Enter 

to toggle to next trace.  Press Delete to remove the cursor. 

Available Preferences 

Color - Cursor is the color of the next available cursor (as configured in Cursor 

/ Color Preferences in the Preferences screen). 

Display Status – Display status (on or off) is configured in the Trend Single 

Cursor / Plot Preferences in the Preferences screen. 

 The default status is on. 
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Trend / Overall Alarm 

Use an overall alarm overlay to display your overall alarms graphically (as configured in 

POINT Properties) on the active trend plot. 

To display an overall alarm overlay: 

 With a trend plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Overall Alarm and click OK. 

Feedback Area - Identifies the POINT, displays private alarm or alarm name (if shared), 

and the alarm levels set. 

Information Area - Specific information displays on the Overall Alarm tab.  Tab 

information includes POINT name, type, alarm level values and alarm message 

summaries.  

Right-Click Context Menu -  Right-click on the overall alarm overlay anchor to reveal 

its context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences 

Color – Alert and Danger colors appear as configured in Cursor / Color 

Preferences in the Preferences screen. 

Display Status – Display status (on or off) is configured in the Trend Overall 

Alarm / Plot Preferences in the Preferences screen. 

 The default status is on. 

Trend / Linear Speed 
 

Use a linear speed overlay to graphically display the value of the linear factor 

multiplied by the running speed. 

To display linear speed overlay: 

 With a trend plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Linear Speed and click OK. 

Feedback Area – Displays amplitude, frequency, orders, and linear speed. 

Information Area - No tabs display for this overlay. 

Right-Click Context Menu -  Right-click on the linear speed overlay anchor to reveal its 

context menu.   
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Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences 

Display Status – Display status (on or off) is configured in the Trend / Linear 

Speed / Plot Preferences in the Preferences screen.  

 The default status is off. 

Linear Speed Overlay Settings 

 

Figure 4 - 56. 

The Linear Speed Settings Screen. 

Use the Linear Speed Settings screen to set the text attributes for your linear speed 

overlay. 

In the Text attribute section: 

 Click the Transparent checkbox to display a transparent text annotation over the 

active plot. 

 Click the Background Color button to select the color of the textbox background. 

 Click the Font button to select the desired font. 

 Observe linear speed edits in the Preview window before applying 

your linear speed overlay. 

 Click OK to close the screen and save your edits. 

Trend / Curve Fit 

Use a curve fit overlay to graphically display the projected linear direction a trend is 

heading based on current data 

To display a curve fit overlay: 

 With a trend plot displayed, select the View menu’s Plot / Plot Overlays / Curve 

Fit option, or use the curve fit toolbar button. 

Feedback Area - Identifies the curve fit and associated POINT. 
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Information Area - Specific information displays on the Curve Fit tab.  Tab information 

includes:  

Date, time, and amplitude for 2 years from last plotted measurement. 

Date, time, and amplitude when alert exceeded (or projected to be reached). 

Date, time, and amplitude when danger exceeded (or projected to be reached). 

Information is sorted by the POINT name or color of the current trace. 

Right-Click Context Menu - Right-click on the curve fit overlay anchor to reveal its 

context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences  

Color – Color appears as configured in Curve Fit / Color Preferences in the 

Preferences screen. 

Display Status – Display status (on or off) is configured in the Trend Curve Fit 

/ Plot Preferences in the Preferences screen. 

 The default status is off. 

Trend / HAL Alarm 

The HAL alarm overlay has the following characteristics: 

 If HAL alarm levels have been defined for a POINT in the POINT Properties > HAL 

Alarms tab, then the HAL trend plot will open with the HAL alarm overlay displaying 

the alert and danger level lines.  

 The alert (yellow) and danger (red) lines are shown for the selected frequency. 

 

Figure 4 - 57. 

Example of HAL Trend Plot with HAL Alarm Overlay. 
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In the example below, the active overlay is the single cursor (indicated by the square box 

on the cursor) and the primary feedback text is displayed in black. When you use the 

mouse to hover your cursor on the circle at the right, representing the HAL Alarm 

overlay, the blue secondary feedback text highlights and displays alarm information.  

 

Figure 4 - 58. 

Example of HAL Trend Plot with HAL Alarm Overlay Feedback Text. 

To change the HAL alarm cursor to a different frequency, either: 

 click the HAL alarm anchor and use the up/down arrow keys to select different 

frequencies on the HAL Alarm plot, OR 

 right click the HAL alarm anchor to open the context menu and then select another 

HAL alarm frequency to highlight on the trend plot.  

The line for the selected frequency is highlighted and the corresponding highlight 

rectangle indicates the current measurement displayed in the feedback text. 

 

Figure 4 - 59. 

Example of the HAL Trend Plot Anchor Context Menu. 
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A HAL Alarm tab is added to the information area at the bottom of the HAL trend plot 

when the cursor is visible. The tab shows the POINT name, its frequency, and the alert 

and danger threshold values set on the POINT Properites > HAL Alarm tab for the 

current selected HAL alarm. Alarm levels display in the plot and are updated 

appropriately for each HAL frequency. 

 

Figure 4 - 60. 

Example of the HAL Alarm Tab for the HAL Trend Plot. 

Spectrum / Single Cursor 
 

Use a single cursor on a spectrum plot to display the amplitude for the frequency of 

the cursor’s current placement 

To display a single cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / 

Single Cursor option, or use the single cursor toolbar button. 

Feedback Area - Displays amplitude, frequency, number of orders, and phase angle (if 

available). 

Information Area - Specific information displays on the Spectrum tab.  Tab 

information includes POINT name, cursor color, frequency, amplitude of each channel, 

number of orders, and phase angle (if available).  

Right-Click Context Menu -  Right-click on the single cursor overlay anchor to reveal 

its context menu.  Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Set Speed – Launches the Set Running Speed dialog. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove.  Left 

and right arrow keys move one line at a time.  Shift and the left or right arrow moves 

15 lines at a time. 

Available Preferences 

Color - Cursor is the color of the next available cursor (as configured in Cursor 

/ Color Preferences in the Preferences screen). 

Display Status – Display status (on or off) is configured in the Spectrum 

Single Cursor / Plot Preferences in the Preferences screen. 

 The default status is on. 



Displaying Graphic Plots 

Overlay Types 

4 - 66  SKF @ptitude Analyst for SKF Microlog Analyzer 

  User Manual 

Set Running Speed 

The calculated or custom running speed appears on the active plot if the running speed 

overlay is displayed. 

To specify the running speed: 

 Right click on the single cursor overlay and select Set Speed from the pop-up 

menu. 

 

Figure 4 - 61. 

The Set Speed Dialog. 

Use the Set Speed dialog to edit the running speed for the measurement.   

Current frequency – Displays the frequency of the current cursor position on the open 

plot. 

To set a custom running speed: 

 Enter the desired frequency in the Calculated running speed field and click OK. 

To automatically calculate running speed by current frequency and number of 

orders: 

 Enter the desired value in the Equivalent to order# field. 

 Click OK. 

Spectrum / Running Speed 

Use a Running Speed overlay to visually indicate the running speed frequency 

(Machine’s running speed at time of measurement). 

To display a running speed overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option to display the All Overlays dialog.  

 Select Running Speed and click OK. 

 Use the Customize menu’s Toolbar option to activate the running 

speed overlay toolbar button. 

Feedback Area - Displays amplitude, frequency, orders, and running speed. 

Information Area - No tabs display for this overlay. 
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Right-Click Context Menu -   Right-click on the running speed overlay anchor to reveal 

its context menu.  Available options include: 

Next Trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

 An anchor symbol appears on the bottom of the plot.  Click the 

anchor to toggle between multiple spectra. 

Available Preferences 

Color – Running speed color is configured in Running Speed / Colors  in the 

Preferences screen). 

 The default color is black. 

Display Status – Display status (on or off) is configured in the Running Speed 

- Spectrum / Plot Preferences in the Preferences screen. 

 The default status is on. 

Spectrum / Band Cursor 
 

Use a band cursor to display the frequency / time and amplitude difference (delta) 

between two cursor positions. 

To display a band cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / 

Band Cursor option, or use the band cursor toolbar button. 

Feedback Area - Displays left amplitude and frequency, right amplitude and frequency, 

orders, and delta (distance between cursor positions in frequency units).  

Information Area – Specific information displays on the Spectrum Band tab.  Tab 

information includes left frequency and amplitude for each channel, right frequency and 

amplitude for each channel, orders, delta, and overall for each channel.   

Right-Click Context Menu - Right-click on the band cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes the overlay from the plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

The band cursor is made up of three parts.  The fundamental left line, fundamental 

right line, and the band width.  The active line is indicated by the cursor line focus icon.  

This icon displays as a triangle on the active part of the cursor.  Use left and right arrow 

keys to move band width or an individual line (depending on which is active) left or right.  

The Page Up and Page Down keys toggle between left line, right line, and band width. 

 The individual fundamental lines and the band width move in 

small increments (one line at a time).  Use the Shift and the left 
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or right arrow key to move part or the entire band in larger 

increments (15 lines at a time). 

Available Preferences –  

Color - Cursor is the color of the next available cursor (as configured in Color 

Preferences in the Preferences screen).  Cursor line focus icon color appears 

as configured in Cursor Line Focus in Color Preferences in the Preferences 

screen. 

Display Status – Display status (on or off) is configured in the Spectrum Band 

Cursor / Plot Preferences in the Preferences screen. 

 The default status is off. 

Spectrum / Harmonic Cursor 
 

Use a harmonic cursor to display multiples of the current frequency. 

To display a harmonic cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / 

Harmonic Cursor option, or use the harmonic cursor toolbar button. 

Feedback Area – Displays the value for fundamental and harmonic amplitude, 

frequency, and orders.  When the mouse pointer is positioned over a harmonic marker, 

that marker’s amplitude, frequency, and orders display on the feedback area’s second 

line. 

Information Area – Specific information displays on the Harmonic Cursor tab.  Tab 

information includes POINT name, cursor color, frequency, amplitude of each channel, 

number of orders, and percentage of each channel’s fundamental frequency for each 

harmonic.  

 

Figure 4 - 62. 

The Harmonic Cursor Tab. 

The Harmonic Cursor tab provides details on potential harmonics using SKF’s 

Harmonic Activity Index (HAI).  All impact defects create spectra with a fundamental and 

a series of harmonics (i.e., a harmonic pattern).  The amplitudes of these harmonics are 

affected by the defect itself, as well as the filtering effect of the machine.  HAI is a 

calculation that quantifies the likelihood of harmonic patterns being present in a 

spectrum, and therefore, the likelihood of a defect being present. 

The result of the HAI calculation is displayed in the Activity Index column.  The Activity 

Index is a quick indicator to determine if there is a meaningful pattern under the 

current cursor position (i.e., whether or not there is a defect associated with this 
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frequency).  It can also act as a guide to determine the best cursor position for a 

suspected a harmonic pattern. 

An HAI value of 2.5 or greater indicates a likely defect pattern; HAI values of 3 or more 

show clear patterns. 

 HAI values are the same across spectra from different sources 

(i.e., the number of lines or unit types do not matter).  

 HAI values are calculated from spectral data only.  In some 

spectra, many different sources unrelated to each other may 

create a seemingly harmonious pattern.  The HAI value for this 

pattern might be high enough to suggest a true pattern is shown.  

To verify it is a true pattern, always check a few spectra taken 

over time for similar HAI values. 

Right-Click Context Menu -  Right-click on the harmonic cursor overlay anchor to 

reveal its context menu.  Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes the overlay from the plot. 

Keyboard Support – Press Enter to toggle to the next trace.  Press Delete to remove. 

Left and right arrow keys move the fundamental line in small increments (one line at a 

time).  Use the Shift and the left or right arrow key to move in larger increments (15 

lines at a time).   

Ctrl and the left or right arrow key moves the marker on the far right in small 

increments. 

Available Preferences   

Color - Cursor is the color of the next available cursor (as configured in Color 

Preferences in the Preferences screen). 

Display Status – Display status (on or off) is configured in the Harmonic 

Cursor / Plot Preferences in the Preferences screen. 

 The default status is off. 

Number of Harmonics – Maximum number of harmonic markers displayed 

(1-100). 

 The default number is 50. 

Spectrum / Sideband Cursor 
 

Sideband markers consist of an array of five pairs of markers evenly spaced on both sides of a sideband cursor 

reference position.  Sideband markers are referenced as located from left to right around the center cursor.  Sideband 

markers to the left of the center cursor are referenced with negative numbers; their associated markers to the right of 

the cursor are referenced with positive numbers.   

To display a sideband cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / 

Sideband Cursor option, or use the sideband cursor toolbar button.  
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Feedback Area - Displays the center position's amplitude and frequency, orders, delta, 

and each sideband marker's amplitude and frequency (arranged negative to positive). 

When the mouse pointer is over a sideband marker, its amplitude and frequency display 

on the feedback area’s second line. 

Information Area – Specific information displays on the Sideband tab.  Tab 

information includes sideband position, frequency, orders, amplitude, and delta 

(arranged negative to positive by sideband marker number).  

Right-Click Context Menu - Right click on the sideband cursor overlay anchor to reveal 

its context menu.  Available options include: 

Next Trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Use the left and right arrow keys to move the center cursor in small increments (one 

line at a time).  Use Shift and the left and right arrow keys to move the center cursor in 

larger increments (15 lines at a time).  Use Ctrl and the left and right arrow keys to 

move the markers in and out in small increments (left arrow to expand / right arrow to 

contract).  Use Ctrl and Shift and the left and right arrow keys to move markers in 

larger increments (15 lines at a time). 

You may drag every individual marker, effectively changing the delta value, and thus the 

location of all other markers. 

Available Preferences 

Color - Cursor is the color of the next available cursor (as configured in Color 

Preferences in the Preferences screen). 

Display Status – Display status (on or off) is configured in the Sideband 

Cursor Spectrum / Plot Preferences in the Preferences screen. 

 The default status is off. 

Spectrum / Peak Cursor 
 

Peak cursors label all peaks above a user determined amplitude. 

 The default amplitude is based on the Threshold % preference.   

To display a peak cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / Peak 

Cursor option, or use the peak cursor toolbar button. 

Feedback Area - Displays the amplitude line value and the total number of peaks.  

Displays each peak's position, amplitude, frequency, and orders. 

Information Area – Specific information displays on the Peak tab.  Tab information 

includes peak position (index), amplitude, frequency, and orders.  

Right-Click Context Menu - Right-click on the peak cursor overlay anchor to reveal its 

context menu.  Available options include: 
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Next Trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Use the up and down arrow keys to increase or decrease the amplitude line 1% of the 

current amplitude value.  Use the Shift and up and down arrow keys to increase / 

decrease the amplitude range in larger increments (10% at a time). 

Available Preferences 

Color - Cursor is the color of the next available cursor (as configured in Color 

Preferences in the Preferences screen). 

Display Status – Display status (on or off) is configured in the Peak Cursor - 

Spectrum / Plot Preferences in the Preferences screen. 

 The default status is off. 

Threshold % - This value is used to determine the initial position of the cursor as a 

percentage of the full scale value. 

 The default amplitude is based on the Threshold% preference. 

Spectrum  / Band Alarm  

Use a band alarm overlay to display all band alarms assigned to the active POINT. 

 If the band alarms display was previously modified for the active 

POINT, then only those marked visible will display. 

To display a band alarm overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Band Alarm and click OK. 

 Use the Customize menu’s Toolbar option to activate the band 

alarm overlay toolbar button. 

In displayed band alarm overlays, solid lines represent peak values and dashed lines 

represent overall values.  Green lines represent the band’s peak and overall value for 

the measurement, yellow lines show alert alarm values, red lines show danger alarm 

values. 

Feedback Area– When anchor is active, displays band alarm for specific POINT.  When 

band alarm is active, displays band name, alarm level, and value (Overall Danger and 

Alert / Peak Danger and Alert). 

Information Area – Specific information displays on the Band Alarm tab.  Tab 

information includes low and high frequency values, orders, peak, overall alert and 

danger alarm values, data values, for example: peak value and status / overall value, 

and status.  
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Right-Click Context Menu -  Right-click on the band alarm overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes the overlay from the plot. 

Settings – Launches Band Alarm Settings dialog. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences 

Color – Color preferences set in following areas of the Preferences screen: 

Band Alarm / Colors – Configures frequency lines (left and right) 

colors. 

Clear / Colors – Configures data value line colors. 

Alert / Colors – Configures alert color. 

Danger / Colors – Configures danger color. 

Display Status – Display status (on or off) is configured in the Band Alarm - 

Spectrum / Plot Preferences in the Preferences screen. 

 The default status is off. 

Band Alarm Settings Dialog 

Use the Band Alarm Settings dialog to show / hide available band alarms on the active 

POINT's plot.  Available Band Alarm names, visibility status, and frequency range display 

on the tab.   

 

Figure 4 - 63. 

The Band Alarm Settings Dialog. 
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Band Alarm Settings fields include: 

POINT - Displays POINT name. 

Available band alarms - Displays individual band alarms and their visibility status, 

frequency ranges, and channels.  

To show / hide band alarms: 

 Click the band alarm’s checkbox to toggle the band alarm’s status from Show to 

Hide. 

 Click OK to save changes, click Cancel to close the dialog without saving changes. 

 These display settings are stored with the POINT.  Whenever the 

POINT displays, the current settings are used. 

Spectrum / Envelope Alarm 

Use an envelope alarm overlay to display the envelope alarm assigned to the active 

POINT(s). 

To display an envelope alarm overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Envelope Alarm and click OK. 

The generated envelope alarm remains in * EDIT * mode until you Save or Undo your 

settings using the plot’s context menu. 

Editing the Envelope Alarm 

After you have generated an envelope alarm, you can edit it graphically using your 

mouse, or enter numeric envelope parameters using the Set Frequency dialog. 

To graphically edit the envelope alarm: 

 While in edit mode, the plot window displays  

* EDIT * in each upper corner.  Move the mouse over the envelope alarm.  The 

cursor changes to an up arrow. 

 Click the mouse on the portion of the envelope alarm line to be edited.  A square 

icon identifies where the line will be drawn. 

 Drag the mouse to draw the line to create the new envelope alarm.   

Tip -  You can use your keyboard’s Insert key to begin drawing the envelope alarm line.  

Then, use the arrow keys to move the line, and the Insert key again to stop drawing the 

line. 

 Right-click within the plot to display its context menu. 

 Select Save to save your envelope alarm settings and end * EDIT * mode, or select 

Undo to undo your settings. 

To edit the envelope alarm using numeric frequency ranges: 

 Click the Set Range button.  The Set Frequency dialog displays. 

 Enter the desired low frequency, high frequency, and level value. 
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 Click OK.  The displayed envelope alarm automatically conforms to your entries. 

Feedback Area – Identifies the envelope alarm and POINT. 

Information Area – Specific information displays on the Envelope tab.  Tab information 

includes each frequency that pierced the envelope, FFT amplitude, and alarm amplitude.  

Right-Click Context Menu -  Right-click on the envelope alarm overlay anchor to 

reveal its context menu.  Available options include: 

Next Trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences 

Color – Alarm line color is configured in Danger / Colors in the Preferences 

screen. 

Display Status – Display status (on or off) is configured in the Envelope Alarm 

- Spectrum / Plot Preferences in the Preferences screen. 

 The default status is off. 

Spectrum / Linear Speed 
 

Use a linear speed overlay to graphically display the value of the linear factor 

multiplied by the running speed. 

To display linear speed overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Linear Speed and click OK. 

Feedback Area – Displays amplitude, frequency, orders, and linear speed. 

Information Area - No tabs display for this overlay. 

Right-Click Context Menu -  Right-click on the linear speed overlay anchor to reveal its 

context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Settings – Launches the Linear Speed Settings screen.   

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences 

Display Status – Display status (on or off) is configured in the Spectrum / 

Linear Speed / Plot Preferences in the Preferences screen.  

 The default status is off. 
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Spectrum / Frequency 
 

Use a frequency overlay to label POINTs’ assigned frequency set(s) for identification 

and analysis of bearing defects, etc.  

 The current POINT must have an assigned frequency set.  

To display a frequency overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / 

Frequency option, or use the frequency toolbar button. 

Feedback Area – Displays the number of fundamental frequencies available for the 

POINT.  Displays individual frequency label, orders, each multiple’s amplitude and 

frequency. 

When the mouse pointer is over a frequency label, that label’s amplitude and frequency 

values display feedback area’s second line. 

 The number of fundamental frequencies is not limited to the 

number of displayed frequencies. 

Information Area – Specific information displays on the FAM tab.  Tab information 

includes all displayed frequencies for active overlay, harmonic, frequency, orders, and 

amplitude values.  

Also included on the FAM tab is an Activity Index column.  The Activity Index displays 

the result of an HAI (Harmonic Activity Index) calculation, which quantifies the likelihood 

of defects at the FAM frequencies for the BPFO, BPFI, BSF, and FTF harmonics in the 

spectrum.  

A HAI value in the Activity Index column of 2.5 or greater indicates a likely defect 

pattern; HAI values of 3 or more show clear patterns. 

Right-Click Context Menu  - Right-click on the frequency overlay anchor to reveal its 

context menu.  Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Next Frequency – Advance to next frequency set. 

Previous Frequency - Return to previous frequency set. 

Remove – Removes the overlay from the plot. 

Settings – Launches Frequency Settings screen. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove the 

overlay.  Use the plus (+) and minus ( -) keys to cycle through the four frequency sets 

for an individual POINT and return to original selection. 

Available Preferences 

Color – Frequency color is configured in Frequency  / Color Preferences in 

the Preferences screen). 

Display Status – Display status (on or off) is configured in Frequency – 

Spectrum/Plot Preferences in the Preferences screen. 

 The default status is off. 
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Frequency Settings Screen 

Use the Frequency Settings screen to enable/disable any or all frequencies for display 

on the current POINT’s plot. 

 

Figure 4 - 64. 

The Frequency Settings Screen. 

To enable / disable frequencies: 

 Click the checkbox next to the frequency set to enable it for display.  Clear the 

checkbox to disable the frequency set. 

Display parameters fields include: 

Multiples - Enter number of multiples for each label. 

Bandwidth % - Enter bandwidth % for each label. 

 Settings are permanently saved with the POINT. 

 Click Show All to enable all frequencies for display, click Hide All to disable all 

frequencies for display. 

 Click OK to save changes, click Cancel to close screen without saving changes. 
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Spectrum / Diagnostic Cursor 

 Use a diagnostic cursor to let @ptitude Analyst compute and display all relevant 

harmonic series of the current spectrum, and rank all series found according to 

probability.  

 This option is only available with @ptitude Analyst CMSW7400. 

To display a diagnostic cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot Overlays / Diagnostic 

Cursor option, use the diagnostic cursor toolbar button, or press X on your 

keyboard. 

@ptitude Analyst uses a patented algorithm to distinguish between very probable and 

less probable harmonic series, and ranks all series found according to probability. 

The result is shown on the Diagnostics tab in the info area below the spectrum plot.  

The probability is expressed as an activity index, whereby values of 1.5 and higher 

indicate an increasing probability of a significant harmonic pattern.   

In addition, the algorithm compares the fundamental frequency of each series to any 

frequency associated with the POINT (e.g., bearing defect frequencies).  If a match is 

found, it displays the name of this frequency next to the related harmonic pattern. 

 

 

 

Figure 4 - 65. 

The Diagnostics Tab. 

 List of patterns ranked by probability 

 Activity Index (2.5 or greater indicates a likely defect pattern; 3 or more show 

clear patterns)  

 Pattern matches BPFO 

Feedback Area – Displays the values for the currently shown harmonic series by activity 

index, fundamental frequency, and orders. 

Information Area – Specific information displays on the Diagnostics tab.  Tab 

information includes harmonic frequency, orders, and activity index for all relevant 

harmonic series, sorted by activity index.  Use the mouse or cursor keys to scroll 

through the list and display the highlighted series on the spectrum plot. 
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Right-Click Context Menu -  Right-click on the diagnostic cursor overlay anchor to 

reveal its context menu.  Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes the overlay from the plot. 

Keyboard Support – Press Enter to toggle to the next trace.  Press Delete to remove. 

Available Preferences  

Color - Cursor is the color of the next available cursor (as configured in Color 

Preferences in the Preferences screen). 

Diagnostics Percentage – Configured in Diagnostic Percentage – Spectrum 

/ Plot Preferences in the Preferences screen.  Filters the list of harmonic 

patterns displayed, based on a percentage of the highest Activity Index detected 

in the spectrum.  (For example, if the highest Activity Index is 3.5, a Diagnostics 

Percentage of 50% would filter out any harmonic patterns with an Activity 

Index below 1.75.) 

 The default percentage is 30%. 

Diagnostic Cursor – Configured in Diagnostic Cursor – Spectrum / Plot 

Preferences in the Preferences screen.  Determines whether the diagnostic 

cursor is on by default when a spectrum plot is displayed.  

 The default status is off. 

Waterfall / Single Cursor 
 

Use a single cursor to select a particular frequency across one or more spectra 

and toggle between open spectra. 

To display a single cursor overlay: 

 With a waterfall plot displayed, select the View menu’s Plot / Plot Overlays / Single 

Cursor option, or use the single cursor toolbar button. 

Feedback Area – Displays the amplitude and frequency for the selected spectrum line 

with a marker.  Displays the spectrum's name and date / time. 

Information Area – Specific information displays on the Waterfall tab.  Tab 

information includes selected spectrum line's amplitude and frequency, measurement 

date / time, and selected measurement details.  

Right-Click Context Menu - Right-click on the single cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next POINT - Toggles between open POINTs  (with two or more POINTs 

active). 

Next / Previous Spectrum – Moves to next or previous spectrum for active 

POINT. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to the next POINT.  Press Delete to remove.  

Use the left and right arrow keys to move to next / previous frequency in small 



Displaying Graphic Plots 

Overlay Types 

SKF @ptitude Analyst for SKF Microlog Analyzer  4 - 79 

User Manual 

increments (one line at a time).  Use the up and down arrow keys to move to next / 

previous spectrum for the POINT. 

 Use Shift and left and right arrow keys to move to next or 

previous frequency in larger increments (10 lines at a time).   

 In Palogram mode, the keys are reversed.  Use left and right 

arrow keys to move to next / previous spectrum, and up and 

down arrow keys to move to next / previous frequency. 

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in Cursor 

/ Color Preferences in the Preferences screen. 

Display Status – Display status (on or off) is configured in the Single Cursor - 

Waterfall / Plot Preferences in the Preferences screen. 

 The default status is on. 

Waterfall / Band Cursor 
 

Use a band cursor to calculate and display the delta between two frequencies. 

To display a band cursor overlay: 

 With a waterfall plot displayed, select the View menu’s Plot / Plot Overlays / Band 

Cursor option, or use the band cursor toolbar button.  

Feedback Area – Displays the minimum and maximum frequency and delta for the 

active POINT. 

Information Area – Specific information displays on the Waterfall Band tab.  Tab 

information includes minimum and maximum frequency and delta for the active POINT.  

Right-Click Context Menu - Right-click on the band cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next POINT - Toggles between open POINTs  (with two or more POINTs 

active). 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to the next POINT.  Press Delete to remove.  

The band cursor is made up of three parts, the fundamental left line, fundamental right 

line, and the entire band.  The active line is indicated by the cursor line focus icon.  This 

icon displays as a triangle on the active part of the cursor.  Use left and right arrow keys 

to move the entire band or an individual line (depending on which is active) left or right.  

The Page Up and Page Down keys toggle between left line, right line, and entire band. 

 The individual fundamental lines and the entire band move in 

small increments (one line at a time).  Use the Shift and the left 

or right arrow key to move part or all of the band in larger 

increments (15 lines at a time). 

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursor / Color Preferences in the Preferences screen.  Cursor line focus icon 
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color appears as configured in Cursor Line Focus in Color Preferences in the 

Preferences screen. 

Display Status – Display status (on or off) is configured in the Band Cursor - 

Waterfall / Plot Preferences in the Preferences screen. 

 The default status is off. 

Polar Vector / Single Cursor 
 

Use a single cursor to display the magnitude and phase for FFT / phase data and to 

navigate between individual readings for a selected order. 

To display a single cursor overlay: 

 With a polar vector plot displayed, select the View menu’s Plot / Plot Overlays / 

Single Cursor option, or use the single cursor toolbar button. 

Feedback Area – Displays amplitude, phase angle, POINT name, and measurement 

date / time for cursor location. 

Information Area – Specific information displays on the Polar Vector tab.  Tab 

information includes POINT name, date / time stamp, amplitude, and phase angle. 

Right-Click Context Menu - Right-click on the single cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.  

Use the left and right arrow keys to move to next or previous reading (by date/time). 

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in Cursor 

/ Color Preferences in the Preferences screen. 

Display Status – Display status (on or off) is configured in the Single Cursor – 

Polar Vector / Plot Preferences in the Preferences screen. 

 The default status is on. 

Polar Vector / Phase Alarm Cursor 

Use a phase alarm overlay to graphically display alarm levels for phase data.  Normal 

levels display inside small enclosed areas.  Alert levels are contained within a larger 

enclosed area.  Danger levels appear outside the enclosed area. 

To display a phase alarm overlay: 

 With a polar vector plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Phase Alarm and click OK. 

 Use the Customize menu’s Toolbar option to activate the phase 

alarm overlay toolbar button. 
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Feedback Area– Displays POINT name and phase alarm. 

Information Area – Specific information displays on the Phase Alarm tab.  Tab 

information includes order number, start and end angle, and low and high amplitudes 

for enabled alarms (alert, danger, or both). 

Right-Click Context Menu -  Right-click on the phase alarm overlay anchor to reveal 

its context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.   

Available Preferences 

Color – Alarm colors configured in Danger and Alert / Colors in the 

Preferences screen. 

Display Status – Display status (on or off) is configured in the Phase Alarm – 

Polar Vector / Plot Preferences in the Preferences screen. 

 The default status is on. 

Mag / Phase / Single Cursor 

Use a single cursor to display amplitude and phase data in linear form for trending 

purposes.  Navigate by date / time and simultaneously analyze magnitude and phase 

data. 

To display a single cursor overlay: 

 With a mag / phase plot displayed, select the View menu’s Plot / Plot Overlays / 

Single Cursor option, or use the single cursor toolbar button. 

Feedback Area – Displays POINT name, date / time, amplitude, and phase. 

Information Area – Specific information displays on the Mag/Phase tab.  Tab 

information includes POINT name, date / time, amplitude, and phase. 

Right-Click Context Menu -  Right-click on the single cursor overlay anchor to reveal 

its context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.   

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursors / Color Preferences in the Preferences screen. 

Display Status – Display status (on or off) is configured in the Single Cursor – 

Mag-Phase Trend / Plot Preferences in the Preferences screen. 

 The default status is on. 
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Time / Single Cursor 
 

Use a single cursor to analyze a time waveform’s amplitude and time data. 

To display a single cursor overlay: 

 With a time plot displayed, select the View menu’s Plot / Plot Overlays / Single 

Cursor option, or use the single cursor toolbar button. 

Feedback Area– Displays amplitude and time data for cursor’s location on the plot. 

Information Area – Specific information displays on the Time tab.  Tab information 

includes POINT name, amplitude, and time.  

Right-Click Context Menu - Right-click on the single cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.   

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursors / Color Preferences in the Preferences screen. 

Display Status – Display status (on or off) is configured in the Single Cursor –

Time / Plot Preferences in the Preferences screen. 

 The default status is on. 

Time / Harmonic Cursor 
 

Use a harmonic cursor to create and view a time interval’s harmonics. 

To display a harmonic cursor overlay: 

 With a time plot displayed, select the View menu’s Plot / Plot Overlays / Harmonic 

Cursor option, or use the harmonic cursor toolbar button.  

Feedback Area – Displays amplitude and time of fundamental left line and right line of 

cursor.  Displays interval in time and interval as a frequency. 

Information Area – Specific information displays on the Harmonic Cursor tab.  Tab 

information includes POINT name, left and right fundamental lines' amplitude and time, 

interval, frequency, and all visible harmonic labels.  

Right-Click Context Menu - Right- click on the harmonic cursor overlay anchor to 

reveal its context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.  

The cursor is made up of three parts.  The fundamental left line, fundamental right line, 

and the entire cursor.  The active line is indicated by the cursor line focus icon.  This 
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icon displays as a triangle on the active part of the cursor.  Use the left and right arrow 

keys to move the entire cursor or either individual line (depending on which is active) 

left or right.  The Page Up and Page Down keys toggle between selections of left line, 

right line, and entire cursor. 

 The individual fundamental lines and the entire cursor move in 

small increments (one line at a time).  Use the Shift and left and 

right arrow keys to move all or part of the cursor in larger 

increments (15 lines at a time). 

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursors / Color Preferences in the Preferences screen. 

Display Status – Display status (on or off) is configured in the Harmonic 

Cursor –Time / Plot Preferences in the Preferences screen. 

 The default status is off. 

 The Time – Harmonic cursor's fill pattern lines slope downward 

from left to right to distinguish it from a Band cursor.  A Band 

cursor’s fill pattern lines slope upward left to right. 

 The default number of harmonics is 50. 

Time / Band Cursor 
 

Use a band cursor to identify the time interval and amplitude delta. 

To display a band cursor overlay: 

 With a time plot displayed, select the View menu’s Plot / Plot Overlays / Band 

Cursor option, or use the band cursor toolbar button.  

Feedback Area – Displays amplitude and time of left and right fundamental lines and 

the delta (in time). 

Information Area – Specific information displays on the Time Band tab.  Tab 

information includes current position, amplitude, time, delta (frequency and time), 

positive and negative peak, RMS and time domain statistics for the time data shown 

within the band, including: 

Standard Deviation – A basic measure of the spread of values within a set 

around their average value. 

Skew – A measure of the asymmetry of the time domain values when plotted 

around their average.  Whereas the Standard Deviation suggests that values 

are homogeneously distributed left and right of their average, the Skew 

indicates whether this assumption is true. 

Kurtosis – A measure of the general extent of peaks.  A high value means that 

more of the variance is due to infrequent, extreme deviations as opposed to 

frequent, modest deviations. 

Crest Factor – A calculation of the highest absolute Peak / RMS value of the 

signal.  The Crest Factor is a measure of general extent of peaks as compared 

to a pure sinusoid.  The crest factor for pure sinusoid is 1.41 (square root of 2). 
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 This information also displays on the Info tab in time plots.  Time 

domain statistics on the Info tab pertain to the entire plot, 

whereas statistics on the Time Band tab only pertain to the time 

interval within the band. 

Right-Click Context Menu - Right-click on the band cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.  

The band cursor is made up of three parts.  The fundamental left line, fundamental 

right line, and the entire band.  The active line is indicated by the cursor line focus icon.  

This icon displays as a triangle on the active part of the cursor.  Use left and right arrow 

keys to move the entire band or an individual line (depending on which is active) left or 

right.  The Page Up and Page Down keys toggle between the left line, right line, and 

entire band. 

 The individual fundamental lines and the entire band move in 

small increments (one line at a time).  Use the Shift and the left 

or right arrow key to move part or all of the band in larger 

increments (15 lines at a time). 

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursors / Color Preferences in the Preferences screen.  Cursor line focus 

icon color appears as configured in Cursor Line Focus in Color Preferences in 

the Preferences screen. 

Display Status – Display status (on or off) is configured in the Band Cursor –

Time / Plot Preferences in the Preferences screen. 

 The default status is off. 

Cursor Cross Hashing – Cross-hashing (on or off) is configured in the Cursor 

Cross-Hashing – Time / Plot Preferences in the Preferences screen.  

Determines whether the band is shaded with a single diagonal line or a cross-

hash.  

 The Time – Band cursor’s fill pattern lines slope upward from left 

to right to distinguish it from a harmonic cursor.  A harmonic 

cursor’s fill pattern lines slope downward from left to right.  Cross 

hashing can be useful to help further distinguish a time band 

cursor from a harmonic band cursor.   
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Time / Peak Cursor 
 

Use a peak cursor overlay to label all peaks above a set amplitude value. 

To display a peak cursor overlay: 

 With a time plot displayed, select the View menu’s Plot / Plot Overlays / Peak 

Cursor option, or use the peak cursor toolbar button. 

Feedback Area – Displays the line's current amplitude, total number of peaks displayed, 

and the peak number, amplitude, and time for as many displayed peaks as space allows. 

Information Area – Specific information displays on the Peak tab.  Tab information 

includes POINT name, line amplitude, and each peak number's time and amplitude.   

Right-Click Context Menu - Right-click on the peak cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.   

Use the up and down arrow keys to increase / decrease the amplitude range in small 

increments (1% at a time).  Use the Shift and up and down arrow keys to increase / 

decrease the amplitude range in larger increments (10% at a time). 

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursors / Color Preferences in the Preferences screen. 

Display Status – Display status (on or off) is configured in the Peak Cursor –

Time / Plot Preferences in the Preferences screen. 

 The default status is off. 

Time / Linear Speed 

Use a linear speed overlay to graphically display the value of the linear factor multiplied 

by the running speed. 

To display linear speed overlay: 

 With a time plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Linear Speed and click OK. 

Feedback Area – Displays amplitude, frequency, orders, and linear speed. 

Information Area - No tabs display for this overlay. 

Right-Click Context Menu -  Right-click on the linear speed overlay anchor to reveal its 

context menu.   
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Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences 

Display Status – Display status (on or off) is configured in the Time / Linear 

Speed / Plot Preferences in the Preferences screen.  

 The default status is off. 

Analysis and Reporting Manager Add-On 

The Analysis and Reporting Manager (ARM) provides graphical displays of Microlog 

module data (e.g., Recorder, Run up / Coast down, FRF, etc.).   

The ARM add-on to @ptitude Analyst allows you to associate ARM data files with your 

hierarchy and access graphical displays of Microlog module data from within @ptitude 

Analyst. 

Uploading and Linking ARM Data 

Module data may be uploaded from the Microlog and saved with ARM, and then linked 

to your @ptitude Analyst hierarchy. 

To transfer and link module data: 

  Select the Transfer menu’s Microlog ARM data option.  The Mobile Device 

Viewer wizard launches. 

 Follow the wizard to upload your Microlog module data to ARM files and link them 

to any element in your @ptitude Analyst hierarchy. 

 Click the Help button or press F1 on your keyboard for help on 

the wizard options. 

Viewing ARM Data 

From within @ptitude Analyst, you can: 

Launch the Analysis and Reporting Manager where you can select Microlog 

module data files from the Explorer-style tree structure; 

View a list of ARM data associated with any element in your @ptitude Analyst 

hierarchy and quickly open a graphical display of a selected item. 

To launch the Analysis and Reporting Manager: 

  Select the View menu’s Analysis and Reporting Manager option, or select the 

View Analysis and Reporting Manager toolbar icon.  The Analysis and Reporting 

Manager displays. 
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 Refer to the help files within the ARM add-on for instructions on locating and 

viewing data from your Microlog modules. 

To view linked ARM data for a hierarchy element: 

 Highlight the item in the @ptitude Analyst hierarchy whose linked ARM data you 

would like to view. 

  Select the View menu’s Linked ARM Data option, or select the View Linked 

ARM Data toolbar icon.  The Linked Analysis and Reporting Manager (ARM) 

Data dialog displays. 

Options include: 

Linked File List – Lists all ARM data files linked to the currently selected hierarchy 

element.  Use your mouse or the up and down arrow keys on your keyboard to highlight 

the desired data file. 

Name – The linked ARM data file name. 

Description – A user defined description of the file. 

Date Added – The date the module data was collected. 

View – Launches ARM at a graphical display of the selected Microlog module data. 

Delete – Deletes the link between the ARM file and the @ptitude Analyst hierarchy 

element. 

Edit – Opens an edit dialog where you can modify the link description. 
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Generating and Printing SKF @ptitude Analyst Reports 

Overview 

 The File menu's Print option or the toolbar's Print button may be 

used at any time to print the contents of the “active” @ptitude 

Analyst window (including graphic display windows). 

 Microsoft Internet Explorer version 4.X or newer is required to 

view reports. 

@ptitude Analyst’s Reports feature provides options for controlling the generation and 

printing of hard copy reports showing database and measurement information.   

Collection Status – Produces a report of set ROUTE activity dates and the 

status of each POINT.  POINT status includes Collected, Not Collected (current 

time period), Missed (previous time period), and Uncollectible. 

 If a conditional POINT’s source POINT has not been collected, or if 

the source POINT has been collected, but the conditional POINT’s 

criteria was not met, then the conditional POINT displays an 

Uncollectible status and is not counted toward the total 

percentage of non-compliant POINTs.   

Compliance – (calendar-based POINTs only)  - Produces a report of the 

collection status for all calendar-based POINTs in a ROUTE (for either the 

current or previous data collection interval). 

If reporting on the current data collection interval (implying that the calendar-

based time period has not yet expired), for each ROUTE collected, the report 

displays the number of calendar-based POINTs in the ROUTE, the number of 

these POINTs that have been collected so far, and the percentage of POINTs 

that have been collected vs. all calendar-based POINTs. 

If reporting on the previous data collection interval, the report is split into two 

sections.  The top section displays those POINTs that are in compliance (as 

described in the paragraph above).  The bottom section displays similar data 

for those POINTs that are out of compliance.  In addition, when reporting on 

the previous data collection time period, you have the option to list POINT ID 

information for all POINTs that are out of compliance. 

Exception - Produces a report of POINTs in violation of specified exception 

criteria. 

History - Produces a report of machine notes. 

Last Measurement - Reports POINTs’ last measurement values. 

Overdue/Non-Compliant- Produces a report of all POINTs that are overdue or 

out of compliance for data collection as per their data collection schedule. 
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Pending Overdue/Non-Compliant – Produces a forecast report of all POINTs 

that will be overdue/non-compliant within a user specified time period  (e.g., 

report all POINTs that will be overdue/non-compliant if they are not collected 

within the next seven days). 

ROUTE Statistics - Produces a report of statistics for one or more ROUTEs.  

Statistics include when due, last downloaded, total number of POINTs in the 

ROUTE.   

ROUTE History Report - Produces a report of ROUTE history for the selected 

ROUTEs.  ROUTE History reports include ROUTE collection time duration, and 

start and stop times.  The amount of reported ROUTE historical information is 

determined using the ROUTE Properties / General tab.  

SET Statistics - Produces a report of statistics for the selected data source.  

The statistics include total number of POINTs, POINTs in alarm, POINTs 

disabled, and POINTs overdue. 

Upload Statistics – Produces a report of the statistics for information last 

uploaded from the DAD. 

 Each of @ptitude Analyst’s report types may be customized.  

Report setup is discussed later in this chapter. 

Reports Screen 

 Select the File menu’s Reports option.  The Reports screen displays. 

The Reports screen allows you to select, configure, manage, and generate reports.  

Each report type is available for use and may also be used as a starting point to 

customize reports to fit your particular application. 

 Reports may also be generated automatically using the Scheduler 

feature.  Refer to Chapter 2, Working With Your SKF @ptitude 

Analyst Database for more information on scheduling automatic 

reports. 

Use the Reports screen to work with existing reports and to create new report 

templates.  The top area provides options for new and current reports.  The bottom 

area provides options for preserved (archived) reports. 
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Figure 5 - 1. 

The Reports Screen. 

Select report area - Displays all existing report definitions. 

 Click a report’s name to select it.   

Reports options include: 

Generate – Generates a report to the computer display based on the selected report 

definition. 

View – Displays the latest generated version of the selected report. 

Add – Defines a new report based on a pre-defined @ptitude Analyst template. 

Copy – Defines a new report using the selected custom report as a template. 

Edit – Launches the Report Editor screen to edit the selected report. 

Remove – Deletes the selected report definition.  When you delete a report from the 

screen's top area, you are asked if you also want to delete all preserved historical 

reports for the selected report definition. 

 When a report is removed, its corresponding subdirectory and all 

included files are also removed from your computer’s hard drive.  

If you wish to delete a report, but save previous copies, copy the 
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report’s files from its subdirectory to a new location on your hard 

drive before removing the report. 

History area – Displays all existing preserved reports for the selected report definition. 

 Refer to the Report Editor / General section later in this chapter 

for more information on preserving historical reports. 

 Click a preserved report's name to select it. 

View - Displays the preserved version of the selected report, identified by its date and 

time. 

Send – Launches the Recipient Selection dialog and allows you to send the report in 

an email message to one or more selected contacts or groups of contacts.  The report is 

sent in HTML and PDF format to the selected email recipients.  

 Refer to the SKF @ptitude Analyst Introduction and Global 

Features User Manual, Chapter 2, Getting Around in @ptitude 

Analyst / Contact Information section for details on how to set 

up contacts and groups.  

Rename – Allows you to rename the selected preserved report.  The Enter Name 

dialog displays, prompting you to enter the new report name.  Click OK to rename the 

selected report. 

Remove – Removes the selected preserved report. 

Close – Closes the screen. 

To generate a @ptitude Analyst Report: 

 Open the Hierarchy window whose data you wish to report.  If necessary, open or 

select hierarchy items within the window to limit the report’s content. 

 Select the File menu’s Reports option.  The Reports screen displays. 

 Select a report from the Reports screen’s Select report area. 

 Click the Generate button.  The report is rendered and when complete, displays in 

a report window for viewing or printing. 

  Report generation progress displays in the progress bar 

in the screen’s lower right corner. 

 When setting up a report, there is an option to select the data 

source at the time the report is generated.  If this has been 

selected, the Select Data Source dialog displays.  Refer to the 

Selecting the Data Source heading, later in this chapter, for 

details. 

 Press your keyboard’s End key to go to the end of the report. 

 Press your keyboard’s Home key to go to the top of the report. 

To print a generated report: 

 With the generated report on the computer’s display, use the Print toolbar button 

or select the File menu’s Print option.   
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To view an existing report:  

 In the Reports screen, select the desired report. 

 Click the View button.  The report displays in a Report window and is available for 

viewing and/or printing. 

Use the Reports screen to “add” a customized report type.  Customized reports are 

based on pre-defined report types, then modified to suit your particular application.  

Once your new report type is defined, it is available for selection from the Reports 

screen, and may be generated as needed. 

To add a new report: 

 Click the Report screen’s Add button.  The Select Report Template dialog displays. 

The Select Report Template dialog displays all pre-defined @ptitude Analyst report 

templates.  These templates may be used to generate reports without further 

modification, or as a starting point for creating custom reports. 

 Select the template to use as a basis for your new report. 

 If you wish to use the selected report “as is,” (no modifications are 

required) assign the report a unique name, verify the path 

settings, and click the OK button to accept all default settings. 

 Click OK.  The Report Editor screen displays. 

Report Editor 

The Report Editor screen contains three tabs: 

General – Defines the new report’s identity and processing parameters. 

Definition – Defines the new report’s criteria, criteria settings, and content. 

Assign – Allows you to configure default report configurations for both public and 

hierarchy-specific reports. 

Report Editor / General tab fields include: 

Name – Using standard file naming conventions, assign the new report a unique name.  

Do not use the pound sign (#) in your report name as it can cause errors when printing.  

The assigned name identifies the most recently generated report and is used to name 

the disk directory (folder) where the report and all its supporting files are stored.  If you 

maintain historical reports, a separate directory is created beneath the report's directory 

identified by the historical report's name. 

If you change a report’s name, all data for the previously generated report remains in 

the subdirectory with the original report’s name.  The original report subdirectory 

cannot be deleted using @ptitude Analyst. 

Title – Enter a descriptive title for the report.  This text appears at the top of the 

generated report. 

Header – Enter text to display in the printed report’s header area. 

Footer – Enter text to display in the printed report’s footer area. 
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Preserve Reports – Click to enable report preservation.  When enabled, newly 

generated reports are archived, organized by report definition and date / time. 

Report is Available for all users – Click to enable and define the report as a public 

report, available to all @ptitude Analyst users.  If you do not check this option, the 

report is defined as a private report, available only to the report creator. 

Report is Available for all hierarchies – Click to enable and make the report available 

for use with all @ptitude Analyst hierarchies.  If you do not check this option, the report 

will only be available to the current hierarchy. 

Report can specify data sources from multiple hierarchies – Click to enable and 

make the report available for use with all @ptitude Analyst hierarchies, as well, as 

enable the ability to select multiple data sources from multiple hierarchies.  If you do not 

check this option, the report will only be available using a single hierarchy source. 

Report Editor / Definition 

The Report Editor / Definition tab is divided into two main areas, the Select report 

criteria area in the tab's left panel and the criteria setup panel on the right.  Click an 

item to expand and view any sub-items available for configuration.   

 

Figure 5 - 2. 

The Report Editor / Definition Tab. 
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Select report criteria – Select attributes to appear in the report.   

Criteria setup (contents change depending upon item selected in left panel) – 

Allows you to configure the selected report criteria to determine report content.  

To select an element to include in the report: 

 Highlight the item and click the item’s checkbox to include it in your report.  Once 

selected, the item's input fields (if any) display in the tab's right panel.  Available 

report elements are detailed in the Report Criteria section later in this chapter. 

 Click the item's + icon to expand the item in the hierarchy list and view its additional 

configuration options. 

 Click an additional configuration item to select it.  When selected, the additional 

item's set up fields display in the Criteria Setup area, allowing you to further 

customize the report.  Available setup fields are detailed in the Criteria Setup 

Fields section later in this chapter. 

Report Criteria 

The following items display in the Select report criteria area as top-level items.   

Alarms - Select individual alarm conditions and types to include in the report. 

Last Measurement - Select to include all POINTs in the report with a last 

measurement. 

Overdue/Non-compliant – Specify the amount of overdue POINTs to include in the 

report. 

Priority – Includes any Machine with a set priority matching your selection(s). 

Inspection / Upload Statistics – Select one or more alarm conditions (Clear, In alert, In 

danger); select the columns, date range and type of notes to include. Check Upload 

Statistics to include a summary of the last data upload from the DAD. 

Work Notification – Select to include all work notifications, a fixed number of them, or 

select a date or date range. Specific ROUTEs and work request statuses can be selected 

for the report.  

SET Statistics – Select to include a summary of the hierarchy item and all its children. 

ROUTE Statistics – Select to include a summary of ROUTE data collection status for 

each ROUTE included in the report. 

History – Select to include all machine notes and images for any machine in the 

selected data source. 

Measurement Statistics – Select to include a summary of statistical information for a 

selected measurement type (selected by the Full Scale Units setting) and alarm 

threshold (selected by the Threshold Level setting).  This setting includes the average 

amplitude for last measurement data of the specified measurement type, and indicates 

all POINTs with an amplitude above the specified alarm threshold in the report. 

Collection Status - Select to include a summary of the ROUTE activities and its POINTs’ 

status. Include all collection activities, a fixed number of them, or select a date or date 

range. You can choose to show only missed or uncollected POINTs.  



Generating and Printing SKF @ptitude Analyst Reports 

Reports Screen 

5 - 8  SKF @ptitude Analyst for SKF Microlog Analyzer 

  User Manual 

Route History – Specify the amount of historical ROUTE information to include in the 

report. 

 Include records by comparing options under Route History are 

only applicable to the date range settings.  They further filter the 

range based on start time, end time, or both. 

Compliance – Select ROUTEs on which you wish to report a summary of compliance 

status, and specify to report status for either the previous collection interval (previous 

compliance) or the current collection interval (current compliance).  You may also 

specify to list all missed or out of compliance POINTs for the specified ROUTEs and to 

exclude interval-based POINTs. 

Transient – Select to include transient data and specify the phase order (1 – 4). 

 

Criteria Setup Fields (right panel setup fields) 

Columns 

Use the Columns input area to specify which columns appear in report tables, to specify 

column order, and select column sort criteria. 

 

Figure 5 - 3. 

The Report Editor / Definition Tab, Columns. 
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Available columns – Displays all available columns for the selected report element.  

Included columns – Displays all included columns for the selected report element. 

To include / exclude columns: 

 Click the column type to select it. 

 Use the Include / Exclude buttons to move the selected column to the Included 

columns area to include in the report, or move the selected column to the 

Available columns area to exclude it from the report. 

To specify column order: 

 Click the column type in the Included columns area. 

 Use the Up and Down buttons to place the column into the desired position. 

To specify sort criteria: 

 Select a column type from the Sort on drop down list box. 

 Click the desired sort method button, Ascending or Descending. 

 Click the Set All button to use the current column settings for all matching column 

types in other report element setup fields.  For example, the same column settings 

are available for various report elements.  The Set All feature allows you to 

configure this information once and then use the same settings for all applicable 

report elements. 

 Click OK to save changes, or Cancel to undo settings. 

Date Range 

Use the date range fields to specify a date interval.  This date interval is used to 

retrieve only POINTs with a last measurement that falls within the indicated 

date interval. 

Only include enabled POINTs – Select (check) to have the applicable report 

criterion retrieve data from enabled POINTs only. This checkbox can be 

selected or not selected (checked or not checked) by default and may or may 

not be editable depending on the selected report criterion. 

 For Alarms and Overdue/Non-compliant criteria – This checkbox 

is selected (checked) by default and is read-only. Thus, these 

criteria will always retrieve data from enabled POINTs only for 

reporting. 

 For Last Measurement, Inspection, and Measurement 

Statistics criteria – This checkbox is not selected (not checked) by 

default and is editable. Thus, by default these criteria will retrieve 

data from all POINTs for reporting, but you can select (check) this 

checkbox to have them retrieve data from enabled POINTs only. 

No date range restriction – Select to remove date range restrictions. 

Absolute date – Enter “absolute” (calendar) dates for date range restriction. 

Relative date – Enter number of days (from / to) for date range restriction. 
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 Click the Set All button to use the current date range settings for all date range 

settings in other report element setup fields.  The Set All feature allows you to 

configure this information once and then use the same settings for all applicable 

report elements. 

General 

Use the General fields to configure general report element information. 

Include image – Click to enable and include any images associated with the 

selected report element. 

Grouped by machine – Click to enable and display included report items 

grouped by machine. 

Plots 

Use the Plots fields to specify which plot types are to be included with the report table 

for the selected report item. 

 

Figure 5 - 4. 

The Report Editor / Definition Tab. 

Include plot information tables – Click to enable and include plot content 

details and overlay information in table format on the report. 
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Plots area - Displays all available plots.  Click a plot type to include it in the 

report. 

 Selected plots are created only if there is associated data. 

Overlays area – Displays overlays associated with the selected plot type (if 

applicable). 

 Click the Set All button to use the current plot and overlay settings for all matching 

plot and overlay types in other report element setup fields.  For example, the same 

plot settings are available for various report elements.  The Set All feature allows 

you to configure this information once and then use the same settings for all 

applicable report elements. 

Measurement History 

Use the Measurement History fields to specify which measurements to include in the 

report. 

Last fixed number of measurements – Select this option and type in or use 

the arrow buttons to specify the fixed number of measurements to include in 

the report. 

Measurements in this date range – Select this option to include all 

measurements occurring between your entered date interval in the report.  

Type in a start date in the From field and an end date in the To field, or use 

the arrow buttons to display a pop-up calendar to select start and end dates. 

Measurements from the last fixed number of days – Select this option to 

include measurements occurring within a specific number of days in the report.  

Type in or use the arrow buttons to specify the fixed number of days. 

All measurements – Select this option to include all measurements in the 

report. 

Notes 

Use the Notes fields to specify which notes to include in the report. 

Note Categories – Click to enable and include one or more note categories for 

the selected report item in the report.  Note categories include ACK Alarm 

Note, Coded Note, General Note, Non-Collection, Oil Analysis Note, and 

Operating Time Reset.  

Settings area – Use the settings area to define which notes to include in the 

report. 

Last fixed number of notes – Select this option and type in or use 

the arrow buttons to specify the fixed number of notes to include in 

the report. 

Notes in this date range – Select this option to include all notes 

occurring between your entered date interval in the report.  Type in a 

start date in the From field and an end date in the To field, or use the 

arrow buttons to display a pop-up calendar to select start and end 

dates. 
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Notes from the last fixed number of days – Select this option to 

include notes occurring within a specific number of days in the report.  

Type in or use the arrow buttons to specify the fixed number of days. 

All notes – Select this option to include all notes in the report. 

Routes 

Use the ROUTEs  fields to specify which ROUTEs to include in the report. 

Routes – All available ROUTEs display in the ROUTEs area.  Click to select one 

or more ROUTE.   

 Click Check All to select all available ROUTEs.  Click Clear All to clear your 

selections. 

 Click the Set All button to use the current ROUTE selections in other report 

element setup fields.  The Set All feature allows you to configure this information 

once and then use the same settings for all applicable report elements. 

Overdue 

Use the Overdue fields  to specify the number of days to use with projection and 

trending. 

Number of days from today - Enter a number in the text field or use the up 

and down arrows to indicate the number of days from now for use with 

projection and trending. 

Report Editor / Assign 

Use the Report Editor screen's Assign tab to configure default report settings, and to 

override defaults and to override defaults when the report is generated from the 

current hierarchy. 

The Assign tab varies, depending on whether Report is available for all hierarchies or 

Report can specify data sources from multiple hierarchies is enabled on this 

screen’s General tab. 
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Figure 5 - 5. 

The Report Editor / Assign Tab with Report is available for all hierarchies Disabled. 
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Figure 5 - 6. 

The Report Editor / Assign Tab with Report is available for all hierarchies Enabled. 
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Figure 5 - 7. 

The Report Editor / Assign Tab with Report can specify data sources from multiple hierarchies 

Enabled. 

The tab provides fields to configure default report settings.  Options include: 

Report Location – Specify the path for the disk directory for report storage.  The report 

is stored in a subdirectory (using the report’s name) beneath this indicated directory.  

For example, specify E:\SKF @ptitude Analyst\Reports to place all reports in their 

unique directories branching from a “reports” directory. 

 Click the Browse button to specify a new path. 

 Reports are stored in HTML format and are available for copying, 

moving, and sharing over intranet, world wide web, etc. 

Data Source – Select the source of the data to include in the report.  Use the plus and 

minus icons to expand the hierarchy as needed to display sub-items. If Report can 

specify data sources from multiple hierarchies is disabled, options include: 

Selected Node – Select to include data from the node that is selected in the 

hierarchy at the time the report is generated, including all sub items. For 

example, if a SET is selected in the hierarchy when the report is generated, all 

POINTs from all Machines under that SET are included. 

Current Hierarchy – Select to include all data from the hierarchy that is open 

when the report is generated. 
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Primary Hierarchy - Select to us the currently selected primary hierarchy as 

the report's data source. 

Last Uploaded – Select to include the most recently uploaded data. 

ROUTEs / Workspace – These options appear in the upper section’s Data 

source list if the report is only available for this hierarchy (i.e., Report is 

available for all hierarchies is disabled).  Select a previously defined ROUTE 

or Workspace to use with the report. 

 ROUTE based reports, such as ROUTE Statistics, ROUTE History, 

Compliance, and Collection Status, use data from the ROUTEs 

specified on the Definition tab, rather than the source data 

specified on the Assign tab. 

If Report can specify data sources from multiple hierarchies is enabled, options 

include: 

Selected Node – Select to include data from the node that is selected in the 

hierarchy at the time the report is generated, including all sub items. 

Select Data Source -  Select multiple hierarchies, groups, and POINTs to 

include in your report. 

Define title, data source, and/or history name at time of generation – Enable to 

receive an option to override the Data source selection at the time the report is run.  If 

this is enabled, you must manually specify this report information each time the report 

is generated.  Before report generation occurs, the Select Data Source dialog displays, 

prompting you to enter report information and select the report’s data source.  (See 

Selecting the Data Source below for details.) 

If the Report is available for all hierarchies check box is enabled on the Report 

Editor’s General tab, the tab's bottom area allows you to configure reports specifically 

for use with the current Hierarchy only.  If you do not use the bottom area's 

configuration options, the default configuration from the tab's top section is used. 

 You must edit the report in each hierarchy where you wish to 

override the default options.   

The top line of this section displays the current hierarchy name and indicates whether 

the default settings are used, or if custom overrides have been established in the fields 

below. 
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Figure 5 - 8. 

The Report Editor / Assign Tab’s Default / Custom Line. 

 hierarchy name 

 default / custom  

The remaining fields function as previously described.  These settings will be used to 

generate the selected report type for the current Hierarchy only. 

 Click the Use Defaults button to clear your custom configuration and return to all 

default settings. 

Selecting the Data Source 

If Define title, data source, and/or history name at time of generation is enabled on 

the Report Editor’s Assign tab, the Select Data Source dialog appears when the 

report is generated. 

The Select Data Source dialog varies, depending on whether Report can specify data 

sources from multiple hierarchies is enabled on the Report Editor’s General tab. 
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Figure 5 - 9. 

The Select Data Source Dialog. 
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Figure 5 - 10. 

The Select Data Source Dialog when Report can specify data sources from multiple hierarchies is 

Enabled on the Report Editor’s General Tab. 

This dialog lets you configure the report title, specify whether to preserve a copy of the 

generated report, and specify the data source for this instance of the report.   

 The data source defaults to the Data source setting on the 

Report Editor’s Assign tab. 

 In the Report title field, enter the report title. 

 Click the Preserve report checkbox to enable report preservation.  When enabled, 

newly generated reports are archived, organized (by default) by report definition 

and date / time. 

If Preserve report is enabled, you can also manually enter a History name to use 

when organizing your preserved reports, instead of the default date / time naming 

method.  The History name determines how the reports are organized, and how they 

display in both the Report Editor / General’s History window, and in the separate 

preserved reports directory created in the disk directory (folder) designated as the 

report storage location.  The History name field displays “[Date] [Time]” until you type 

in the field.  If you do not type within the History name field, the preserved report is 

named and organized by its date / time. 

To assign a manual history name: 

 In the History name field, enter text to identify and organize your preserved 

reports, overriding the default date / time history name.   
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To select the report’s data source: 

 From the Select data source for report window, click to select the appropriate 

data source from the displayed hierarchy list.   

 Use the plus and minus icons to expand the hierarchy as needed 

to display sub-items. 
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Appendix A 

SKF @ptitude Analyst Toolbars 

Toolbar Tools 

@ptitude Analyst’s toolbars and toolbar button assignments are described below..  You 

can enable any or all of the available buttons by using the Custom Toolbar dialog 

discussed later in this chapter. 

Primary Toolbar 

Hierarchy Window – open Hierarchy window. Organizes your monitored machinery 

measurements into a hierarchy structure consisting of Groups (which may be 

organizational SETs, machines, or custom groups) and measurement POINTs. 

ROUTE Manager – open ROUTE dialog. A ROUTE is a measurement POINT collection 

sequence that is downloaded to a data acquisition device (DAD).  

Workspace Manager – open Workspace dialog. A workspace organizes specific Groups 

into one location for easy comparison and analysis. 

Report Setup – open Reports dialog. 

System Information – open System Information view to see the Event Log and Online 

Data 

Properties – open Properties dialog for the active hierarchy item (could be Group 

Properties or POINT Properties) 

Print – print window contents (also print to file). 

Exit – exit the application. A confirmation message displays before exiting. 

Hierarchy View Toolbar 

Alarm Details – open the Alarm Details view.  

Apply Filter – open Apply Filter dialog. When a filter is applied, the resulting items 

display in a new Workspace window. 

Apply Template – open the Apply Template dialog to select a template to apply to the 

hierarchy.  

Navigation Toolbar 

Auto Link – link any open Hierarchy, Workspace, ROUTE, Transient, Template, or 

Alarms window (source windows) to any open Alarm Details or Plot window (target 

windows). With Auto Link enabled, selections in one of the source type windows 

automatically affect all open target type windows.  

For example, suppose you have a Hierarchy window open (source type window), select a 

POINT, and display its spectrum (target type window). With Auto Link enabled, when 
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you select a different POINT in the Hierarchy window, the plot window automatically 

updates to display the newly selected POINT's spectrum. 

Previous POINT – move focus to the previous POINT in the hierarchy. 

Next POINT – move focus to the next POINT in the hierarchy. 

Previous Measurement - move focus to the previous measurement. 

Next Measurement - move focus to the next measurement. 

View Icons Toolbar 

Large Icons – display measurements as large icons. 

Small Icons – display measurements as small icons. 

Simple List Icons – display measurements as a simple list. 

Detailed List Icons – display measurements as a detailed list. 

Plots Toolbar 

Trend Plot – view a POINT’s most recent reading in comparison with its previous 

readings and its alarm set up. See how the POINT is “trending” over time to detect 

gradual changes in process conditions.  

Spectrum Plot – view measured vibration signals with respect to frequency. An FFT 

spectrum plot displays vibration amplitudes at various component frequencies. [stacked 

or combined] 

Time Plot – view a short time sample of a raw vibration signal with vibration amplitude 

plotted over the time scale.  Current time plots are compared to past time plots to 

analyze changes in vibration amplitude or frequency. 

Spectrum Waterfall Plot – view three-dimensional waterfall plots of POINT’s historical 

spectra collected over time. 

Cascade Plot – view plots of collected spectra against running speed on the Z-axis.  

The Cascade plot is similar to the Waterfall plot, but instead of plotting collected spectra 

against time, the data is plotted against running speed on the Z-axis. 

Topology Plot – view a top-down view of a cascade or waterfall plot using color intensity 

to visualize the spectral peaks. 

Polar Vector Plot – shows vibration amplitude and phase.  The phase angle is the angle 

the shaft travels from the start of a triggering event to when the point at which the 

sensor experiences maximum positive force.  This relationship provides valuable 

information on shaft orbit and shaft position and is used for analysis, balancing, and 

shaft orbital analysis. 

Mag/Phase Plot – shows trends plotting the amplitude (top) and phase / angle (bottom) 

aligned by the measurement date.  Mag / Phase trends may be used to determine if a 

machine’s mechanics are changing by analyzing the shifting in phase. 

Orbit Plot – view the dynamic motion of the center of a rotating shaft with signals from 

two perpendicularly mounted transducers. 
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SCL Plot – view a trend of the shaft’s average centerline for Orbit POINTs.  Shaft 

centerline plots can be used to show the movement of the shaft within the bearing. 

Mag/Speed Plot – view trends plotting the amplitude (top) and speed (bottom) aligned 

by the measurement date. 

All Plots – open the All Plots dialog to select the plot type to display from all available 

plots, including combination plots, in addition to the plot types commonly represented 

with toolbar buttons. 

HAL Trend Plot – view the trend for a POINT that has a defined Frequency set plus FFT 

data measurements. 

Combination Plot Tools 

Spectrum/HAL Trend –view the Spectrum and HAL Trend plots together for a POINT 

with associated frequencies. 

Contribution/Profile – displays an overview of different frequencies’ contributions to 

overall vibration within a POINT. 

Band Trend - combine the spectrum and available band trends for the selected POINT.  

Analyze the energy within the band to closely monitor that particular frequency range. 

Extracted Band – display a waterfall and extracted band plot.  The energy of the 

frequency within the band across the spectrum displays.  

Extracted Trend – display a trend plot of spectrum amplitudes at a frequency.  A 

waterfall plot shows which spectra are to be used.  The single cursor in the waterfall 

controls which frequency to plot in the trend.  The waterfall plot is the primary plot. 

Mag/Speed/Spectrum – view a POINT’s mag / speed trend plot and a spectrum plot.  

The two plots display in two different panels with the mag / speed panel as the primary 

panel.  

Mag/Speed/Spectrum/Time – view a POINT’s mag / speed plot, spectrum plot and time 

plot.  The three plots display in three different panels. 

Mag/Speed/Time – view a POINT’s mag / speed trend plot and a time plot.  The two 

plots display in two different panels with the mag / speed panel as the primary panel. 

Trend/Spectrum – view both a trend plot and a spectrum plot for a trend record 

indicated by the single cursor position. 

Trend/Spectrum/Time – display a POINT’s trend plot, spectrum plot, and time 

waveform plot. The three plots display in three different panels with the trend plot as 

the primary panel. 

Trend/Time – view both a trend plot and a time waveform plot for a trend record 

indicated by the single cursor (if available). 

Plot Tools Toolbar 

Plot Settings – open Plot Settings dialog for the active plot. 

Information Area – open information area beneath the active plot. 

Set Speed – set the cursor position to correspond with the spectrum’s running speed.  
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Set Speed (Multiple) – set the same measurement speed for multiple FFT 

measurements 

Activate Zoom – Click to activate the zoom feature, then click and drag across the area 

of the plot which you would like to zoom. The plot will redraw to display the selected 

area. When using a mouse scroll wheel, position your cursor over the area of the plot 

which you would like to zoom. While holding the Ctrl key, roll the mouse scroll wheel up 

or down.  Rolling up causes the plot to zoom in, while rolling down causes the plot to 

zoom out. 

Zoom Out – zoom out one level. 

Live Data – initiates live data mode when a single POINT is selected. The active display 

updates as new data is collected by its on-line device. Previous spectra and time 

waveform plots are overwritten by updated spectra / time waveforms. 

Play Sound Byte – launches the utility providing various playback options to listen to 

sound data waveform through your computer's speakers or connected earphones. 

Overlays Toolbar 

Overlay Settings – open the Overlay Settings dialog for the selected overlay. 

Single Cursor – display single cursor. Use a single cursor to view individual 

measurement data on the trend plot by moving the cursor to various measurement 

records. Use a single cursor on a spectrum plot to display the amplitude for the 

frequency of the cursor’s current placement. 

Harmonic Cursor – display harmonic cursor to view multiples of the current frequency. 

Opens Harmonic Cursor tab in the plot information area to show details on potential 

harmonics using SKF’s Harmonic Activity Index (HAI). 

Band Cursor – display band cursor to view the frequency / time and amplitude 

difference (delta) between two cursor positions. Opens Spectrum Band tab in the plot 

information area to show details of the left and right cursor positions. 

Sideband Cursor – display sideband cursor reference position with an array of five pairs 

of sideband markers evenly spaced on both sides. Sideband markers to the left of the 

center cursor are referenced with negative numbers; their associated markers to the 

right of the cursor are referenced with positive numbers. Opens Sideband tab in the plot 

information area to show details of the marker positions. 

Peak Cursor – display peak cursor and label all peaks above a user-determined 

amplitude. Opens Peak tab in the plot information area to show details of peak position 

(index), amplitude, frequency, and orders. 

Previous Frequency – display the previous frequency. 

Frequencies – display all frequencies associated with the active plot. 

Next Frequency – display the next frequency. 

Display indicators for notes – active if notes are related to the plot. 

Text Annotation – open Text Annotation Settings dialog. 

Linear Speed – display the value of the linear factor multiplied by the running speed.  
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Curve Fit – display a curve fit overlay to graphically represent the projected linear 

direction a trend is heading based on current data.  

Diagnostics – compute and display all relevant harmonic series of the current spectrum, 

and rank all series found according to probability. The results are shown on the 

Diagnostics tab in the info area below the spectrum plot.  The probability is expressed 

as an activity index, whereby values of 1.5 and higher indicate an increasing probability 

of a significant harmonic pattern. [This option is only available with @ptitude Analyst 

CMSW 7400.] 

In addition, the fundamental frequency of each series is compared to any frequency 

associated with the POINT (for example, bearing defect frequencies). If a match is found, 

the name of this frequency is displayed next to the related harmonic pattern. 

CTA Cursor – display CTA cursor on a time plot and view a time interval’s average 

waveform. Opens CTA Cursor tab in the plot information area to show details of label, 

interval, frequency, magnitude, and contribution (%). 

Band Alarm – display band alarm levels on the plot. Band Alarms provide alert and 

danger alarms on both peak and spectral values within a defined frequency band. 

Envelope Alarm – display a "total spectrum" envelope alarm for the POINT.  You can 

select from a list of previously created envelope alarms or edit a private (unique) alarm 

for the current POINT.  

HAL Alarm – display HAL (harmonic activity locator) alarm levels on the plot for a 

dynamic measurement POINT.  

Overall Alarm – display the alert and danger levels designated for detection of 

machinery faults. The overall alarm levels are based on the measurement’s “baseline” 

vibration level. 

Phase Alarm – display alarm levels for phase data on a polar vector plot.  Normal levels 

display inside small enclosed areas.  Alert levels are contained within a larger enclosed 

area.  Danger levels appear outside the enclosed area.  

Bearing Clearance – display the bearing’s clearance value (typically supplied by the 

manufacturer).  The clearance value assumes the shaft is centered in the bearing and 

defines the physical distance between the shaft and the bearing, multiplied by 2. 

Exponential Curve Fit – display a curve fit overlay to graphically represent the projected 

nonlinear trend based on current data. 

Oil Analysis –display the Oil Analysis overlay on a trend plot. 

All Overlays – open the All Overlays dialog and select the overlays to display. 
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Custom Toolbars 

Toolbar buttons are available for each menu item and available function.  By default, 

only toolbar buttons for commonly utilized features are active.  Buttons are arranged by 

related functionality in separate sections of the toolbar area.  You can enable any or all 

of the available buttons using the Custom Toolbar dialog. 

To open the Custom Toolbar dialog: 

 Select the Customize menu’s Toolbars option.  The Custom Toolbar dialog 

displays. 

 

Figure A - 1. 

The Custom Toolbars Dialog. 

The Custom Toolbars dialog has two main areas.  The Toolbars area displays all 

available toolbars, sorted by name.  All available buttons (active and non-active) for the 

selected toolbar display in the dialog’s second area, Buttons. 

You can configure each toolbar to display the buttons you frequently use.  You may 

activate buttons that are inactive by default, or inactivate buttons that are active by 

default.   
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By default, the Hierarchy View, Navigation, Overlays, Plot Views, Plots, Primary, 

and View Icons toolbars are activated. 

 Click the checkbox next to the toolbar to activate the toolbar. 

 Click the checkbox next to the individual available buttons to activate the buttons for 

the selected toolbar. 

 Click Display toolbar titles to display the toolbar’s descriptive name on the toolbar 

itself for easy identification. 

 Click OK to rebuild all toolbars incorporating your selections. 

 Custom toolbar selections are stored with your user name and 

automatically display for you after initial log in. 
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